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INTRODUCTION 

Desktop publishing with PageMaker on the Macintosh has made great 
progress since we first become involved with version 2.0 of the program 
a few years back. From version 2.0 to 3.0 and now to 4.0, we've seen a great 
product become better and better. The engineers at Aldus Corporation 
have not just m ade PageMaker more powerful with each revision but 
have also better equipped it, making it easier and easier for the graphic 
artist to use it to produce a wider variety of publications. PageMaker, 
which started out as the ideal program for producing the one- or two-page 
layout, is now fully capable of producing d ocuments of several hun
dred pages. 

With all its changes, the program remains true to its original pasteboard 
metaphor, wherein the PageMaker publication window is organized like 
a graphic artist's table, with the area surrounding the one- or two-page 
spread representing the pasteboard onto which text and graphic images 
are pasted. Even if you've never had the pleasure of doing manual layout 
(and so will never miss fun stuff like your waxer, X-acto knife, or press 
type), we're sure that you'll find this system very natural and will become 
comfortable with it in no time at all. For those of you who have worked "on 
the boards," we're positive that you're going to love the world of electronic 
cut-and-paste offered by PageMaker and will soon wonder how you ever 
did it the old-fashioned way. 

A FEW WORDS 
ABOUT THIS BOOK 
v 

This book is intended for all users of PageMaker 4 whether or not you've 
used previous versions ofPageMaker or have a background in the graphic 
arts. Throughout, we've a ttempted to answer the most important question 
the new PageMaker user has: Now that I've got all of these page layout 
capabilities at my command, how do I use them to create the kind of 



xviii 

publications tha t I need to produce? For though it's true tha t as a Macintosh 
program PageMaker 4 is easy to use, that's not the same thing as sayin g 
its use is transparent to the user. 

You'll find that we've tried to answer this question through a combination 
of simple hands-on exercises with fully illustrated discussions on using all 
major features ofPageMaker 4. Chapters 1 through 3 provide a thorough 
introduction to desktop publishing with PageMaker. Chapter 4 explores 
basics of type and its use in PageMaker publications. Chapter 5 discusses 
preparing text and the ins and outs of placing it. Chapter6 takes up graphic 
images and how to prepare and place them. Chapter7 examines the relation
ship between type and graphics in a publication, and the composition and 
layout of the page. Chapter 8 takes a look at using PageMaker 4's new 
"book" features, which make it easy to produce tables of contents and 
indexes for longer publications as well as to print them. Chapter 9 covers 
printing your publications (in-house and out). Here, you' ll also find a 
discussion of using color in publications and preparing them for printing. 
Appendix A is a handy glossary of PageMa ker and desktop publishing term
inology, and Appendix B provides a guide to desktop publishing utility 
programs and companion products that can enhance the use of Page
Maker 4. 

Throughout these chapters, you'll find that we've placed notes, tips, 
and appropriate warnings in the margins to call your attention to short
cuts and paten tia 1 pitfalls when using the feature that's being discussed in 
the main text. Also, note that the names of all menu and dialog box options 
are noted with the use of a d ifferent font (Helvetica Narrow) from the 
regular text (PaJati:no). 

We sincerely hope that our book provides you with a clear an d easy-to
follow road map to using PageMaker 4 tha t not only makes your journey 
profitable, but thoroughly enjoyable as well! 

Greg Harvey & Shane Gearing 
September 7, 1990 
Inverness, California 
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DESKTOP 
PUBLISHING 

Overview of Desktop Publishing V 1 

This chapter gives you a brief overview of desktop publis hing on the Mac
intosh with PageMaker. Ifyouare new to graphic design and the publishing 
industry, you will definitely want to read through these general discus
sions of desktop publishing and how to put together your 0\·vn desktop 
publishing system on the Macintosh. If you are already familiar with 
desktop publishing and understand how the Macintosh handles type and 
graphics, you can safely skip this chapter and move right to Chapter 2 
where you will begin to get hands-on experience with the program. 

WITH PAGEMAKER v 
The term desktop publishing can be defined as the use of a personal com
puter to perform all orsomeofthesteps followed in traditional publishing. 
These are the major steps taken in publishing a document: 

1. Create the text for the publication. 

In desktop publishing this is done with a word processor like 
Word or MacWrite. In conventional publishing, this is done 
either with a typewriter or word processor. 

2. Typeset the edited text for the publication. 

In desktop publishing this is done with a page layout program. 
In PageMaker, you can automatically assign type specifications 
by tagging the word-processed text with the name of a style that 
indicates what font and type size to use. In conventional publish
ing, the text is typeset on a dedicated phototypesetting machine, 
which produces galleys, or galley proofs. Galleys are long sheets of 
typeset text that are the proper width but not the proper page 
leng th. 
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Note 
V' 
A halftone is special 
"screened" version of a 
continuous-tone image 
like a photograph that 
breaks it down into a 
series of tiny dots of 
various sizes that can 
be reproduced by the 
printing press and 
appear as various 
tones of gray to the 
naked eye. 

3. Create the artwork for the publication. 

In desktop publishing this is usually done with separate graphics 
programs like MacPaint and MacDraw, although simple graphics 
like mled lines, borders, and shaded boxes can be created right in 
PageMaker. Photographic images for the publication are con
verted into digitized images by scanning. In conventional pub
lishing, most of the artwork is created by hand by artists working 
with pens, pencils, and other traditional drawing tools. Any 
photographs to be included in the publication are readied for 
printing by creating halftones. 

4. Create the page layout or design for the publication. 

In desktop publishing this is done with the page layou t software. 
In PageMaker, you can create te111plntes, which make it easy to 
reuse the page layouts that you develop for a particular type of 
publica tion, such as a newsletter or brochure. In conventional 
publishing, a graphic artist develops the design of the publication 
on paper, first with rough sketches called tl111111bnnils and finally 
with a complete layout called the camp (for comprehensive). Once 
the final design is approved, the layout is marked in blue pencil 
on paste-up boards indicating where the text and graph ics are to 
go on each page. 

5. Paste up the pages of the publication by placing the text and 
graphics. 

In desktop publishing, this step is done by selecting the docu
ments that contain either the text or graphics to be placed on the 
page. Once a text document is selected and its starting position 
indicated, the text flows according to the page design and style 
assigned to it. If you are placing a graphic, the software usually 
allows you to size, sca le, and crop it if necessary after placing it 
on the page. In conventional publishing, the page makeup s tep is 
done manually by graphic artists. To place text, the galleys are 
cut to fit the space on the page and then pasted in place on 
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paste-up boards. Graphic elements like charts, graphs, and ruled 
lines are also cut and pasted into place on each page. 

6. Send the proofread pages to the printer, who uses them to 
make the plates for printing the initial run. 

In desktop publishing, this step is omitted if the masters for the 
publication are to be produced on a laser printer and then photo
copied. However, if the printed publication requires higher 
resolution than is possible with a laser printer, you can have the 
masters printed on an imagesetter. The printer can then make 
negatives and plates from these high-resolution masters to 
produce the initial print run just as in conventional publishing. 

PageMaker provides you with a page d esign and layout system that is 
modeled on the manual page makeup and layout methods traditionally 
employed by graphic artists. You can crea te a great many desktop pub
lishing applications with it, anything from a standard newsletter to a more 
demanding book design. PageMaker also makes it easy to combine text 
and graphics created from other sources into a seamless page. 

There are two primary benefits to using PageMaker over conventional 
methods for publishing: 

• Substantial savings in annual printing costs 

• Considerable reduction in the time it takes to produce pub
lications 

These savings are especially dramatic for those businesses that previously 
had to rely on outside artists and services for all their publishing needs. 
The time savings you can realize with PageMaker (once you've mastered 
the program) contribute to the overall cost-effectiveness of desktop pub
lislung. In addition, desktop publishing can make you more competitive 
in your field by allowing you to disseminate the latest and mostup-to-date 
information. You will also find tha t desktop publishing allows you to 
accommodate last-minute revisions and corrections that were impossible 
to deal with when using conventional methods. 
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Not only will you be able to expedite production, you will also gain 
more control over its final packaging. If you are doing all of the designing 
yourself with PageMaker, you will have more opportmlity to experiment 
with your designs. Because of its cost-effectiveness, you will also be 
encouraged to desktop-publish more of the documents and forms that you 
use in the office. Many businesses, both small and large, have found that 
the wholesale use of desktop publishing enables them to enhance their 
business image through the use of professional-looking publications. 

DESKTOP 
PUBLISHING ON 
THE MACINTOSH 
v 

Desktop publishing began on the Macintosh with the introduction of the 
LaserWriter by Apple. It should be noted that from the inception of 
desktop publishing, PageMaker has been the leading desktop publishing 
program on the Macintosh, where it continues to earn high marks for the 
many ways that it facilitates page design and layout. 

Even though desktop publishing is no longer confined to the Macintosh 
but is thriving in the MS-DOS environment as well (where Ventura leads 
PageMaker on the PC), the Macintosh remains a natural and, in some 
ways, superior environment for desktop publishing. There are severa l 
reasons for this, all of which s tem from the fact that Macintosh has 
always been a graphics-based computer w hereasMS-DOS computer 
has always been and remains primarily a text-based machine. 

The graphics-based environment of the Macintosh enables PageMaker 
to achieve a high degree of correspondence between the page as displayed 
on the screen and as printed (often referred to by the term WYSIWYG
What You See Is What You Get). This high correspondence between the 
way type and graphics appear on the screen and the way they appear in 
print makes PageMaker an efficient design tool. 

In using the Macintosh, you will find many similarities in the way each 
program operates, regardless of the type of application you are using. This 



Note 
\1 
The correspondence 
between the displayed 
page on the Macintosh 
and the printed page 
on the LaserWriter is 
actually fairly low: the 
screen resolution is 
72 dpi (dots per inch) 
while the LaserWriter's 
resolution is 300 dpi. 
Nevertheless, coupled 
with the Macintosh's 
black-on-white display, 
this screen resolution 
is sufficient to give you 
a very accurate idea of 
how your design will 
appear when printed. 
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similarity between programs can help you in desktop publishing where 
you may need to rely upon many different graphics programs as well as 
your word processor to prepare all of the illustrations and text that you 
need in a single PageMaker publication. 

You will also find that there is a high degree of standardization among 
the different graphics file formats on the Macintosh that permits the easy 
transfer of illustrations into PageMaker. In addition, PageMaker is able to 
read the file formats used by the most popular Macintosh word proces
sors. In the event that PageMaker can' t read the file format used by your 
word processor, you can always save your file as a Macintosh text file, 
which PageMaker can read. And finally, because each Macintosh program 
makes use of and gives you access to the Clipboard (the temporary storage 
location for any text or graphic tha t you cut or copy), you can always use 
it to transfer text and illustrations from an application program to a 
PageMaker publication should PageMaker fail to support direct importation. 

Putting Together Your Desktop Publishing System 
v 
The minimum hardware requirements for rurming PageMaker 4 are a 
Macintosh with 1 megabyte of memory and a hard disk. This means that, 
at the very least, you must have a Macintosh Plus with a hard disk. The 
recommended configuration consists of a minimum of 2 megabytes of 
memory on a Mac SE/30, II, Ilx, Ilcx, Ilci, Ilfx, or Mac portable. Although 
you can run PageMaker 4 on the minimum configuration, you will 
probably find the program to be very sluggish (especially in comparison 
to PageMaker 3), and you may find it frustrating if you work with the 
program regularly. 

If you have to add a hard disk to your Macintosh to use the program, you 
should get the biggest disk that you can afford . In most cases, if you are 
serious about publishing with PageMaker and your publications normally 
require graphic images with the text, you will find that a 20Mb hard disk 
is too small for your needs. This is because graphics files tend to require a 
lot of disk space, especially those that contain scanned images. If at all 
possible, consider a 40Mb hard disk as the minimum size and get an even 
larger one if you can afford it. 
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Selecting a Printer to Use with PageMaker 
v 
For printing with PageMaker, you will probably want to have access to a 
PostScript laser printer like the LaserWriter. Although you can use a dot
matrix printer like the Image Writer II or Image Writer LQ to produce very 
rough drafts of the publications you create in PageMaker, you will want 
at least the quality of a 300-dpi laser printer such as the LaserWriter to 
produce the final printed versions of your work. In fact, some publica tions 
will demand an even higher-quality output than is possible with a laser 
printer. In such cases, you can take your final PageMaker files to a service 
bureau to be printed on a PostScript imagesetter like a Linotronic L-100 
(wi"th a resolution of 1270 dpi) or an AGFA 9400-PS (with a resolution of 
2400 dpi) . 

PostScript is a language developed by Adobe Systems that describes to 
the printer how the text and graphics on the page are to be printed. It has 
now become the industry standard for printing in desktop publishing. 
One of the reasons for its wide acceptance is that any document saved in 
the PostScript format (referred to as Encapsulated PostScript format or 
EPS) is printed at the maximum resolution that the PostScript printing 
device you are using is capable of producing. For example, if you print a 
PageMaker file on a LaserWriter, it prints at a resolution of 300 dpi. 
However, if you then take the same file and print it on Linotronic 100, it 
prints at a resolution of 1270 dpi. Another advantage to u sing PostScript 
as the page description language is that images (both type and illustra
tions) described by it can be easily scaled, rotated, and otherwise ma
nipulated. This scaling ability allows you to select the type size as an 
independent aspect of the font (thus saving a great deal of disk space) and 
print the page at sizes both larger and smaller than 100 percent. 

There are many PostScript laser printers that can be used with the 
Macintosh. Of course, the most popular laser printer for the Macintosh is 
one of the Laser Writer models made by Apple Computer, Inc. Currently, 
you can choose between the LaserWriter liNT (which replaces the 
LaserWriter Plus) or IINTX by Apple. The difference between ·these 
models is one of speed and cost. The Laser Writer IINTX is faster and more 
expensive. 



Note v 
The LaserWriter liNT 
and IINTX allow you to 
connect to an IBM PC 
through a serial port 
only. And, unlike with 
the QMS-PS 810, you 
can't switch between 
Apple Talk and DOS 
simply by changing a 
switch setting. You 
must also restart the 
printer, thereby exiting 
Apple Talk. Doing this 
flushes any fonts that 
have been downloaded 
to the LaserWriter from 
memory, making them 
unavailable to the MS
DOS printer. 
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The LaserWriter IINTX also gives you another feature that is not 
available on the cheaper LaserWriter liNT: it allows you to connect a 
dedicated hard d isk to the printer on which you can store all of the 
downloadable or soft fonts (that is, fonts that aren't built into the printer) that 
you use in d esktop publishing with PageMaker. Fonts stored on the 
printer's hard disk need not be copied (downloaded) to the printer's 
memory before they can be used in printing. The number of fonts that you 
can load on the disk is restricted only by the size of the hard disk. 

In addition, there are several PostScript laser printers that can be used 
with PageMaker from vendors other than Apple, including such printers 
as the QMS-PS (models 810 and II) and the TI OmniLaser. The big 
advantage that these printers give you over the LaserWriters is tha t they 
make it extremely easy to switch between printing from an IBM PC
compatible computer and a Macintosh. For example, the QMS-PS 810 is 
equipped with both AppleTalk and parallel printer ports, allo,.ving you to 
connect the printer to an IBM PC with a parallel cable and to a Macintosh 
with an AppleTalk connector. To switch the printer for use with a new 
computer, you only have to press a button at the back of the printer to select 
the number assigned to the printer. 

When shopping for a PostScript laser printer, you will want to verify 
how many resident fonts the printer offers as well as which ones they are. 
Both the LaserWriter liNT and IINTX have 11 resident fonts, as does the 
QMS-PS 810. These 11 include the typefaces Courier, Times, Helvetica, 
Palatino, ITC Bookman, ITC Avant Garde, New Century Schoolbook, and 
Zapf Chancery. In addition, you get two special symbol fonts, Zapf 
Dingbats and Symbol, and a condensed version of Helvetica, Helvetica 
Condensed. 

Besides the fonts included, you will want to compare the amount of 
printer memory (RAM) included and how fast it prints. The amount 
of RAM is important because it determines not only the number of down
loadable fonts that the printer can retain but also how quickly the printer can 
produce complex graphic images on the page. A PostScript printer should 
have at least 1.5 megabytes of memory. Both the LaserWriter liNT and 
IINTX come with 2 megabytes of RAM, and you can exp and the RAM of 
the IINTX up to a maximum of 12 megabytes. 
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Note 
\1 
Apple Talk is the 
name of the network 
capabilities built into 
the Macintosh System. 
If you connect all of 
your Macintosh 
computers and printers 
with Apple Talk 
connectors, any 
computer can print to 
a laser printer. 

As to printing speed, most PostScript laser printers are rated at about 
8 pages per minute. Tlus represents an average printing speed when the 
pages contain only text. If the pages you are printing contain many 
graphics, you can expect it to take longer to print them. The more 
expensive PostScript laser printers are rated at about 15 pages per minute 
(almost twice as fast as the LaserWriter lis). 

A PostScript laser printer represents a big inveshnent (anywhere be
tween $3,500 and $10,000, depending upon the brand of printer and its 
configuration). To help defray its cost, you can connect the laser printer to 
all of the Macintoshes in the office. You can do this easily with AppleTalk 
connectors (which include a connection box, short cable, and plug tha t fit 
into the laser printer or Macintosh), allowing each user access to it. 

Using Copy Centers and Service Bureaus 
\1 
If a PostScript laser printer of any kind is beyond your means at the present 
time, you can still produce rough drafts of your PageMaker publications 
with a dot-matrix printer and then take your disk to a local copy center and 
print the final version on their LaserWriter. This is essentially the proce
dure you follow when your PageMaker publications demand the high 
resolution of a PostScript imagesetter and you d on't own one: you prepare 
the publication in PageMaker with the LaserWriter as the proof printer 
and then send the disks with the final version to a service bureau, which 
prints the pages on their imagesetter. 

Using an External Monitor 
\1 
One of the biggest problems in doing desktop publishing with Page Maker 
on the Macintosh Plus, Macintosh SE, or Macintosh SE/30 is the small size 
of the screen. Designing the layout for just a single page on tlus 9-inch 
screen is fairly difficult: it is becomes an even more arduous task if you 
have to design a two-page spread in PageMaker. For although PageMaker 
can display a full page or even two facing pages on the built-in screen, the 
image is far too small for you to make ou t any but the largest details. 
Therefore, as you build and refine your page d esign in PageMaker, you are 



Overview of Desktop Publishing V 9 

constantly switching between larger page views to see details and smaller 
page views to gauge the overall effect. 

To help make the design and layout process easier and less time
consuming by cutting down on the amount of zooming and scrolling that 
you must do in PageMaker, you can purchase an external monitor for your 
MaCintosh. If you have a Macintosh SE, there are several brands of full
page or dual-page black-and-white monitors that you can use. If you have 
one of the Macintosh lis (II, Ilx, Hex, Ilci, or Ilfx) or SE/30, in addition to 
using these full- or dual-page black-and-white monitors available for the 
SE, you can also use either a grayscale (that is, a monitor capable of 
displaying various shades of gray rather than simply black or white) or 
color monitor, of which there are many models and sizes to choose from. 

A full-page monitor usually has a 15-inch screen (measured diago
nally), which is capable of displaying an entire81/z by 11 inch page at actual 
size in PageMaker. A dual-page monitor usually has a 21-inch screen, 
which is not quite large enough to display two entire 81/z by 11 inch facing 
pages at actual size (however, you can read almost all of the type when 
using PageMaker's Fit in window view, which displays the page size on a 
21-inch screen at about 80% of actual size). 

When selecting an external monitor for desktop publishing with Page
Maker, there are several things you need to consider: 

• Does most of your design work consist of one-page layouts or 
do you work as much or more with two-page spreads? 

If you rarely work on two-page spreads or layouts that are larger 
than 81/z by 11 inches, the less expensive full-page display is 
probably sufficient for your needs. On the other hand, if you 
work on a number of multipage publications that use facing 
pages, you will probably be more satisfied with a dual-page 
display. 

• Is most of your work printed in color? 

If this is case and you have a Macintosh II, Ilci, Ilfx, or SE/30, you 
might want to consider getting a color monitor. PageMaker 4 
supports the use of spot color in your publications, and many 
Macintosh graphics programs like Adobe Illustrator '88 and 
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Aldus Freehand (version 2.0) support color separations. Al
though the colors as displayed on the monitor don't match the 
printer's colors exactly, using a color monitor can help save a lot 
tin1e in creating illustrations and page layouts. 

• Does your work incorporate a lot of photographs or other types 
of scanned images? 

If you work with black-and-white publications that use a lot of 
scmmed images (see the following section for information on 
sca1mers) and you have one of the Macintosh Us or the SE/30, 
you might want to consider getting a grayscale monitor. This 
type of monitor (usually a dual-page display) is capable of 
displaying various shades of gray (from 64 to 256). This gives 
you a much more realistic view of how a scanned image will 
appear when printed. PageMaker 4 itself contains controls which 
allow you to adjust scam1ed images that you bring in to your 
publications. In addition, programs like Digital Darkroom from 
Silicon Beach Software and Image Studio by Letraset give you 
even more control over the way scanned images appear in your 
publications, even allowing you to retouch them. When perform
ing such work, it helps to use a grayscale monitor because it can 
reflect changes made to the gray levels in an image in ways tha t a 
black-and-white monitor can't. 

When shopping for an external monitor, be sure that you spend enough 
time viewing the display (preferably in PageMaker using documents 
similar to those you will be creating). While manufacturer specifications 
sheets rely heavily on objective data, giving you all of the numbers on the 
resolution and refresh rates of the monitor, the most important aspect of 
a monitor is subjective: be sure that you will feel comfortable working long 
hours in front of it. 

Using a Scanner 
v 
In addition to a large hard disk, a PostScript laser pri11ter, and a large-size, 
external monitor, there is possibly one more piece of equipment tha t you 
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might want to consider adding to your desktop publishing system: a 
sca1mer. Attaching a scanner to your Macintosh allows you to convert 
photographs and other printed images into d igitized images that can be 
placed in your PageMaker publications. Scanned images are saved in a 
type of graphics file known as a grayscale imnge. 

There are several styles of scanners available: hand-held scanners that 
you move down a page to scan it, printer-mounted scanners that you 
attach to dot-matrix prin ters and that scan line-by-line, sheet-fed scanners 
into which you feed single sheets (much like feeding individual sheets to 
a fax machine), and flat-bed scanners with which you lay the sheet on a 
glass (like using a photocopy machine). Of these, the flat-bed design is the 
most versatile because it allows you to scan illustrations and photos in 
bound volumes as well as on sing le sheets, and you generally get the 
poorest quality from the printer-mounted and hand-held scanners (which 
are the cheapest). 

You should understand that the sca1mer is currently the weak Link in 
desktop publishing. The grayscale images that the scanner produces are 
both unwieldy in size (a full-page ph oto can easily require as much as 
150,000 bytes in storage) and poor in resolution when compared to the 
quality of p h otographs in printed material produ ced by conven
tiona l means. 

Primarily because of the lesser quality, m any desktop-published docu
ments won'tuse scanned images to produce illustrations like photographs 
in top-quality publications. Instead, such figu res are prepared in the 
traditional manner of producing halftones and then manually stripping 
them into the blank areas left for such illustrations on the pages. 

The problem with the digital halftones produced by sca1mers is that 
they u se a fixed dot size (although this dot size differs depending upon the 
type of printer you are using, it is constant for that particular printer) . 
Traditional halftones smooth the transition between grays in the image by 
differing the size of the dot according to an area's lightness or darkness. 
Because the computer image can't produce variable-size dots, it has more 
trouble reproducing finer grada tions in the image. 

Scanners differ in the number of gray levels (between 16 and 256) they 
can produce and their resolution (also referred to as the screen frequency, 
which is rated in lines per inch). However, you need to beawarethatas you 
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increase the number of gray levels read in an image, you necessarily 
reduce the printed resolution. As a result, the scanned image represents a 
compromise that allows the highest number of grays at the best possible 
screen resolution. 

Even if the quality of a scanned image is not an issu e in the publication 
you are creating, you still have to be careful that you don't include so many 
scanned images in your PageMaker file that it becomes unwieldy. At best, 
such a file will be slow in printing and, at worst, it can be impossible to 
print because some of its pages require more memory than your laser 
printer has available. 

Despite these problems, you must rely upon scanned images if you 
want or need to produce your publications entirely with PageMaker. To 
help improve the quality of scam1ed images, the program includes an 
image control command that allows you not only to alter their brightness 
or contrast but also to change the number of gray levels or increase or 
decrease the screen frequency of the image. 

For Those Upgrading to PageMaker 4 
v 
If you have used previous versions of PageMaker and are upgrading to 
version 4.0, you will be eager to learn the major new features that have 
been added to it. These include: 

• The Story Editor, which gives you the ability to edit, spell check, 
hyphenate, and find and replace text in your publication 

• New typographic options, which give you greater control over 
the word and letter spacing of the text of the publication 

• Special text effects, including rota ting text in 90° increments and 
condensing and stretching text 

• Links between external text or graphics files and your publica
tion, which can be updated automatically 
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• The Table Editor, which enables you to design and edit complex 
charts and graphs for your publications (PageMaker 4 can also 
import tables created with Word 4.0's Table fea ture) 

• Larger page capability-PageMaker 4 publications can now 
contain up to 999 pages 

• Assembly of several individual publications into a "book," which 
can be printed with a single command 

• Automatic generation of a table of contents for a single publica
tion or multiple publications that have been assembled into a 
book 

• Automatic generation of indexes, including up to three levels of 
subheadings per entry for any number of publications 

AI though the book refers to new features in version 4.0 throughout, you 
will find that the bulk of new features are covered in Chapters 5, 6, and 8. 
Therefore, if you are in a hurry to become familiar with the new features 
and commands in version 4.0 and are comfortable with the basics of using 
PageMaker, you should jump ahead and read through the material in 
these chapters. 

For Those New to Desktop Publishing 
v 
If you have no formal training in design or experience in the publishing 
industry, you can relax. While it's certainly true that a basic knowledge of 
printing terms and some experience in graphic design helps, this knowl
edge and background are certainly not prerequisites to learning PageMaker. 
In fact, you can find many people \•vho have used desktop publishing as 
their entry point into the exciting world of graphic arts and printing. 

However, if you are new to the field, you can help accelera te your 
mastery of PageMaker by taking some time to become familiar with 
the more basic publishing terms that appear on the menus used by the 
program. These include terms such as facing pages, font, italics, justification, 
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kerning, leading, picas, and points. All of these terms and more can be found 
in Appendix A of this book. 

If you ever come across a menu option or term in the text whose 
meaning isn' t clear, you should look it up in this appendix before attempt
ing to complete the exercises that make use of it. This appendix contains 
not only descriptions of the terms but also some figures and diagrams 
illustrating their functions and usage. 

For Those New to the Macintosh 
V' 
If you are new to the Macintosh as well as PageMaker, you'll need to 
review the documentation that came with your computer before attempt
ing to complete the exercises on PageMaker contained in the next few 
chapters. These exercises already assume that you are familiar with the 
mouse and the meaning of common terms that describe its usage such as 
click, drag, and double-click. Jn addition, you need to know how to use the 
scroll bars, move and resize windows, and use pull-down menus. 

If you aren't familiar with these terms or actions, refer to your Macin
tosh System Software User's Guide. This booklet contains basic informa
tion and tutorials covering the use of the mouse, how to manipulate 
windows, and working with files and fi le folders. If you take the time to 
go through these tutorials, you will be well prepared for the exercises that 
you will meet in the upcoming chapters. 

Getting Help in PageMaker 
V' 
To use the online help in version 4.0 of PageMaker, you select the Help 
option on the Windows menu. The screen shown in Figure 1.1 will then 
appear. From this screen you can get help on how to use specific Page
Maker commands or on specific tasks such as starting a new publication 
or working with text blocks. 

Click the Commands button on this menu for a list of PageMaker 
commands . To obtain informa tion about a specific command, choose 
the command nam e in the li st and click the Select button (or double
click the command name). The help screens for the selected command 
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41 File Edit Options Page Type Element l l@fil·ii§i 

( Using Help ) 
( Commands ) 
( Topics ) 
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Aldus PageMaker 4.0 

Figure 1 .1: The PageMaker Online Help opening screen 
v 

) 
) 

give you infom1ation about how to use it, any keyboard shortcut, and 
where to find more information in the documentation. To view help 
screens about related commands, select the d es ired comma nd from the 
More Help pop-up menu by dragging to your selection and releasing 
the mouse button. 

You can also get online help about a particular desktop publishing topic 
or procedure from the opening online help screen by clicking the Topics 
button. When youdo,PageMakerdisplaysa lis toftopicson which you can 
obtain help. When you find a topic of interest, choose it and click on the 
Select button (or daub le-click the topic). To view help screens a bout related 
or alterna te procedures in PageMaker, select the desired topic in the More 
Help pop-up menu. 

When you are finished with the online help, click the Quit Help button; 
this returns you to your previous place and view in PageMaker. 

PageMaker also allows you to obtain menu-sensitive help as you are 
working with the program. To get help about the use of a particular menu 
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option, you press ~+? (or the Help key on the extended keyboard) to 
change the pointer into a question mark, and then use it to click on the 
appropriate menu command. This takes you to the first help screen for that 
command. Once there, you can use the Commands or Topics button to ex
plore other PageMaker commands or procedures. 
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[f you haven't already turned your Macintosh on, now is the time to do so. 
From now on, we will be working directly with the PageMaker program 
rather than talking about how it can be used . If you aren't a t your 
Macintosh as you read this chapter, you will have to follow along in the 
text as best you can, referring to the accompanying figures. You should, 
however, go back over this information and perform the exercises con
tained here as soon as you get the chance. 

STARTING PAGEMAKER v 

P ag~Mal<~r 4 .0 
PageMaker Icon 
v 

To start PageMaker, turn on your Macintosh and follow these steps, using 
Figure 2.1 as a guide: 

1. Move the pointer to the hard-disk icon shown in the upper 
right corner of the desktop and double-click the mouse. 

2. Locate the PageMaker 4.0 folder in the hard-disk window, 
move the pointer to it, and double-click the mouse to open it. 

3. Locate the PageMaker 4.0 icon (shown on the left) in the Page
Maker 4.0 folder, then point to it and double-click the mouse. 

It will take a few moments for PageMaker to load and the program's 
menus to become active. While the program is loading, review the start
up steps. 

Whenever you want to start PageMaker without opening a particular 
publication, you must double-click on the PageMaker 4.0 icon. However, 
if you want to work on a specific publication that you have created, you can 
instead move the Pointer to the name of a publication folder that contains 
the file you want to work on, double-click to open the folder, and then 
double-dick on the publication instead. This saves time because you don't 
have to take the extra s tep of opening the desired publication file from the 
File menu. Double-clicking directly on the publication file icon starts 
PageMaker and opens the publication file you want to work on. 
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Figure 2.1: Starting PageMaker from the desktop 
v 

Aldus Installer Diagnostics 

Opening a Publication in PageMaker 
v 
When you open PageMaker by double-clicking on the PageMaker icon, 
you have to use the Open option on the File menu to retrieve your pub
lication. You can see the File menu and its options to the left. Now take 
these steps: 

1. Move the pointer to the word File on the menu bar. 

2. Click and drag the pointer to the Open option and then release 
the mouse button. 

As you can see from looking at the Open option on the File menu, you can 
also select this option by pressing ~+0, which is the standard method for 
opening a file on the Macintosh. 



Note 
'V 
The Command key is 
often marked with the 
Apple icon('*) as well 
as the cloverleaf icon 
(~).However, in this 
book, it will always be 
denoted by the 
cloverleaf icon. 
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The Open publication dialog box appears as shown in Figure 2.2. Notice 
in this figure that the name of the current folder is listed as PageMaker 4.0. 
All of the folders located within this folder are listed in the box below. 

Now, open a sample publication located in the Tutorial folder. 

3. Move the pointer to the Tutol'ial folder in the list box and click 
the mouse to select it. 

4. Next, move the pointer to the OK button in the upper right 
comer and click the mouse to open the folder. 

This is not the only way to select and open a folder. Instead of clicking on 
the Tutorial folder to select it and then clicking on the OK button to open 
it, you could have done both by double-clicking on the folder. Also, you 
don't have to click on the OK button to open a folder; you can, instead, 
press either Return or Enter. 

Ia Aldus PageMaker 4.0 I 
D MPM 4 Book rf2 
0 Templates 
0 Tutoriel 

Figure 2.2: The Open publication dialog box 
\1 

Windows 

llriiH~ 

=HD 20 

Open: 

®Original 
0Copy 
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After opening the Tutorial folder, you'll see that it contains several of its 
own fold ers. The sample publica tion we want is located in the Lesson 3 
folder. Go ahead and open this folder. 

5. Double-dick on the Lesson 3 folder to open it. 

There is only one publication, Lesson 2 done, in this folder. You want to 
open a copy of this sample p ublication. 

6. If n ecessary, click on the Copy radio button at the lower right 
corner of the list box beneath Open. 

7. M ove the pointer to the OK button and click to open a copy of 
this publication. 

In a few moments the Lesson2 done publication will appear in the window. 

PUBLICATION 
WINDOW 
v 

Now is a good time to examine the parts of the PageMaker window. Fig
ure 2.3 shows you the window as it appears on a Macintosh Plus or 
Macintosh SE, with each part of the publication window identified. 
PageMaker presents its information in a standard Macintosh window that 
contains a Close box, a title bar, scroll bars, and a zoom box. You can also 
see that it contains a Toolbox window in the upper right corner. This 
window has its own Close box in its upper left corner. If you click on this 
box, the window will disappear. You can also relocate this window by 
clicking and dragging on the gray area at its top. 



Getting Acquainted with PageMaker 4 V 23 

AL RULER /MENU BAR 

Element Windows 

ifi.0"1RP.tifiltfAlP.Jrl 
' 'I ' ... ·· ··n-T ' IM-'DI : (. ~-,?---
! -~ 

..•. .. 
' 

' 
' 
' ' 

PAGE ICON 

-' ' 1'-
i' 
' 
' 

i ... .. .............. L ................. . 

; 

Figure 2.3: The PageMaker publication window 
\1 

The Title Bar 
v 
Notice tha t the title bar currently reads "Untitled" instead of "Lesson 2 
done," the name of the file you opened. Because you opened a copy of this 
file rather than the original, PageMaker does not give it a name. It is up to 
you to give this file a name when you first save the changes to it or when 
you quit PageMaker. 

The Rulers 
v 
In this particular publication, the horizontal and vertical rulers are visible 
in the publication window. When you start a new publication, the program 
automatically displays these rulers on the screen. To turn their display off, 
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you select the Rulers option on the Options menu with the mouse or you 
press ~+R. This command is a toggle: if the rulers are visible, selecting it 
will turn them off, and if they are invisible, selecting it will turn them on. 

Notice tha t the rulers display their horizontal and vertica l mea
surements in inches. You can change the system of measurement at any 
time from inches to inches decimal, millimeters, picas, or ciceros (a 
European system similar to picas used in the U.S.), if you are more com
fortable using any one of them. To do so, you select the Preferences option 
on the Edit menu and make your changes in the Preferences dialog box shoW11 
in Figure 2.4. Then to change the units u sed by the horizontal ruler, you 
choose the Measurement system option and select the desired type of unjts 
from the pull-down menu. To change the uruts used by the vertical ruler, 
you perform the same procedure with the Vertical ruler option. From the 
pull-doW11 menu, you can choose the same typeofmutsas you used on the 
horizontal ruler, or new uruts. 

Along with the standard uruts-lnches, Inches decimal, Millimeters, Picas, 
and Ciceros- the Vertical ruler pull-down menu also offers a Custom option 
that allows you to ma tch the tick marks of the vertical ruler to the 
leading that you are using. To do this, type in the leading measu rement 
in points. Then, if the Snap to ruler option is on, PageMaker aligns the 

Prefer ences n OK B 
Layou t ulew: [ cancel ] 

Measurement system: j lnches I 
Verti ca l rul er : jlnches I I points 

Greek t e11t below: p l11 e1s 

Guides: 
0 Front 
@ Back 

Story uiew: 

De tail ed graphics: 
0 Gray out 
@N ormal 
0 High resolution 

Show layout problem s: 
0 Loose/ tight lines 
0 "Keeps" vio lations 

Size: l.--1-2- --,l-1>-.l points Font: jTime s I 

Figure 2.4: The Preferences dialog box 
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Note 
v 
Selecting new units for 
the measurement 
system after you have 
placed text or graphics 
on the page may make 
it harder to align new 
objects, as the tick 
marks of the new 
system will probably 
not correspond to 
those used by the 
previous system. 
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baselines of selected text with the tick marks on the vertical ruler. Doing 
this makes it a great deal easier to align text and graphics vertically on the page. 

When you set the system of measurement to new units, this affects no t 
only the horizontal ruler but aJso a ll dialog boxes tha t require you to enter 
measurements. For example, if you were to reset the margins for the 
publication after changing from inches to picas, you would then need to 
enter the margin settings in picas ins tead of inches. 

You can always override the default units of measurement when setting 
new values in dialog boxes by adding unit abbreviations to the numbers 
you enter, as in the following examples: 

5i for 5 inches 

5p for 5 picas 

Op5 for 5 points 

When the p follows the number, it means picas, and when the p precedes 
the number, it means points. However, PageMaker will not accept a value 
like p5: you must place the 0 before the p so that the program inlerprets it 
as zero picas and 5 points. 

In this book, we will use inches ins tead of picas and points. Picas and 
points are used primarily by people who have formal training in typ e
se tting and manual page layout. Most users without such training find 
it easier to determine the correct settings in inches. Note, however, tha t 
we must use the point measurement system for determining type size and 
line height: PageMaker doesn't give us the option of using any other 
system of measurement. 

Zero Lock and Moving the Zero Points 
v 
Before we leave the topic of the rulers, notice that the 0 points on the horizon
tal and vertical rulers coincide with the upper left corner of the p age in the 
publication window. You can change where the 0 points on each ruler 
intersect as long as the Zero lock setting is not on. You can tell that the Zero 
lock is not operative in this publication because you can see the two dotted 
intersecting lines (they appear almost like ghosted lines) in the upper left 
corner where the horizontal and vertical rulers meet. You use these 
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intersecting lines to change the position of the zero points on the rulers. 
When Zero lock is on, these lines are no longer visible. 

To see how easy it is to change the position of the zero points, move them 
so they intersect the left corner of the heavy black line (rule) at the top of 
the newsletter right below the PORTRAIT masthead. 

1. Move the Pointer to the comer that contains the intersecting 
lines for moving the zero points. 

2. Drag the intersecting lines so the horizontal line is aligned 
with the top of the heavy black rule in the publication and the 
vertical line is aligned with the left edge of the graphic image 
and the first column of text (as shown in Figure 2.5). 

3. When you have the lines in position as shown in Figure 2.5, 
release the mouse button to set the zero points for the horizon
tal and vertical rulers. 

Figure 2.5: Repositioning the zero points of the horizontal and vertical rulers 
v 



Tip 
V' 
Put any text or graphic 
elements that you 
need to reuse in the 
publication on the 
pasteboard. When you 
need to place one of 
these elements on the 
page, locate it on the 
pasteboard, copy it, 
and then place the 
copy on the page. That 
way, the original will 
remain on the paste
board conveniently 
located for the next 
time it nas to be used 
in the publication. 
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The zero points of the horizontal and vertical rulers now coincid e with 
the top of the heavy ruled line and the left edge of the first column in the 
publication. If you wanted to lock them here while you make some 
modifications to the layout of the publication, you could now select the 
Zero lock option located on the Options menu. When working on a p ubli
cation, you can move the zero points to new positions in the publication 
whenever you need to do any sort of measuring (as long as Zero lock is off). 

Try changing the position of the zero points so tha t they once again 
coincide with the top and left edge of the page. 

4. Again move the Pointer to the corner that contains the inter
secting lines for moving the zero points. 

5. Drag the intersecting lines so the horizontal line is aligned 
with the top of the page in the publication and the vertical 
line is aligned with the left edge of the page. 

6. Release the mouse button to set the intersection of the zero 
points on the upper left corner of the page. 

The Pasteboard 
\1 
The white area that surrounds the page or pages tha t you are viewing in 
the publication window is called the pasteboard. You can use the paste
board just as you would the free space on a work table if you were doing 
page layout manually, that is, as a temporary storage area where you can 
keep graphics or text until you are ready to place them on the page. 

Presently, you can only see part of the pasteboard on the left and right 
sides of the page. In fact, the pasteboard extends in all four directions 
around the page or two-page spread displayed in the publication window. 
PageMaker automatic ally centers the page or facing pages between the left 
and right areas of the pasteboard. To bring more of the pasteboard into 
view, you use the scroll bars on the right and bottom of the publication 
window. 
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Note 
v 
If the Toolbox window 
is covering up the 
topmost part of this 
scroll bar on your 
display, move it down 
before you attempt to 
scroll the page down 
to expose the paste
board area that 
extends above the 
page. 

1. Move the Pointer to the scroll box in the horizontal scroll bar at 
the bottom of the publication window, drag it as far to the left 
as it will go, and then release the mouse button. 

Now you can see all of the pasteboard area to the left of the page. 

2. Click on the same scroll box, drag it as far to the right as it will 
go, and then release the mouse button. 

Here, you can see all of the pasteboard area to the right of the page. 

3. Position the Pointer in the middle of the scroll bar at the bot
tom of the publication window and click the mouse once. 

This centers the page once again in the window. 

4. Move the Pointer to the scroll box in the vertical scroll bar on 
the right side of the publication window, drag it as far down as 
it will go, and then release the mouse button. 

Now you can see the previously hidden pasteboard area that 
extends below the page. 

5. Click on the same scroll box, drag it as far up as it w ill go, and 
then release the mouse button. 

This reveals the pasteboard area that extends above the page. 

6. Position the Pointer in the middle of the vertical scroll bar on the 
right side of the publication window and click the mouse once. 

This repositions the page vertically in the publication window. 

Note that you can also click on either the left or right arrows in the scroll 
bars to scroll the page more slowly. 

The Toolbox v 
The Toolbox window, normally in the upper right corner of the Publica
tion window, contains the tools tha t you use to type and edit text, position 
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text and graphics, crop and resize graphics, and draw lines and shapes in 
the publication. Figure 2.6 identifies each tool by name. 

DIAGONAL-LINE TOOL 

POINTER--.,. 

SQUARE-CORNER TOOL 

ROUNDED-CORNER TOOL 

Figure 2.6: The Toolbox 
"il 

r---- PERPENDICULAR-LINE TOOL 

..---CROPPING TOOL 

L---CIRCLE/OVAL TOOL 

When you open an existing publication or start a new one, the Pointer 
is automatically selected. To select a different tool, you simply move the 
Pointer to that tool's icon in the Toolbox and click. The Pointer will then 
change. What it changes to depends upon which tool you select. Table 2.1 
shows you the Pointer associated with each tool in the Toolbox. 

Table 2.1 : The Icon Associated with Each Tool in the Toolbox 

Tool Icon 

Pointer ~ ~ 

Text tool A I 1-Beam 

Cropping tool ~ ~ 
Drawing tools D 0 O l-"- + Crossbar 
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Tip 
v 
If you use the Apple 
extended keyboard, 
you can select the 
Pointer by pressing 
Shift+F1. 

Rlignment ~ 

style ~ 

Define styles... X 3 

Type menu 
v 

Using the Pointer 
v 
The Pointer is used to select menus and their options as well as to position 
tex t and graphics in the publication or to select these elements once they 
have been placed on the page. You are already familiar with how you use 
the Pointer to select menu options. In the next chapter, you will learn how 
you use the Pointer to position the text and graphics tha t you want to add 
to a new page. Later on in this chapter, you will use the Pointer to select the 
text and graphics that have al ready been placed in the Portrait newsletter. 
Once you have selected text in a publication, you can then use the Pointer 
to reposition the text on the page or on a new page. Once you have selected 
a graphic in a publication, you can use the Pointer to resize it or to move 
it on the same page or to a new page. 

Using the Text Tool 
v 
Notice tha t w hen you select the Text tool, the Pointer changes to the 1-Beam. 
If you have used other word processors or graphics programs on the 
Macintosh, you are already familiar with using the 1-Beam. If you haven' t 
yet had a chance to work wi th this tool, you only need to know that you 
use the crossbar on the 1-Beam to line up the base line of the text tha t 
you want to enter. Then, after positioning the 1-Beam, you click the mouse, 
and the program displays a flashing vertical insertion pointer, which we 
will refer to simply as the cursor. 

All of the text that you then type is entered from the insertion point on, 
and the cursor moves along so tha t it always follows the last character 
entered. If you make a typing mistake, you can use the Delete key to 
remove the character or characters, from right to left. To move the cursor 
to a particular character, you press the right arrow key (or the 6 key on the 
numeric pad) or the left arrow (or 4 key on the numeric pad). 

Changing the Font 

You use the Type menu options (shown to the left) to change the font, 
type size, leading, width of characters, amount of space between letters 
and words, type style, or alignment of selected text or text that you are 



Note 
\1 
The 1-Beam cursor is 
also used to select text 
for enhancement or 
editing. To select text, 
you position the 1-Beam 
at the beginning of the 
text and then drag the 
cursor until all of the 
text is highlighted (sel
ected). After selecting 
your text, you can re
place it just by starting 
to type, delete it by 
pressing the Delete or 
Clear key, or enhance 
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about to enter with the Text tool. Notice that the Font, Size, Leading, Set 
width, Track, Type style, Alignment, and Style options on the Type 
menu are followed by solid triangles that point to the right. When you 
select any one of these options, a new pop-up menu of options appears on 
the same level as its parent option, inunediately to its right. To select one 
of these options, you move the Pointer over to the pop-up menu and drag 
down to the new option you want to use before releasing the mouse 
button. 

Figures 2.7 through 2.10 show you the pop-up menus that appear w hen 
the Font, Size, Leading, and Type style options are selected from the Type 
menu. The check marks before the options in each pop-up menu show you 
which options are currently selected. When you select a new option, the 
pop-up menu and parent menu both disappear. When you retu rn to 
the pop-up menu, you will see the check mark preceding the option you 
chose last. 

it by selecting an option r------------------------------, 
on the Type menu. 

r • File Edit Options 

I Stone Serif 
2Stone Sans 
Athens 
Auant Garde 
B I Stone Serif Bold 
B 2St one Sans Bold 
B Aachen Bold 
Benguiat 
Bookman 
C Futuro Condensed 
C Heluetica Condensed 
Cl Futuro Condensedligh t 
Cl Helue tica Condensed light 
CHB Futuro CondEHtraBo ld 
Coiro 
Ce ntSchbk a 
Century Old Style 
Chicogo 
..... 

Leading 
Set width 
Track 
Type sty le 

Type specs ... 
Paragraph ... 
Indents/tabs ... 
Hyphenation ... 

Alignment 
Style 

Figure 2.7: The first part of the pop-up menu of available fonts 
\1 

XT 
XM 
X I 
X H 

~ 
~ 
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Note v 
The pop-up menu 
always appears to the 
right of the selected 
option next to the 
triangle unless, as in 
the case of the Font 
option, there is insuf
ficient room on the 
right side of the 
publication window 
to fully display the 
options {see Fig-
ure 2.7). 

,. 

Track 
Type style 

Type specs .. . 
Paragraph .. . 
Indents/tabs .. . 
Hyphenation .. . 

Figure 2.8: The pop-up menu of standard point sizes 
V' 

ID 
om 
11 
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0~ 
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30 
36 
48 
60 
72 

Now, select some text in the newsletter and examine the text specifica
tions assigned to it. 

1. Click on the Text tool in the Tools menu. 

The Pointer will change to the 1-Beam. 

2. Next, click on the A in Aldus in the heading for the story about 
Aldus Manutius. 

Now, examine the font, type size, leading, and type style for this 
heading in this newsletter. The easiest way to do this is by select
ing the Type spec option on the Type menu. 

3. Click on Type spec in the Type menu or press ~+ T. 

The Type specifications dialog box now appears. This dialog box shows 
you all of the current type settings for the selected text at a glance. Notice 



,. 
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Track 
Type style 

Type spe cs .. . 
Paragraph .. . 
Indents/ tab s .. . 
Hyphenation .. . 

Figure 2.9: The pop-up menu of standard leading choices 
V' 

that the font is Tim es, the type size is 18 point, the leading is 24 point, and 
the type style is bold. 

These type specifications are defined as part of a s tyle named heading 1, 
and the heading 1 s tyle is currently selected for this heading. In PageMaker, 
you can define styles that conta in information on the font and font 
attributes used in the text as well as on the formatting applied to that text. 

We will explore s tyles and how they can help in designing a publication 
later on in Chapter 7. For now, it is enou gh to know tha t styles have been 
used to format the Portrait newsletter and that the heading 1 style is cur
rently selected. You can verify this for yourself. 

1. Move the Pointer to the Type menu and drag it down to the Style 
option. 

Notice tha t when you highlight the Style option, a pop-up menu 
giving you an alphabetical listing of all of the styles d efined for 



34 V Mastering PageMaker 4 on the Macintosh V CH 2 

Type specs .•. 
Paragraph ... 
Indents/tabs .. . 
Hyphenation .. . 

Figure 2.10: The pop-up menu of type styles 
\1 

ltolir. 
Underline O:JCU 
Strikethru O:JC/ 
mmuoom~ oxn 
"lilmc!JC!l l!:D 

~ Reuerse 

thjs publication appears. Notice, also, that the heading 1 style is 
checked, indicating that it is currently selected. 

2. Without releasing the mouse button, move the Pointer down to 
the Define styles option and then release the mouse button. 

The Define styles dialog box appears (Figure 2.11). Notice that the 
styles are listed in a scroll box and that the current style, heading 
1, is listed below the window. 

3. Move the Pointer to the down arrow on the scroll bar to the 
right of the scroll box and click the mouse one time. 

This scrolls the list of styles so that you should see the Subhend 2 
style as the last entry in the scroll box. 

4. Move the Pointer to heading 1 in the scroll box and click the 
mouse one time. 



Note 
\7 
The asterisk (*) 
following the name of 
some of the styles in 
the Define styles 
dialog box iRdicates 
that the style was 
imported into Page
Maker from a word 
processing program 
such as Word. The 
program uses a plus 
sign(+) after a style 
name to indicate that 
formatting beyond that 
called for in the style 
has been applied to 
the selected text. 

• File Edit 
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Options Page Windows 

Define styles n OK , 
Style: ( Cancel ) 

Caption ·········-······~············ 

•' I I (New ..• l 
Headline ( Edit ... ) Normal+ 
paragraph" (R emoue) 
Subhead 1 

( Copy ... ) Subhead 2 

next : Normal+ face : Times + bold+ size: 1 8 + le~ding : 

24 +flush left + space after : 0.167 +hyphenation 

Figure 2.11 : The Define styles dialog box showing the contents of the heading 1 style 
v 

You now see the contents of this style, as shown in Figure 2.11. 
Notice that in addition to listing Times as the font, 18 point as the 
type size, 24 point as the leading, and bold as the type style, it 
also gives you information about alignment and spacing at the 
end of the style, and indicates that hyphenation is used. 

5. Click on the Cancel button after examining the contents of the 
heading 1 style. 

You can display the Style palette in the publication window by selecting 
Style palette from the Options menu (or by pressing :3:€+ Y). When the Style 
palette is d isplayed on the screen, you can go directly to the Edit style dialog 
box to view or modify the style. Just hold down the :3:€ key when you click 
on a style name in the palette. 

If you don' t specify thefo.ntto be used with a style, you can always select 
the type face, size, leading, and styles from the individual choices on the 



36 V Mastering PageMaker 4 on the Macintosh V' CH 2 

Tip v 
If you use the Apple 
extended keyboard, 
you can select the 
Cropping tool by 
pressing Shift+F8. 

Type menu. After you select the font attributes, they will be used whenever 
you select the Text tool and enter text. 

Changing the Font for Existing Text 

If you want to change the font and font attributes for a particular section 
of text after it has been placed on the page, select the text with the Text tool 
(by clicking and dragging until all of the text to be affected is highlighted). 
Then, choose the Type specs option on the Type menu (or press~+ T) and 
make the desired changes on the Type specifications dialog box. 

Using The Cropping Tool 
V' 
When you select the Cropping tool from the Toolbox, the Pointer changes 
into the same icon used for the tool itself. You use the Cropping tool to 
adjust the size or position of a graphic image placed in your publication. 
Before you can use the Cropping tool, you must have placed the graphic 
in the publication and it must be selected (all of these techniques will be 
covered at length in Chapter 6). To resize the image, you place the Cropping 
tool on one of the corners and click the mouse. It then changes to a double
headed arrow that you drag until the image is the size you want. 

You can also use the Cropping tool to ad just an image with in its 
borders. To pan the image, you place the Cropping tool in the center of 
the image and click the mou se. This time, the Cropping tool changes 
to the Grabber hand. Without le tting up on the mouse button, you 
drag the Grabber hand until the image is p ositioned v,rithin its 
borders as you want it. 

Using the Drawing Tools 
V' 
There are five drawing tools included in PageMaker: the Diagonal-line 
tool, Perpendicular-line tool, Square-corner tool, Rounded-corner tool, 
and Circle/ oval tool. When you select any of these tools, the Pointer 
becomes the Crossbar. 

You use the Perpendicular-line tool to draw rules in the publication. 
These rules can be horizontal, vertical, or diagonal at 45 •. To draw a 
diagonal rule a t any other angle besides 45 ·,you use the Diagonal-line tool 



Tip 
v 
If you use the Apple 
extended keyboard, 
you can select the 
Diagonal-line tool with 
ShifttF2, Perpen
dicular-line tool with 
ShifttF3, Square
corner tool with 
ShifttF5, Rounded
corner tool with 
ShifttF6, and Circle/ 
oval tool with 
ShifttF7. 

None 
Hairline 
.Spt ---

..IJpt ---
2pt ---

4pt ---

6pt ---
8 p t 
12 pt 

-------
Reuerse line 

Line menu 
\1 
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instead of the Perpendicular-line tool. To draw a rule with one of these 
tools, you select the appropria te tool, position the Crossbar at one of the 
two ends, and then click the mouse and drag to the other end before 
releasing the mouse button. 

The Square-corner tool is used to draw rectangles and squares. If you 
want these shapes to have rounded corners, you use the Rounded-corner 
tool instead. The Circle/ oval tool is used to draw ellipses or circles. All of 
these shapes are drawn from one of their corners (in the case of the oval or 
circle, you are drawing from the corner of an imaginary rectangle or square 
into which the oval or circle fits). 

To draw one of these shapes, you select the appropriate tool, position 
the Crossbar at one of the corners, and then click the mouse and drag to the 
opposite corner before rel~asing the mouse button. To create a square 
instead of a rectangle or a circle instead of an ellipse, you hold down the 
Shift key after selecting the drawing tool and before you begin dragging 
the Crossbar. 

Changing the Line Thickness 

To change the line thickness for the rule or shape you are creating (or 
have selected), you select the Line option from the Element menu. The line 
pop-up menu (shown to the left) then appears. Line thickness is measure~ 
in points and runs from Hairline to 12 points. As you can see from the Line 
menu, you can also select a double-line or dotted-line pattern for the rule 
or shape that you are creating. The line thickness or pattern you choose 
remains in effect until you select a new one . 

To make a line invisible, you select the None option. This is typically 
used with shapes like rectangles or squares that are shaded, and often 
contain text or graphics. Selecting a shading pattern for a shape drawn 
with the drawing tools is discussed in the next section. 

You use the Reverse line option to change the line pattern to or from the 
paper color. By d efault, white is the paper color unless you change it with 
the Define colors option on the Element menu (see Chapter 9 for information 
on using colors in a publication). Therefore, to draw lines in white in a 
publica tion, you would choose Reverse line on the Line menu, select one of 
the drawing tools, and then d raw your shape. Note that unless you draw 
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Page menu 
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your shape on a contrasting background, as created with one of the fill 
types (discussed in the next section) or colors that you have defined (see 
Chapter 9), all lines that you draw with the Reverse line option will be 
invisible, as they will now match the paper color (white on white in this 
instance). 

Varying the Fill Pattern or Shading 

When you draw a shape like a rectangle, square, ellipse, or circle, the fill 
pattern is automatically set to none. Once you have drawn the shape, if it 
is selected, you can choose a particular kind of shading or fill for it. To do 
this, you select the shading or pattern from the Fill pop-up menu (shown 
to the left) that appear s when you select the Fill option on the Element menu. 
You can choose between no fill (None), the paper color (normally white), 
and solid fill (normally black) for a shape, or you can select a particular 
gray shading percentage from 10 to 80 percent. Below the gray shading 
percentages, you see a number of special patterns that can be used to fill 
the shape that you have drawn. Note that you can't mix these patterns with 
a gray shading percentage; PageMaker will only allow you to select one or 
the other for your shape. 

Changing the Size of the Page View v 
The page layout for the copy of the Porh·ait newsletter that you have 
opened fits completely in the publication window on your screen. As you 
would expect, PageMaker allows you to increase the page size so you can 
do detail work that requires being able to actually read the text and make 
out details of the graphics you' re using. From the Page menu (shown at 
left), you can select Fit in window, 25%, 50%, 75%, Actual size (1 00%), 200%, 
or 400%. 

The program is set up to "greek" any text that appears 6 pixels high or 
smaller (refer to Figure 2.4 to verify this setting in the Preferences dialog 
box). Greeked text in PageMaker is shown by the thick, gray rules 
(mimicking a manual technique u sed by some layout artists when they 
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draw thumbnail sketches of a page layout). Greeked text is used only to 
indica te the shape of the text on the page. Note tha t \·vhen viewing the 
Portrait newsletter with the Fit in window page viev,r on a Mac SE or SE/30 
screen, all but the major headings are greeked (although you can only read 
the masthead, PORTRAIT). 

What text is greeked depends not only upon the point size of the text 
but also on the page size that you've selected and the size of the monitor 
you are using. To see how this works, increase the size of the page as 
follows: 

1. Pull down the Page menu and select the 50% size option (Fig
ure 2.12). 

Note that at half size, the body text is no longer greeked, al
though it is too small to be read. You can choose the 50% size 
option very quickly by pressing ~+5. 

File Edit Options Page 

Figure 2.12: Viewing the page at 50% size 
v 
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2. Move the Pointer back to the Page menu and select the 75% size 
option (Figure 2.13). 

At three-quarter size, the body text is legible, although it is still 
pretty small. You can choose the 75% size option very quickly by 
pressing 3€+7. 

3. Move back to the Page menu and select the Actual size option 
(Figure 2.14). 

At full size, you can easily read the body text. The text, however, 
is still too small to use as the basis for letter- and word-spacing 
adjustments. You can choose the Actual size option very quickly 
by pressing 3€+1 (for 100%). 

4. Move back to the Page menu and select the 200% size option 
(Figure 2.15). 

File Edit Options Page Type Element Windows 

· .. AirliisMilliiil 
tius- The 
Ori.gin.alPage 
Maller 

Figure 2.13: Viewing the page at 75% size 
v 



Note v 
If you hold down the 
Shift key as you 
select the Fit in 
window option on 
the Page menu, the 
program changes to 
what it calls the "Fit in 
world" view, which 
shows you the entire 
page and all the 
pasteboard area 
surrounding it. 
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r C Fi l e Edit Options Page Type Element Window s 

·· · Ai(flis . Manu:~·· · 

tius-The 
Original Page 
Maker 

Figure 2.14: Viewing the page at actual size 
'V 

At twice actua l size, the body text is quite large enough to not 
only make out the letters but also the spacing between the letters 
and words (although the letters for this font and size are very 
grainy). You can choose the 200% size option very quickly by 
pressing ~+2. 

5. Move back to the Page menu and select the 400% size option. 

As you can plain ly see, at four times actual size, you can perform 
all types of detail work on a small section of text. You can in
crease the page size to 400% by pressing ~+4. 

6. Move the Pointer back to the Page menu and select the Fit in 
window option. 

You can always select Fit in window very quickly by pressing ~+W. Be
cause you will need to vary the size of the page often as you execute your 
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Note v 
For every scroll box 
movement in one 
direction, the page 
view moves in the 
opposite direction: down 
for up, up for down, left 
for right, and right for 
left. However, you only 
have to drag the scroll 
box a short way in the 
scroll bar to produce a 
large movement in 
page view. 

Aldus Manu
tins-The 
Original Page 

Figure 2.15: Viewing the page at 200% size 
'\1 
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page designs, you should probably get in the habit of using these ~+letter 

sequences as soon as possible. 

Scrolling the Page in the Publication Window v 
As you increase the size of the page view, you can only see smaller and 
smaller sections of the page in the publica tion window. This is especially 
true if you are using PageMaker on a Macintosh Plus or Macintosh SE or 
SE/30 with only the 9-inch built-in screen, although this can become a 
p roblem at actual size and 200% size even on a Macintosh SE or Mac
in tosh II with a single- or dual-page monitor. To move to new sections of 
the page at larger viewing sizes, you need to know how to scroll the page. 

We have already touched on using the scroll bars in the publication 
window to move new sections of the page into view. To scroll the page 
view, you can either drag or cl ick the scroll box in the scroll bar or click one 
of the two arrows in the scroll bar until the page is properly positioned. In 
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the vertical scroll bar, you drag the scroll box down to move the page view 
up and drag it up to move the page view down. Likewise, in the horizontal 
scroll bar, you drag the scroll box to the righ t to move the page view to the 
left and move it to the left to move the page view to the right. 

In addition to using the scroll bars, you can also use the Grabber hand 
(shown to the left) to do this. To change the currently selected tool into the 
Grabber hand, you hold down the Option key before you depress the mouse 
button. Always be sure to depress the Option key before you depress the 
mouse button. If you have chosen a drawing tool like the Perpendicular
line tool and click the mouse button before you press the Option key, you 
end up drawing a ru Ie instead of scrolling the page with the Grabber hand. 
If you have chosen the Pointer and click the mouse button before you press 
the Option key, you select the graphic or section of text tha t the Pointer is 
on ins tead of getting the Grabber hand. If you ever start a rule or shape by 
mistake, immediately select the Clear op tion on the Edit menu (or press the 
Delete or Clear key on the keyboard). 1 f you ever select a graphic or section 
of text by mistake, immediately click the mouse anywhere outside of the 
borders of the image or text. 

Once the Pointer changes to the Grabber hand, you can move the mouse 
in any direction to scroll new text into view. You may, however, have to 
release the Option key and mouse button to view the part of the page 
brought into view. Note tha t you are not limited to up and down or left and 
right movements as when using the scroll bars: you can a lso pan the page 
diagonally. It is also possible to change direction or retrace your move
ments as long as you don' t release either the Option key or mouse button. 

THE STORY EDITOR v 
There are two ways you can edit the tex t of a publication in PageMaker 
4.0: in the publica tion itself in what's referred to as the layou t view, or 
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in a special text-editing window called the Story Editor. In previous ver
sions of PageMaker, all text editing had to take place right on the page in 
layout view. Version 4 now makes it much easier to do your editing with 
the Story Editor in the story view. 

To change from the default layout view to the story view, you simply 
select the Edit story option on the Edit menu (you can also use the keyboard 
shortcut ~+E or triple-click on the text with the Pointer tool). When you 
do, PageMaker will open a new story window that contains only the 
cmrently selected text. This story window contains two areas: a sidebar on 
the left that shows the names of the styles (if any) used to format the text, 
and an area to the right that contains the actu al text of the story. Neither 
graphic images placed ir1 the text nor the page layout of the text are 
displayed in the story window. 

The font and point size used to display the text of the story in the Story 
Editor are determined by Size and Font settings in the Preferences dialog box. 
The default setting is Times in 12-point size. To change this to some other 
size or font, you need to select Preferences on the Edit menu, and then select 
the Size and/ or Font options beneath Story view in the Preferences dialog box. 

Figme 2.16 shows you the text of the newsletter in story view. There, 
you see the story window with the first heading and the first three 
paragraphs of the story on Manutius. Notice that the names of the styles 
used to format this heading (hending 1) and these paragraphs (Normal) are 
listed in the first column of the story window to the left of the text itself. 
Notice, also, that U1e title of this story window," Aldus Manutius-Th:1," 
is taken from the first part of the title for this story. PageMaker always 
names the story window using the first 18 characters of its text. 

If you choose the Story Editor when no story is selected, PageMaker will 
open a new story window (titled "Untitled:1") that is empty except for a 
dot in the sidebar and a vertical bar after the cursor in the area where the 
s tory text usually is displayed. To rectify such a situation, you first need 
to close the new story window (by clicking on the Close box in the upper 
left corner), then select the text you want to edit (by clicking somewhere 
within it), and, finally, reopen the Story Editor (~+E or triple-click). 

If you use the Pointer tool to select the story you wish to edit before you 
get into the Story Editor, Page Maker will place the cursor at the beginning 
of the text in the story window. If, however, you use the Text tool to select 
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~ * File Edit Options Story Type Windows 

h~ading I 
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printer, e.rul entrepreneur-va:~ establishing vhat vould become th.e e:reatest 

publishing holl3e in Europe, th.e Aldine Press . Liltt Colwnb\13, Ald\13 Manuli\13 

vas driven by foite of of intellect e.rul pel'3onality 10 realize a lifelong dream. 

Norm~l Aldus' e:realest pa,ion vas Greek literature, vhich vas rapidly e;oing up in 

smoke in th.e wake a! th.e maraud in( Turkish army. I 1 seemed o bvio \13 to Ald \13 
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public. The question vu, hov? 
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books vere still being copied by scribes, letter by letter, a penstroke at a time. 

Because of th.e intensity a! 1hi3 labor, books vere fev e.rul cosily. 'They vere 

Figure 2.16: The story window showing text in the story view 
'V 

the text, the cursor will remain in the same position in the text in the Story 
Editor as it was in originally in the layout view. You can use this technique 
to edit text with the Story Editor's commands from a particular place in 
your publication. 

You can open several story windows at one time. PageMaker allows 
you to open a window for each text block placed iJ.1 your publication as a 
unit (you will learn more about placing text in Chapter 5). You can also 
open a new story window, and then either enter new text with the Story 
Editor or import text prepared with as tandalone word processor. Text that 
you enter in a new story window can then be placed in your publicatio~. 

To open a new story window from layout view, you either select the Edit 
story option on the Edit menu or press ::J:€+E without firs t selecting text. If 
you are already in s tory view, you can open a new window by selecting the 
New story option on the Story menu. 
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The Story View Menus 
v 

When you select the story view, PageMaker changes the menu bar by 
dropping the Page and Element menus and adding the Story m enu (Fig
ure 2.17). When you switch from layout to s tory view, you will also notice 
that certain options found on both menus become available while others 
become unavailable. For instance, the Find and Change options on the Edit 
menu, which are unavailable (they appear "grayed out" on the menu) in 
layout view become available as soon as you go into story view. At the 
same time, you will notice that File options such as Page setup, Print, and 
the like, which are available in layout view, become unavailable as soon 
as you get into story view. 

To facilitate text editing in story view, some menus offer new options 
that aren't even displayed on the same menu in layout view. For example, 
you see Display~ and Display style names on the Options menu when you are 
in story view. Neither of these options is displayed on the Options menu 
when you are in layout view. Of course, all of the options on the Story 
menu (New story, Close story, and lmport) areaccessibleonlyinstoryview, 
as this menu appears only when you are using the Story Editor. 

In later chapters, we will explore how to use the commands such as Find, 
Change, Spelling, Create Index, and the Uke, that are unique to the story view 
menus. For now, just practice how to switch between layoutand storyview. 

1. Position the Pointer somewhere on the first column of text in 
the Portrait newsletter and click to select the text. 

/STORY VIEW MENU BAR 

,. a File Edit Options Story Type Windows 

/LAYOUT VIEW MENU BAR 

r C File Edit Option s Page Type Element Windows 

Figure 2.17: Menu bars in story view and layout view 
'1 
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The first text block becomes selected (you can tell tha t it is se
lected because of the wind ow-shade handles tha t now appear at 
the top and bottom of the first column of text) . 

2. Select the Edit story option on the Edit menu (remember that 
ins tead of choosing the option from the menu, you can also 
press :i€+E). 

Doing this switches the program from layout to story view. You 
should now see the firs t part of the text (including the title) in the 
story window that overlays the first page of the publication itself. 
Notice tha t the greeked text of the publication in the page layout 
window below has now become "grayed out." The text and 
graphics in the page layout reappear as soon as you select its 
window. Notice in the story window that the cursor is located 
before the very first character of the title. Notice, too, tha t the 
Toolbox has disappeared. When you are in story view, the Text 
tool is automatically selected and none of the other tools are 
available. 

3. Select the layout view again by clicking somewhere on the 
page layout window below the story window. 

Although clicking on the page layout window below is the 
easiest way to return to layout mode, you can also return to this 
view by selecting Edit layout on the Edit menu (or pressing ~+E). 

As soon as you select the layout view, the story window becomes 
hidden and the text and graphics in the newsletter reappear . 

4. Return to s tory view by selecting the window called" Aldus 
Manutius-Th:l" on the Windows menu. 

Once you've opened a story window, there is no need to reopen 
it when you want to edit some of its text with the Story Editor; 
simply choose its name on the Windows menu. Basic text ed iting is 
performed the same way in a story window as it is in any stan
dard Macintosh word processor, so now let' s select a word in the 
text and replace it. 
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5. Position the Text tool immediately before the gin greatest (the 
second word following Aldus' in the second paragraph) and 
double-click to select it. 

The entire word should now be selected. 

6. Type fondest and press the spacebar so that the beginning of 
the second paragraph reads Aldus' fondest passion instead of 
Aldus' greatest passion (as soon as you start typing, your new 
text replaces the selected text). 

Now, verify that the change you made in the Story Editor is 
reflected in the page layout. 

7. Click somewhere on the page layout window below. 

With the Fit in window view, the text is either greeked or too small 
to read. To check to see that your change was made in layout 
view, you should enlarge the view to actual size. 

8. In the Fit in window view, locate the second paragraph of text in 
the first column, position the Pointer somewhere on this 
paragraph, and then hold down ~+Option and click the 
mous e once. 

This not only enlarges the view to actual size but also shows you 
the area of the publication containing the text you want to view. 
Now, you can verify that the change made in the story view is 
reflected in the layout view. To complete this exercise, you'll 
need to close the story window. 

9. Click on Aldus Man uti us-Th:1 in the Windows menu to select the 
Story Editor, and then click on the Close box in the upper left 
corner. 

You can also close an active story window by selecting the Close 
story option on the Story menu or by pressing ~+W while in story 
view. Once a story is closed, its title will no longer be displayed 
when you select the Windows pull-down menu. When only one 
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story window is open, closing it automatically returns you to 
layout view (when more than one s tory window is open, you are 
returned to the previously opened story window). 

EDITING TEXT 
AND GRAPHICS 
IN LAYOUT VIEW v 

Tip v 
If you make a mistake 
when editing the text 
or graphics, you can 
undo it by selecting 
the Undo option on 
the Edit menu or by 
pressing ~+Z. 

You can also edit text blocks in layout view. In fact, the simple word 
replacement you just made in story view could just as easily have been 
accomplished in layout view. Normally, you will find it easier and faster 
to make editing changes to the contents of the text blocks in the story view. 
Layout view will most often be reserved for placing text and graphics in 
a publication or making changes to their placement. 

Adding Graphics to the Publication 
"V 

Try the next exercise to see how you go about adding a new graphic 
element to the newsletter-shading the masthead (the area that contains 
PORTRAIT, the nam e of the publication). To do this, you must draw a 
rectangle around this area, fill it with a shading pattern, remove its 
borders, and send it to the background. 

1. Press ~+5 to select the 50% or half-size page view, and then 
hold the Option key and depress the mouse button. When the 
Pointer becomes the Grabber hand, use it to scroll the page so 
that you can see the top half. 

2. Click on the gray bar in the Toolbox and drag it to the bottom 
of the screen to ensure that you have a completely unobscured 
view of the newsletter masthead at all times. Then, click on the 
Square-corner tool (the one right below the Pointer tool) in the 
Toolbox. 
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You will use the Square-corner tool to draw a box around the 
masthead area. You can then add shading to this box. Notice the 
guidelines around the masthead (in a different color on a color 
monitor or as dotted lines on a monochrome monitor). You are 
now going to draw a rectangle whose left, top, and right sides 
conform to the guidelines that define the areas of the newsletter 
that contain the masthead and text columns, and whose bottom 
side coincides with the top of the h eavy rule. 

3. Position the Crossbar on the corner of these guidelines right 
above and to the left of the Pin PORTRAIT, drag the mouse to 
the right until you reach the corner above and to the right of the 
Tin PORTRAIT, and then move the cursor down until the 
bottom of the rectangle touches the top of the heavy rule that 
contains the newsletter volume and date information. When 
the outline of your rectangle is positioned correctly around the 
masthead of the newsletter, release the mouse button. 

Now, you are ready to shade the new rectangle that you have 
drawn around the masthead. 

4. Select the Fill option on the Element menu, and then select 10% on 
the Fill menu. 

PageMaker responds by filling the new rectangle with a 10% 
shading pattern. Notice, however, tha t the shading obscures the 
text of the masthead. You need to move the shaded rectangle 
behind the text of the masthead. 

5. Select the Send to back option on the Element menu (you can do 
this quickly by pressing a€+ B). 

Your masthead should look like the one in Figure 2.18. Now that 
you have filled the rectangle, you can remove the lines that form 
its borders. 

6. Select the Line option on the Element menu, and then select None 
on the Line menu. 
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Figure 2.18: The masthead with the shaded rectangle sent to the background 
v 

The rectangle that you just drew and modified is stili selected. To 
complete this change, you need to deselect it. 

7. Select the Pointer tool in the Toolbox. 

Selecting a new tool automatically deselects the element that is 
currently selected (the rectangle in this case). You can tell tha t it 
is no longer selected because you no longer see the handles (the 
tiny black squares surrow1ding the shape) that are used to move 
and resize the graphic. 

Selecting and Repositioning Elements on the Page v 
Let's get some more practice selecting text and graphics in the publica tion 
and repositioning them. 
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1. Using the Pointer, click somewhere on the portrait of Aldus 
Manutius at the top of the first column (beneath the heavy rule) 
to select it. 

Notice that when you select this graphic, PageMaker shows you 
two sets of handles: those that define the graphic image and 
those tha t define the amount (and the shape) of the space that 
surrounds the image. In this particular case, you see handles only 
on the right and bottom sides of the graphic. Now, see what hap
pens when you take the picture of Aldus Manutius out of the 
publication and place it on the pasteboard. 

2. Click on the center of the picture of Aldus Manutius, hold 
down the mouse button a couple of seconds, and then drag the 
image to the left of the publication. When it is positioned over 
the pasteboard, release the mouse button. 

Notice that as soon as you release the mouse button to reposition 
the graphic image on the pasteboard, PageMaker repositions the 
text in the first column so that it fills the empty space previously 
occupied by the picture. Next, try enlarging the point size of the 
heading of this article. Because this heading is formatted with a 
style called heading 1, you need to change the type size in its Edit 
style dialog box. 

3. Press 3€-Y to display the Style palette. Hold the 3€ key as you 
click on the heading 1 style in this window. 

This takes you directly to Edit style dialog box for the l1eading 1 style. 

4. Click on the Type button in the Edit style dialog box, and then 
increase the type from 18 to 24 points and the leading from 24 
to 26 points. When you've finished making these changes, click 
on OK in the Type specifications dialog box and then again in the 
Edit style dialog box. 

You can now see the effect of increasing the size of the heading in 
the newsletter (Figure 2.19). Next, see what happens if you put the 
picture of Aldus Manutius back into its original position. 
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5. Click on the graphic of Aldus on the pasteboard and drag it 
back to its original position in the first column. Make sure that 
the top of the graphic lines up with the horizontal guideline 
beneath the heavy rule, and that the left edge of the graphic 
lines up with the left edge of the first column. When it does, 
release the mouse button. 

Once again PageMaker reformats the text of the article so that it 
conforms to the outer boundary of the Aldus graphic. Next, let's 
resize the graphic so that it's a little smaller. Start by enlarging 
the page view to actual size. 

6. Position the Pointer somewhere on the graphic, and then press 
3€+0ption and click the mouse button to change the page view 
to actual size. 

Figure 2.19: The newsletter after removing the graphic and increasing the type 
V size of the heading 
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Now, you should reposition the zero points so that they intersect 
the upper left corner of the graphic image. 

7. Move the Pointer to the upper left corner of the PageMaker 
display that contains the intersecting lines for moving the zero 
points. Drag these lines down and to the right until they coin
cide with the upper left corner of the graphic, and then release 
the mouse button. 

The upper left corner of this graphic now coincides with the 
vertical and horizontal zero points. You can now use the vertical 
ruler to reduce the height of the graphic to lY2 inches. To help 
you resize the graphic to this height, you should add a guideline. 

8. Position the pointer on the horizontal ruler at the top of the 
display, then hold down the mouse button. When the Pointer 
changes to a double-headed arrow, drag the guideline down 
until it corresponds to the 1~-inch mark on the vertical ruler. 
When it does, release the mouse button. 

You will now resize the graphic w1til its height corresponds to 
the guideline you just added. To maintain the correct proportions 
when resizing the image, you need to hold the Shift key as you 
drag the mouse to resize it. 

9. Position the Pointer on the handle in the lower right corner 
(the white handle of the graphic itself, not the black one that 
marks the space surrounding the graphic). Then hold down 
the Shift key and the mouse button. As soon as the Pointer 
changes into a double-headed arrow, drag the mouse diago
nally until the bottom of the Aldus graphic coincides with the 
guideline at the 1~ mark on the vertical ruler. When this 
happens, release the mouse button. 

As soon as you release the mouse button to resize the graphic, 
PageMaker automatically reformats the text block to conform to 
this new shape. Finally, deselect the graphic image. 
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10. Position the Pointer anywhere on the pasteboard and click the 
mouse. 

You can deselect a text block or graphic image either by selecting 
a new tool from the Toolbox or by clicking the mouse in a new 
area of the display. Your screen should now resemble the one 
shown in Figure 2.20 . 

. . .. Aldti"& Mariti~· 
tius-The 
Original 
Page Maker 

Figure 2.20: The newsletter after resizing the graphic image of Aldus Manutius 
v 

Modifying a Graphic on the Master Page v · 
Let's make one more change to the Portrait newsletter. Let's increase the 
thickness of the border surrounding the page. This border was created by 
drawing a rectangle with the Square-corner tool. To increase the line 
thickness, you only have to select the rectangle, and then select a new point 
size on the Line menu. Begin this exercise by changing the page view to Fit 
in window. 
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1. Select the Fit in window option on the Page menu or press ~+W. 

Next, you need to select the rectangle that creates the border for 
the page. 

2. Position the Pointer somewhere on the rectangle that encloses 
the masthead and columns of body text in the newsletter, and 
then click the mouse to select it. 

Notice that this rectangle does not become selected when you 
click on it. No matter where you click on this rectangle, you will 
find that you can't select this shape with the Pointer tool. If you 
clicked on the greeked text on either side at the very bottom of 
the page (representing the footer for the newsletter), you would 
also find that you couldn't select it. 

You can't select this information because it was placed on the master 
page created for this publication. When you start a new publication in 
PageMaker, you usually start by crea ting master pages that contain all of 
the standard text and graphics that you want printed on every page of the 
publication. After setting up the master pages, each new page that you add 
to the publication already contains all of the text and graphics placed on 
its master page. Then you place the text and graphics unique to that page. 

Before you can edit any graphic or text placed on a master page, you 
must select it. 

3. Position the Pointer on the page icon that contains the R (for 
right-hand page) exactly in the lower left corner of the publica
tion window (the master page icons are always located before 
the icons representing the actual pages in your publication). 

When you select the master page icon, only the guidelines and 
the information added to the master page remain in the publica
tion window. Notice that besides the rectangle border, the only 
other information placed on the Portrait newsletter master page 
is the footer information at the bottom of the page. 
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4. With the Pointer tool, click somewhere on the rectangle that 
forms the page border. 

I 

As soon as you click on the shape in the master page, it is se
lected (as evidenced by the appearance of the handles). Now, you 
can increase the point size of the lines used to draw this graphic. 

5. Select Line from the Element menu, and then select 4 pt on the Line 
menu. 

Notice that the border lines are now noticeably thicker. Return to 
the first page. 

6. Click on the page 1 icon in the lower left corner of the screen 
display to the right of the right-hand master page icon. 

Once again you see the actual text and graphics on page 1. 
Notice that the newsletter border appears thicker on page 1 and 
that this border graphic is no longer selected. 

SAVING YOUR WORK v 
All of the work you have done up to now is still unsaved and is, therefore, 
at risk. To save this modified copy of the Portrait newsletter in a new file, 
you must give it a name when you select the save option. 

1. Press ::i€+5 to begin the save procedure (you can also choose 
this option by selecting the Save option on the File menu with 
the mouse). 

The Save publication as dialog box appears (as shown in Figure 2.21). 
Notice the because you have not saved this copy of the publica
tion previously, no file name appears in this dialog box. 

2. Type Portrait News #1 as the name for this file and click on the 
OK button (or press the Enter or Return key) . 
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Notice that the file name you just entered now appears in the title 
bar, replacing "Untitled." 

Your work is now saved on disk (in the same folder as the original Lesson 
2 done file). 

PRINTING YOUR WORK v 
Before you quit PageMaker, you will probably want to print your work. If 
you have a printer attached to your Macintosh, go ahead and take the 
following steps to obtain a printout of the p age. 

1. Press ~+P to bring up the Print to dialog box (you can also 
choose this option by selecting it on the File menu with the 
mouse). 

Notice the name of the printer that appears after Print to in this 
dialog box. This is the name of the printer that is currently se
lected in the Chooser. If this is not the printer you are going to 
use, you must select the Cancel button in this dialog box. Then 
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select Chooser from the Apple menu and designate the name of 
the printer you want to use before selecting the Print command 
again. If you are printing with a laser printer, check that the name 
of the printer after Printer type at the bottom of the dialog box 
matches the name of the printer following Print to at the top. If not, 
click on the Change button and select the correct printer name. 

2. Click on the Print button (or press Enter or Return). 

Your printed page will resemble the one shown in Figure 2.22. 

3. After the page is printed, select the Quit option by pressing 
~+Q (you can also choose this option by selecting it on the File 
menu with the mouse). 

1. Move the pointer to the hard-disk icon shown in the upper 
right corner of the desktop and double-dick the mouse. 

2. Locate the PageMaker 4.0 folder in the hard-disk window, move 
the pointer to it, and then double-click the mouse to open it. 

3. Locate the PageMaker 4.0 icon in the PageMaker 4.0 folder, 
point to it, and then double-click the mouse. 

PageMaker 1. Select the Open option on the File menu or press ~+0. 
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Aldus Manu
tins-The 
Original Page 
Maker 
Five hundred years ago, 

Christopher Columbus was on his knees in 
throne rooms throughout Europe, scrambling 
to finance his first voyage to the New World. 
Meanwhile, his Venetian countryman Aldus 
Manutius-scholar, printer, and entrepre
neur-was establishing what would become 
the greatest publishing house in Europe, the 
Aldine Press. Like Columbus, Aldus Manu
ti us was driven by force of of intellect and 
personality to realize a lifelong dream. 

Aldus' fondest passion was Greek litera
ture, which was rapidly going up in smoke in 
the wake of the marauding Turkish army. It 
seemed obvious to Aldus that the best way to 
preserve this literature was to publish it
literally, to make it public. 1l1e question was, 
how? 

Although it had been forty years since t11e 
advent of Gutenberg's perss, most books were 
still being copied by scribes, letter by le tter, a 
penstroke at a time. Because of the intensity 
of this labor, books were few and costly. They 
were also unwieldy. Far too large to be held 
in the hands or in the lap, books sat on lec
terns in private libraries and were seen only 
by princes and the clergy. 

One day, as he watched one of his workers 
laboring under the load of books he was 
carrying, Aldus had a flash of insight: Coop
uld books from tl1e Aldine Press be made 

Portrail 

V' CH2 

small enough to be carried without pulling a 
muscle? And could he produce the elegant, 
lightweight volumes he imagined and still sell 
them at an attractive price? 

The first problem was how to print more 
legible words per page and thus reduce the 
number of pages. Aldus needed a smaller 
typeface that was both readable and pleasing 
to the eye. The work of the Aldine Press had 
attracted the notice of the finest typographic 
artists in Europe, so Aldus was able to enlist 
t11e renowned Francesco Griffo da Bologna to 
design a new one. Under Aldus' direction, 
Griffo developed a typeface t11at was 
comparatively dense and compact and t11at 
imitated the calligraphy of courtly correspon
dence. The result of this Aldus-Griffo col
laboration was the ancestor of what we now 
call italics .. 

The new typeface enabled Aldus to print 
portable and highly readable books. Besides 
the first edition of Dante's Divine Comedy, 
Aldus published the essential texts of Greek 
literature: the histories of Herodotus and 
Thucydides, the tragedies of Sophocles, t11e 
epics of Homer, and the treatises of Aristotle, 
tl!Us rescuing them from relative oblivion. 

The timing was perfect. With the growth 
of the merchant class in Venice, Florence, 
Naples, and Rome, a new market ripe for 
books had recently emerged. This newly 
prosperous middle class was flush with money 
and ankshious for intelligent ways to spend it. 
1l1e new books from the Aldine Press were an 
immediate success. 

As more books became available, the 
middle classes in Italy-and ultimately in all 
of Europe-grew more literate and t11e Aldine 
Press became more prestigious. And Aldus, 

Page I 

Figure 2.22: The printed version of the modified newsletter 
\1 



To Open a 
Publication 
Before Starting 
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2. Double-click the folder containing the publication you 
wish to open. 

3. To open a copy of the publication, dick on the Copy radio 
button, and then click on the OK button. To open the original 
publication, just double-click on the name of the file. 

PageMaker 1. Double-click on the folder that contains the publication file 
you wish to open. 

To Change 
the Size of the 
Page View 

2. Double-dick on the name of the file you wish to open. Doing 
this will start PageMaker and open the original publication 
that you selected at the same time. 

1. To change the page view to actual size (100%), select the 100% 
option on the Page menu or press ~+1. To enlarge a specific 
part of the page to actual size from the Fit in window view, posi
tion the Pointer in the area, then press :J€+0ption, and then 
click the mouse button once. To return to Fit in window page view, 
press :J€+0ption and click the mouse button a second time. 

2. To change the page view to twice actual size (200%), select the 
200% option on the Page menu or press :J€+2. To enlarge a spe
cific part of the page to 200% size from actual size, position the 
Pointer in the area, then press :J€+0ption+Shift and click the 
mouse button once. To return to actual size, press :J€+0ption 
and click the mouse button a second time. 

3. To change the page view to three-quarters actual size (75%), 
select the 75% option on the Page menu or press :J€+7. 
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To Save a 
Publication 

4. To change the page view to half actual size (50%), select the 50% 
option on the Page menu or press 3€+5. 

5. To change the page view so that the entire page will be dis
played on the screen, select the Fit in window option on the Page 
menu or press 3€+W. 

1. To save a publication for the first time, select Save on the File 
menu or press 3€+5. Then, type an original file name for the 
publication in the Save dialog box, and click the OK button. 

3. To save subsequent changes to the publication under the same 
file name, press 3€+5. 

4. To save subsequent changes to a publication under a new file 
name, select Save As on the File menu, then, type a new file name 
for the publication in the Save dialog box, and click the OK 
button. 



DESIGNING 
YOUR FIRST 
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v 



Designing Your First Publications V 65 

Whether or not you have a background in graphic design and conven
tional publishing, if you are ne'"' to desktop publishing, you may initially 
find using PageMaker to be a somewhat overwhelming experience. You 
may, for example, feel uncertain as to how to begin a new publication in 
PageMaker even when you have a clear idea of how you want the final 
publication to look and what it will contain. 

To help you overcome any such feelings, this chapter concentrates on 
how to begin new publications. In it, you will learn how to create two new 
publications: the first from a template supplied with the program, and the 
second from scra tch. In each instance, we wilJ examine closely how to go 
about using PageMaker's basic features to translate your design into a 
reality. 

CREATING A 
PUBLICATION 
FROM A TEMPLATE v 

Wll 
~ 
PageMaker 
Template Icon 
V' 

One of the folders supplied w ith your PageMaker 4 package is marked 
Templates. This folder contains quite a few templates for common appli
cations such as newsletters, flyers, brochures, and the like. A template provides 
a ready-made form whose design you can adopt or customize to create your 
own publication. PageMaker templates use the icon shown on the left. This 
icon differs froni the one used for regular PageMaker publications in that it 
contains no interior shading to represent text on the page. 

Each template contains text and graphics that function merely as 
placeholders to give you an idea how the publication w ill look. To create 
your own publication, you replace these placeholders with the actual text 
and graphics that you have prepared with your word processor and the 
other graphics programs you use. If you find that you don't need a 
particu lar placeholder, you just delete it. In most cases, you will also have 
to make other minor adjustrnents in the design, especially when the text you 
have prepared won' t fit in the amount of space allowed in the template. 
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Exercise 1: Making a Brochure from a Template 
v 
To learn how to build a publication from a template, you should perform 
the following exercise in which you will use the template called Brochure 
to create a brochure for a fictitious company called Sloane & Garrett. 

1. Start PageMaker, then select Open from the File menu (or 
press 3€+0). 

2. Double-click on the Templates folder to open it. 

3. Locate Brochure 1 and double-click on it to open a copy of this 
template. 

Double-clicking on the file name will open a copy of the template 
and not the original because Copy is the default. You can tell that 
this is a copy because the Title bar shows Untitled rather than 
Brochure 1, the name of the template file. 

4. Select the Save option on the File menu (or press ~+S). 

It is always a good idea to select a name for the publication and 
save it under this name at the outset. That way, you can save 
yarn work as you progress simply by pressing ~+5. 

5. Type SG Brochure #1 as the name for the document. Make sure 
that the Publication button is still selected, and then click on the 
OK button (or press Return or Enter). 

You should now see the name of the publication in the Title bar. 

Notice that the first page of this brochure has placeholders for the com
pany name, brochure title, mailing address, return address, and three 
headings. 

Replacing the Text Placeholders in the Template 
v 
The placeholders for all of the text for the outside cover of the brochrne are 
saved on page 1 rather than on the right-hand master page; this brochure 
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consists of two pages only-outside (page 1) an d inside (page 2). 

1. Position the Pointer on the Company Name placeholder, hold 
down the 3€+0ption keys, and then click the mouse to increase 
the page view from Fit in window to actual size (100%). 

Next, you are going to select the Company Name placeholder 
and then edit its contents in the story view. 

2. Click somewhere on the Company Name placeholder to select 
it, and then press 3€+E to get into story view. 

You should see Company Name as the name of the style in the 
sidebar of the story \·vindow. The cursor should be positioned 
immediately before the C in Company Name to the right. 

3. Hold down the Option and Shift keys and press the right
arrow key (6 on the numeric keypad) twice to select Company 
Name, and then type Sloane & Garrett. 

Before you return to the publication, you should make a couple 
of changes to the Company Name style that formats this text in the 
brochure. 

4. Position the Pointer on Company Name in the Style palette, 
hold down the 3€ key, and then click the mouse to open the Edit 
style dialog box for this style. 

You will increase the type size from 18 to 24 points and change 
the type style to italic. 

5. Click on the Type button in the Edit style dialog box, and then 
increase the Size to 24 points and click the Italic check box under 
Type style near the bottom of the dialog box (leave Bold selected). 

Now, you are ready to return to the story window to see the 
effects of your changes to the Company Name style. 
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6. Click on the OK button in the Type specifications dialog box, and 
then click the OK button in the Edit style dialog box. 

When you return to the story window, you will see the text 
displayed in italk style (remember that the font and type size of 
the text in the story window are determined by these settings 
in the Preferences dialog box). 

7. Click on the Close box in the upper left corner of the story 
window to close it and return to the brochure. 

When you return to the brochure, you should now see the results 
of editing the Company Name placeholder and editing the Com
pany Name style. Your screen should now resemble the one 
shown in Figure 3.1. 

Next, you will edit the graphic placeholder below the company name 
and replace the Title Placeholder text. To do this, you should scroll this 

' • File Edit Options Pa 

~Sloane & 
lGarrett 

Figure 3.1: Brochure template after replacing the Company Name placeholder and editing its 
v style 
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lower section of the third panel of the brochure into view. 

8. Use the Grabber hand (by holding down the Option key before 
you depress the mouse button) to drag the lower right corner of 
the brochure into view. 

You should be able to see the lower part of the shaded rectangle 
graphic and all of the Title Placeholder text. 

9. Click somewhere on the shaded rectangle to select it. 

This rectangle is a graphic placeholder that would normally be 
replaced by some sort of graphic image (most likely a scanned image). 
h1 this exercise, you will just select a new fill pattern for the shape. 

10. Select the Fill option on the Element menu, and then select the larger 
diagonal fill pattern (shown iri Figure 3.2) on the Fill menu. 

,. • Fi le Edit Options Pe 

None 
1. Paper 

~olid Brinq tu tmn t 
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30"1. ~ I!''Ht rototiun ... 

./40"1. QiiiP TeHt wrap ... 
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Rounded corners ••• 

11111111111111 Define colors ... 
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l.inl:: info ... 
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Figure 3.2: Selecting a new diagonal fill pattern for the brochure 
v 
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Now you are ready to select the Title Placeholder and replace this 
with the title for the brochure. 

11. Triple-click somewhere on the Title Placeholder in the bro
chure (or click once, then press ~+E). 

This takes you directly to the story window. Here, you will enter 
the actual title for the brochure. 

12. Select the word Title and replace it with the word Financial, 
then select the word Placeholder on the line below and replace 
it with the word Services. 

Next, make a slight modification to the type for this placeholder 
by making it bold. 

13. Position the Pointer on Title in the Style palette, hold down the 
~ key, then click the mouse to open the Edit style dialog box for 
this style. 

14. Click on the Type button in the Edit style dialog box, then click the 
Bold check box under Type style near the bottom of the dialog box. 

Now you are ready to return to the story window to see the 
effects of your changes to the Title style. 

15. Click on the OK button in the Type specifications dialog box, then 
click the OK button in the Edit style dialog box. 

The Financial Services text in the story window should change to 
bold. You are now ready to return to the publication. 

16. Click on the Close box of the story window to close it. 

The third panel of the brochure is now completed. Next, you will work 
on the center panel that contains the return address and the mailing 
address. Note that both these addresses are rotated 90° counterclockwise 
(PageMaker 4 allows you to rotate any text block in 90° increments). As 
you will address your Sloane & Garrett Financial Services brochure with 
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mailing labels printed with your word processor, you don't need to retain 
the placeholders for the mailing address in your brochure. 

17. Use the Grabber hand to scroll the page up slightly and to the 
right so that you can see part of the mailing address and all of 
the return address in the PageMaker display. 

Before you replace the return address placeholders, you should 
delete the mailing address placeholders. 

18. Click somewhere on the mailing address placeholders near the 
center of the middle panel to select this text block, then press 
the Delete key to remove it. 

Now you are ready to replace the return address placeholders 
with Sloane & Garrett' s mailing address. 

19. Click on the mailing address in the lower left corner of the middle 
panel of the brochme, then press 3€+E to get into story view. 

Although this text is rota ted in layout view, it assumes a normal 
orientation in story view (this is why you always want to edit 
rotated text blocks with the Story Editor). 

20. Replace the Name placeholder with Sloane & Garrett. Replace the 
Address placeholder with 4096 West 49th Avenue. Replace the 
Citt;, State Zip placeholder with New York, NY 10012. 

Presently, the type size for the return address is 8.5 points. 
Increase this size to 9 points and change the leading to 9 (this is 
referred to as setting the text sol id-9 on 9) . 

21. Position the Pointer on the second Mailing Address style (it is 
already selected) in the Style palette, hold down the 3€ key, 
click the mouse to open the Edit style dialog box for this style, 
then click on the Type button in the Edit style dialog box, and 
change the Size to 9 points and the Leading to 9 points. 
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22. Click on the OK button in the Type specifications dialog box, click 
the OK button in the Edit style dialog box, then click on the 
Close box in the story window to return to the layout view. 

23. Your brochure should now resemble the one shown in Figure 3.3. 

You are almost finished with the outside of the brochure. All tha t 
remains to do is to replace the headings in the first panel (this 
panel will be the first one you see when you open the folded 
brochure). 

24. Select the Fit in window view (:J€+W), then click somewhere on the 
text in the first panel of the brochure to select it, and press 3€+E 
to get into story view. 

This s tory has three Head 1 placeholders (you can only see the 
first two) that you will replace with real text in the story window. 
Notice that body copy for this brochure template is made up of 

r ei; File Edit Options Poge Type Element Windows ... 
~0 SG Brochure # 1 

Figure 3.3: Sloane & Garrett brochure after deleting the mailing address placeholder and replacing the 
V return address placeholder 
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Latin text. This is dummy text whose only purpose is to show the 
effect of the shape of the text on the design of the publication. 
This dummy text will be replaced with the actual text before the 
brochure goes into production. In your brochure, you will leave 
the dummy text as body copy placeholders. 

25. Select the first Head 1 placeholder and replace it with 
MUTUAL FUNDS. Select the second Head 1 placeholder and 
replace it with ROCK-SOLID INVESTMENTS. Select the third 
Head 1 placeholder (you will have to scroll up the text to see it) 
and replace it with PORTFOLIO ANALYSIS. 

Change the Head 1 style from regular to italic boldface type. 

26. Position the Pointer on the Head 1 style in the Style palette, 
hold down the ~ key, click the mouse to open the Edit style 
dialog box for this style, then click on the Type button in the Edit 
style dialog box, and click on the Italic check box under Type style. 

27. Click on the OK button in the Type specifications dialog box, click 
the OK button in the Edit style dialog box, then click on the 
Close box in the story window to return to the layout view. 

If you are using a Mac Plus, SE, or SE 30 with the built-in 9-inch 
screen, you won't be able to see the headings in the first panel in 
the Fit in window view (at that size, all of the text in this panel is 

. greeked). If this is the case, you need to increase the page view 
(to about 75%) to verify your changes. 

28. Press ~+S to save your changes under the same file name. 

If you have a printer available, you should now print the first 
page of your brochure (we aren't going to go on and complete the 
inside of the brochure-you can do that on your own if you like). 

29. Press ~+P, then select the 2 in the Page range and replace it 
with 1 before you click on the Print button. 

Your printout should resemble the one shown in Figure 3.4. 
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CREATING A 
PUBLICATION 
FROM SCRATCH v 

Designing Your First Publications V 75 

Now that you have a better idea of how to build a publication from a 
template, you are ready to learn how to design a publication from scratch. 
Although templates are great timesavers, not every publication you under
take in PageMaker can be created efficiently from one of the templates that 
come vvith the program. 

Most of the time, as part of designing a new publication, you build a new 
template. This template contains the layout grid, which determines the 
number of text columns and any elements su ch as running heads or 
page numbers tha t should appear on almost every page of any publication 
built from the template. 

After you save your design as a template file, you then open this file 
whenever you need to start a new publication that follows the design. Then, 
you build your publication by adding the necessary text and graphics from 
word processing and graphics files that you've already prepared, using 
separate Macintosh programs. Once you've finished layingoutthe pages, you 
save the publication in its own file. 

Designing the Cover for an Annual Report v . 
For the first publication of your own design, you will create the cover 
for the 1990 annual report for the firm of Sloane & Garrett. Since this has 
been the first year in which the company has wholeheartedly embraced 
desktop publishing with PageMaker, it is only fitting that PageMaker be 
used to produce the entire annual report. 

The final design for the cover of the annual report is shown in Figure 3.5. 
In this exercise, you will create a new template and then use it to build the 
actual cover following the design shown here. Although the body of 
the annual rep ort will be built from the same template (modified some
what), it will not be kept in the same publication file as the ~over. 
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Sloane & Garrett 
Annual Report 
for year ending December 31, 1990 '90 

"The direction we take in the 1990s 
will determine our course well into 
the 21st century." 

CONTENTS ln se perpetuo Tempus as 
revolubile gyro lam revocat 
Zcphyros, vcrc tcpentc, novos. 
lnduiturque brev Tell us reparata 
iuvcntam, lamque sol uta gelu 
dulce virescit humus. Faller? an 
et nobis rcdeunt in carmina 
vires, lngcniumque mihi 
munere veris adest? Munerc 
veris adest, itemmquc vigescit 
ab illo (Quis putet?) atque 
aliquod iam sibi poscit opus. 
Castalis ante osculos, bifid 
umque cacumen oberr.u. 
Pyrenen somnia nocte ferunt 
Concitaquq arcane fervent mihi 
pectora motu, Et furor, et 
sonitus. 

In se perpctuo Tempus as 

-Gary Sloane 

revolubile gyro lam revocat 
Zcphyros, vere tepente, novos. 
lnduirurque brev Tell us reparata 
iuventam, lamque sol uta gelu 
dulce virescit humus. Failor? an 
et nobis redeum in carmina 
vires, Ingeniumque mihi 
munerc vcris adcst? Munere 
veris adest, itemmque vigescit 
ab illo (Quis putct?) atquc 
aliquod iam sibi poscit opus. 
Casta! is ante osculos, bifid 
umque cacumen oberrat. 
Pyrenen somnia nocte fcmnt. 
Concitaquq arcane fervent mihi 
pectora motu, Et furor, et 
sonitus. 

In se perpetuo Tempus as 
revolubile gyro lam revoc:u 

Figure 3.5: Final design for the cover of the Sloane & Garrett annual report 
'i/ 

Opening a New Publication 
'V 
The first step in creating a new publication is to select the New option on the 
File menu. Doing this brings up the Page setup dialog box shown in Figure 3.6. 
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Figure 3.6: The Page setup dialog box that appears when you open a new publication 
v 

In this d ia log box, you specify the page type and size, orien tation of 
tall (portrait) or wide (landscape), starting page, number of pages, and 
margins. You also indicate if the publication is double-sided (that is, will 
be printed on both sides of the paper) and if you want to work with facing 
pages (that is, left-hand and right-hand pages displayed at the same time). 
Table 3.1 gives you a description of each option in the Page setup dialog box. 

For the cover of the annual report, you will want to use most of the 
PageMaker defaults except the facing pages and the margin settings. Note 
that the inside margin, which is the one that always faces the alley or gutter 
(that is, the inside edge where the publication is bound), is on the left for odd
numbered (right-hand) pages and on the right for even-numbered (left-hand) 
pages. The outside margin also shifts according to whether the page is a left
hand or right-hand page, although just the opposite of the inside margin. 

If you have not quit PageMaker since the last exercise and still have the 
brochure on the screen, select the Close option on the File menu (or click on 
the Close box in the upper left corner of the Publication window). Then click 
on the Yes button when prompted to save the changes to the file. 

If you've already quit PageMaker, start the program by double-clicking 
on the PageMaker icon in your PageMaker 4.0 folder. When the program 
finishes loadin g, you can then begin the following exercise. 
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Table 3.1: The Page Setup Options 

OPTION 

Page 

Orientation 

Start page# 

DESCRIPTION 

Select one of the predefined page sizes (letter, legal, or 
tabloid) or select custom and enter the page dimension 
(width followed by length). The maximum page size is 17 
inches by 22 inches. Always choose a page size that your 
printer can use. 

Refers to the orientation of the page as it is prin ted. Tall 
(or portrait) is used when the page is longer than it is wide. 
Wide (or landscape) is used when the page is wider than 
it is long. U yow· publication requires both tall and wide 
pages, you must create sepaTate publications for them 
using different orientations. 

Enter a number between 1 and 9999 that represents the 
proper page number for the fi rst page of the publication. 
Accept the default of 1 if your publication d oesn't use page 
num bers. 

#of pages Enter a number between 1 and 999 that represents the 
number of pages you need for the publication. Note that 
you can always add pages when working on the 
publication. 

Double-sided If your publication is to be printed on both sides of the 
paper, leave the Double-sided box checked. PageMaker 
will shift the inside margin to the right on left-hand 
(even-numbered) pages and to the right on right-hand 
(odd-numbered) pages. 

Facing pages [f you want to have left-hand and right-hand pages 
displayed on the screen as you work on your publication, 
leave the Facing pages box checked . Note that this option is 
inoperative if you uncheck the Double-sided box. 

Margins in You can accept the default margin settings or enter new 
values. Default values are shown in inches unless you 
change the default unit of measurement (using the 
Preferences option on the Edit menu). 
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1. Select the New option on the File menu (3€+N), if you haven't 
done so already. 

2. Click on the Facing pages check box to uncheck it. 

3. Press the Tab key until the Inside margin setting is highlighted 
and type 1.5. 

4. Press the Tab key once so that the Outside margin setting is se
lected and type 1. 

5. Press the Tab key once more so that Top margin is highlighted 
and type 2. 

6. Press the Tab key once more so that the Bottom margin setting is 
selected and type 1, then click on the OK button (or press 
Return or Enter). 

You should now see page 1 of your new publication on the 
screen. The different colored or dotted lines within the page 
show you the new margin settings that you just specified. 

Setting Up the Column Guides on the Master Page 
v 
The next step is to create the column guides that set up the margins for the 
three columns used in the design. Column guides include two vertical 
lines: the first defines the right margin of the preceding column, and the 
second defines the left margin of the next column. Column guides determine 
how text is laid out on the page when you place a story from your word 
processing file. The text automatically follows the colwnn guides, flowin g to 
the top of the next column as soon as the current colwnn is full, and filling 
colwru1s across the page from left to right. 

In addition to column guides, you will also add some non printing ru ler 
guides (also referred to as simply guides or guidelines) that are helpful when 
you are manually positioning type and graphics on the page. You can 
create both horizontal and vertical guides. 

By the way, column guides and nonprinting ruler guides represent the 
blue pencil lines that a conventionalgraphicartistwoulddrawon the pasteup 
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boards to guide the placement of the type and graphics to be pasted on the 
page. The graphic artist uses light blue pencil because the camera can't detect 
this color and therefore the guides don't get picked up on the printing 
plates. On a monochrome monitor, PageMaker displays guides as dotted 
lines, reinforcing the idea that they represent nonprinting lines. On a color 
monitor, they appear in a different color. 

1. Click on the right-hand master page icon (R). 

The column guides are placed on the master page. This design 
calls for three colunms separated by 2 picas (about .375"). 

2. Select Column guides on the Options menu. 

3. Type 3 for the number of columns and press the Tab key. 

4. Type 2p for the space between columns (Figure 3.7) and click 
on the OK button (or press Return or Enter). 

Remember that you can always use another w1it of measurement 
by adding its abbreviation after the number. In this case, you are 
overriding the default of inches by tem1inating the 2 with a p for pica. 

You can now see the two sets of colunu1 guides that divide the master 
page into three colunu1s. Notice that the three columns are of equal width. 
PageMaker always sets up equal columns. For this design, however, we 
don' t want the three coltunns to be equal. In fact, we want the first column 
to be much narrower. 

Changing the colurm1 wid ths is a simple procedure: you simply drag 
the column guides to the left or right until the columns are sized the way 
you want them. 

5. Press ~+7 to change the page view to 75% size. 

6. Scroll the page view up and to the right until you can see the 
upper left corner of the page (similar to the view shown in 
Figure 3.8). 
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Figure 3.7: Column guides dialog box 
v 

The Toolbox will be in your \•vay when you are measuring dis
tances with the horizontal ruler, so you'd better move it. 

7. Drag the Toolbox to the left so that it is on the pasteboard, clear 
of the page. 

The first column needs to be only one inch \•vide. To change its 
width, you need to drag the firs t pair of column guides so that 
the right margin of the column measures 2.5" on the horizontal 
ruler (the 0" point is flush with the left edge and the inside 
margin is 1.5"). When you click on one of the column guides, the 
cursor changes to a double-headed arrow to let you know that 
you can drag the column guides (as a pair) to the left or right. 

8. Click on the left line of the first pair of column guides. When 
the cursor changes to the double-headed arrow, drag it left 
until it is aligned with the 2.5" mark on the horizontal ruler 
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(as shown in Figure 3.8), then release the mouse button. 

Notice that the column guides moved as a pair. Next, the right 
margin of the second column needs to be aligned with the 5" 
mark on the horizontal ruler. 

9. Click on the left line of the second pair of column guides. 
When the cursor changes to the double-headed arrow, drag it 
left until it is aligned with the 5" mark on the horizontal ruler, 
then release the mouse button. 

Adding Guidelines to the First Page 
v 
Before you begin generating the text for the cover, you will want to add 
two horizontal guidelines that will aid in the placement of this text. The 

Figure 3.8: Adjusting the column guides on the right-hand master page 
v 
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first guide will be used to position the title for the report, and the second 
guide will be used to position the contents information. 

You can add nonprinrn1g horizontal and/ or vertical ruler guides to any 
page in a PageMaker publication. To create such guides, you put the 
Pointer on the appropriate ruler and dick the mouse. The Pointer will 
change to a double-headed arrow, and you will see the guide (a dotted line 
on monochrome monitors) as you drag down (if you are creating a 
horizontal ruler guide) or to the right (if you are creating a vertical ruler 
guide). To get rid of a guideline that you have added to a page, you click 
somewhere on the line and then drag it back to the appropriate ruler before 
releasing the mouse button. 

You will position your first guideline3Ys" down from the top of the page 
(which corresponds to 0" on the vertical ruler). 

1. Position the Pointer on the horizontal ruler and click the mouse. 
When the double-headed arrow appears, drag the ruler line down 
until it lines up with the 3Ya-inch mark on the vertical ruler, then 
release the mouse (Figure 3.9). 

Note that at 75% size, the 3Ys-inch mark is equivalent to the 
second tick mark under the 3 on the vertical ruler. Next, you will 
add a nonprinting ruler line that is 6!14 " from the top of the page. 
The 6Y4-inch mark on the vertical ruler is the fourth tick mark 
under the 6. 

2. Scroll the page view down until you can see the 6-inch mark on 
the vertical ruler. 

3. Position the Pointer on the horizontal ruler once more and click 
the mouse. When the double-headed arrow appears, drag the 
ruler line down until it lines up with the 6%-inch mark on the 
vertical ruler, then release the mouse. 

4. Press ~+ W to select the Fit in window page view. 

At this point, you should save your work. You will save this 
document as a templa te called SG AnRpt Cover. Saving this 
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Figure 3.9: Adding the first guideline to page 1 
\1 

document as a templa te will make it easy to use these margin 
settings and guidelines to create variations of the basic cover 
design. 

5. Select the Save option on the File menu (3€+S). 

6. Type SG AnRpt Cover as the document name and click on the 
Template radio button, then click on the OK button (or press 
Return or Enter). 

Creating the Headlines for the Publication 
v 
Now you are ready to save a copy of the report cover as a publication. 
Then, you will enter and format the tex t for the headlines on the cover. 

1. Select the Save as option on the File menu, then edit the file 
name to SG AnRpt 90 Cover. Note that the Publication radio 
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button is automatically selected, then click on the OK button. 

Now you are ready to enter the title for the report. This text will be 
entered in a new story window. You will then create a new Title style for 
this text that will set the type in 14-point Helvetica bold with 14-point 
leading (set solid). 

2. Select Edit story from the Edit menu (or press 3€+E). 

PageMaker responds by opening a new story window. Here, you 
will enter a three-line title for the report cover. Remember, if you 
make a mistake when typing, you can press the Delete key to 
remove characters to the left of the cursor. 

3. Type Sloane and Garrett and press the Return key. 

4. Type Annual Report and press the Return key. 

5. Type for year endi11g December 31, 1990. 

Next, you are ready to create a nev.r style that will format these titles. 

6. Select the Define styles option on the Type menu (or press 3€+3). 

The Define styles dialog box appears. Note that there is already a 
Headline style created for you. You will base your new Title style on 
this one, although you will modify some of the type specifications. 

7. Click on Headline in the dialog box to select it, then click on the 
New button. 

This takes you to the Edit style dialog box, where you need to 
name the style. 

8. Type Title, then click the Type button in the Edit style dialog box. 

This takes you to the Type specifications dia log box. Here, you 
need to change the font from Times to Helvetica, the size from 30 
to 14, and the leading from Auto to 14. 
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. 

9. Select Helvetica as the Font, 14 points as the Size, and 14 points 
as the Leading in this dialog box, then click the OK button in the 
Type specifications dialog box. Click the OK button in the Edit style 
dialog box, and, again, in the Define styles dialog box to return to 
the story window. 

Now, you are ready to apply your Title style to the text in the 
story window. 

10. Press ~+ Y to display the Style palette, then select all three lines 
of text in the story window (you can do this quickly by clicking in 
front of the S in Sloane, holding down Shift, then clicking after 
the 0 in 1990). Click on the scroll bar in the Style palette until you 
see your Title style, then click on it to apply it to highlighted text. 

• 

Notice that Title replaces the dots in the sidebar and that the text 
is now displayed in bold in the story window (Figure 3.10). Next, 

• , Fi le Edit Options Story Type Windows 
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Note v 
If you try to close a 
new story window that 
contains text before 
you place it in the 
publication, Page
Maker will beep and 
display a dialog box 
warning you that the 
story has not yet been 
placed. You can then 
select the Place button 
to place the text in the 
publication, the Dis· 
card button to 
abandon it, or the 
Cancel button to 
return to the story 
window. 
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you are ready to place this story on the cover. 

11. Select the Place option on the File menu (or press ~+D). 

When you select the Place option, PageMaker loads the text in to 
the Text icon, showing tha t the story is ready to be placed begin
ning at the position where you click the mouse. 

12. Position the Text icon somewhere in the top margin, then click 
the mouse. 

You now see the three-line title at the top of the page (as shown 
in Figure 3.11). Notice tha t it is still selected . Change the page 
view to actual size before a ttempting the final placemen t of this 
text at the top of the report cover. 

13. Position the Pointer on the top guideline of the report cover, 
then press ~+Option and click the mouse button to increase 

File Edit Options Poge Type Element Windows 
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Figure 3. 11 : Placing the three-line title on the page 
v 
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the page view to actual size. Move the Toolbox and Style palette 
to the lower left corner of the screen, if necessary. Scroll the 
page with the Grabber hand until you see all of the text and the 
top of the page (similar to the view in Figure 3.12). 

You will now place the three-line title so that the text is aligned 
with the left margin of the cover and the baseline of the last line 
of text is si tting on the firs t guideline you placed on the page. 

14. Click somewhere on the three-line title. After a couple of 
seconds, drag the text block until it is aligned with the left 
margin and top guideline as shown in Figure 3.12, then release 
the mouse button. 

Notice that the limits of the text box extend well beyond the three 
lines of text on the right. Before you deselect the block, you 

a File Edit Options Page Type Element Windows 

Figure 3.12: Final placement of the three-line title on the report cover 
v 



Designing Your First Publications V 89 

should resize it so that the right edge of the text box is aligned with 
the right margin of the second column (tha t way, its borders won't 
overlap the next text box tha t you are going to place on its right). 
To resize the text block, you must click on the handle in the lower 
right comer, then drag the mouse to the left until it is the width 
you want it. 

15. Position the Pointer on the handle in the lower right corner of 
the text box. Hold down the mouse button until the Pointer 
turns into a double-headed arrow. Drag the mouse to the left 
until the right edge of the text block is aligned with the line 
marking the right edge of the second column (Figure 3.13). 
When you have sized the text block correctly, release the mouse 
button. Then, click the Pointer somewhere outside of the text 
block to deselect the text box. 

Figure 3.13: Resizing the text box containing the three-line title 
v 
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Tip v 
The opening and 
closing single quotes 
are not only the only 
special typesetting 
characters that you 
can enter from the 
keyboard in Page
Maker. For a more 
complete list, refer to 
the table printed on 
the inside back cover 
of this book. 

Creating and Placing the Year Logotype 
v 
Next, you are going to create another text block for the annual report 
cover. This text block will contain only '90, which willbesetin a large point 
size. This element acts more like a graphic image than a text block in the 
design. For this reason, we will refer to it as the year logotype. However, 
because it consists purely of text, you wm create it with the Story Editor. 

1. Select Story edit on the Edit menu, or press 3€+E to open a new 
story window. 

The first character that you are to type is the apostrophe. Instead 
of using the ' key on the keyboard, you are going to use the 
combination Option+Shift+]. This enters the closing single quote 
used in typesetting (') instead of the standard apostrophe used in 
word processing('). To produce the complementary character, 
the opening single quote ('), you press Option+]. 

2. Press Option+Shift+] and type 90. 

Now you are ready to set this text in the Times bold font in 
110-point size. Because this is a nonstandard type size, you can't 
select it when creating a style. For that reason, you will have to 
format this logotype the old-fashioned way, using the Type menu. 
As Times is a lready selected as the font, you only have to change 
the size to 110 points and the type s tyle to bold. 

3. Use the 1-Beam cursor to select the text '90 i~ the story window, 
then select the Size option on the Type menu, and the Other 
option on the Size menu. When the Size dialog box appears, type 
110 and click on the OK button (or press Return or Enter). 

4. Select the Type style option on the Type menu, then select Bold on 
the Type style menu. 

Before you place the year logotype, you should use the Tracking 
option on the Type menu to control the runow1t of space between 



Designing Your First Publications V 91 

characters. To reduce the amount of spacing between the apostro
phe, 9, and 0 without crushing them together, you will choose the 
Normal tracking option (by default, tracking is off). 

5. Select Track on the Type menu, then select Normal on the Track menu. 

Now you are ready to place the year logotype in the report cover. 
This time, try closing the story window before you place the text. 

6. Click the Close box in the upper left corner of the story win
dow. Click the Place button in the message dialog box that 
appears. 

The year logotype will placed so that the apostrophe is aligned 
with the left margin of the third column and 90 rests on the first 
guideline that you added to the template. 

7. Position the Text icon so that it is aligned with the guideline 
marking the left edge of the third column and the top margin, 
then click the mouse button to place the logotype in the third 
column (as shown in Figure 3.14). 

You may have to fine-tune the placement of this text so that the 
ball and tip of the apostrophe are just touching the guideline for 
the third column, and the bottom of the 9 and 0 are just resting 
on the horizontal guideline. 

8. If you need to fine-tune the placement of the year logotype, 
position the pointer somewhere inside the text block, then hold 
down the mouse button until the Pointer changes into the four
headed arrow. Then use the mouse to reposition the logotype 
as shown in Figure 3.14. When you have the logotype exactly 
where you want it, release the mouse button. 

9. Click the Pointer somewhere outside of the text block to dese
lect the logotype. 
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File Edit Options P 

Figure 3.14: Final placement of the year logotype on the report cover 
v 

Adding a Horizontal Rule 
v 
The next element to be added to your cover is a heavy black horizontal line 
called a rule (corresponding to the use of a ruler as the straight edge to draw 
a line). You can draw horizontal or vertical rules, using a variety of line 
thicknesses or patterns. To complement the boldness of the '90 on the cover, 
you will make your horizontal rule as thick as possible (that is, 12 points 
wide). 

1. If necessary, use the Grabber hand to scroll the page to the left 
so that you can see the left margin of the report cover. 

2. Select the Perpendicular-line tool (the one immediately to the 
left of the A). 

3. Select the Line option on the Element menu, then select the 12 pt 
option on the Line menu. 
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4. When the cursor changes to the Crossbar, position it under the 
first horizontal guide flush with the left margin, then press 
3€+0ption+Shift and click the mouse to increase the page view 
to 200% in this vicinity. 

5. Position the Crossbar so that it is in line with the 3Y4-inch mark 
on the vertical ruler and flush with the left margin. 

6. Drag the mouse to the right until the line is flush with the right 
margin (the page will scroll as you continue to move the mouse 
to the right), then release the mouse. 

7. Press 3€+W to select the Fit in window view, then select the Pointer 
tool, which automatically deselects the heavy rule. 

Your report cover should now resemble the one shown in Fig
ure 3.1 5. At this point, you should save your changes. 

Figure 3.15: Annual report cover with year logotype and rule 
'V 
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Tip 
'V 
In addition to an em 
dash, you can create 
a somewhat shorter 
dash in PageMaker 
called an en dash 
(almost as wide as 
the lowercase n in the 
typeface). The en 
dash is used mostly 
to separate numbers, 
as in pages 1-3 or 
02-25-92. You can 
also use an en dash 
in place of an em 
dash when the em 
dash appears too 
long in the particular 
font you are using. 
The only time you use 
a regular hyphen is 
when hyphenating 
text such as brother
in-law, or when the 
em and en dashes 
are not available in 
the font you have 
selected (as is the 
case when using 
Courier). 

8. Select Save from the File menu (or press 3€+S). 

Creating and Formatting the Pull Quote 
\1 
Next, you will create the italicized quote that fills the center section of the 
cover design. This text is referred to as a pull quote because it is pulled ou t 
of the body text. As usual, you will enter this text in its own story window 
and format it yvith its own style. 

1. Press 3€+E to open a new story window. 

The text that you are about to enter is a quotation. In typeset text, 
you see two types of quotation marks. The first is the open quote 
("),which is placed a t the beginning of the quotation and created 
in PageMaker by pressing Option+[. The second is the close quote 
("),which is placed at the end of the quotation and is produced by 
pressing Option+Shift+[. 

2. Press Option+[, then type The direction we take in the 1990s will 
determine our course well into the 21st century., and press 
Option+Shift+[. 

All that remains in completing the pull quote text is to add the name of 
the chairman, whose quote this is, and place it beneath the quotation. As 
part of this process, you will learn how to enter an em dash(-), the longest 
dash you can create in PageMaker (so called because it is about as wide as 
the lowercase m in the typeface). Em dashes are preferable to regular 
hyphens for setting off parenthetical text on a page because they are longer 
and stand out better. 

3. Press Return to start a new line, then press Option+Shift+ - and 
type Gary Sloane. 

Notice how long the em dash is. Now you need to create the Pull 
Quote style that will format this text. 

4. Select the Define styles option on the Type menu (3€+3). 
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5. Click on the New button, then type Pull Quote as the name for 
the style. 

6. Click on the Type button, then set the Font to Helvetica, the Size 
to 24, and the Leading to 26. Click on the Bold and Italic check 
boxes under Type style. 

7. Click on the OK button on the Type specifications dialog box, click 
on the OK button on the Edit style dialog box, and click on the 
OK button in the Define styles dialog box. 

Now you are ready to apply the style to both the quote and the 
person quoted. 

8. Position the 1-Beam at the beginning of the pull quote, click the 
mouse button, then click the Pull Quote style in the Style 
palette. 

9. Position the 1-Beam in front of the em dash in the second 
paragraph, then click the mouse button, and click on the Pull 
Quote style in the Style palette. 

Let's set this last line in a somewhat smaller font and right-align it. 

10. Select the text -GanJ Sloane, choose the Size option on the Type 
menu, then select 18 pt as the size. 

11. Select the Alignment option on the Type menu, then select Align right 
on the Alignment menu. 

Notice that the selected style in the Style palette is now Pull 
Quote+ instead of just Pull Quote. Whenever you make a format
ting change that isn't included as part of the style, PageJviaker 
indicates this by adding a plus sign ( +) to the style name. Be
cause you changed the alignment of this text from the default of 
Align left to Align right, this text will be right-justified in the text 
block that you are about to place in the report cover. 
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Placing the Pull Quote in the Publication 
v 

Your next task is to place the pull quote text in the report cover. To help 
in placing the text, you will first add a new guideline to mark the location 
of the baseline of the first line of the quote. 

1. Click somewhere on the report cover below the story window 
to select the page layout view without closing the story win
dow. Position the Pointer on the guideline of the left margin in 
the area below the heavy rule that you drew on the page, press 
3€+0ption+Shift, then click the mouse to increase the page 
view to 200%. 

Next, you will add a horizontal guideline at the 4\14 -inch mark on 
the vertical ruler. 

2. Position the Pointer on the horizontal ruler at the top of the 
page, then hold the mouse button until the Pointer becomes a 
double-headed arrow, and drag a horizontal guideline down 
the page. When you reach the 4¥4-inch mark on the vertical 
ruler, release the mouse button. 

3. Select the 50% page view by pressing 3€+5. If necessary, scroll 
the page view vertically so that you can see the middle area 
of the report cover below the title, year logotype, and rule. 

Now you are ready to place the pull quote. 

4. Select the Untitled:l window on the Windows menu, then select 
the Place option on the File menu (3€+D). 

When you place this text, you will want it to run the entire width 
of the page between the left and right margins. This means that it 
will span all three columns on the page. To accomplish this, you 
must size the text block as you place it. By making the text block 
as wide as the right margin of the report, you can ensure that its 
text spans all three columns. 
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5. Position the Text icon so that it is resting on the guideline you 
just added and it is against the left margin. Next, drag the 
mouse diagonally until the text block extends as far as the right 
margin and just below the 5¥2-inch mark on the vertical ruler 
(use Figure 3.16 as a guide), then release the mouse. 

You will probably have to fine-tune the placement of this text. You 
want the baseline of the firs t line of the quote to be resting on 
your guideline, with the heel of the Tin The resting on the left 
margin. 

6. Enlarge the page view to 75% by pressing 3€+7. 

7. Move the text block so that the baseline of the first line of the 
quote is resting on the horizontal guideline on the 4Y<l -inch 
mark, and the heel of the Tin The is resting on the guideline 

Windows 

Figure 3.16: Sizing and placing the pull quote in the report cover 
'V 
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marking the left margin of the report cover (the open quote will 
then extend slightly to the left of the left margin). Use Figure 3.17 
as a guide in placing this text block. 

Fine-Tuning the Alignment by Reflowing Text 
\1 
Notice the alignment of the second and third lines. Instead of aligning the first 
character of these lines with the Tin The, the programhasautomaticallyaligned 
them with the open quote. You will have to realign the last two tines manually 
so that the ·win will and the tin the are flush left ·with the Tin The. 

To accomplish this, you firs t shorten the text block until only the fi rst 
line is displayed. Then, you will reflow the text of the last two lines, this 
time positioning the text block in line with the Tin The. Before you do this, 
you should add a guide to mark the vertical position of the second line. 

Figure 3.17: Adding a horizontal guideline to mark the vertical position of the second line of the 
V pull quote 
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1. Drag a guide down from the horizontal ruler until it is posi
tioned right under the baseline of the second line of text, then 
release the mouse as shown in Figure 3.17. 

Now you are ready to shorten the text box by dragging the 
bottom window-shade handle upward. 

2. Position the Pointer on the bottom window-shade handle, and 
diag the box up until only the first line of text is displayed, 
then release the mouse (Figme 3.18). 

Notice that the bottom window-shade handle now contains a 
downward-pointing triangle (as shown in Figure 3.18) rather 
than being empty. This indicates that there is more text to flow. 

3. Click on the bottom window-shade handle to load the text into 
the Text icon. 

File Edit Options Page Type Element Windows 

Figure 3.18: Resizing the text block so that only the first line of the pull quote is displayed 
v 
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Next, you need to position the Text icon so that it is aligned with 
the beginning of the second column and rests on the guide you 
just added . However, if you then just click the mouse, the text 
will be constrained to the second column. To extend the text 
beyond the second colunm, you need to click and drag the Text 
tool so that the text block is wide and long enough to accommo
date the text before releasing the mouse. 

4. Position the Text icon so that it is flush left with the beginning 
of the second column and is resting on the second guideline. 

5. Click and drag the Text tool down diagonally until you have 
drawn a box that extends as far as the right margin and far 
enough down to accommodate the last two lines of text as 
shown, then release the mouse. 

6. If n ecessary, select the text block again and fine-tune its posi
tion so that the baseline of the second line of text is resting on 
the second horizontal guideline, and the first letters in the 
second and third lines of the quote are aligned with the left 
margin under the Tin The, as shown in Figure 3.19. 

7. Save your work by selecting Save on the File menu (~+S). 

Placing Dummy Text to Complete the Annual Report Cover 
v 
To finish the report cover design, all that remains is to add a one-word title 
for the text in the first column and place the durrm1y text from the Lorem 
Ipsum document located in the Templates folder. Begin by creating the title. 
It is so short that you will place it and enter it simultaneously in layout 
view (it's a waste of time to open a story window and create a style for so 
short a title). 

1. Select the Text tool in the Toolbox, then change the page size to 
Fit in window (~+W) . . 
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Figure 3.19: Final placement for the last two lines of the pull quote 
v 

2. Press ~+Option and click the 1-Beam at the intersection of the 
left margin and the last horizontal guideline you drew at the 
6¥-t-inch mark on the vertical ruler. 

3. Once the page is redrawn, click the 1-Beam exactly at the inter
section of these two guidelines. 

Next, you will use the Type specifications dialog box to format the 
text of the title you are about to type. 

4. Select the Type spec option on the Type menu (~+ T), select 
Helvetica as the Font and Bold as the Type style, then click the OK 
button (the size remains 12 points). 

5. Type CONTENTS. 

6. If needed, resize the page and fine-tune the position of CON
TENTS so that its baseline is resting on the guide and the C is 
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flush left with the left margin, as shown in Figure 3.20. (Remem
ber to select the Pointer tool before you try to drag the text box!) 

Now you are ready to place some of the text in the Lorem Ipsum 
file into the second and third columns. Before you attempt to 
place this text, you should change the page view so tha t you can 
see the second and third columns of the page. 

7. Select the 50% page view by pressing 3€+5, then use the Grab
ber hand (Option+click) to position the page so that you can 
see the bottom margin and the second and third column guides 
on the screen. 

To place text from another file, you use the Place command on 
the File menu. 

8. Select the Place command on the File menu (a€+ D). 

File Edit Options Poge Type Element Windows 

............ .. .. .... ..... ONlEI:f TS. 

Figure 3.20: Final position for the CONTENTS title for the report cover 
v 
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The Lorem lpsum file is probably loca ted in. the Templates folder in 
your PngeMnker 4.0 folder. If necessary, you need to select that 
fold er when placing the LoreJn Ipsum document. 

9. Change to the folder that contains the Lorem. Ipsum. document, 
then click on it in the document list to select it (Figure 3.21). 

Notice that the As new story button is selected, as are the Retain 
format and Convert quotes check boxes. PageMaker knows that this 
document contains text rather than a graphic because its creator 
was a word processor (Word 4.0). 

10. Click the OK button (or press Return or Enter). 

Once the text of the docmnent is loaded, the Pointer changes into 
the Text icon. To flow the test in the second column, you merely 
position the Text icon and click the mouse. 

Place document 

Ia Temp lates I 

•~!l~~~~~m~e~i~~~~e~omdWIII~II·~ I•Wio . .,,,., 
mn~ 

~ ~:~~:: ~ ~ ~ Place: 

Windows 

1: j<H t n OK ll 
[ Conce l ) 

= HD 20 

0 Manual 3 W @As new story 
0 Memo ~ 0 fl<!pl <J< inq l'nt in' st or~J 
0 Newsletter I tv 0 ln~Prtinq t•~11t 

~Retain format ~ Conuert quotes DRead tags 

Figure 3.21: The Place document dialog box 
'l 
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11. Position the Text icon so that it is flush left with the beginning 
of the second column and resting on the guideline, then click 
the mouse. 

12. If necessary, fine-tune the position by dragging the text box so 
that the baseline of the first line of text is resting on the guide
line, and the first letter of the dummy text paragraph is flush 
with the left margin of the second column. If the bottom win
dow-shade handle extends below the bottom margin, drag it up 
so that it's flush with that guideline. 

If you scroll the page down until you can see the bottom window-shade 
handle, you will notice that there is still more text to place (indicated by the 
downward-pointing triangle in the handle). To pick up the text for the third 
column, you only have to click on this bottom window-shade handle with the 
Pointer. Doing so changes the Pointer into the Text icon again and loads 
it with the con tinuation of the story. 

13. Position the Pointer on the bottom window-shade handle and 
click the mouse. 

14. Position the Text icon so it is flush left with the beginning of 
the third column and resting on the guideline, as shown in 
Figure 3.22, then click the mouse. 

15. If necessary, fine-tune the position of the second text block by 
dragging it so that the baseline of the first line of text is resting 
on the last horizontal guideline and the left margin of the text 
block is flush with the left margin of the third column. Drag 
the bottom window-shade handle up a bit if any lines of text 
extend below the bottom margin. 

Note that the presence of the downward-pointing triangle in the 
bottom window-shade handle (Figure 3.23) indicates that there is 
still more text to place. To place this text, you would have to add 
a second page to the publication, then click on the triangle in the 
window-shade handle to load this text, go to the next page, and 
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Figure 3.22: Positioning the Text icon to flow the text for the third column of the report cover 
'\7 

place this text with the Text icon. In this exercise, we will leave 
this dummy text unplaced. 

Formatting the Dummy Text to Complete the Report Cover 
v 
The last thing you have to do is format the dummy text that you just placed 
from the Lorem Ipsum file. When PageMaker brings in text from a document 
crea ted in an other program, it assigns the Normal style to it. This s tyle uses 
the New York font (a common ly used Mac screen font) in 12 points w ith 
Auto leading. You will want to assign the Body text style to this "dummy" 
text. Body text is a style that PageMaker provides for you. This style formats 
the text in each selected paragraph as 12-point Times with Auto leading. 
In addition, it automatically indents the first line of each paragraph by 
0.333 of an inch. 

1. Click on the first block of dummy text that you placed in the 
second column to select it. 
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Figure 3.23: Final positioning for the second text block of Lorem lpsum 
V' 

Although you placed the Lorem Ipsum text in two blocks, Page
Maker still considers the text to constitute a single story. 

2. Select Edit story on the Edit menu, or press ~+E. 

To format all of the paragraphs in the Lorem Ipsum file, you need 
to use the Select all command. 

3. Choose the Select all option on the Edit menu, or press a€+ A to 
select all paragraphs in the story window. 

Now you are ready to apply the Body text style to the text of the 
Lorem Ipsum file. 

4. Click on Body text in the Style palette. 

Note that the style changes from Normal to Body text in the story 
window. Now you are ready to close the story window and 
return to layout view. 
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5. Click on the Close box in the story w indow to return to your 
report cover. 

Notice that the paragraphs of dummy text in your report cover 
are now formatted according to the Body text style. 

6. Select the Fit in window page view (3€+ W) and compare your 
screen with the one shown in Figure 3.24. Next, you need to 
save your changes to the report cover. 

7. Select th e Save option on the File menu (~+S) . 

8. If you have a printer connected to your Macintosh, print a copy 
of your annual report cover. Compare your printout to the one 
shown earlier in Figure 3.5. 

Now is a good time to take a break. If you want to leave PageMaker, 
select the Quit option on the File menu. 

Window s 

:- ····:· i···· ·· ·· ···T)hl\ .. ! 
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Figure 3.24: Completed design of the 1990 annual report cover 
v 
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ESSENTIAL 
TECHNIQUES 
v 
To Create a 
Publication 
from a 
Template 1. Start PageMaker. 

2. Choose the Open option on the File menu (3€+0). 

3. Select the folder that contains the template you wish to use. 

4. Double-click on the template name, or click on the OK button 
to open a copy of the template (always make sure that the Copy 
and the not the Original radio button is selected). 

5. Choose the Save option on the File menu (3€+S), then enter an 
original file name for your publication. 

6. Replace the placeholders for the publication's titles with actual 
text. You can use the Story Editor (3€+E) to enter the text and 
either define a style (3€+3) or use the Type specs command on the 
Type menu to format the titles you enter. 

7. Replace the body text placeholders with the contents of the 
word processed documents that contain the body text for your 
publication. Use the Place option on the File menu (3€+0). If 
necessary, format the text with either a style or the Type specs 
command on the Type menu. 

8. Replace fue graphics placeholders with the graphic images you 
wish to use by selecting the Place option on the File menu (3€+D). 



To Open 
aNew 
Publication 
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9. Choose the Save option on the File menu (3€+S) to save your 
changes, then choose the Print option on the same menu (3€+P) 
to print it. 

1. Start PageMaker. 

2. Choose the New option on the File menu. 

3. Specify the page type and size, orientation, starting page 
number, the estimated number of pages, and the top, bottom, 
inside, and outside margins, and indicate if you want facing 
pages displayed on the screen in the Page setup dialog box. 

4. Design all of the elements that are used consistently through
out the publication on the left and right master pages. To select 
a master page, click on the L or R page icon in the lower left 
corner of the screen. 

5. If the master pages of the new publication require text col
umns, create the column guides by selecting the Column guides 
option on the Options menu and specifying the number of 
columns and the space between them. 

6. Add a design grid to the left and right master pages consisting of 
vertical and horizontal non printing guidelines that help you place 
the text and graphics on each page. To create these guides, you 
drag them from the appropriate ruler, then release the mouse 
button when they are positioned correctly on the master page. 

7. Select the first page of the publication (by clicking on the 
page 1 icon in the lower left corner of the screen). 

8. Create the titles for the first page of the publication. You can 
use the Story Editor (3€+E) to enter the text, or select the Text 
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tool from the Toolbox and enter them directly on the page. 
Then, format them with a style (~+3) or use the Type specs 
command on the Type menu. 

9. Place the body text for the first page of your publication, using 
the Place option on the File menu (~+D). If necessary, format the 
text with either a style or the Type specs command on the Type 
menu. If the text of a story continues to the next page, click on 
the bottom window-shade handle, then click on the page icon 
for the following page, and place the text on that page. 

10. Place the graphics images for the first page with the Place 
option on the File menu (~+D). 

11. Select the page icon for the next page of the publication, and 
continue placing the required text and graphics. 

12. When you have finished placing all of the text and graphics for 
the publication, choose the Save option on the File menu (~+S) 
and enter a new file name for your publication. Then choose 
the Print option on the same menu (~+P) to print it. 
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Probably no single element will be more important to you in desktop 
publishing than type. Seldom, if ever, wiU you be called upon to produce 
a publication with PageMaker that does not use type in some way. On the 
contrary, you may find many cases in which your d esign relies entirely 
upon typ e, requiring no graphics of any kind. 

In this chapter, we will look a t h;pogmphy (the ar t of setting and ar
ranging type on the page) from the perspective of how type is specified 
and used in PageMaker. Begim1ingwith a d iscussion of basic typographic 
concepts, we will quickly progress to the use of PageMaker's many typo
graphic controls and the creation of special type effects that you can use to 
enhance your design. 

FUNDAMENTALS 
OF TYPE 
v 

The le tterforms of our Roman alphabet so familiar to all of us take on a 
great many variations in the type designer's hands. Asdesktoppublishing 
has become w idespread, the availability of both traditional and modern 
typefaces for the Macintosh has increased significantly. Today, hundreds 
of typefaces are available from an array of software publishers, such as 
Adobe, Bitstream, and AGFA/Compugrap hic. Together, these software 
vendors offer the would-be desktop publisher almost all of the typefaces 
ava ilable to traditional graphic artists. 

The type tha t you choose for your PageMaker publications will, there
fore, depend less on type availability (pu tting aside budget considerations 
for the moment) than on your own sense of design. ln selecting the righ t 
type, you need to consider several factors. Before we examine these factors 
in some detail, let's be sure that we are familiar with the vocabu lary used 
to describe type. 
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Note v 
The terms typeface 
and font are not 
interchangeable. 
Traditionally, a 
typeface refers to a 
named type design 
(such as Helvetica or 
Palatino), and a font 
refers to a complete 
set of characters in 
one type size of a 
particular typeface 
(such as 12-point 
Helvetica or 24-point 
Palatino). Because of 
PostScript's scalable 
font technology, a font 
in PageMaker is no 
longer tied to a specific 
size; it refers mostly to a 
particular type design in 
a particular style and 
weight, as in lTC 
Garamond Ultra or 
Futura Light Italic. 

Classifying Type 
v 
Despite the long, rich tradition behind publishing, the classification of type 
remains inexact. So inexact, in fact, that little agreement has been read1ed in 
classifying type beyond the most basic distinction of serif or sans serif. 

Serifs are the small cross-strokes that are added to the beginning and end 
of many of the longer strokes that make up many of our letters. Serifs first 
appeared i11 ancient Roman monuments where the 'letters were chiseled in 
stone (some say that the real purpose of serifs was to mask small discrepan cies 
between the letters introduced by the stonecutters; the more plausible expla
nation is that they were used to finish off rough edges left at the tops and 
bottoms of the carved letters). Later on, serifs appeared in the handwritten 
manuscripts prepared vvith quill pens by mectieval scribes. 

When printing began, the first typefaces used all tried to mimic the 
handwritten books in circulation and, as a result, they all used serifs. Serifs 
and type became so intertwined that all type designed prior to 1800 is 
classified as serif type. Historically speaking, sans serif type-that is, type 
lacking any serifs (sans being the French word for without)-is a fairly 
modern occurrence. 

Because sans serif typefaces lack the embellishing cross-strokes, to 
many people these types appear starker or, at least, cleaner than their serif 
counterparts. As most of us associa te s tarker, cleaner lines with modern 
design and art movements, it is easy to understand why graphic designers 
will often choose a sans serif type when they want a more modern feel to 
a piece, and prefer serif type for traditional jobs. 

It is also important to note tha t many professionals consider sans serif 
type more difficult to read than serif type. Although modern research on 
the legibility of serif versus sans serif type is still inconclusive, it has been 
fotmd that the serifs added to the letterforms act almost like guides lead
ing the reader's eye to the right. This may not only make it easier for most 
readers to keep their place in the text, but also help them decode the words 
on each line. Because serif type seems to offer increased legibility, many 
professional designers tend to set long passages of body text in serif type, 
reserving sans serif type for larger size headings. 

Although the distinction between serif and sans serif type seems clear
cut in theory (a typeface either has serifs or it doesn' t), it is actually not so 



Note 
\1 
Memphis is often 
referred to as an 
Egyptian type be
cause of its square 
serifs. Supposedly, 
this reminded some
one of Egyptian 
hieroglyphics (or 
Egyptian art, with 
squared-off 
shoulders?). 
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well delineated in practice. Within the serif classification, you find a wide 
variation in the types of serifs, so that some type designs appear more 
seriflike than others. On the other side, within the sans serif classification, 
you find hybrid typefaces where most of the letters don't use serifs but a 
few of them do. 

Figures 4.1 and 4.2 show you samples of a few popular serif and sans 
serif types. The first typeface shown in Figure 4.1 is Times, or Times 
Roman, one of the most commonly used serif typefaces. As you can see, its 
serifs could easily have been cut with a chisel (harkening back to the 
Roman stonemasons). Below Times, you see a typeface called New 
Baskerville. Notice that this typeface also employs distinct, chiseled serifs, 
like Times. Below New Baskerville, you find Memphis. Although this 
typeface clearly has serifs, they appear much more squared off than in 
either of the other two typefaces. The serifs in Memphis clearly do not 
evoke chisel marks in stone. 

Serif 

Times 
a bcdefghijklmnopqrstuv wx yz 
ABCDEFGHIJKLMNOPQRSTUV 
WXZ&!? 1234567 890$¢ 

New Baskerville 
abcdefghijklmnopqrstuvwxyz 
ABCDEFGHIJKLMNOPQRSTUV 
vvxn&! ?1234567890$¢ 

Memphis 
abcdefghijklmnopqrstuvwxyz 
ABCDEFGHUKLMNOPQRSTUV 
WXYZ&!? 1234567890$¢ 

Figure 4.1 : Samples of serif typefaces 
Y' 
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Sans Serif 

Helvetica 
abcdefghijklmnopqrstuvwxyz 
ABCDEFGHUKLMNOPQRSTUV 
WXYZ&!?1234567890$¢ 

Optima 
abcdefghijklmnopqrstuvwxyz 
ABCDEFGHIJKLMNOPQRSTUV 
W XYZ& !?1234567890$ct 

Futuro 
abcdefgh i j kim nopqrstuvwxyz 
ABCDEFGHIJKLMNOPQRSTUV 
VVXYZ&!?1234567890$¢ 

Figure 4.2: Samples of sans serif typefaces 
V' 

The first typeface in Figure 4.2 is Helvetica, surely the most commonly 
used sans serif typeface in desktop publishing. Undoubtedly, as you use 
PageMaker, you too will come to rely on this versatile type when the piece 
calls for the use of a sans serif typeface. Notice that even in Helvetica, a 
couple of serifs have fow1d their way into the design: the tail of the 
lowercase a and the spur of the numeral 1 could be serifs. The same is true 
for Optima, the second sans serif typeface illustrated in Figure 4.2. Notice, 
however, that the only serif used by Futura, the third type in Figure 4.2, is 
on the spur of the numerall , where it distinguishes the lowercase I from 
the numeral1. 

Type Families 
v 
Beyond the simple serif and sans serif classification, you will find typ e 
designs most often categorized into families. A type family is made up of all 
the varia tions (most in terms of weights and styles) available for a 



Tip 
v 
Although close in 
appearance, oblique 
and italic type differ. An 
oblique type consists of 
roman characters 
slanted to the right. An 
italic type is a separate 
slanted type design 
based on the roman 
member of the family. 
Because italic re
presents a separate 
design, it usually 
displays much better 
proportions than the 
computer-generated 
oblique style. 
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particular typeface such as Helvetica or Futura. At a minimum, a type 
family consists of at least two members: roman and italic (sometimes 
called oblique). Many of the more conunonly used typefaces have huge 
families, consisting of a wide array of treatments (see Figure 4.3 for an 
example). Beyond roman and italic, a type may offer different weights, 
such as ultra light, light, book, medium, demi, bold, and extra bold, as well 
as spacing variations, as in condensed, compressed, or expanded. When 
some of these weigh ts and spacing are available in both roman and italic 
styles, you can see how a type family can become quite large. 

Using a type family 'Ar:ith many members gives the artist a great deal of 
flexibility when it comes to copyfitting. In addition, the selection of such 
a type often allows you to realize all the variations called for in your design 
without falling prey to the common desktop-publishing mistake of using 
too many typefaces in one piece. 

Measuring Type v 
Although attempts at standardizing the way type d esigns are classified 
have not progressed very far, the same is not true of the way type is 
measured. Here, we find a well-defined system that is universally used in 
traditional and d esktop publishing (at least in the United States). 

The recognized standard units of type measurement are points and picas. A 
point is Yn inch (0.01384 inch). One pica equals 12 points and is Y6 inch (0.01666 
inch), making 6 picas to the inch. 

Futuro Light 
Futuro Book 
Futuro Medium 
Futuro Bold 
Futura Extra Bold 

Futuro Light Oblique 
Futuro Book Oblique 
Futuro Medium Oblique 
Futuro Bold Oblique 
Fufura Extra Bold Oblique 

Futuro Condensed Ught 
Futuro Condensed 
Futuro Condensed Bold 
Futura Condensed Extra Bold 

Futuro Condensed light Oblique 
Fulura Condensed Oblique 
Futura Condensed Bold Oblique 
Futura Condensed Extra Bold Oblique 

Figure 4.3: Some of the members of the Futura type family 
v 
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The pica, as the larger unit of type measure, usually describes the larger 
dimensions of the publication such as the line length, column width, di
mensions of illustra tio11S, and the size of the page. The point, as the smaller 
unit, usually describes such dimensions as the size of type, line spacing, 
and thickness of rules. 

Type Size 
\7 
Figure 4.4 shows how the point size of type is measured. When measuring 
the size of type, we measure from the top of the ascender (the part of the 
vertical stroke on letters such ash and t that extends above the mean line) 
to the bottom of the descender (the part of the vertical stroke on letters such 
as g and p that extends below the baseline). Note that some designs have 
a small gap between the ascender line and the cap line (as is the case in the 
Century Old Style type shov.rn in Figure 4.4). For that reason, point size is 
not measured from the top of the capital letters, but ra ther from the top of 
the ascenders. · 

The apparent size difference between types of the same point size is due 
to variations in the x-height, that is, the distance between the baseline and 
mean line. This distance can vary quite a bit from typeface to typeface, and it 
is an important factor to consider when specifying type size. 

This is especially true in the case of the smaller point sizes used to set 
extensive text passages such as the body copy for a publication. A 10-point 
type size (normally fine for the body text) may appear too small when set 
if the type you select has a particularly small x-height. In such a case, you 
may have to increase the point size one or two points in order to achieve 
the appearance you want. On the other hand, if you are using a type with 

Figure 4.4: Measuring type size 
v 

top of ascender 
to bottom of descender 
equals point size of type 
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an unusually large x-height, you may wish to decrease the type size a point 
or hvo. 

Figure 4.5 illus trates the effect that differences in x-height can have on 
the appearance of the type size. Although the type in the column on the 
right appears clearly to be larger than the one in the column on the left, 
the passages are, in fact, both set in 12 points with 4 points ofleading (see the 
following section for more on leading). The apparent type size difference is 
due entirely to the difference in x-height. The passage on the left is set in 
New Baskerville, a type known for its small x-height. The one on the right 
is set in New Century Schoolbook, a type known for its large x-height. 

Double, double, toil and trouble; fire 
burn and cauldron bubble. Fillet of a 
fenny snake, in the cauldron boil and 
bake; eye of newt, and toe of frog, wool 
of bat, and tongue of dog; adder's fork, 
and blind-worm's sting, lizard's leg, and 
howlet's wing; for a ch arm of powerful 
trouble, like a hell-broth boil and 
bubble. 

Figure 4.5: Effect of x·height on apparent type size 
\1 

Leading 
v 

Double, double, toil and trouble; fire 
burn and cauldron bubble. Fillet of a 
fenny snake, in the cauldron boil and 
bake; eye ofnewt, and toe of frog, 
wool of bat, and tongue of dog; 
adder's fork, and blind-worm's sting, 
lizard's leg, and howlet's wing; for a 
charm of powerful trouble, like a 
hell-broth boil and bubble. 

Line spacing in a publication is specified by a measurement known as 
leading (pronounced like ledding-a seldom-used alternate spelling). 
Leading gets its name from the practice of placing strips of lead between 
lines of metal type to maintain a particular line spacing. Different thick
nesses of lead were used to obtain d ifferent spacing between lines. 
Although this practice was abandoned as soon as phototypesetting was 
adopted, the term remains current and is used in almost all Macintosh 
programs, not just desktop publishing software such as PageMaker. 
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Figure 4.6 illustrates how leading is measured. Note that the amount of 
lead ing is equal to the distance between each line minus the poin t size. In 
this figure, the distance between the two baselines is 76 points and the type 
size is 72 points, leaving a leading of 4 points (shown by the shading). 

Although Figure 4.6 illustrates how leading is calculated, it does not 
indicate how you specify leading in PageMaker (and many other Mac 
programs). When you designate the leading for type in a PageMaker 
publication, you always enter the poin t size plus the leading. In other 
words, if you want 4 points of lead ing when the type size is 72 points, you 
enter 76 as the leading measurement. 

Figure 4.6: Measuring leading 
v 

Line Length 
\1 

Type size-top of 
ascender to bottom 
of descender (72 pt.) 

Line length is normally measured in p icas (in PageMaker, you can easily 
measure the line length in inches, if you prefer). The length of the line in 
a publication is influenced by several factors, the most important of which 
are the overall page size, number of columns to be used, and the size of 
margins and gutters. 

When determining the line length, remember that, ideally, each line 
should contain a complete thought. If the line length is too short, the reader 
can have trouble following the meaning of the text due to the frequent 
interruptions in the flow of thought. Also, short line lengths often engen
der word spacing problems and excess hyphenation, which degrade 
legibility. 
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When the line length is too long, legibility also su ffers . In this case, the 
reader 's eye often experiences fa tigue. As a result, you tend to lose your 
place in the text and can end up rereading lines as the eye travels from the 
end of one long line to the beginning of the next. The problems are made 
worse when the same words and phrases occur in two or more consecutive 
lines of text a t either the beginning or end of the lines (called stacking). 

In determining the proper line length, you can use the rule of thumb that 
says the line length (in picas) should be 1.5 to 3 times the size of the type 
(in points) to be used. In other words, if you are setting a passage in 10-point 
type, the proper line length will be 15 to 30 picas long. If you are setting it in 
12-point type, the line length should be between 18 and 36 picas. 

When applying this rule of thumb, be sure to take into account the x
height of the font you have selected. Those typefaces with large x-heights 
can have longer line lengths than those with small x-heights. For example, 
if you were setting a passage in 10-point New Baskerville (a type with a small 
x-height), you would be better off keeping the line length arow1d 15 picas. If, 
on the other hand, you were setting a passage in 10-point New Century 
Schoolbook, you could probably get away with a line length of 30 picas. 

Letter Spacing and Word Spacing 
v 
PageMaker au tomatically determines the amount of space between the 
letters in each word and the words in each line of text that you set. This 
spacing is determined by several factors, including the font, type size, line 
length, and the type of a lignment you choose. (PageMaker 4 offers you 
several methods for overriding the default word or letter spacing that the 
program selects, all of which are d iscussed later in this chapter.) 

Letter spacing is the amount of space between each letter. Most of the 
time you will, not need to make any adjustment to the letter spacing used 
by PageMaker. In setting larger type sizes, however, you will encounter 
places where particular pairs of letters appear poorly spaced. In such 
situations, you can use PageMaker'skernin.g controls to adjust the amount 
of letter spacing between the pair. Kerning refers to bringing together 
pairs of letters that are too widely spaced. In our alphabet, such letter pairs 
as To, Wa, and Yo appear to be set too far apart when normalletterspacing 
is applied. Such pairs of letters are referred to as kern pairs because they often 
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Tip v 
You can produce an 
em space in Page
Maker by pressing 
~+Shift+M, an en 
space (Y2e m) by 
pressing ~+Shift+N, 

and a thin space 
(Y4 em) by pressing 
~+Shift+T. 

Tip 
v 
In an attempt to avoid 
most word-spacing 
problems when setting 
justified type in col
umns, try to maintain a 
minimum width of at 
least 39 characters 
(one and a half 
alphabets). 

require kerning (we shall look at some of these pairs later in this chapter 
when you learn how to do kerning in PageMaker). 

Word spacing is the amount of space between words in the line of type. 
This spacing is also set automatically by PageMaker. When specifying the 
amount of spacing, it is common to use units called em spaces and en 
spaces. An em space is described as a square that is as high and wide as the 
point size of the type. An en space is one-half of an em space. In PageMaker, 
you \•vill meet a third type of space called a thin space. A thin space is equal to 
one quarter of an em space. In most typefaces, an em space is about the width 
of the lowercase m and the en space is about the width of the lowercase n (thus 
the appropriate names). The average word spacing used by PageMaker in 
setting a line is about one-third of an em space. 

Type Alignment 
v 
Word spacing is most influenced by the type of alignment selected for the 
text block you are placing. PageMaker allows you to choose between five 
different a lignments: 

• Left alignment (flush left/ragged right). This is the easiest ar
rangement for the eye to read, as the word spacing remains 
constant. 

• Right alignment (flush right, ragged left). This arrangement is 
more difficult to read, as the eye must search for the beginning of 
each succeeding line. This alignment is used mostly to set short 
headlines. 

• Centered. This arrangement offers the same difficulty for the eye 
. as right alignment. This alignment, too, is most effective when 
setting column headings. 

• Justified (flush left and right). This arrangement gives the text a 
neat, boxy shape. To achieve flush left and right margins~ Page
Maker must use variable word spacing in each line. This can 
result in lines that appear set too loose or too tight. 



Using Type Effectively V 123 

• Force-justified (flush left and right). This alignment is identical 
to justified except for short lines a t the end of a paragraph. Unlike 
justified, force-justified justifies every line in the selected text, 
including the last one. 

Of the five alignment styles, justified is the one selected most often for 
typeset material. When using this alignment, you often need to use 
PageMaker's hyphenation and other typographic controls to avoid pec_u
liar word spacing. 

Choosing the Right Type 
v 
If we can agree that clear communication is the main function of publish
ing, then we can define the right type as the one tha t best conveys the 
message of our piece. This means tha t as part of the process of selecting 
fonts for your publication, you need to understand wha t you wish to say 
and who you want to say it to. As part of this process, you need to examine 
these factors: 

• Type of publica tion: Is it a piece with little text and lots of illus
tra tions (such as flyers and ca talogs), little text and no illustra
tions (such as forms and coupons), or a lot of text with a fair 
number of illustra tions (such as a manual or book), or some other 
combination? 

• Purpose of the publication: Is it to inform, persuade, entertain, or 
all three? 

• Tone of the publication: Is it funny, serious, or somewhere in
between? 

• Intended audience: Does it consist of a particular group with a 
uniqu e viewpoint? 

Although answering such questions won't necessarily indicate which 
fonts to use, it can narrow the field considerably by indicating those fonts 
that would be inappropria te. Because fonts have their ovvn personalities, 
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you can immediately mJe out some as rmsuitable once you are clear on the 
message and audience of your publication. 

Figure 4.7 illustrates how the different personalities of type affect text. 
Here, you see first two lines of Shakespeare's Macbeth set in four different 
fonts. The first two represent more conservative and, therefore, more 
legible fonts. The last two are more much decorative and, therefore, less 
easy to read. However, they do tend to reflect something of the mood 
evoked by the words "in thunder, lightning, or in rain." 

Which font do you think is the right one for this message? That question 
is hard to answer without knowing where this text will be used and for 
whom it is intended. For instance, you Vlould probably choose between 
the first and second font if this were to be appear in a new edition of the 
play intended for the actors in learning their parts. On the other hand, you 
would probably tend to choose between the third and fourth ones if the 
text were to appear in a flyer or on the playbill used to advertise a local 
production of this Shakespeare classic. 

In addition to the contents and audience for the piece, one more factor 
can influence your font choices: the method used to produce the final 
publication. As you work with PageMaker, you will find that some fonts 

When shall we three meet again 
In thunder, lightning, or In rain? 

When shall we three meet again 
In thunder, lightning, or in rain? 

When shall we three meet again 
In thunder, lightning, or in rain? 

When sh~ we t:hree .neer ~c:Un 

ln t:hunder, ~ht:nl"'J· or ln rrun? 

Figure 4.7: The influence of four different fonts on one piece of text 
'1 



Warning 
V' 
If you select a font in 
your publication that 
isn't available when 
PageMaker goes to 
print the document on 
a laser printer, the 
program will print the 
bitmapped version of 
the font, which will 
appear jagged. 
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reproduce better than others at the lm.ver resolution (300 dots per inch) of 
which PostScript laser printers such as the Laser Writer are capable. If you 
intend to u se such laser printers, you will probably want to s tay clear of 
some decora tive fonts that often appear grainy at this resolution. This is 
not, of course, a considera tion if you intend to have the publication printed 
using higher-resolution prin ters and are only using the LaserWriter to 
print proofs. 

Once you have narrowed dm·vn your font choices, you can begin to 
experiment with them. PageMaker makes it easy to experiment with 
setting text in various fonts (in Chapter 7, you will learn how to use styles 
in PageMaker to help you with this task). 

Fonts in Desktop Publishing 
v 
Computer-genera ted fonts exist as screen fonts and printer fonts. The 
Macintosh screen has a resolution of only 72 dpi (dots per inch), whereas 
a PostScript laser printer has a resolution of a t least 300 dpi. With that 
much d iscrepancy (or more) between the screen and printed versions of 
type, a special screen version of each font must be able to display them 
more or less as they will appear prin ted. If you are printing your Page
Maker publica tion w ith a d ot-matrix p rinter such as one of the 
Image Writers, the resolu tion of the screen and printed version of the font 
will be almost the same. 

All Macintosh screen fonts are bitmnpped, meaning that they are drawn 
·with the Quick Draw d isplay language and, as their name implies, consist 
of bits (or p ixels) that are either turned on and off. Unlike printer fonts, 
screen fonts can' t be scaled without becoming dis torted. For that reason, 
you must ins tall the screen version for the fonts you use in every individual 
point size if you want to be able to see how they will appear when printed. 

When you choose a point size for which you don't have a screen font 
installed , the version displayed on the screen will be distortedin. someway 
(in larger sizes, you' ll see jagged edges). Figure 4.8 illustrates this type of 
d istortion with the Times and Helvetica fonts. The 12-point Times and 
Helvetica in the first and third lines have screen fonts installed. Compare 
their d isplay \•vith those of the 14-poin t Times and Helvetica text in lines 
two and four, for w hich there are no corresponding screen fonts. The 
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Ti p 
v 
You can always tell in 
PageMaker which 
point sizes have 
corresponding screen 
fonts installed because 
the size is in outline 
font on the Size pull
down menu. All sizes 
that appear in regular 
type on the menu have 
no screen fonts 
installed. 

£f point Times vith no screen for« i.rutal]ed 

12 point Helvetica "With screen font installed 

14 point Helvetica \lAth no screen fontinslalled 

Figure 4.8: Fonts with and without corresponding screen fonts 
'V 

., 

distortion in the 14-point font size occurs mainly in the letter spacing. This 
makes it impossible to spot potential kerning problems prior to printing 
the publication (to say nothing of trying to solve them with PageMaker's 
manual kerning). 

Because it is important to have an accurate display of the type you are 
setting in your publication with PageMa ker, you will want to install screen 
fonts for all of the fonts and point sizes that you commonly use. To copy 
screen fonts in all the point sizes you use to your System folder, you must 
use the Apple Font/DA mover utility. In addition, you must copy the· 
printer fonts to your System folder (you do this by dragging the appropri
ate font icons to the System folder) so that PageMaker can download them 
to your PostScript laser printer (see Chapter 9 for more information on 
using printer fonts). 
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Generating Screen Fonts with Adobe Type Manager 
v 
For serious desktop publishers who require hundreds of fonts in a wide 
range of sizes, copying screen fonts for each point size they might use is not 
a practical solution. Fortunately, another alternative is to purchase the 
utility called Adobe Type Manager (A TM). This program generates screen 
fonts of any size from PostScript printer fonts (although it is most useful 
for large type sizes). 

For A TM to work, you only have to copy the printer font and the 10-and 
12-point bitmapped screen fonts for the desired font family (such as Times, 
Helvetica, and so on) to your System folder. The utility will then generate 
bitmapped screen fonts for any point size you select in PageMaker. To see 
the difference that Adobe Type Manager can make in the screen display of 
type, compare the48-point text shown in Figure4.9 (displayed without the 
appropriately sized screen fonts and ATM turned off) with that shown in 

Figure 4.9: Text display without screen fonts and ATM turned off 
"i1 
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Figure 4.10, where ATM is turned on. If you use a dot-matrix printer to 
produce your publications, the improved screen fonts created by ATM 
will carry over to your printouts (the screen version has no effect on the 
printout w hen using a laser printer). 

When using ATM with PageMaker, you may notice the program 
slowing d own when you select any commands that require PageMaker to 
redraw the screen. This is because when A TM creates screen fonts, it stores the 
charactersinaspecialareaofRAMcalled thefontcache.Toavoid slowing down 
PageMaker operations, you need to allot more memory to the ATM font 
cache (the default size is 92K). 

To do this, you select the Control Panel on the Apple menu and then 
double-click on the A TM trademark (a large lowercase A). That will bring 
up the Adobe Type Manager Control Panel shown in Figure 4.11. To 
increase the size of the font cache so that PageMaker will run faster, click 
on the up arrow under Font Cache. If possible, you should increase the font 
cache to at least 256K (more if you are crea ting a publication that uses a lot 

Figure 4.1 0: Text display with ATM turned on 
v 



Using Type Effectively V 129 

r S File Edit 

Video 

AdobezypeA1anage~ 

Person~ liztd for: 
GREG HARVEY 
HARVEY & "SSOCIATES 

ATM Font Cache Prosorvo 

@on 
Ooff 

@ Lin• spacin9 

0 Char acttr shapos 

@ 1983-1990 Adobe Systems lneorporatod. 
A11 Rights Res•rvod. Patents Ponding . 

Figure 4.11 : The Adobe Type Manager Control Panel 
v 

00., 

of fonts in large sizes). To increase the amount of RAM available for fonts 
in PageMaker, you may need to decrease the size of the font cache and live 
with the slower response time (you can also free up RAM by turning off 
MultiFinder, ifyou run PageMakerand ATM under it). After changing the 
Font Cache setting, you need to restart your Mac before the change will take 
effect (be sure that you have saved any publication that you are working 
with in PageMaker before you do this). 

Because PageMaker4 requires so much memory to run, you may not be 
able to avoid the slowdown in PageMaker operations when using ATM. 
On Macs with the minimum hardware configuration for running Page
Maker 4, you w ill probably not be able to take advantage of the Adobe 
Type Manager at all. 

You can turn A TM on and off from the Adobe Type Manager Control 
Panel. If you ever need to remove ATM from your system, be sure to click 
the Off button, restart your Mac, and then drag the ATM icons to the Trash. 

Notice in Figure 4.11 that the Adobe Type Manager Control Panel also 
allows you to choose between preserving the line spacing or the character 
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shapes. When you select the Line spacing radio button (the default), A TM 
preserves the same line spacing in your PageMaker publication whether 
you have the utility turned on or off. Using this option may result in 
clipped descenders of some fonts and compressed capital letters that use 
accents or other diacritical marks. 

To avoid clipping and compression, you select the Character shapes 
radio button. With this option active, A TM increases the size of the 
boundary surrounding each character to preserve its shape. As a result, 
you may find line spacing d iffers when ATM is turned on and off. 

If you print your PageMaker publications with a PostScript laser 
printer, you will want to use ATM's default of Line spacing because any 
clipping or compression of type on the screen will not affect the printing 
of the text. However, if you print your publications with a dot-matrix 
prin ter, you will want to use the Character shape setting because the on
screen display of the type does affect the way the text appears when 
printed. As with changing other settings on the Adobe Type Manager 
Control Panel, a change in the Preserve setting will not take effect until you 
restart the Macintosh. 

PAGEMAKER'S 
TYPOGRAPHIC 
CONTROLS 
v 

Having surveyed the vocabulary used to describe type and how fon ts are 
specified in desktop publishing, it's time to examine the typographic 
controls offered by PageMaker 4. These con trois include setting the overall 
values for letter and word spacing in the text, designating whether words 
are to be hyphenated as well as when hyphenation should occur, specifying 
the areas of text or letter pairs to be kerned, and indicating the type and 
amow1t of leading to be used. With such an array of typographic controls, 
you should be able to handle almost any spacing problem that might occur 
in a PageMaker publica tion. 
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Controlling the Letter and Word Spacing 
v 
The Word space and Letter space settings in the Spacing attributes dialog box 
(shown in Figure 4.12) control the word spacing and letter spacing used in 
the text of your publication. To reach this dialog box, you need to select the 
Paragraph option on the Type menu (~+M) and then click on the Spacing 
button. Notice that you can set the rninirnurn, desired, and maximum word
space and letter-space percentages from the Spacing attributes dialog box. 

The Word space settings in this dialog box represent a percentage of the 
space band, that is, the amount of space created when you press the space
bar (because this distance varies with the point size you select, the Word 
space settings are expressed as percentages ra ther than as distances). By 
default, the Desired percentage of word space is set at 100% of the space 
band, the Minimum amount a t 50% of the space band, and the Maximum 
amount at 200% of the space band . These minimum and maximum 
settings give PageMaker the freedom to comp ress the word space down 

r a File Edit Options Page 

ParagnJph specifications 

Indents: 

Le ft 

First 

Spacing attributes 

Word space: Letter space: 

Minimum ~~~ '7. Minimum 1'--s- '1 % 

n OK ll 
( Cancel ) 

Desired It 00 I % Desired l 0 I '7. 

MaHimum j 200 I '7. MaHimum j2s I % 

Pair k erning: 181 Auto oboue Q:IJ points 

Leading method: ® Proportional 0 Top of caps 

Autoleading: ~ '7. of point size 

Figure 4.12: The Spacing attributes dialog box with default settings 
v 

Reset 
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to one-half the amount of the space band or to expand thewordspaceup to 
twice th e amount of the space band to fill out a line of justified text. The 
d esired setting tells Page Maker to m ake the word space equivalent to 
the space band whenever possible. 

The Letter space settings in this dialog box represent a percentage of 
variation from the pen advance, that is, the distance between the left edge 
of a character and the left edge of the next character in the word in the 
selected type size. By defau It, the Desired percentage of letter spacing is 0% 
of variation from the pen advance. The Minimum and Maximum Letter space 
settings express what percentage of the space band PageMaker can add to 
(positive values) or subtract from (negative values) the space between 
letters (that is, the pen advance). The Minimum setting of -5% means that 
PageMaker can subtract up to 5% of the amount of the space band, and the 
Maximum setting of 25% means that the program can add up to 25% of 
the amount of the space band in adjusting the spacing between letters. 

By adjusting the minimum, desired, and maximum settings for Word space 
and Letter space, you can control the amount of looseness or tighh1ess in 
justified text. In adjusting the Word space setting, the range limits for 
Minimum and Maximum are between 0% and 500% of Desired. For the Letter space 
setting, the range limits are between -200% and 200% of Desired. Keep in mind, 
however, that for both the Word space and Letter space settings, the percentage 
you specify for the Minimum must be less than or equal to the percentage for 
Desired, and the Maximum must be more than or equal to the Desired. 

Regardless of what Word space and Letter space settings you use, Page
Maker sometimes must exceed the high and low ranges in order to justify 
yom text (this is especially true when using the Force justify alignment). To 
have PageMaker display any text that exceeds yom word spacing and 
letter spacing ranges, you need to select the Loose/tight lines option under 
Show Layout Problems on the Preferences dialog box of the Edit menu. When 
this option is chosen, PageMaker highlights any text on the current page 
where the word spacing or letter spacing exceeds the percentages speci
fied in the Spacing attributes dialog box. 

To take care of such spacing problems, you can try using typographic 
controls, including hyphenation, track kerning, and kerning individual 
letter pairs. Many times, you will have to use a combination of these 
controls to solve the particular spacing problems in large sections of text. 
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Generally, you should start with hyphenation, followed by track kerning. 
If fine-tuning is required, you can resort to manual kerning to complete 
the job. 

Controlling the Hyphenation of Text 
\7 
When setting left-aligned or justified text, you can often eliminate many 
spacing problems simply by hyphena ting the text. PageMaker offers you 
several hyphenation options. It also allows you to specify the number of 
consecutive hyphens that can occur, set the size of the hyphenation zone, 
and add your own words to a user hyphenation dictionary. To change any 
of these settings or to turn hyphenation on or off, you need to choose the 
Hyphenation option on the Type menu. If you are defining or editing a s tyle, 
you select the Hyph button in the Edit style dialog box. 

When you select Hyphenation, the program displays the Hyphenation 
dialog box shown in Figure 4.13. As you can see in this figure, by default, 
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Figure 4.13: The Hyphenation dialog box 
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PageMaker's automatic hyphenation is turned on, using the Manual plus 
dictionary option. Under this setting, PageMaker w ill hyphenate words in 
the selected text accord ing to its hyphena tion d ictionary as well as d iscre
tionary hyphens you have entered. Discretionary hyphens are those that you 
enter manually by pressing Option+- (the hyphen) when typing a word. 
They indicate where you will allow hyphenation to occur within the word. 

If you wish to restrict the hyphena ting that the program can do in a 
section of text, you should select Manual only in the Hyphenation dialog box. 
When this option is chosen, PageMaker will hyphenate only a t discretion
ary hyphens. 

To increase the amount of hyphena ting in your text, you should select 
the Manual plus algorithm option. When you select this option, PageMaker will 
hyphenate words in the selected text at any discretionary hyphens, according 
to the hyphenation shown for the words in its dictionary, and according to 
basic hyphenation rules (algorithms). Note that with this third option, words 
that are no tin the dictionary may end up being hyphenated incorrectly (what 
is correct according to a computer algorithm is often incorrect in English). 

You will also notice that yol:l can determine the number of consecutive 
lines in the text tha t can end in hyphens with the Limit consecutive hyphens 
to option in the Hyphenation dialog box. By default, PageMaker places no 
limit on the number of succeeding lines that can be hyphena ted. To limit 
the number of lines, you need to click on this option and enter a number 
between 1 and 255. ln most cases, you will want to restrict the number of 
consecutive hyphens to 3 or less to avoid this kind of stack. 

The Hyphenation zone option at the bottom of the Hyphenation dialog box 
determines when PageMaker will hyphenate unjustified text (that is, text 
that is not aligned with either the Justify or Force justify option). If the last 
word in a line starts to the left of the hyphenation zone and does not fi t entirely 
within the rightmargin,PageMakerwilltry to hyphenatetheword,according 
to thetypeofhyphenation chosen.Bydefault, theprogramsets thehyphenation 
zone at Yz inch (or 3 picas). To have the program hyphenate more frequently, 
you should decrease the size of this zone. To have the program hyphenate less 
often, you should increase the size of this zone (this will create a more ragged 
right margin). 

You can use the Add option in the Hyphenation dialog box to add a word 
to the user dictionary, to select a new dictionary to be used, or to remove 



Note 
v 
To apply track 
kerning to a section 
of existing text, you 
should select the text 
before you select the 
desired Track 
option. If you choose 
a Track option 
without having 
selected any text, 
Page Maker will 
apply the track 
kerning to any new 
text that you enter in 
layout or story view. 
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a word from the dictionary. Note that PageMaker uses the same user 
d ictionary to perform spell-checking in the Story Editor as it does to 
hyphenate \•vords when you select the Manual plus dictionary or Manual plus 
algorithm hyphenation option. (For specific information on how to add 
words to the user dictionary and indicate where they should be hyphen
ated, see the section on spell-checking text in the next chapter.) 

Using Track Kerning 
v 
PageMaker lets you automatica lly tighten or loosen the word and letter 
spacing for selected text with its Track command. The Track command adjusts 
word and letter spacing according to standardized track curves (this 
process is known as trnck kerning). According to these curves, the larger the 
poin t size, the greater the adjustments made to the spacing: 

You can select the Track command directly from the Type menu or in
directly by first selecting the Type specs option (~+ T) on the Type menu and 
then selecting the Track option in the Type specifications dialog box. If you are 
formatting text with a style (covered in Chapter 5), you can select the Track 
command on the style's Type specifications dialog box by selecting the Type 
option in the Edit style dialog box. 

The Track command makes available six track-kerning options. When 
you use the default of No track, PageMaker applies no track kerning to your 
text, using instead its own linear spacing calculations. To loosen up a 
section of text or a heading, you can choose either the Very loose or Loose 
option. To tighten up a section of text or a heading, you can choose between 
Normal, Tight, and Very Tight. 

Figures 4.14 and 4.15 illustrate the effect that track kerning can have on 
both smaller body text (12-point, in this case) and larger display text (30-
point headline) . The first example shows how PageMaker sets the text 
when the default of No track is used. The next five samples of the text and 
headline show what happens as the d ifferent track-kerning options are 
employed. 

Notice the difference between No track and Normal in two examples shown 
in Figures 4.14 and 4.15. The Normal track-kern curve tightens the spacing 
slightly so tha t it conforms more to the type designer's optimal letter 
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Warning v 
The use of track kern
ing on large sections 
of text will slow down 
the program's re
sponse time when it 
is performing any 
operation that re
quires the program 
to redraw the screen. 

Glamis thou art, and Cawdor; and shalt be what thou art ~ 
promis'd. Yet do I fear thy nature; It is too full o' the milk of No track 
human kindness to catch the nearest way. 

Glamis thou art, and Cawdor; and shalt be what thou art~ 
promis'd. Yet do I fear. thy nature; It is too full o' the milk Very loose 
of human kindness to catch the nearest way . 

Glamis thou art, and Cawdor; and shalt be what thou art r-
promis'd. Yet do I fear thy nature; it Is too full o' the milk of Loose 
human kindness to catch the nearest way. 

Glamis thou art, and Cawdor; and shalt be what thou art promis'd. ~ 
Yet do I fear thy nature; it is too full o' the milk of human kindness Normal 
to catch the nearest way. 

Glamis thou art, and Cawdor; and shalt be what thou art prornis'd. Yet ~ 
do I fear thy nature; itis too full o' the milk of human kindness to catch Tight 
the nearest way. 

Glamis thou art, and Cawdor; and shalt be what thou art promls'd. Yet ~ 
do I fear thy nature; it is too full o' the milk of human kindness to catch Very tight 
the nearest way. 

Figure 4.14: Applying the Track options to 12-point body text 
v 

spacing for the font. In the body text, you can see a noticeable improve
ment in word spacing as a result of using Normal. In the headline, Normal has 
caused an awkward word break with the hyphenation of the word 
Graphics. To rectify this situation, you can either select the Tight track-kerning 
option or use manual kerning (see next section) to try to tighten the letter 
spacing in the word Comm11nicntion sufficiently so that the word Graphics 
does not break and the entire headline can be set on one line. 

Kerning Pairs of Letters v 
In addition to applying kerning to entire sections of text, you can also kern 
individual letter pairs, either automatically or manually. In the Roman 
alphabet, some letter pairs normally require kerning, especially when set 
in larger point sizes. The type designer identifes such common letter pairs 
or kern pairs and indicates values for kerning them. 
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Communication in ~ Graphics 
Communication in ~ Graphics 
Communication in r-Graphics 
~ommunication in Graph-~ 
ICS 

Communication in Graphics ~ 

Communication in Graphics 
Figure 4.15: Applying the Track options to a 30-point headline 
v 

~ 

No track 

Very loose 

Loose 

Normal 

Tight 

Very tight 

PageMaker automatically reduces the letter spacing between all kern 
pairs in a font above the point size listed in the Spacing attributes dialog box 
(12 points is the default). Because it takes the program longer to draw 
kerned text on the screen, you may sometimes want to boost the threshold 
at which automatic kerning takes place by increasing this point size. 

To do this, select the Paragraph option (~+M) on the Type menu, then 
choose the Spacing button on the Paragraph specifications dialog box to get 
to the Spacing attributes dialog box, and enter a new point size after Pair 
kerning. You can also disable automatic pair-kerning for all point sizes in 
the Spacing attributes dialog box by clicking on the Auto above check box listed 
after Pair kerning. 

Figure 4.16 shows you the more common kern pairs printed with and 
without automatic kerning. Both sets of kern pairs are printed in 30-point 
Times. The first set uses the default values (auto pair-kerning for sizes 12 
points and larger) for the Pair kerning settings in the Spacing attributes dialog 
box. For the second set, auto pair kerning has been turned off by clicking 
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To Tr Ta Tu Tw Te Ty 
WaWAWeWo 
Yo Ya yo P. T. 

To Tr Ta Tu Tw Te Ty 
WaWA WeWo 
YoYayoP. T. 

Figure 4.16: Typical kern pairs with and without automatic kerning 
V' 

on the Auto above check box to uncheck it. Notice how much space there is 
between certain pairsofletters(especialJy Yo and Ya) when automatic kern
ing is turned off. Indeed, even in the first set where automatic pair-kerning 
did take place, pairs such as Yo and yo could stand even more kerning. For 
such cases, you can use PageMaker's manual kerning. 

Manual Kerning 
v 
PageMaker 4 allows you to manually adjust the amount of space between 
any two characters in either large (Yzs of an ern space) or small (Yioo of an 
ern) increments. When kerning manually, you can either decrease or 
increase the amount of space between two characters. 

To kern manually, you need to select the Text tool and place the cursor 
between the two letters before using the following keystrokes: 

• Press ~+Delete to tighten the space between letters in large in
crements. Press Option+Delete to tighten the space in small 
increments. 

• Press ~+Shift+ Delete to loosen the space between letters in large 
increments. Press Option+Shiit+Delete to loosen the space in 
small increments. 
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• To remove all kerning between characters, select the text, then 
press ~+Option+K 

You can also use the key combinations listed above to adjust the amount 
of space between more than just two characters. To kern a block of text, 
select it before you press the appropriate key combinations. 

~ecifying the Amount of Leading 

Leading refers to the vertical distance between the lines of text. In tradi
tional publishing, where type is set by hand, the amount of leading is 
calculated by measuring the distance from one baseline to the next and 
subtracting thepointsize ofthe text. The leading then represents the amount 
of space between the bottoms of the descenders in one line and the tops of 
the ascenders in the next line (Figure4.6). For example, if the measurement 
between baselines is 12 points and the size of type is 10 points, there will 
be 2 points of space between the bottoms of the descenders in the line 
above and the tops of the ascenders in the following line. When specifying 
leading in modern publishing, however, you enter the measurement 
between baselines. For example, to set 10-point type with 2 points of space, 
you specify 12 points as the amount of leading. 

When you set text in PageMa ker, the program places each line of text inside 
a bar called a slug (this term is borrowed fTom traditional publishing, where 
it refers to a line of type that has been cast ina single piece), whid1 includes the 
text and its baseline, and may include the amount of leading below. You 
can actually see the slug used by PageMaker when you highlight a line of 
type with the Text tool. For instance, if you highlight a line oflO-point type 
to which you have assigned 12 points of leading, the slug will appear 12 
points high. 

Proportional versus Top of Caps Leading 
v 
Two kinds of leading are available in PageMaker 4, which determine 
where the program places the baseline of the text in the slug. You can 
choose between the proportional method and the top-of-caps method 
(proportional is the default). The appearance of the slug changes depending 
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Tip v 
PageMaker assigns 
a leading value to all 
characters on a line, 
including nonprinting 
ones such as tabs 
and carriage returns. 
If you select a line of 
text and it appears 
as though no 
leading is assigned 
to it, it may be that 
one of these non
printing characters 
carries a different 
leading from the 
other characters in 
the line. To rectify 
this, triple-click on 
the paragraph with 
the Text tool to 
select all of it, then 
assign the desired 
leading to it. 
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Type menu with 
Leading pop-up 
choices displayed 
v 

on whether you are using the proportional or top-of-caps method. In the 
first, the slug appears evenly distributed around the text line; using top
of-caps, the slug is heavier at the bottom (under the text line). 

In the proportional method, the baseline of the text is positioned two
thirds of the way down from the top of the slug. For example, if you have 
specified 12 paints as the leading using the proportional method, Page
Maker will place the baseline of the text dow n 8 points from the top of the 
slug (8 points is two-thirds of 12 points) . 

In the top-of-caps method, the baseline is the same distance from the top 
of the slug as the height of the tallest ascender of the largest font used in 
that line. Despite th.e name top-of-caps, the size of the largest capital in the 
line does not determine the placement of the baseline. Instead, it always 
corresponds to the height of the tallest ascender of the largest font 
in the line. 

The top-of-caps method can be useful when you are creating a special 
type effect with negative leading, w here the lines of type may touch or 
even overlap. In most normal situations, however, the default propor
tional method works fine. To change the leading method, you need to 
access the Spacing attributes dialog box and click on either the Proportional 
or Top of caps radio button. To get to this dialog box, you need to choose 
Paragraph on the Type menu, then click the Spacing button. 

When you place text or enter text in PageMaker, the program automati
cally applies leading equal to 120% of the point size used, so that if you are 
setting 10-point type, PageMaker will automatically assign 12 points of 
leading. This percentage represents a standard amount of leading that is 
quite adequate for most type sizes. If you wish, however, you can modify 
this Autoleading percentage in the Spacing attributes dialog box. For example, 
if your piece uses type in large point sizes, you may want to increase the 
percentage to 140% or more. 

Although the Leadi11g default is Auto, you can easily assign a fixed 
leading to the type that you are setting. To do this, you can select Leading 
from either the Type menu (shown to the left) or the Type specifications 
dialog box (shown in Figure 4.17) and then highlight the desired amount 
of leading. The leading choices shown on the pop-up menu depend upon 
the point size of the selected text (if no text is currently selected, then an 
assortment of standard leading values is displayed). 



Note v 
The Other option is 
available on/ywhen 
you select Leading 
from the Type menu; 
it doesn't show up 
when you choose the 
Leading pop-up 
menu in the Type 
specifications dialog 
box. If you know you 
want to use a non
standard leading 
value, select the 
Leading option from 
the Type menu. 

r S File Edit Options 

Type specifications 

Font: 

Size: 

leading: 

Set width: 

Color: 

Type style: 

14 
18 
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Position: I Normal! 

Case: I Normal I 
Track: I No troclc I 

n OK n 
Cancel ] 

(options ... ] 

0 Outline 0 Reuerse 
erline 0 Shadow 0 Strilcethru 

Figure 4.17: The Type specifications dialog box with Leading pop-up choices displayed 
v 

PageMaker 4 allows you to assign leading values from 0 to 1300 points 
in increments as small as 0.1 point. If you don't see the desired value listed 
on the Leading menu, you need to choose the Other option, then type in the 
number of points. Any new leading value is applied to all selected text. If 
no text is selected when you change the leading, the new value is applied 
to text that you then enter. 

CREATING SPECIAL 
EFFECTS WITH TYPE v 

You can easily create several special type effects with PageMaker. These 
include rotating, compressing, and expanding selected text; using small 
caps; and specifying distinctive type styles such as outline or reverse. In 
this section, we shall look at these as well as techniques for creating two 
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other special type effects: drop caps and kerning superscripted text. 
Although PageMaker 4 doesn't yet enable you to shape type around 

curves or rotate it at oblique angles, plenty of Mac programs are available 
that can accomplish these effects and more. For information on products that 
enable you to enhance type, see Appendix B. 

Rotating Type 
v 
In PageMaker 4, you can rotate selected text in 90° increments. Figure 4.18 
shows you all four rotations, and Figure 4.19 shows you the Rotation dialog 
box from which you select the text rotation. To get to this dialog box, you 
select the Text rotation option on the Element menu. Note that this option is 
available only in layout view and when a text block has been selected with 
the Pointer tool (otherwise, the Text rotation option on the Element menu 
appears grayed out) . 

If you wish, you can create the text to be rotated in story view, then place 
it on the page or pasteboard. Then, as long as the text block is still selected 
(you should see the window-shade handles), you can choose the Text ro· 
tation option on the Element menu. In the Text rotation dialog box, you click 

Figure 4.18: Type rotation in goa increments 
v 



Figure 4.19: The Text rotation dialog box 
v 
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Windows 

on the A icon that represents the rotation you want to u se. PageMaker will 
then rotate the selected text in the orientation selected, and you can use 
the Pointer tool to drag it to its final position on the page. 

A text block rotated in any but the normal orientation should always be 
edited with the Story Editor (to edit it in layout view, you would have to 
first change its orientation to normal, make your changes, and then modify 
its orientation again). Remember that to get into story view, you need to 
select the text with the Pointer tool, then choose the Edit story option (~+E) 
on the Edit menu. After you have made your changes to the text in the Story 
Editor, click on the Close box in the upper left corner of the window. Your 
changes will then be reflected in the text block in the rotation used as soon 
as you return to layout view. 

Compressing and Expanding Type v 
The Set width command on the Type menu or from the Type specifications 
dialog box can be used to compress or expand type within a text block by 
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scaling its characters. The Set width menu choice represents percentages of 
the normal ,.vidth of the type (expressed as 100% and selected with the 
Normal option, ~+Shift+X). The compression options are 70%, 80%, and 
90% of normal. The expansion options are 110%, 120%, and 130% of 
normal. 

Figure 4.20 shows you the effect of using these various Set width options 
to compress and expand a headline. 

If you want to use a compression or expansion percentage other than 
the ones listed on the Set width menu, you need to select the Other option 
and enter a percentage value between 1% and 250%. PageMaker will accept 
percentages in this range in 0.1 % increments. Note, however, that the Other 
option is not available when you select Set width in the Type specifications 
dialog box. If you need to enter your own percentage, you must select the 
Set width option on the Type menu to get to the Other d ialog box. 

Filling Out a Line with Force Justify 
v 

Sometimes, you will wan t to fill out a line of type without distorting the 
characters or modifying the letter spacing.ln such cases, you can use the Force 
justify alignment to have PageMaker add the necessary word spaces to fill out 
the line. When you use this aligmnent option, PageMaker adds enough 

TliE TRAGEDY OF MACBETH 70% 

ThE TRAGEDY OF MACBETH 80% 

THE TRAGEDY oF MAcBETH 90% 

'THE ThAGEDY OF MACBETII Normal (JOO%) 

ThE 'TRAGEDY OF MACBETH --- JJO% 

THE 'TRAGEDY OF MACBETH --

THE TRAGEDY OF MAcBETI-I ---

J20% 

Figure 4.20: Using various Set width settings to compress and expand type 
V' 

J30% 
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word spacing (in equal increments) to make the text align with the left and 
right edges of the text-block boundary or the left and right margins of the 
column or page if the text is being placed. 

Figure 4.21 shows you this effect. In this figme, the text block extends 
to the entire margin settings. To have the headline fill out the entire width 
of the margins as does the ru le benea th, you simply select all the text in 
the headline and then change the alignment from the default of Left align 
to Force justify. You can do this by selecting Alignment from the Type menu 
and then the Force justify option from the Alignment menu, or simply by 
pressing ~+Shift+F. 

Using Small Caps 
v 
Whereas text set all in caps can sometimes be hard to read, text set in all 
small caps or in a combination of regular capitalization and small caps can 

,. a File Edit Option s Pog e Typ e Element Window s 

Figure 4.21: Using the Force justify alignment to fill out a line of text 
'1 
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Tip v 
Small caps are perfect 
for setting acronyms 
such as UNICEF, SCSI, 
and the like, and they 
are also often used to 
set times, as in 2 PM 
and 10:30 AM, to 
prevent the capitals 
from dominating the 
text. Small caps can 
also be used effectively 
to set off the initial line 
of text in a new section 
or chapter. 

often be effective. As a case in point, refer to Figure 4.22, which shows three 
sample headlines. The first is set in all caps, the second uses initial caps 
with small caps in place of lowercase letters, and the third uses the 
standard combination of initial caps with lowercase letters. All three 
headlines are set in 24-point Galliard. Note how much more room the 
headline requires when set in all caps as opposed to small caps and 
uppercase and lowercase (in fact, note that the small caps version is only 
slightly longer than the uppercase and lowercase one). 

THE TRAGEDY OF MACBETH 

THE TRAGEDY OF MACBETH 

The Tragedy of Macbeth 
Figure 4.22: Using small caps 
\1 

In typesetting, small caps are capital letters in a smaller size tha t have the 
same density as the capital letters in the font. Although many designers 
create small caps in a publication by juxtaposing capitals in a smaller point 
size with capitals in a larger point size (say 10 points for the small caps 
when the text is set in 12 points), this often results in small caps that are of 
a lighter density. Traditionally, a small cap is about73% of the height ofthe 
full capital and about 82% of its width. 

In PageMaker 4, small caps are sized at 70% of the point size used for the 
full capitals. You can, however, adjust this percentage up or down as you 
see fit. To set a line in small caps, you need to choose the Type specs option 
on the Type menu (~+ T), then select the Case pop-up menu on the Type 
specifications dialog box. Normal is the default case, which means that 
uppercase and lowercase letters appear in selected text exactly as you 
entered them. To convert all lowercase letters to small caps, you select the 
Small caps option (all uppercase letters in the selected text will remain full
size capitals; only lowercase letters become small caps). To convert all of 
the selected text to caps, you choose the All caps Case option. 
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To change the size of small caps, click on the Options button in the Type 
specifications dialog box (~+ T). This takes you to the Type options dialog 
box, shown in Figure 4.23. Once there, you need to click on the Small caps 
size button and enter the new percentage for small caps size. 

Using Different Type Styles v 
PageMaker, like most other Mac programs, offers you several different 
type styles (or a ttributes), such as bold, italic, underline, and so on, that can 
be applied to your text. The Type style command available on the Type 
menu (shown on the left) leads to a pop-up menu that includes these 
different attributes as well as a Normal option that will remove all previ
ously selected attributes. You can also select these attributes in the Type 
specifications dialog box. In fact, when you wish to apply more than one 
format to the text you have selected (or to the text you are about to type, 
if no text is highlighted), it is more efficient to choose them in this dialog 

r 8 File Edit Options Po 
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Font: 
Type options 

Size: 

l eading: 
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Super/sub script size: 
Set width: 
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Figure 4.23: The Type options dialog box 
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box. There, the a ttributes are listed a t the bottom of the window and are 
selected by clicking on the desired check box. Because more than one check 
box can be selected at a time, you can add several effects in a single 
operation, as in specifying Bold, Italic, and Outline for the selected type. 

Reversing Type 
\1 
Most of PageMaker's type style attributes-bold, italic, underline, 
strikethru, outline, and shadow-are commonly foLmd in other Macintosh 
programs (especially word processors), with the exception of the Reverse 
option. You can use this type style to create white text on a black (or near
black) background. An example of reverse text is shown in Figure 4.18, 
where the rotated text on the left has been printed in white on an 80% 
shaded (in other words, almost black) background. 

Although it is easy to create a reverse (you simply choose the Reverse option 
on the Type style menu or click its check box in the Type specifications dialog box, 
available on the Type menu), you need to be careful becauseyoucaneasily lose 
the type on the page. As soon as you select Reverse, PageMaker changes any 
selected type from black to the color of the paper (this is white unless you have 
changed it with the Define colors command on the Element menu). This means 
tl1at the type blends into the page and disappears. All you will then see are 
the window-shade handles and the rest of the bounding box. When you 
click elsewhere on the page or select a new tool, the reversed text disap
pears entirely! If this ever happens to you, you need to choose the Select all 
option on the Edit menu (~+A) and then locate the window-shade handles 
that seem to have no text between them. 

To display the reversed (and invisible) text, you need to drag it to a dark
colored background. In Figure 4.18, the reversed text is positioned on a 
rectangle shaded with an 80% fill. This rectangle was drawn in PageMaker 
with the Square-corner tool, then the None option was selected on the Line 
menu and the 80% option on the Fil l menu. 

Creating Drop Caps 
\1 
The initial caps at the beginnings of new sections in longer publications are 
often emphasized to call attention to the new section. One of the most 
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effective ways to emphasize the initial letter is to make it into a drop cap. A 
drop cap is a capital set in a larger point size than the surrounding text. It 
fits into a text block that is normally two or three lines deep. Figure 4.24 
uses a drop cap to emphasize the first line of Act 1, Scene 1 of Macbeth. In 
this example, thedropcap(the Win When)issetin36-pointNewBaskenrille 
bold, and the body text is set in 14-point New Baskerville. As you can see, 
with fixed leading of 16 points for the body text, the bottom of the drop cap 
sits on the baseline of the second line of the first speech. The top of theW 
is placed even with the tops of the ascenders in the first line of the speech. 

PageMaker 4 offers several ways of creating a drop cap. One of the most 
common methods (not used in this example) is to cut out the initial cap, 
enlarge it, and then paste it in place and reflow the remaining text around 
it (we will look at thjs method in Chapter 7). A second method treats the 
drop cap not as text but as a graphic that is placed at the beginning 
of the text. Because the drop cap is placed as a graphjc, the remillning text 
flows around it to avoid its graphic boundary. You can use this method to 
create a contoured drop cap (a teclmique that we will explore in Chapter 6). 

ACfl 
Scene I [A heath] 

77umdw and liglltning. F.nler three Waldla 

1. Witch 

W hen shall we three meet again 
In thunder, lightning, or in rain? 

2. Witch. When the hurlyburly's done, 
When the battle's lost and won. 
3. Witch. That will be ere the set of sun. 
1. Witch. Where the place? 
2. Witch. Upon the heath. 
3. Witch. There to meet with Macbeth. 
1. Witch. I come, Graymalkinl 
[2. Witch.] Paddock calls:-Anonl 
All. Fair is foul, and foul is fair; 
Hover through the fog and filthy air. 

Figure 4.24: Text set with drop cap 
v 

Exeunt. 
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A third method for creating a drop cap in PageMaker 4 was used to 
create Figure 4.24. In this method, the drop cap remains part of the 
paragraph. After enlarging the first letter, you use the superscript position 
to "drop" it into place in relation to the rest of the text. Because the drop 
cap remains part of its paragraph, changes to the text and graphics on 
preceding pages of the publication will never separate the drop cap from 
its attendant text when the text is reflowed. 

The following technique uses the Subscript Position option in the Type 
specifications dialog box to drop the cap down. It also uses the Super/sub
script size and Subscript position options in the Type options dialog box to 
control the size and finaJ placement of the drop cap. 

1. Make sure that you are in layout view, then select the Text tool 
and use it to select the first character in the paragraph (the one 
you want to turn into a drop cap). 

Next, you need to increase the size of the character. You will 
want to enlarge it to between two and four times the point size of 
the rest of the text of the paragraph. 

2. Use the Size option on the Type menu to increase the point size 
of the selected character. Choose the Other option and type in 
the point size if none of the predefined choices will do. 

Now you need to reposition the enlarged character from the Type 
specifications dialog box. 

3. Select the Type specs option from the Type menu (~+ T), then 
change the Position option from Normal to Subscript by selecting the 
Subscript option on the pop-up menu. 

Next, you need to modify the size and position of the subscript 
character in relation to the rest of the paragraph. To do this, you 
need to modify the Super/subscript size and Subscript position 
settings in the Type options dialog box. 

4. Click on the Options button in the Type specifications dialog box. 
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In addition to setting the size of small caps, you can also set the 
size of superscripted and subscripted text. Notice that by default, 
super I subscripted text is sized at 58.3% of the current font size. 
In this case, you want to make the super I subscript size 100% of 
the font size (you are using subscripting to "drop" the cap, not 
size it down). 

5. Click on the Super/subscript size option and change its value to 100. 

Next, you need to adjust the subscript position. PageMaker 
expresses this value as a percentage of the point size that the text 
is to be shifted down from the baseline of the text. You will have 
to experiment with subscript position values until you have the 
drop cap positioned correctly-this value varies with the font 
and type size. In the example in Figure 4.24, a value of 40% for 
the subscript position was sufficient. 

6. Click on the Subscript position option and enter the percentage 
that the baseline of the drop cap should come down in relation 
to the baseline of the rest of the paragraph's text (a value some
where between 35% and 75% should be adequate). 

7. Click on the OK buttons in the Type options and Type specifications 
dialog boxes (or press Retum or Enter twice). 

Now that you have the drop cap positioned correctly, you prob
ably need to indent the beginning of the first two or three lines of 
the body copy to make room for the drop cap. To do this, you can 
use tabs (the use of the Indents/Tabs dialog box is covered fully in 
Chapter 7). 

8. Press ~+I or select Indents/Tabs on the Type menu to bring up the 
Indents/Tabs dialog box (the tab ruler will be automatically 
aligned with the left margin of your paragraph). 

You need to move the first tab stop on the ruler so that it can be 
used to position the first few lines of body copy to the right of the 
area used by the drop cap. 
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9. Drag the first tab stop (the arrow bent 90° to the left) to a posi
tion on the ruler that you can use to indent the first few lines of 
text, then click on the OK button in this dialog box. 

Now all you need to do is to indent the first few lines of text to 
this new tab stop. 

10. With the cursor (insertion pointer) positioned immediately in 
front of the second character (the one right after the drop cap), 
press the Tab key to indent the first line to the first tab stop, then 
place the cursor at the end of the first line and press Shift-Enter. 

Pressing Shift-Enter inserts a new-line marker at the end of the 
line (if your first few lines end with carriage returns, you don' t 
have to insert new-line markers at the end of the lines). Doing 
this allows you to indent the next line of text as it interrupts 
PageMaker's word wrap (you will learn more about all of this in 
the next chapter). 

11. Move the cursor to the beginning of the second line of the 
paragraph, then press Tab to indent this line of text. If your 
drop cap extends to another line, you need to repeat the process 
of inserting a new-line marker at the end of this line and then 
inserting a tab at the beginning of the next line. 

Kerning Superscripted Text v 
The last technique we will look a t uses the superscript position and 
manual kerning to embed part of the word in an enlarged cap (as 
illustrated in Figure 4.25). This crea tes a rather dramatic effect that is often 
seen in logos and ads. Because this type effect embeds part of the word in 
an initial cap, it can onlybeused with words beginning with letters that are 
open on the right side such as C, T, or L (this effect really works best with 
the letter C). 

The technique for creating this type effect is surprisingly easy in 
PageMaker. 
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Figure 4.25: Embedding characters in an enlarged cap with superscript and manual kerning 
\1 

1. Select the Text tool in layout view, click somewhere on the 
page or pasteboard, then type the text, including the initial cap 
and all of the text to be embedded in it. 

Now you are ready to enlarge the initial letter. 

2. Select the Size option on the Type menu, and increase the size of 
the selected letter so that it is at least three or four times the 
size of the rest of the text. 

Next, you need to select the rest of the text. You will then super
script this text and kern it. 

3. Select the rest of the text, then choose Type specs on the Type 
menu or press :}€+ T to get into the Type specifications dialog box. 

Next, you need to change the position. 

4. Change the position for the selected text from Normal to Super
script by selecting the Superscript option on the pop-up menu. 

Now, you need to modify the size and position of the super
scripted text in relation to the initial letter. To do this, you need to 
modify the Super/subscript size and Superscript position settings in 
the Type options dialog box. 

5. Click on the Options button in the Type specifications dialog box. 
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As with the drop cap example ea rlier, you want to make the 
super /subscript size 100% of the fon t size (you are u sing 
superscripting to boost up the selected text, not size it down) . 

6. Click on the Super/subscript size option and change its value to 100. 

Next, you need to adjust the superscript position. PageMaker 
expresses this value as a percentage of the point size tha t the text 
is to be shifted up from the baseline of the text. You will have to 
experiment with the Superscript position value until you have the 
text positioned correctly; this value varies with the font and type 
size. In the example in Figure 4.25, a value of 100% for the Super
script position was required . 

7. Click on the Superscript position option and enter the percentage 
that the baseline of the selected text should come up in relation 
to the baseline of the initial letter. 

8. Click on the OK button on the Type options and Type specifications 
dialog boxes (or press Return or Enter twice). 

The last step is to use manual kerning to move the superscripted 
text to the left so that it is embedded in the enlarged cap . 

9. Click the I-Beam to position the cwsor on the second character 
of text, then press ~+Delete until the selected text is positioned 
where you want it in relation to the initial cap (you can press 
Option+ Delete to kern this text in finer increments). 

That's all there is to it! Although we used PageMaker's superscrip t 
position to place the selected text up in rela tion to the enlarged cap, we 
could just as well have used the subscript p osition to move the enlarged 
cap down in relation to the rest of the text, just as we did with the drop cap 
in the previous technique. 



ESSENTIAL 
TECHNIQUES v 
To Kern 
Manually 

To 
Rotate Text 
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1. Place the cursor (the insertion pointer) between the two letters 
you wish to kern, or select the characters with the I-Beam 
cursor. 

2. To reduce the space between the letters in large increments, press 
~+Delete. To reduce it in small increments, press Option+ Delete. 

3. To increase the space between the letters in large increments, 
press ~+Shift+ Delete. To reduce it in small increments, press 
Option+Shift+ Delete. 

4. To remove all kerning between characters, select the text, then 
press ~+Option+K. 

1. In layout view, select Edit story on the Edit menu (~+E), then type 
in the text to be rotated. You can select its font, type size, and 
type style using the Type menu in the Story Editor. 

2. Click on the Close box in the Story Editor, then click on the 
Place button in the warning dialog box that appears. 

3. Click the Text icon in the area of the page where you want the 
text to be or somewhere on the pasteboard. 

4. With the text block still selected, choose the Rotate text option on 
the Element menu. 

5. Click on the icon that represents the orientation you wish to 
use, then click on the OK button. 
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To 
Compress or 
Expand Type 

6. Drag the text block to its final position on the page, then click 
somewhere outside its bounding box to fix it. 

1. Select the text that you wish to expand or compress with the 
Text tool in layout view. 

2. Choose the Set width command on the Type menu. 

3. If you wish to compress the selected type, choose either the 
70%,80%, or 90% option. 

4. If you wish to expand the selected type, choose either the 110%, 
120%, or 130% option. 

5. If you find that the predefined Set width options compress or 
expand your type too much, choose the Set width command on 
the Type menu, then choose the Other option and type in the 
percentage value between 1% and 250% (100% represents the 
normal character spacing). 

6. Click on the OK button to return to layout view. To return the 
text to its normal spacing, select it with the Text tool, then press 
~+Shift+ X). 



5 
TEXT 

PREPARATION 
~-~= AND 

PLACEMENT 
v 
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This chapter explores the process of text preparation and placement in 
your publications. Whereas the text-editing capabilities of PageMaker's 
layout view are adequate for creating short titles and headlines for a 
publication, you will undoubtedly want to use a more powerful text editor 
to prepare the body copy of your piece. With PageMaker 4.0, you can use 
either the program's built-inStory Editor or a stand-alone word processor 
to prepare such text. 

You should base the decision on whether to use PageMaker's Story 
Editor or a stand-alone word processor on your degree of familiarity with 
each as well as the desktop publishing procedures followed in your office. 
If you have to prepare your own copy, and you're already reasonably 
comfortable with one of the word processors such as Microsoft Word or 
MacWrite, there is no reason not to use them, as PageMaker recognizes 
and uses most of their formatting. On the other hand, since the new Story 
Editor offers most of the word processing features you need to prepare 
text-including paragraph formatting, search and replace, hyphenation, 
and spell checking-you really don't have to use a stand-alone word 
processor unless you want to. 

However, if copy is prepared by a separate group in your office, you will 
probably find it to be easier on everyone concerned if text is prepared and 
edited outside of PageMaker, using the word processor upon which the 
company has standardized. If last-minute edits are ever required after 
the publication has been paged, you can use the built-in Story Editor to 
make them (and then export a copy of the final version in the word 
processor's format). In such cases, however, it is imperative that the people 
in charge of copyediting be aware of what word processing forma tting is 
retained and which formatting is lost when the text is imported into 
PageMaker. 

Once you've prepared your text (whether in PageMaker with the Story 
Editor or outside with a s tand-alone word processor), you have to know 
how to place it in your publication. In the second part of this chapter, we 
look closely at all the methods available for placing text in your publica
tions. But before we explore text placement in a publication, let's make 
sure that we're clear about all aspects of its preparation. 

At the end of this chapter, we'll examine the more specialized work of 
setting tables for a publication. The formatting requirements for preparing 
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body copy for a publication are rather lax when compared with those of 
a typeset table. Fortunately, PageMaker offers two alternatives for setting 
tables so that their complex formatting is recognized and retained in your 
publication: you can use the Table Editor in Word 4.0 or the one included 
in Page Maker 4.0. If you use Word 4.0, we urge you to explore its excellent 
Table Editor. In this chapter, however, we cover only how to successfully 
import Word tables into PageMaker; we will reserve the how-to in
formation for PageMaker's Table Editor. 

PREPARING TEXT 
WITH STAND-ALONE 
WORD PROCESSORS v 

In order for PageMaker to read formatted documents that you have 
prepared with other word processors, a special import file called a filter 
must be available for that program's file format. PageMaker 4.0 includes 
import filters for the following Macintosh programs: 

• Acta Advantage 1.0 

• MacWrite 1.0 through 5.0 and MacWrite II 

• Microsoft Word 3.0 and 4.0 

• Microsoft Works 1.0 and 2.0a 

• WriteNow 1.0 and 2.0 

• WordPerfect 1.0 through 1.04 

In addition, PageMaker 4.0 also supplies filters that allow you to import 
document files prepared with IBM PC and PC-specific word processors 
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and text editors. For Page Maker to be able to recognize text files created on 
the PC, the files must use the correct file name extensions. The PC text file 
formats and their requ ired file ex tensions are: 

• WordPerfect 4.2 files with the .WP extension, or WordPerfect 5.0 
files with the .WPS extension 

• XyWrite III Plus files with the .XY3 extension 

• Text files saved in the Document Content Architecture (DCA) 
format with the .DCA extension 

• Text files saved in the Microsoft Rich Text format (RTF) with the 
.RTF extension 

• Tex t files saved in the ASCII format w ith the .TXT extension 

To bring one of these PC text files to the Mac, you must use either a 
network product such as TOPS or AppleTalk, or a communications bridge 
such as Mac Link or PC Mac Bridge (be sure to transfer the PC text f ile to the 
Mac in binary form). Or, if your Macintosh has one of the new Super 
(FOHD) drivesand your PC is equipped with a3 V2-inchdrive, you can use 
it along with the Apple File Exchange utility to copy your PageMaker
compatible text fi les on to the Mac and translate them to the Macintosh file 
format. 

Note that you should always remove any graphic images from the PC 
document files before you translate them. Also, if you use any nonstandard 
ASCII symbols in your document (including foreign-language and other 
special symbols, such as the trademark and section symbols), these will 
not transla te correctly on the Mac (the Macin tosh and IBM PC character 
sets are different). You will have to edit such characters once the text is 
placed in PageMaker. 

If you use Microsoft Word 3.0, 4.0, or 5.0 on the PC, you can import your 
text files directly to PageMaker as long as they are saved in either the 
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ASCII, ASCII with line breaks, or RTF file format on the IBM PC. To import 
a text file saved in the normal Word format into PageMaker on the Mac, 
you need to open the file with Word 3.0 or 4.0 on the Mac, then save it in 
Macintosh Word format before you import it into PageMaker 4.0. 

Import (and export) filters are au tomatically copied to your hard d isk 
when you install PageMaker. They are placed in the Aldus Filters folder in 
the A ldus folder, which is loca ted inside the System folder. If you need to 
conserve d isk space, you can remove all of the filter files (import or export) 
that you don't use. Before you place these filters in the Trash, be sure that 
you have them backed up on a floppy disk. That way, you can always 
reinstate any one of these unused filter files to the A ldus fo lder, should you 
ever have to place a text fil e tha t uses it. 

Formatting Documents for PageMaker 
V' 
When you import text files into PageMaker, the program retains some of 
the document's formatting attributes and ignores others. Knowing which 
attributes will and will not be transferred can save you a great deal of time 
in preparing the text files for your publication. 

PageMaker recognizes and preserves the following formatting and 
attributes added to word processed documents for which there are filters: 

• Carriage returns: Use carriage returns only at the end of para
graphs or to force the end of a line in the document. 

• Tabs: Use tabs to create first-line indents as well as to format 
tabular tex t into columns (do not use the word processor's 
column feature to format tabular material). 

• Inden ts: Use left and right indents to d etermine how far the text 
is indented from the left and right edges of the column in the 
PageMaker publica tion into which the text is flowed. 

• Fonts: Fonts and type styles are retained un~ess a font is specified 
tha t is not currently on your Macintosh, in which case Page
Maker will substitute its default font, Times. 



Note 
v 
For information on 
PageMaker styles, 
jump ahead to 
Chapter 7. 
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PageMaker may n.ot retain the following formatting and attributes added 
to word processed documents for which there are fil ters: 

• Left and right margins: Margins are determined by the column 
width and placement of the text in the PageMaker publication. 

• Page numbering: Page numbers should be added to the appro
priate master page of the publication in PageMaker. 

• Headers and footers: Running heads for the publication should 
be added to the appropriate master pages in PageMaker. 

• Forced page breaks: In most cases, page breaks are determined 
entirely by the page layout used in PageMaker and the way you 
flow the text. 

Because PageMaker doesn't always retain page numbers, headers and 
footers, and mnnual page breaks that you enter in the word processed text, 
be aware that you may have to recreate such elements in the publication 
if your design calls for them. Use them in preparing the text only if it helps 
you in preparing and editing the document. 

Importing Documents with Style-Name Tags 
v 
Some formatting will be lost as soon as you place your word processed text 
in your publication. Thus, you are better off taking the time to define the 
styles in PageMaker that add such formatting and then adding style-name 
tags to the document in your word processor. These tags indicate where 
these styles should be used. A sh;le-nnme tng is created by taking the name 
of the PageMaker style that is to be used and enclosing it in a pair of angle 
brackets. For example, you would place the s tyle-name tag <First head> 
at the begilming of a first- level heading to have the program format it with 
the specifications called for in a corresponding PageMaker style called 
First head. 

To ensure that a s tyle-name tag is not interpreted as normal paragraph 
text, the tag must be entered at the very beginning of the paragraph to 
which it applies, and you must remember to check the Read tags check box 
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in the Place document d ialog box at the time you import the document into 
PageMaker. If you forget to check Read tags before you import the docu
ment, the program will not forma t the incoming text accordingto the styles 
named. Instead, it will use whatever formatting you assigned to the text in 
the word processor. 

If, when reading tags, PageMaker finds that a paragraph of the in1 por ted 
document lacks a tag, the program assigns it the style of the preceding 
paragraph. If you have crea ted a tag that has no corresponding style in the 
publication, the program will create a new style using the tag's name. This 
new style will contain the type specifica tions used in the paragraph 
following the style-name tag. 

When crea ting the copy in your word processor, tagging each paragraph 
as you enter it may seem tedious, but you will be amazed at how much 
time it can save when you place the text in your publica tion. Not only can 
it make paging a publkation go fas ter, but, as you will see when we take 
up the subject of defining and using styles in Chapter 7, it can expedite the 
design process by making it easy to experiment with new formats even 
after all of the text has been placed. 

Importing Word 4.0 Documents 
v 
Of all the formats used by Macintosh word processers, PageMaker is most 
compatible with the one used by Microsoft Word version 4.0. If you are 
using Word 4.0 to create your text files, you will find that PageMaker not 
only retains the basic formatting- as it does with all other word processors 
for which it has filters-but also allows more complex and specialized 
formatting, including: 

• Table of contents entries in the document either from .c. para
graphs or from an outline. 

• Index entries in the document. 

• The "page break before paragraph" setting, imported as either As 
page break before or As column break before. 



Note 
v 
If your Word docu
ment contains graphic 
images, PageMaker 
will place each image 
after the line of text to 
which it is tied without 
attempting to flow the 
text around it. See 
Chapter 6 for infor
mation on placing 
graphics in a pub
lication. 
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• Condensed/expanded character spacing, using either Set width, 
Track kerning, or Manual kerning. 

• Styles defined and used in the Word d ocument. 

Importing Special Formats Used in Word 
v 
You can control the way PageMaker imports special formatting, such as 
tables of contents and index entries, or condensed and expanded character 
spacing, from Word 4.0 files. To do so, you may need to use the Microsoft 
Word 4.0 import filter dialog box (shown in FigureS.l) when you are placing 
the Word file. To bring up this d ialog box, you must select the Place option 
on the File menu in layout view, then hold the Shift key as you click on the 
OK button (after selecting the desired Word document in the List box and 
choosing the appropria te Place options). 

Microsoft Word <1. 0 import filter, u2.0 n OK D 
~ Import table of contents entries 

® From .c. paragraphs 
0 From outline 

~ I mpo rt indeH entries 

Import condense d/eHpanded spacing as 

®Set width 
0 M anual kerning 
0 Track kerni ng 

~ Import page break before paragraph 

® As pag e break before 
0 As column break before 

Figure 5.1: The Microsoft Word 4.0 import filter dialog box 
v 

( Cance l ) 
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Note v 
PageMaker does 
not retain hard 
page breaks that 
you manually 
insert into a Word 
document. 

If you forget to hold down the Shift key when you click the OK button 
(or press the Enter or Return key), PageMaker will import the Word 
document using the default settings shown in the dialog box in Figure 5.1. 
These settings include importing table of contents entries from paragraphs 
marked with the .c. codes in the docwnent rather than from headings in an 
outline, importing all index entries, converting condensed and expanded 
type in the document to a set width percentage rather than through the use 
of manual or track kerning, and retaining page breaks that are specified 
with the Page break before option in Word's Paragraph dialog box and placing 
them before the paragraph (as opposed to breaking before a column). 

To have PageMaker ignore any of this formatting in the incoming Word 
document, you need to bring up the Microsoft Word 4.0 import filter dialog box 
and uncheck the appropriate check boxes. To change the way PageMaker 
imports table of contents or index entries, condensed and expanded type, 
or page breaks before paragraphs, you open this dialog box and click on 
the appropriate radio button. After making all necessary changes in this 
dialog box, you click on the OK button, and PageMaker will import the 
selected Word document. 

Importing Word Style Sheets 
v 
The styles that you define and use in your Microsoft Word documents are 
automatically transferred to your PageMaker publication as long as the 
Retain format box in the Place document or Import document dialog box is 
checked when you import the Word document into PageMaker. If this 
check box is not selected at the time you place your Word document, the 
document's style sheet will not be brought into PageMaker, and the pro
gram will format the text of the Word document according to its default 
settings. 

When you do import styles created in Word, their names are added to 
your PageMaker publication's Style palette (displayed on screen by press
ing ~+ Y or by selecting Style palette on the Windows menu). To indicate 
that a particular style has been imported from a word processing docu
ment, PageMaker places an *(asterisk) after its name in the Style palette 
list. Note that if a style in the Word document has the same name as a 
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PageMaker style, the program ignores the incoming Word style and 
retains the settings of the original PageMaker style. 

Figure 5.2 shows the PageMaker Style palette after placing a Word 
document in a new publication. In this example, three styles-First Head, 
Second Head, and Normal (indicated by the asterisks following their 
names)-were imported from Word. A fourth style in the original Word 
document called Body Text was not imported because its name conflicted 
vvith the PageMaker default style also called Body Text. Because PageMaker 
retained its own Body Text style, this name is not followed by an asterisk 
in the Style palette. 

Importing Tables Created with Word's Table Editor 
v 
In addition to the formatting outlined above, PageMaker will also recog
nize and import tables created in Word with that word processor's Table 

m. ips'U..m. dobr sila.mtt,con.st<:1tt"Utra.i:it'isc i:n.g t lit1 St < <J.AJlu.c ~um.my!W>~ 

ull.lortot 4o!Drt lll."i"".lliq ll.llll. mi. volu.t}>.t . Ul wisiu.Uu4 m.i>.im. 
tl<lrdt>.tioh lllli.m.c orpor SIISci~il !Dbo~is hisl u.t iliq ui~ ox •• c om.m.o4o --~-.~~ror.:;:~---,.'-= 

irillft do )Dr all.. h4rt rltU 'NJpu.t>l.t V1Jilt SS t m.oJuti.t <OhStq ll.l t, V111U1IJO. <OJI>rt 

hulh f.cilisis •t v.ro orcs t t lC cum.su t t illS to o4io 4igllissim. q uiblu4il prltSt :ol hptl.tlllll 
Jnit•"B"t 4 uis 4o)D,. to ft"i'i!llullo. ft.cilisi. Lo,.m ;,sum. 4o!Drsil t.lll.t t, c DhStclrtu.r 

Figure 5.2: Style palette showing styles imported from Word 4.0 
v 
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Editor. Wh en you import such a table created in Word, you can import it 
as either text or a graphic. If you save the Word table as a PICT graphic file, 
you must import the table as a graphk into PageMaker. If you impor t it as 
a graphic, you can resize and crop the table but you will no longer be able 
to edit its text. 

To import a Word 4.0 table as a graphic, you must use the following 
procedure: 

1. In Word 4.0, turn off the Show Hidden Text and Show Table Gridlines 
options in the Preferences dialog box. 

2. Next, select the entire table-don't include any lines above or 
beneath the table, even if they are blank. 

3. Then, press :t€+0ption+D to copy the table to the Clipboard as 
a PICT graphic. 

4. Exit from Word, start PageMaker, open the publication, and go 
to the page that is to contain the imported Word table. 

5. Select the Paste option (:t€+ V) on the Edit menu-if you wish to 
import the table as an inline graphic, choose the Text tool and 
click the insertion point at the appropriate place in the text 
before choosing the Paste option. 

If you wish to retain the ability to edit the table, you must save it in Word 
4.0 as a text-only file and then import it into PageMaker as text. A table 
imported as text loses its graphic elements such as border lines and shad
ing. As a text file, the colmm1s of the table are separated by tabs and the 
rows separated by paragraph returns. The left edge of each cell in a Word 
table becomes a left-a ligned tab to which the text in the cell is aligned. Once 
the table is placed in your PageMaker publication, you may have to use its 
Indents/tabs command to realign the text (for more information on usin g 
tabs and indents in PageMaker, see Chapter 7). 
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To import a Word 4.0 table as a tab-delimited text file tha t can be edited 
in PageMaker, you must follmv this procedure: 

1. In Word 4.0, insert a new line immediately above the table you 
wish to use and type a capital T in this new line. 

2. Next, select the T that you just typed, choose the Character 
command on the Format menu, and check the Hidden option in 
the Style dialog box. 

3. Save the Word file, exit from Word 4.0, start PageMaker, open 
the publication, and go to the page that is to contain the im
ported Word table. 

4. Select the Place command on the File menu (in layout view) or 
the Import command on the Story menu (in story view), then 
choose the Word file that contains the table, and click on the 
OK button. 

Importing Text-Only Files 
v 
If PageMaker 4.0 does not supply an import filter for the word processor 
that you are using, you can always bring your document into PageMaker 
by saving it as a text-only file . When you choose a file saved in the text-only 
(or ASCII) format from the list box of the Place document or Import docu
ment dialog box, the program automatically opens the Smart ASCII import 
filter dialog box shown in Figure 5.3. I 

By default, PageMaker imports your text-only file into the publication 
as is. If necessary, you can use the options in the Smart ASCII import filter 
dialog box to modify how the text is imported. If the file places carriage 
returns at the end of each line of text, you can remove them by checking 
the At end of every line option. Likewise, you can have the program remove 
carriage returns entered at the end of each paragraph by checking the 
Between paragraphs button. 
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Tip 
'\7 
If you don't know how 
many spaces are 
used to indent the first 
line of each para
graph, import the text 
file without using this 
option and verify the 
number in Page
Maker. Then, use the 
Story Editor's Change 

command to delete 
the spaces by re
placing them with no 
character. Finally, 
create a style that 
indents the first line of 
each paragraph and 
apply it to the text. 

Smart ASCII import filter, u 1. 2 

Remoue eHtra carriage returns: 

0 At end of euery line 

0 Between paragraphs 

Windows 

0 llut k•~ •~P tllhll~s. ll~ts <Jrld lnd (HJh llS i ~ 

0 Repl ace Iiiii or m ore spaces with o tob 

0 Monospoce, import as Courier 

1:81 No conu ersion, import as is 

' · ..... . .:. ~ . .. . . .. . . .. 0 • •• •• •• • •••• 0 . 0. 0 • • ••• 

Figure 5.3: The Smart ASCII import filter dialog box 
\1 

If you check either the At end of every I ine or Between paragraphs option, the 
But keep tables, lists and indents as is option becomes available. If you check 
this option, PageMaker will not remove carriage returns from lines that 
begin with spaces or tabs or tha t contain tabs within them. 

If you have used spaces to indent the first line of each paragraph in your 
text-only file, you can have PageMaker replace the spaces with tabs by 
checking the Replace_ or more spaces with a tab option and then entering 
the appropriate number of consecutive spaces that should be converted 
into a tab. Be sure that the number you enter will not result in PageMaker' s 
inserting tabs anywhere in the text except at the beginning of lines. 

The last option, Monospace, import as Courier, converts the text of the 
incoming text-only file to the Courier font. As this font is one of the few 
Macintosh fonts that is monospaced, checking this option will result in 
uniform character spacing. Although you can align text set in such a font 
without using tabs, as your PageMaker reference suggests, we recom
mend using indents and tabs to align text. That way, you can still 
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experiment with setting your text in proportionally spaced fonts without 
adversely affecting its alignment. 

Exporting Text v 
You can save the text of your publication in document files that you can 
edit in your word processor. Provided that PageMaker provides an export 
filter file for your word processor, you will find that the document retains 
most of the formatting that you assign with the program. If PageMaker 
does not provide an export filter for the word processor you use, you can 
save the text in a text-only document. 

Currently, PageMaker provides export filters for the following Macin
tosh and IBM PC word processing file formats: 

• Text only (ASCII) 

• DCA (Document Content Architecture supported by IBM pro
grams such as DisplayWrite 5) 

• MacWrite II 

• Microsoft Word 3.0/4.0 

• Rich Text Format (RTF supported by Microsoft programs) 

• WriteNow 

• XyWrite III Plus 

To export text in one of these file formats, you first need to select the text. 
To export just part of a story, highlight the text with the Text tool either in 
the layout or story view, then select the Export option on the File menu. If 
you want to export the textofanentirestory, click somewhere on the story 
in layout view, then switch to story view (Edit Story on the Edit menu or 
~+E) before selecting the Export option. 

When you select the Export option, PageMaker d isplays the Export 
dialog box, shown in Figure 5.4. Near the top of the Export dialog box, you 
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Figure 5.4: The Export dialog box 
'I 

Options: 
0 EHport tags 

will see a list box displaying the name of the folder in which your exported 
document will be saved. To save your document ina different folder, click 
on the folder nam e a t the top and select the appropriate folder from the 
pop-up menu. Tosave thedocumentona differentdrive, clickon the Drive 
button, then select the correct folder. 

If you originally imported the text or story you selected from a word 
processing document, PageMaker will display the original file name 
beneath the scroll box showing the current folder. If you created the text 
in PageMaker, this area will be left blank. To enter a new document name, 
make sure that the blinking cursor is still on this line and then simply start 
typing. To edit an existing document name, make sure that the name is 
selected before you attempt to edit it. 

By default, PageMaker will save your text in a text-only document (Text 
Only is automatically selected in the list box beneath File format). To select 
a different format, simply click on the appropriate format name (you may 
have to scroll the list to see the file format you wish to use) . 
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If you selected only part of the text (either in the layout or story view), 
the Selected text only radio button will automatically be selected in the 
Export dialog box. If you change your mind and wish to export all of the text 
in the story, click the Entire story button before saving your document. If 
you ever change your mind and find that you really do want to save just 
the selected text, click the Selected text only button before making your copy 
(if no text is selected before you open the Export dialog box, the Selected text 
only radio button remains ghosted). 

If the export file format you selected supports style sheets, all the styles 
that you defined for the text in PageMaker will automatically be transferred 
to the new document (note, however, that some of the formatting called for 
in particular styles may be lost upon translation to the word processor's 
file format). If your word processor doesn' t support s tyles, you can check 
the Export tags ch eck box. Page Maker will then insert style-name tags at the 
beginning of each paragraph in which each style was applied, and save 
these tags as part of the word processing file. That way, you can retain the 
s tyle information and have PageMaker apply this formatting to the text 
should you later import the text into a publication . Exporting the text with 
the s tyle-name tags also gives you an easy way to document the use of 
styles in the publication, which can be useful even if you never again 
import the text into PageMaker. 

THE STORY EDITOR 
v 

As we indicated at the start of this chapter, you d on' t even have to own a 
word processor or text editor to be able to prepare text for your publica
tions, thanks to PageMaker' s new Story Editor. If you did the exercises in 
Chapters 2 and 3, you are already somewhat familiar with the use of 
PageMaker's built-in word processor. 

To recap a bit, the Story Editor provides you with text-editing functions 
with which you can easily create the copy for your publications or edit the 
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Tip 
v 
To change the font 
and the size of the 
type displayed in story 
view to something 
other than 12-point 
Times, select the 
Preferences option 
on the Edit menu and 
select the desired size 
and font beneath 
Story view. 

copy that you import from your word processor. Along with the most 
common editing and formatting features, the Story Editor allows you to 
perform search and replace operations and spell-check the text of 
your story. 

Editing in story view is faster than in layout view, as PageMaker 
displays all of the text in a standard font and text size without showing any 
special page layout formatting or graphic images placed on the page. Also 
contributing to faster editing is the fact that PageMaker grays out all story 
textthatisstill visible on the page beneath the story window. That way, the 
program doesn't have to take the time to reflow the text according to your 
editing changes until you return to layout view. In Figure 5.5, you can see 
this effect. Here, you see a story in the Story Editor whose window 
overlaps part of the area on the page showing where the story has been 
placed. Notice that you can no longer see the type in this area of the page
it will remain dimmed until you return to layout view. 

Body l•xl 

Body text 

}n se perperuo Temp u.s 83 revolubile gyro lam 
revocatZephyros, vere 1Epen1E, novos. lnduiturque 
brev Tell u.s repe.rata iuventam, Iam.q ue soluta gelu 
dull:e 'lirescil humus. Pel!or? o.n et nobis redeuntin 
co.rmina vires , I ng enium.q ue mihi munere veru ad est? 
Munere veru adest, i1Erumque 'ligescil ab ilJo (Quis 

pulE I?) a1que eliquod iam sibi poscil opus. C8318li3 
anlE osculDs, bifid um.q ue ce.cumen o berro.t. Pyrenen 
sol'!UUa noclE ferunt. Concltaq uq an:ano fervent mihi 
pec10ra motu, Et furor, etsonitus. 

In se perperuo Tempus 83 revolubile gyro lam 
revocatZephyros, vere 1Epen1E, novos. lnduiturque 
brev Tell us repe.rata iuventam, lam.q ue soluta gelu 
dulce 'lirescit humus . Pel!or? an et nobis redeunt in 

ue mihi munere veru ad est? 

Figure 5.5: Story view with story window and dimmed page text 
V' 



Tip 
\1 
To select all of the 
text in a particular 
paragraph in the 
Story Editor, simply 
click on its style name 
in the sidebar. 
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In story view, you see only paragraphs of text in a separate window that 
overlaps the current page. By default, PageMaker lists the name of the 
style assigned to that paragraph in the sidebar on the left side of this 
window. If no style is used, the program simply displays a dot at the 
beginning of the paragraph in this area. If you don't need to see the style 
names and want to maximize the size of the s tory window for editing, you 
can suppress the display of the sidebar by selecting Display style names on 
the Options m enu to uncheck it. 

In addition to style names, the Story Editor displays placemarkersin the 
paragraphs of text for three elements: inl ine graphics (that is, graphics that 
are attached to the paragraph in which they are placed and flow with 
them-see Chapter 6), entries marked for the index (see Chapter 8), and 
automatic page numbers inserted into the text (see Chapter 7). Figure 5.6 
shows you a section of text in the Story Editor that contains examples of all 
three place markers. The markers in the first and second lines are inline 

r c File Edit Options story Type Windows • ., MPM4 Ch2 
.... ~ .. ..01 Jn 11,ZJ -~81 }~I },01 10 

-: I ..... 

;;;o Note: I 0;;; Ito~: Qllcl: ~ l~w.~ :t>:~ m 
~ ~01e1! Q 

.on on the File menu, y 

The .ti.Comm.and-is -mmk.ed.w i.th.-Appl€ -icon{ 4t )-and-th£ -cloverl€af d+O, which is the st 

icon-(Q) .fn.rhi.s .book, .i.t. will-always .be .indicared-by -til£. word. shown in Figure 2.2. 
!..; Command· as .iJl..Otomm.and+ o.as .i.t.appears .h£re ·(]>~e .C) I r is listed as P..S"Mal< 

l.isltd in l:ox below. 
:he Tutori:a..l JO!der. 

list box and click hem 

~ 

e upper right comer a 

~ ro .... ... .... ........... .... 10 
L '2:1 l¢ 

Figure 5.6: Story showing place markers for inline graphics, an index entry, and a page 
V number 
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graphics markers (the first is a keyboard graphic imported into the file; the 
second is the cloverleaf symbol created with Chicago, a bitmapped font), 
the diamond-shaped marker in the middle of the last line is an index entry 
marker (adding ~+0 to the book's index), and the cross-hatched marker 
at the end of the last line is a page number marker (this page number will 
be updated automatically, should the text of this note move to an
other page). 

In addition to these place markers, you can also see paragraph markers 
(indicating the use of carriage returns) and tab markers (shown by right 
arrows) by selecting Display ~ on the Options menu. Displaying tabs and 
carriage returns in a document can be helpful in editing text in story view, 
as it enables you to see right away whether you have separated lines with 
carriage returns and have indented text with a uniform number of tabs. 

In addition to showing the location of tabs and carriage returns when 
Display ~ is selected, PageMaker also displays spaces between words as 
centered dots. This allows you to tell at a glance if you have entered too 
many spaces between words. Figure 5.7 shows you a story window where 
the Display~ option is selected but Display style names is not. Notice that the 
Story Editor shows each space as a dot between words. It shows paragraph 
symbols (!f]) at the end of each line that was terminated with a carriage 
return (entered by pressing the Return key). Also, notice that the tabs 
following the numbered items are shown by right arrows. 

Working with Stories 
v 
PageMaker considers a story to be all text that is placed as a single unit. As 
you will see later in this chapter, where we discuss placing text in a 
publication, a story can be broken up into several text blocks around which 
you can place graphics. Even in such cases, when you select any of its text 
and then enter story view, all of its text is accessible for editing. 

To create a new story in the Story Editor, you simply enter story view 
(~+E or Edit story on the Edit menu) when no text block on the page has 
been selected. PageMaker will open a new story called Untitled followed 
by a number representing the order in which it was opened-the first new 
story becomes Untitled:l, the second Untitled:2, and so on. Once a story is 
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r & Fil e Edit Options Story Type Windows 
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Figure 5.7: Story with Display~ on and Display style names off 
\1 

opened, you can begin entering your text just as you would in any 
Macintosh word processor. 

Selecting Stories for Editing 
V' 
To edit an existing story tha t has already been placed in your publication, 
you click somewhere on the tex t to select it (you will see the window-shad e 
handles at the top and bottom), then enter story view. PageMaker will 
place the cursor at the beginning of the story (regardless of where you were 
in the story when you selected it). If you wish to locate the cursor a t a 
particular place in the s tory, you must switch tothe Texttoolin layout view 
and click at the place in the text with the 1-Beam cursor, then enter story 
view. The Story Editor will open the s tory and locate the cursor at the place 
where you cUcked with the Text tool in layout view. 

Once you open a new or existing story, you can always return to layout 
view at any time wi thout first having to close the window in story view. 
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Note 
\1 
The Place command 
in layout view imports 
text and graphics from 
external documents. 
The Place command 
in story view places 
the story in the 
publication! 

The fastest way to do this is to simply click the Pointer somewhere on the 
page. PageMaker will then bring the current page (or pages, if your 
publication uses facing pages) to the front, hiding all open story windows. 

A second method for switching from an active s tory window to the 
current page of the publication is to select the publication on the Windows 
menu. When you display the Windows menu options, you will see the name 
of the publication followed by the titles of all open stories at the bottom of 
the menu. Select the nameofthe publication (it will match the name shown 
in the Title bar of the publication window) by dragging to it. When you 
release the mouse button, PageMaker will place the publication window 
in front, hiding all story windows. 

To return to editing a particular story once you've finished working in 
layout view, you simply return to the Windows menu and select the title of 
the story you wish to work on. 

Closing and Placing Stories v 
When you finish making changes to a story that you've already placed in 
the publication, you simply click on the Close box in the upper left corner 
of the window to have PageMaker update the text in layout view and 
reflow the text as required. If you click on the Close box of a new story, 
PageMaker will sound the alert (usually a simple beep) and then display 
the warning box shown in Figure 5.8. To place the new story in the 
publication, click on the Place button. To abandon the story (meaning that 
you won't be able to retrieve it again), select the Discard button. To cancel 
the action of closing the story window, click on the Cancel button. 

PageMaker offers an alternate method for placing a new story in your 
publication- you simply select the Place option on the File menu (or press 
~+D). The program will then close the story window and load the story 
in preparation for placing it on the page. When editing a story that's 
already been placed in the publication, the Place option becomes Replace 
on the File menu. You can use this option to close the story window and 
update the story in layout view, instead of clicking on the Close box. 



Tip 
V' 
PageMaker indicates 
carriage returns in a 
story in the Page· 
Maker 4.0 Story 
Importer dialog box 
with 1 {vertical bar). To 
see the text displayed 
on individual lines, 
select the story and 
then click on the View 
button. 
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Placing New Stories 
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Figure 5.8: Story has not been placed warning 
v 

Importing Stories from Other Publications 
v 
As with previous versions of PageMaker, version 4.0 does not allow you 
to open more than one document window, meaning that you can only 
have one publication in memory at a time. The program does, however, 
provide the means for bringing stories from other PageMaker 4.0 publica
tions into the publication you're working on. You can copy a story either 
into the story that you are editing or a new s tory that you're creating in 
story view, or p lace it d irectly into your publication using the Place com
mand in layout view . 

To import a s tory from another PageMaker publication, you select the 
Place command on the File menu (or the Import command on the Story menu 
if you're in story view), then double-click on the name of the publication 
or select it and click on the OK button of the Place document dia log box. 
When you d o, the program will display a PageMaker 4.0 Story Importer 
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dialog box similar to the one show n in Figure 5.9. This dialog box shows 
the first 30 characters of each story in the selected publication. To import 
a particular s tory, click on its name to select it. To select more than one story 
for importing, hold down the Shift key as you click on the document 
names. To select all of the stories for importing, click on the Select all button 
or press ~+A. 

By default, PageMaker only lists stories over 20 characters long in the 
PageMaker 4.0 Story Importer dialog box. This eliminates shorter stories such 
as publication headings and titles. If you \•Vish, you can include shorter 
stories such as these or restrict the listing to only longer stories by typing 
a new number at the bottom of the dialog box. To see all of the 
stories in a publication, enterO in this area. After you enter a new value 
for listing stories, the Relist button in the lower right corner becomes active. 
To have the program list all s tories that meet your new requirements, click 
on the Relist button or press Return or Enter. 

Edit Options Pe 

PegeMeker 4. 0 Story Importer, u I. 0 

Select stories to piece es one: ( Se lect ell) 

Slo ene & GorrettiAnnuel Report I for yel'lr 'if! 
"The direction we toke in the 1990s will d 
In se perpetuo Tempu s es reuolubile gyro 

n OK 

( Cencel ) 

Lli c~w 

( Help 

List only stories ouer ~ ~.J1MI ch!lrec ters long ( Fleli~t 

Figure 5.9: The PageMaker 4.0 Story Importer dialog box 
v 



Tip v 
To copy text from one 
story window to an
other, select and use 
the Edit menu's Copy 
and Paste commands. 
To place text in a new 
story window, select 
New story on the 
Story menu, then se
lect the text and use 
the Cut and Paste 
commands. 
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In the PageMaker 4.0 Story Importer dialog box, you see only the first 30 
characters of a story. If 30 characters are not enough to identify whether 
you want to use the story, you can see all of its text in its own story window 
by selecting the story and clicking on the View button. PageMaker will then 
display the text in the correct font and text style. Figure 5.10 shows you an 
example of viewing a story with the View option. Notice in this figure that 
PageMaker shows the text of the selected story not only in the correct font 
but also the right text size and style. 

When you are finished viewing the contents of a story, click on its Close 
box to return to the PageMaker 4.0 Story Importer dialog box. When you have 
selected all of the stories you \•vant to import into the current PageMaker 
publication, click on the OK button in the PageMaker 4.0 Story Importer dialog 
box. If you used the Place option on the File menu in layout view to import 
your story, PageMaker will load the Pointer with the text in preparation 
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=0 SG Brochure # 1 

~ , PageMaker 4.0 Story Importer, uLO OK 

Select stories to place as one: (Select all) ( Cancel J 
Sloane & GarrettiRnnual Report I for year E Q ·····--··-······-···- ·· 

ltltll ,., r•:re~ , • kl;':~:.lriiiff ~-I.! I IJ;.<IIJU , . , ( Uiew J 
In se perpetuo Tempus as reuolubile gyro 

0Ei0 =o Ulew story:t 

"The d1rect1on we take1n the ~ 
1990s will determine our 
course well into the 21st 

= 
century." 
-Gary Sloanar 

Figure 5.10: Viewing the contents of a story 
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Note 
v 
Changes made to the 
type specifications 
affect all text selected 
at the time you make 
them. If no text is 
selected, the changes 
affect the text that you 
type. 

for placing it in the publication (see "Placing Text in a Publication," later 
in this chapter). If you used the Import option on the Story menu in story 
view to impor t your s tory, PageMaker will open a new story window and 
enter the text in this window. Then, to place the imported text in the 
publication, you have to select the Place command on the File menu or click 
on the Close box and the Place button. 

Editing Story Text 
v 
Whether you are creating new copy for a publication or editing text from 
a word processed document or another PageMaker publication, several 
editing teclmiques are available for moving the cursor through the story 
and for selecting text. Table 5.1 summarizes the teclmiques for moving th.e 
cursor (insertion point). Table 5.2 summarizes the teclmiques for selecting 
various amounts of text. Note that you can select text using the cursor 
movements shown in Table 5.1 simply by holding the Shift key as you 
perform the cursor movement. 

The cursor movements and selection techniques recapped in these 
tables (with the exception of selecting a paragraph by clicking on the style 
name in the sidebar) can be used ineitherstoryorlayoutview. When using 
them to edit text in layout view, you first need to select the Text tool 
(Shift+F4 shortcut with the extended keyboard) and click the !-Beam 
cursor to position the insertion point. 

Modifying Type Specifications 
v 
The options on the Type menu are identical in story and layout views, 
except that Indents/tabs (discussed in Chapter 7) and Hyphenation (discussed 
in Chapter 4) are available only when you are in layout view. 

To enhance the text of your stories, you can individually use the Font, Size, 
Leading, Set width, Track, and Type style options or, if you wish to change 
several settings at one time, select the Type specs option(~+ T). Figure 5.11 
shows the Type specifications dialog box that appears when you select this 
option. Note that you can select the font, type size, leading, set wid th 
percentage, positioning, case, tracking, and type styles from this dia
log box. 
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Table 5.1 : Moving the Cursor in a Story 

PRESS: 

7 (on keypad) 

1 (on keypad) 

~ +7 (on keypad) 

~ + 1 (on keypad) 

t- or 4 (on keypad) 

---7 or 6 (on keypad) 

i or 8 (on keypad) 

J. or 2 (on keypad) 

~ +8 (on keypad) 

~ +2 (on keypad) 

Page Up or 9 (on keypad) 

Page Down or 3 (on keypad) 

Home or~ +9 (on keypad) 

End or~ +3 (on keypad) 

Table 5.2: Selecting Text in a Story 

TO MOVE CURSOR (INSERTION POINT): 

To beginning of line 

To end of line 

To beginning of sentence 

To end of sentence 

Left one character 

Right one character 

Up one line 

Down one line 

Up one paragraph 

Dovvn next paragraph 

Up one screen 

Down one screen 

To beginning of story 

To end of story 

TO SELECT: CHOOSE TEXT TOOL & DO THIS WITH MOUSE: 

Word Double-click 

Paragraph Triple-dick or click on style name in s tory window sidebar 

Range of text Drag to highlight text or click a t the beginning of text, hold 
down Shift key, click at the end of text 

Entire story Click anywhere in s tory, then choose Select all on Edit menu or 
press ~ +A 
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Warning v 
Selecting Normal 
(~+Shift+spacebar) 

will not return text that 
you've made All caps 
(~+Shift+K) or Small 
caps (~+Shifi+H) to 
uppercase and 
lowercase. To do this, 
you must select Type 
specs and select 
Normal on the Case 
pop-up menu. 

Type specifications 

Font: I Futuro Book I 
Size: points 

leading: 111 II> I points 

Set width: I Normal II> I percent 

Co I or: [B!3clCJ 

Position: I Normal I 
Case: I Normoll 

Track: I No track I 

n OK u 
[ Cance l ] 

[options ... ] 

~ 

Type style: 0 Normal [8] Italic 0 Outline 0 Reuerse 
0 Bold 0 Underline 0 Shadow 0 Strikethru 

Figure 5.11 : The Type specifications dialog box 
\1 

.., 

PageMaker also provides several keyboard shortcuts for selecting 
common type styles such as bold and italics, as well as changing the case 
(to all caps, small caps, or back to normal). Table 5.3 summarizes these 
shortcuts. Note that if you're applying a type style to the text as you are 
entering it, you choose the type styles with a keyboard shortcut, type the 
text to be enhanced, and then remember to choose the keyboard shortcut 
again or the Normal type style to turn off the effect. 

Finding Text in a Story 
v 
With theadvent ofPageMaker'sStory Editorcomenewsearch and search 
and replace capabilities. You can use the search feature to locate specific 
text, special characters, or text a ttributes such as font or type styles. To use 
this feature to locate text in a story, get into the Story Editor, then select the 
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Table 5.3: Keyboard Shortcuts for Sizing and Enhancing Type 

ATTRIBUTE OR SIZE 

Bold 

Italic 

Outline 

Shadow 

Underline 

Strikethru 

Superscript 

Subscript 

All caps 

Small caps 

Normal 

Next smaller standard type size 

Next larger standard type size 

One point size smaller 

One point size larger 

KEY COMBINATION 

~ +Shift+B 

~ +Shift+I 

~ +Shift+D 

~ +Shift+W 

~+Shift+U 

~ +Shift+/ 

~ +Shift+plus (+) 

~ +Shift+minus (-) 

~+Shift+K 

~ +Shift+H 

~ +Shift+spacebar 

~ +Shift+comma (,) 

~ +Shift+period (.) 

~ +Option+Shift+comma (,) 

~ +Option+Shift+period (.) 

Find option on the Edit menu or press ~+8. When you do, PageMaker w ill 
display the Find dialog box shown in Figure 5.12. 

If you want to locate only text, just begin typing in the word or phrase 
to search for. If you want PageMaker to ma tch the case as you've typed it, 
be sure to click on the Match case check box. If you want to res trict the search 
to complete words so that PageMaker ig nores any occurrences of the 
characters you've entered in other words (such as she in shelf), be sure to 
click on the Whole word ch eck box. 

If text is selected when you select the Find command, PageMaker will 
automatically choose the Selected text radio button, otherwise the Current 
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Note v 
You can use the 
Attributes dialog box 
without entering any 
search text in the Find 
dialog box to have the 
program locate 
occurrences of 
particular attributes, 
including fonts, type 
sizes, type styles, or 
paragraph styles. 

,.. ci; File Edit Options Sto 

time ·1D ·dO·SO. ·F'rom·l\OV·On,-ve .viJl. be ·VOrlting · 
directly. vith. the .PageMake r. program .rather. than .11l.lking . 

about·ii·Can·be .used .. Jf.you.aren' t.at.your-Macin1Dsh.·83· 
you.reod ·this ·Chapter, .you.viJl.h.ave .~o.follov.e.Jong ·in· 
the .text.as-best.you.can,.referring ·ID. the .accompanying. 
figures . -You.should, -hovever, .go .back.over-thi3. 

Find who t: I._M_a_c_i_nt_o_s_h _______ _, 

Options: 0 Match case 0 Whole word 

Search: 0 )t~ll~t:l <~ <l 1eB1 ®Current story 

0 All st or ies 

Figure 5.12: The Find dialog box 
V' 

R Find J 
(Att r ibutes .. J 

story button will be selected. If you wish to have all the stories in the 
publication searched for the text that you have entered, click on the All 
stories button. 

If you want to restrict the search to just the search text that has been 
entered in a particular font, type size, type style, or paragraph style (that 
is, a style applied to the paragraph in which the search text occurs), you 
need to click the Attributes button before beginning the search. Doing this 
brings up the Attributes dialog box shown in Figure 5.13. 

As you can see in this figure, the Attributes box contains four pop-up 
menus: Para style (for paragraph style), Font, Size, and Type style. By default, 
all four of these attributes are set to Any. I£ you wish to restrict the search 
to a particular attribute such as a specific type size, you need to click on 
the pop-up menu in question and choose the new setting from among 
those listed, as shown in Figure 5.13. After selecting the desired attributes 



Tip v 
The quickest way to 
locate a subsequent 
occurrence of search 
text in a story is to 
press the Return or 
Enter key to select the 
Find next option. 

Text Preparation and Placement V 187 

r C File Edit Options Sto 

n OK ll Attributes 
Para 

Find: 
Para style: I Any I ( Cancel ) 

Font: 

Size: 

Type style: 

0 St~ h~ r:1 e<l 1 <~ll1 
0 All stories 

Figure 5.13: The Attributes dialog box 
v 

Find n 
(Attributes ... ) 

for the search in this manner, click on the OK button to return to the Find 
dialog box. 

After selecting all of your search options, click on the Find button to have 
PageMaker locate the first occurrence of the search text. The program will 
search from the cursor's location forward in the text of the story. When a 
match exists, PageMaker will s top at the occurrence and highlight it in the 
story window. As soon as the program loca tes the first occurrence, the Find 
button changes to Find next in the Find dialog box. If you wish to have 
PageMaker locate subsequen t occurrences of the search text in the story, 
you click on this button. 

When you are searching the entire story, PageMaker will search from 
the current location of the cursor to the end of the story. If no occurrence 
of the search text has been located, the program will then display a dialog 
box that asks if you want to continue the search from the beginning of the 
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Note v 
Refer to the table on 
the inside back cover 
of the book for infor
mation on how to enter 
other special char
acters that you can 
enter as search text. 

story. Click on the Yes button to have PageMaker search from the begin
ning of the story to the current position of the cursor. IfPageMaker doesn't 
locate any occurrence of your search text, the program will sound the 
warning and display a Search complete dialog box (click the OK button to 
return to the Find dialog box). When you're finished searching the story, 
click on the Close box in the Find dialog box to return to the Story Editor. 

In addition to locating text, text with attributes, or attributes only in a 
story, the Find command can locate the placement of special characters 
such as tabs, carriage returns, em spaces, or en dashes. Table 5.4 shows you 
how to enter the search text to locate the occurrence of sucl1 special 
characters in the story. For example, to locate the next tab in the currrent 
story, you would enter At after the Find what prompt before clicking the Find 
button. 

When entering search text, you can use A? as a wildcard character that 
stands for any single d1aracter (be sure to enter the caret-Shift+6-before 
the question mark). For example, if you enter 

as the search text, PageMaker will locate words such as you, your, yes, and 
yesterday in the story (assuming that the Whole word option is leftund1ecked). 
Note that you must enter A? for each unspecified character in the search 
text (PageMaker provides no global wildcard character). 

Replacing Text in a Story 
v 
To have PageMaker locate and replace text, you select the Change command 
(~+9) on the Edit menu. This brings up a Change dialog box similar to the 
one shown in Figure 5.14. Enter the text you want to replace after the Find 
what prompt and the text you want to replace it with after the Change to 
prompt. 

As when searching for text with the Find command, you can restrict the 
search to complete words (with the Whole word option) or so that it matches 
in case (with the Match case option). You can also confine the search to the 
selected story (with the Current story option) or extend it to include all 
stories in the publication (with the All stories option). 
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Table 5.4: Finding Special Characters with the Find or Change Command 

ENTER: TO LOCATE: 

Ap Carriage return at end of paragraph (Return) 

An End-of-line marker (Shift+ Return) 

At Tab 

Aw Any space or tab 

As Nonbreaking space 

A< Thin space 

A> En space 

Am Em space 

A= En dash (-) 

A_ Em dash (-) 

A_ Optional hyphen (Option+hyphen) 

A_ Nonbreaking hyphen (hyphen alone) 

Ac Program-generated hypen 

AA Caret 

A? Unspecified (wildcard) character 

? Question mark 

Option+G Copyright symbol (©) 

Option+2 Trademark symbol (TM) 

Option+R Registered trademark symbol (®) 

If you wish to specify attributes to locate in the search text or attributes 
to change to in the change text, click the Attributes button. Figure5.15 shows 
you the Attributes dialog box available from the Change dialog box. Notice 
that this dialog box contains pop-up menus that allow you to specify not 
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Tip v 
Use the Find and 
Change options in the 
Attributes dialog box 
along with the Change 
all option in the 
Change dialog box to 
replace all occur
rences of a particular 
attribute with another 
throughout an entire 
story (check the All 
stories check box to 
change it throughout 
the entire publication). 

s File Edit Options St 

Para 

on, nov i.:l1he time 10 do 30 . Prom nov 
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Find Wh6t: I:::M=6=C::=in=t=o=sh========:l n Find neHt B 
Ch~tnge to: I M~tq I ( Ch~tnge 
Options: 0 M~ttch case 0 Whole word [:=====~] 

Change & find!\-
search: 0 ~~~ ~ ~~ 1:1ed 1 c~ 1 11 ®Current story ( Ch~tnge 611 J 

0 All stories 

Figure 5.14: The Change dialog box 
v 

( Attributes ... ) 

only which a ttributes to search for in the text, but also new attributes that 
PageMaker should apply to it. 

The Find and Change options on the Attributes dialog box make the Change 
command in PageMaker versa tile. It means that you can use it to change 
a particular font, type size, type style, or paragraph style throughou t a 
story. For example, you could use it to change all12-point Times Italic text 
in a story to 14-point Helvetica Bold by selecting Times as the Font 12 as 
the Size, and Italic as the Type style under Find, and selecting Helvetica as the 
Font, 14 as the Size, and Bold as the Type style under Change in the Attributes 
dialog box. 

After you have specified the search and replace text and attributes and 
selected the appropriate search options, click on the Find button (or press 
Return) in the Change dialog box to begin the search. When PageMaker 
locates the first occurrence of the search text (or attributes) in the story, the 
Find button changes to Find next, and the Change, Change & find, and Change 
all buttons become active. Click the Change button to replace the text 
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,.. a File Edit Options St 
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Type style: I Any I 

n OK ll 
( Cancel ) 

Figure 5.15: The Attributes dialog box available from the Change dialog box 
v 
(or attribute) that PageMaker has located (and highlighted). Click the 
Change & find button to replace the current occurrence and look for the next. 
Or, click Change all to have the program replace all remaining occurrences 
in the story without requiring your approval. 

Note that you can click the Change all button instead of the Find button 
at the outset of a search and replace operation to perfonn a global search 
and replace throughout a story. Before using this option, however, you 
should make sure that you have entered your search and replace text (or 
attributes) exactly as you intended. Otherwise, you could end up with 
unwelcome replacements throughout your story or publication. 

Spell-Checking a Story 
v 
PageMaker 4.0 now supports spell-checking in the Story Editor. You can 
use this feature to ensure that the s tories you create with the Story Editor 
or import from word processed documents are free from typographical 
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errors. To use the spelling checker, you need to select the Spelling option on 
the Edit menu(~+ L) in the Story Editor. When you do, a Spelling dialog box 
like the one shown in Figure 5.16 appears on the screen. 

As with the Find and Change commands, when using the Spelling com
mand, you can indicate whether PageMaker is to search for misspellings 
in the current s tory only or all stories by clicking on the appropriate radio 
button a t the bottom of the dialog box. If a range of text is highlighted when 
you choose the Spelling command, the Selected text radio button will auto
matically be selected. If this is not the case, the Selected text op tion is 
ghosted and you can only choose between the Current story and All stories 
options. 

To begin spell-checking, you click on the Start button (or press Return or 
Enter). PageMaker will then check the words in the story from the cursor 
position on, matching them against the words in its spelling and hyphen
ation d ictionary. When the program locates a word that isn' t in the 
dictionary, it will highlight it in the story and display it after the Change to 

r s File Edit Options St 

vindov contains nro area.5: a 

the l!ft that 3hoV3 the name' of the 3tyl.e3 

(if e.ny) wed ttl foiTI\At the text e.nd e.n 
area ttl th! right that con 1alns the actual 

Unknown word : sidebar n Ignore D 

Change to: I sidebar I (Replace J 

~s=id=e=b=o=ar=d======:;:Q~ ( Add ... ~ 
sideband 

Figure 5.1 6: The Spelling dialog box 
v 

., 



Note v 
When you use the 
Ignore option to 
bypass an unknown 
word without adding it 
to the dictionary, 
PageMaker stops at 
each subsequent 
occurrence of the 
term in the story. 
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prompt along with potential alternatives to the u nknown word in the 
scroll box below. To replace the unknown word with one of the words in 
the dictionary, click on the word to place it in the Change to box, and then 
click the Replace button (or press Return or Enter) to insert it in the story. 
If none of the words from the dictionary are correct replacements, you can 
edit the unknown word in the Change to box and then click the Replace 
button. 

Adding Words to the Dictionary 
v 
If the w1known word flagged by PageMaker is spelled correctly, you can 
either use the Add button to add it to a user dictionary or the Ignore button 
to continue the spell-checking of your story. If you click the Add button, 
PageMaker will display an Add word to user dictionary dialog box similar to 
the one sho·wn in Figure 5.17. 

r • File Edit Options Story Type Windows 
_ MP_M<l__l"h'2 

Add word to user dictionary 
1 

llside--bar Word: 
1 

Dictionary: I US English I 
§0~ Add: 0 As all lowercase 

Unl<:n 
@ EIUlctly as typed 

I Change to: I sidebar 
1 

sideboard IQ 1 sideband 

10 

~R 
Search: 0 Sele( t1~1 ! tt~ut ®Current story 

' <J 2 I 3 I 4 I s I G I 1 I 8 I 9 110 111 112113 I[) lJQ I 

Figure 5.17: The Add word to user dictionary dialog box 
v 

n OK J 
I ( Concel ) 

OOOOO .. OOOoOO -OOOO MO"OMo ooo 

(Remoue) 

I (Replace ) 

( Add .. . ) 

0 All stories 

• ., 
I ~ Jld~ 

lti 

0 
IQ 
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Note 
v 
Remember that you 
must click the Manual 
plus dictionary radio 
button in the Hyphen· 
ation dialog box by 
selecting Hyphen· 
ation on the Type 
menu (or pressing 
~+H) in layout mode 
to have PageMaker 
hyphenate words as 
they are entered in 
the dictionary. 

In the Add Word to user dictionary dialog box, PageMaker will attempt to 
hyphenate the word that you want to add to the dictionary. Hyphenation 
breaks are displayed with - (tildes). The program ranks hyphenation 
choices by entering between one and three tildes between syllables: one for 
the highest priority, two for moderate priority, and three for the lowest 
priority. If you wish to reassign the priority given to the hyphenation 
breaks or change where breaks occur, edit the number and position of 
tildes in the word. If you want to prevent PageMaker from ever hyphen
ating the word you are adding to the dictionary, remove all tildes between 
syllables and enter a single tilde at the beginning of the word, as in 

- epode 

You can add the word to a user dictionary associated with any dictio
nary that is installed forPageMaker (see the next section for more informa
tion on obtaining additional dictionaries). By default, PageMaker adds the 
word to the user dictionary associated with the US English dictionary that 
is installed aulomatically as part of the PageMaker installation process. If 
you have installed other dictionaries, you can add your word to one of 
their user dictionaries by clicking on the Dictionary option and then se
lecting the name of the dictionary to use from the pop-up menu. 

The Add word to user dictionary dialog box contains two options indicating 
what case should be used whenaddingtheword to the selected dictionary. 
By default, the Exactly as typed radio button is selected. If you wish to have 
PageMa.ker add the word to the dictionary in all lowercase letters (assuming 
that it hasn't been entered that way), you need to click on the As all lowercase 
button. After selecting the desired options, you add the word to the 
dictionary by clicking on the OK button (or pressing Return or Enter). 

To remove a word that you've entered in the user dictionary (you can't 
remove words entered in the main dictionary), you type the word in the 
Word box and click the Remove button. 

Purchasing Additional Dictionaries 
v 
Aldus Corporation offers several specialized dictionaries tha t you can 
purchase separately and use with PageMaker's spelling checker. These 



Note v 
Because the 
Dictionary pop-up 
menu is located on 
the Paragraph speci
fications dialog box, 
you can create 
paragraph styles that 
use different diction
aries to spell-check 
and hyphenate 
different types of 
paragraphs. For 
example, you could 
create a Deutsch 
paragraph style that 
uses the Deutsch 
dictionary and then 
apply it to all German 
paragraphs in the 
publication. 
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dictionary sets include: 

• American English: American English technical dictionary with 
Legal Supplement (28,000 legal, accounting, financial, and medi
cal terms related to accident, malpractice, and insurance cases) 
and Medical Supplement (35,000 medical terms and abbrevia
tions used in prescriptions based on Webster's Medical Desk 
Dictionary) 

• British English: British English dictionary plus Legal Supplement 
and Medical Supplement (see above for details) 

• Central European: French, Italian, German, and Dutch dictionaries 

• Scandinavian: Danish, Norwegian, and Swedish dictionaries 

• Spanish & Portuguese: Span.ish, European Portugu ese, and 
Brazilian Portuguese dictionaries 

They are a ll available directly from Aldus Corporation. As with the built
in spelling dictionary, these supplemental dictionaries will not only check 
the spelling of special or foreign terms but will also hyphenate them 
appropriately. 

To use one of these supplemental dictionaries, you must install them on 
the hard disk that contains your PageMaker 4.0 fi les. PageMaker will 
support up to ten installed dictionaries, although using more than one 
spelling and hyphenation dictionary in a single publication will slow 
dov.rn the time it takes PageMaker to spell-check your stories. 

To change dictionaries, you need to select the Paragraph option on the 
Type menu (or press ~+M). This brings up the Paragraph specifications 
dialog box. Clicking on the current Dictionary selection in this dialog box 
causes PageMaker to display a pop-up menu of supplemental dictionar
ies, as shown in Figure 5.18. Only the dictionaries that you have installed 
will be listed in bold (w1avai.lable choices will be ghosted). To select a new 
spelling and hyphenation dictionary to use, simply drag to the dictionary's 
name in this pop-up menu to select it, then select the OK option. 
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Figure 5.18: Changing dictionaries in the Paragraph specifications dialog box 

" 
PLACING TEXT 
IN A PUBLICATION 
v 

ules ... J 
ocing ... J 

To place text from a word processed document into a PageMaker publica
tion for which the program supplies an import filter, you need to use the 
Place option (3€+D) on the File menu in layout view. To bring tex t from a 
word-processed document into the Story Editor, you choose the Import 
option from the Story menu in story view. 

When you select tJ1e Place command in layout view, PageMaker d is
plays a Place document dialog box similar to the one shown in Figure 5.19 
(when you choose the Import command in story view, the program dis
plays an Import to Story Editor dialog box with the same options). You use 
the options in this dialog box to select the name of the document to be 



Note 
Y' 
In the list box, if you 
select a folder or a file 
whose format is not 
supported by Page
Maker {that is, for 
which there is no 
filter), the program 
ghosts all three Place 
options. 

Note 
Y' 
The Place comand in 
layout view is used to 
import graphics as well 
as text into a publica
tion. If you select a 
graphics file, different 
Place options appear 
than are shown in 
Figure 5.19 {see 
Chapter 6 for more 
details). 
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Figure 5.19: The Place document dialog box 
v 

brought into your publica tion and specify how the document should be 
placed. 

In Figure 5.19, you see three options beneath Place: 

• As new story: Use thi s option when the document that you've 
selected is to be placed as a new story in the publication (this 
option is selected by default) . 

• Replacing entire story: Use this option to replace the story that is 
currently selected with the document chosen in the list box. 

• Inserting text: Use this option to add the text of the document 
chosen in the list box to the currently selected story (the text will 
be added at the present position of the cursor or insertion point). 
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If you select a portion of text in a publication before you choose the Place 
option on the File menu, the Inserting text option changes to: 

• Replacing selected text: Use tltis option to replace just the text that 
is currently selected with the document chosen in the list box. 

At the botton-1 of the Place document dialog box, you see three check box 
options, the first two of which are checked by default: 

• Retain format: When checked, PageMaker retains the formatting 
used in the original word processing document. Uncheck this 
option if you wish to use the program's default format settings. 

• Convert quotes: When checked, the program converts paired 
double and single quotation marks and apostrophes used in 
contractions and possessives into open and closed quotation 
marks, as shown in Figure 5.20. Uncheck this option if you d on' t 
want to use the typeset-style quotation marks and apostrophes. 

• Read tags: When checked, PageMaker recognizes the style-name 
tags used in the document and formats text accord ing to the 
corresponding PageMaker styles (see the following section for 
details on style-name tags) . Be sure to check this option if you 
have entered style-name tags in your document with your word 
processor. 

As entered in word processed 
document: 

As ploced in PogeMoker publicotion: 

' My f.uhcr is dcccas'd! Come, Gavcston, '"'My father is dcccas'd! Come. G3vcston, 
And share the kingdom with thy dearest friend. • i\nd share the kingdom with thy dearest friend." 

Figure 5.20: Results of using the Convert quotes option when placing text 
\1 



Manual Text Icon 
v 

m: 
Semiautomatic Text Icon 
v 

ror 
Autoflow Text Icon 
v 
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After you select the appropriate import options in the Place document 
dialog box, click the OK button (or press the Return or Enter key). The 
program then displays a message box indica ting the progress of the 
document's importation into Page Maker. As soon a s all characters of 
the document text are imported, the Pointer will change to one of the Text 
icons (see next section), indicating that the document is fully loaded and 
is ready to flow in the publication. If you decide that you no longer want 
to place the document in the publication and Page Maker is still loading its 
text, click the Cancel button in the Importing message box with the Wrist
watch icon. If you decide tha t you don't want to place the text after all text 
has been imported, click the Text icon on the Pointer in the Toolbox palette 
to abandon the operation. 

Flowing Text 
V' 
PageMaker offers three methods of flowing text in a publication: 

• 

• 

• 

Manual text flow: This method stops a t the bottom of each 
column on the page. To continue text flow to subsequent col
utmls on the same or following page, you must load the Pointer 
again, then click the text icon at the beginning of the new section. 

Semiautomatic text flow: This method stops a t the bottom of each 
column, too. However, unlike the manual method, with semiau
tomatic the Text icon remains loaded, ready to place text at the 
beginning of the next section. To change from the manual to the 
semiautomatic method, hold ·the Shift key before you click the 
mouse. This will change the Pointer to the Semiautomatic text 
icon shown to the left. 

Automatic text flow: This method continues flowing text until all 
of it is placed, adding new pages to the publication as required. 

To change the text flow from manual to automatic, you need to select 
Autoflow on the Options menu before you click the mouse on the page to 
begin flowing the text. Under automatic text flow, PageMaker will auto
matically flow text from column to column on each page, adding whatever 
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Tip 
\1 
To temporarily switch 
back and forth be
tween automatic and 
manual text flow, hold 
down and release the 
~ key before you 
click the mouse. To 
temporarily switch 
between manual and 
semi-automatic text 
flow, hold down and 
release the Shift key. 

pages are needed until all text is placed (or until the maximum publication 
size of 999 pages is reached). The program will flow text aroun d any 
graphic images already placed in the publica tion according to the text
wrap specifica tions you have assigned to each graphic (see Chapter 6 for 
details). 

Note that PageMaker switches from automatic to manual text flow 
when you click the Text icon on the Pasteboard, on master pages, or in the 
middle of a story that has already been placed in the publication. For this 
reason, the automatic text-flow method should be reserved for placing text 
as a new story or placing text at the end of an existing story. It is, however, 
the most efficient way to import text into a publication in either of these 
circumstances. 

To stop automatic text flow before PageMaker has finished placing all 
of the text, click the Cancel button in the Composing text message box tha t 
appears on screen during this operation with the Wristwatch icon. 

Using Manual Text Flow 
v 
You can use manual text flow, the program's default method, when you 
wish to place text on the Pasteboard or on the master pages, or you wish 
to restrict the text flow to the current colmm1. It should also be used when 
you wish to shape a text block so that it doesn't conform to the column 
guides on the page (see "Manually Sizing & Positioning Text Blocks" later 
in the chapter for more information). 

When you use manual text flow, PageMaker flows the text from the 
place on the page where you click the Text icon to the end of the current 
column on the page. If there is more text to be placed in subsequent col
umns, PageMaker indicates this by displaying a downward-pointing 
triangle in the bottom window-shade handle. To place this text, you 
simply click the Pointer on this triangle to reload the Text icon, then click 
the Text icon at the top of the next column. 

If you need to manually place text on the next page, click on the triangle 
at the bottom of the last colunm to load the Text icon, click on the next page 
icon at the bottom of the screen to turn the page, then click the Text icon 
at the top of the fi rst colunm on the new page. 



Tip v 
PageMaker auto
matically lists the 
current page number 
or the numbers of the 
current pair of facing 
pages as those to 
delete in the Remove 
pages dialog box. 
Therefore, to delete a 
particular page or pair 
of facing pages, click 
on their number to turn 
to them before you 
select the Remove 
pages command. 
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Inserting New Pages in the Publication 
v 
If there aren't any more pages in your publication, and you still have 
more text to place, select the Insert pages option on the Page menu, then 
type in the number of pages to be inserted in the document and click the 
OK button in the Insert pages dialog box. By default, the After current page 
radio button will be selected in this dialog box so that PageMaker will 
add the number of pages you specify to the end of the publication. If you 
wish the pages to be inserted before instead of after the current page, click 
the Before current page button before you choose OK If your publication 
uses facing pages, you can also have the new pages inserted between the 
current facing pages by selecting the Between current pages radio button in 
thjs dialog box. 

Deleting Pages from the Publication 
v 
If you ever insert more pages in your publication than you need, either 
when specifying the page setup when you first create the publication or 
with the Insert pages command, you can delete them with the Remove pages 
command on the Page menu. This brings up the Remove pages dialog box. 
Here, you type in the number of the first page to be deleted after the Remove 
page(s) prompt and the number of the last page to removed after through, 
then click the OK button (or press Return or Enter). 

When you select the OK button, PageMaker will display a warning 
dialog box, reminding you that you are about to delete all items on the 
selected page(s). To confirm the removal of these pages and the deletion 
of the items they contain from your publication, you must click the OK 
button (pressing Return or Enter here selects the Cancel button). 

Working with Text Blocks v 
The text that you place on the pages of your publication is often placed in 
separate text blocks. When the text blocks all belong to the same story, they 
are said to be threaded. This means that PageMaker keeps track of the word 
order of the story no matter how many text blocks it is broken into. 
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Note 
\1 
When a text block is 
selected, you can 
resize it or reposition it 
with the mouse, copy it 
to the Clipboard with 
the Cut or Copy com
mand, or delete it with 
the Clear command or 
the Delete key. 

To edit the contents of a text block, you use the Text tool and drag the 
cursor to select the desired text. Selected text is highlighted, and any 
editing command that you then choose is applied to all highlighted text. 

To manipulate a text block, you use the Pointer and click somewhere 
within its contents to select the block. When a text block is selected, 
PageMaker displays text-block handles (solid squares in the four corners 
of the surrounding rectangle) and window-shade handles (at its top and 
bottom). 

To select more than one text block on a page or pair of facing pages, hold 
down the Shift key as you click on the various text blocks. If the selected 
text blocks belong to the same story, PageMaker will indicate this by 
displaying plus ( +) signs in the upper and lower window-shade hand les. 
If a text block belongs to a d ifferent s tory from the others on the page, the 
window-shade handles of its text block remain empty. Figure 5.21 illus
trates this situation. In this figure, five different text blocks are selected in 
the pair of facing pages. Of the five, only two belong to the same story, as 
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Figure 5.21: Selecting multiple text blocks 
\1 
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designated by the pluses a t the top and bottom of their blocks. The other 
three text blocks belong to different stories. 

To deselect all the text blocks that you have selected, you simply click 
the Pointer somewhere on the page beyond their borders or else some
where on the Pasteboard . As soon as you d eselect a text block, the text
block handles and ·window-shad e hand les d isappear. 

Manually Sizing & Positioning Text Blocks 
v 
When placing text in manual or semiau tomatic mode, you ca n contro l 
the sizing and positioning of the text block. To do so, click the Text icon at 
the place on the page where you \Vant the text to begin, and then drag the 
Tex t icon d iagonally until you reach the place on the page where you want 
the text to end . Fina lly, release the mouse. You will obtain the result shown 
in Figure 5.22. 

r • File Edit Op ti ons Page Type Elemen t Wi ndows 
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Figure 5.22: Establishing the boundary for a text block 
v 
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When you establish the boundaries of the text block in this manner, 
you are no longer constrained to the current column settings. If you 
wish, you can have your text span columns by stretching the text-block 
boundary so that it extends beyond the column guides. The right edge of 
the bounding box you establish when you release the mouse button 
becomes the right margin for the text block that you are placing. 

After you have placed a text block, you can resizeitorrepositionit in the 
document. To resize a text block within the column guides, select it with 
the Pointer, then drag the lower window-shade hand le up to reduce its 
size or down to increase it. If you wish to resize a text-block so that it no 
longer conforms to the column guides, click on one of the four text-block 
handles until it changes to a double-headed arrow, then drag the text
block boundary until it is the shape and size you want before releasing the 
mouse button. When you change the size of the block so that text must be 
trimmed from its block, PageMaker automatically reflows the leftover text 
to subsequent threaded text blocks in the publication. 

To move the selected text block to a new place on the page or onto the 
Pasteboard, click on the block until the Pointer changes into a four-headed 
arrow, then drag the block to its new position before releasing the mouse 
button. 

Breaking Up a Block into Smaller Blocks 
v 
When laying out pages in PageMaker, you may find situations that require 
breaking up a text block into several smaller ones. This is often the case 
when you need to place a graphic on the page in such a way that it divides 
a single text block you've already placed. To handle such a situation, you 
simply follow this procedure: 

1. Select the text block that needs to be broken up with the 
Pointer. 

2. Drag the lower window-shade handle up to make the text 
block short enough to accommodate yom graphic image. 

3. Place your graphic image on the page. 
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4. Select the text block you just resized, and click on the down
ward-pointing triangle to reload the Text icon. 

5. Position the Text icon below the newly placed graphic image, 
and click (or click and drag, if you wish) to control the size of 
the new text block. 

Reflowing the Text in a Block 
v 
At times, you may need to reflow the text in a block instead of just resizing 
or repositioning it on the page. For example, you may need to change the 
shape of a block so that it does not overlap a new element placed on the 
page, such as a graphic image or table. 

To reflow a text block, you select the block, then drag the lower window
shade handle all the way up until it touches the upper window-shade 
handle and you no longer see any of the tex t, as shown in Figure 5.23. Then 

Figure 5.23: Preparing to reflow the text in a block 
v 
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you click the lm"rer window-shade hand le with the downward-pointing 
triangle to reload the Text icon. Once the text is reloaded, you can then 
resize and reposition it as described above. 

Combining T ext Blocks 
v 
Just as you can break up the text of a story into several blocks to accommo
date graphics and other elements on the page, you can also combine them. 
To combine separate blocks in the same s tory that are placed on the same 
page or pair of facing pages, you follow this procedure: 

1. Select the last text block in the story with the Pointer. 

2. Drag the lower window-shade handle all the way up until it 
touches the upper window-shade handle and all of the text in 
the block disappears (don't load the Text icon by clicking on the 
downward-pointing triangle). 

3. Click the Pointer anywhere on the page to combine the blocks. 

4. Drag the lower window-shade handle of the newly combined 
text block to make it the size you want. 

5. Click the Pointer somewhere outside of the text block to dese
lect it. 

If you wish to combine text blocks from different s tories in the publica
tion, you must use the Cut and Paste commands on the Edit menu to ac
complish this: 

1. Choose the Text tool from the Toolbox, then click the I-Beam 
cursor somewhere in the text block of the one story that you 
wish to combine with a text block of another s tory. 

2. Choose the Select all option on the Edit menu (a€+ A) to select all 
of the text in the block. 
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3. Choose the Cut option on the Edit menu (3€+X) to remove the text 
of the story. 

4. Click the 1-Beam cursor at the place in the other story where 
you want the text combined. 

5. Choose the Paste option on the Edit menu (3€+ V) to combine the 
text cut from the other story at the cursor's location. 

USING THE 
TABLE EDITOR v 

Tab leo Editor 1 .0 
Table Editor Icon 
v 

The Table Editor is a separate utility designed exclusively for crea ting 
tables for your publications. This program is automatically installed when 
you ins tall PageMaker. To start this program, you will have to quit 
PageMakerun.less you are running your Macintosh u nder Multifindernnd 
your computer has plenty of memory. To start the Table Editor, double
click on the program's icon (shown to the left) in the PngeMaker 4.0 folder. 

The Table Editor makes it easy to create any type of list, schedule, form, 
or table-in other words, any information that needs to be organized into 
columns and rows. With it, you can design tables with maximum impact, 
as the Table Editor gives you control over all aspects of the table, including 
alignmentofheadingsand data in thecolumnsandrows, textwrapineach 
column, and types of borders and shading used . Of course, along with 
these more specialized table fea tures, you can also specify the fonts, type 
sizes, and type specifications for all table textjustasyou do in any standard 
PageMaker publication. 

A table created with the Table Editor can be exported to a PageMaker 
publica tion as either text or a graphic. If you choose to export the table as 
text, you can s till edit its contents. However, a table exported as text loses 
all its graphical aspects such as rules, borders, and shading. If you choose 
to export the table as a graphic image, it re tains all of these graphical 
elements but is no longer subject to editing within PageMaker. If you find 
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Note 
v 
Don't worry about 
specifying the exact 
number of columns 
and rows when setting 
up a new table, as you 
can always add and 
delete columns and 
rows from the table 
later on. 

a mistake in the table, you will have to correct it in the Table Editor and 
then export the table to PageMaker a second time. 

Creating New Tables 
v 
To set up a new table, you choose the New option on the Table Editor's File 
menu (orpress~+N). When you do, the TableEditorwilldisplay the Table 
setup dialog box shown in Figure 5.24. Here, you indica te the number of 
columns and rows that you want in the table (3 is the default for colu mns 
and rows) and the dimensions of the table (6 by 3 inches is the default). In 
addition to the overall table size, you indica te the size of the horizontal and 
vertical gutters, that is, the border space separating each row and column 
in the table (0.1 inch is the d efault fo r bo th gutters) . After you 
specify the number of columns and rows, and the dimensions of the table 
and the gutters, click the OK button (or press Return or Enter) . 

Edit Options Uiew Cell Typ e Lines 

Tabl e se tup 

Number of columns: 

Number o f rows: 

Tabl e si ze :J .__ 6 __ __,1 by ._13 _ _ __,1 inches 

Gutter in inches: 

Figure 5.24: The Table setup dialog box 
v 

Column: I 0 . I :=:===: 
Row: ._I o_._l --' 
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When you specify this in formation, the Table Ed itor displays a new 
table that contains blank cells arranged in a grid with the mm1ber of 
columns and rows you specified and with the dimensions you specified. 
Figure 5.25 shows you the blank table that is created ·when you accept all 
the default setup options. This table contains nine cells arranged in three 
columns and three rows, with the dimensions 6 by 3 inches. 

When working with the Table Editor, only two tools are available: the 
Pointer, used to select cells in the table; and the Text tool, used to enter and 
edit the text of the table. Use the Pointer to select individual ceLls, a range 
of cells, complete columns and rows, or all of the cells in the table. Use the 
Text tool to select specific characters or words, or all of the text that has 
been entered within a particular cell. 

As you can see in Figure 5.25, the Table Editor assigns letters to the 
columns of a table and numbers to the rows of the table (as do most 
spreadsheet programs on the Mac and IBM PC). To select an entire row in 
the table, you simply click the Pointer on its row number. Likewise, to 

r C File Edit Options Uiew Cell Type Lines Shodes 

II 
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II 

Figure 5.25: Blank table ready for text entry 
V' 
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select an entire colwnn in the table, you click the Pointer on its column 
letter. If you wish to select the entire table, you click on the square in the 
upper left of the table formed by the intersection of the column containing 
the table's row numbers and the row containing the table's column letters. 

The column and row indicators in the table are referred to as grid labels. 
If you want to view your table without the grid labels, select Grid labels on 
the Options menu (~+8) to uncheck the option. Note, however, that the 
only way to select cells when the grid labels are hidden is by dragging 
the Pointer over them-you can no longer select entire columns or rows 
or all cells with simple mouse clicks. 

In addition to grid labels, the Table Editor displays the gutter space you 
specified by drawing a border around each cell in the table. If you wish to 
view the ta ble without these lines, you select Grid lines on the Options menu 
(~+9) to w1check this option. When the grid lines are no longer visible, all 
you see are the 1-point rules drawn by default arow1d the entire table as 
a border and between each column and row (Figure 5.26). 

Figure 5.26: Blank table with grid labels and grid lines hidden 
v 



Note 
V' 
Use the Delete option 
on the Cell menu to 
delete entire columns 
and rows from the 
table. 
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Entering Text in the Table 
v 
To enter text in your table, you select the Text tool from the Toolbox, then 
click the 1-Beam cursor in the cell where your text is to appear and begin 
typing. As you type, text wiU automatically wrap as soon as you reach the 
right margin of the cell. If you wish to start a new line before text wrap 
occurs, press Shift+ Return (Return moves the cursor to the next row down, 
not the next line down). To move the cursor to the next column to the right, 
press the Tab key. To move it to the previous column to the left, press 
Shift+ Tab. If you wish to move the cursor quickly to a particular cell in the 
table to enter tex t, simply click the 1-Beam cursor somewhere in it. 

To correct typographical errors in the table, you u se the same editing 
techniques as you d o when editing text in PageMaker'sStoryEditororany 
other Macintosh word processor. Remember that the Select all command 
on the Edit menu (~+A) is the quickest way to select all of the text in the 
cell that contains the cursor. 

Deleting Text from the Table 
v 
To delete text from a single cell, simp! y select it with the Text tool and press 
the Delete key. To dele te all the text from several cells, you need to select 
them with the Pointer and then press the Delete key. When you do, the 
Table Editor will display the Clear dialog box shown in Figure 5.27. Notice 
that the All option is selected by default. If you click the OK button with this 
option selected, the Table Editor will remove not only all of the text in the 
selected cells, but also all lines and any shading applied to them. To 
remove only the text from the selected cells, leaving the lines and shading 
as is, you need to click the Text check box before choosing OK. If you wish 
to remove all border lines that you've applied to the selected cells, choose 
the Lines check box. To remove all shading from the cells, dick the Shades 
check box. 

Formatting the Text of the Table 
v 
You can use the Type menu options or the Type specifications dialog box(~+ T) 
just as you would in PageMaker to select the font, type size, leading, and 
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r- c File Edit Options Uiew Cell Type Lines Shades 
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Clear the following from the 
current selection: 
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Figure 5.27: The Clear dialog box 
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typestyles for the textthatyou enter in your table. You can also specify 
the alignment for the text using the· Alignment option on the Type menu. 
However, milike the Alignment option on the PageMaker Type menu, the 
one on the Table Editor Type menu includes options for not only aligning 
the text horizontally within the column (left, Center, and Right) but also 
vertically within the row (Top, Middle, and Bottom). 

To apply these type attributes, use the Pointer to select all of the cells to 
which they are to be applied, then choose the appropriate option on 
the Type menu. If no table cells are selected when you choose one of the 
options, the ath·ibute is applied to the text that you next enter in the table. 

Calculating Totals in a Table 
v 
If your table contains numbers, you can format them so that they are 
displayed the same in all their cells. Further, if the table requires, you can 
have theTa ble Editor sum the numbers in the cells that you've selected and 
place the total in the cell of your choice. 



Note 
\7 
Formatting numbers in 
cells with a number 
format has no effect 
on their alignment in 
the table. If you want 
the decimal points 
aligned, you still need 
to select Right as the 
Alignment option on 
the Type menu. 

Warning 
\7 
If the cells you se
lected don't contain 
any numbers, the 
Table Editor will 
sound a warning and 
display the warning 
dialog box. 
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To apply a format to a range of cells, select them and then choose the 
Number format option on the Cell menu (~+F). This brings up the Number 
format dialog box, shown in Figure 5.28. This dialog box contains njne 
different number formats from which you can choose (the 0% and 0.00% 
options are not visible in the scroll box in this figure). Note that General is 
the default format used for all the numbers you enter in a new table. 

To select a format, click on it and then click the OK button. The Table 
Editor will then apply the chosen format to all of the selected cells that 
contain numbers (any cells with text are ignored). 

To sum a range of numbers across columns or down rows, you first need 
to select the cells with the Pointer. Then, select the Sum option on the Cell 
menu(~+=). The Pointer will change to a new icon similar to the Manual 
text icon, except that it contains a plus sign (see cell C6 in Figure 5.29). To 
have the Table Editor swn the numbers jn the selected cells, click this icon 
in the cell where you want the new total to appear (Figure 5.30). 

,. a File Edit Options Vie w pe Lines Shodes 

_N_um_b_er_f_o_r_m_o_t ------ n OK l 
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Figure 5.28: The Number format dialog box 
v 
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3 l&uer Bodoni 175.001 

4 1rrc Bookman 225.001 
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Figure 5.29: Indicating the range of numbers to total 
\1 

Editing Tables 
V' 

$195.001 

$165.001 

The Table Editor not only makes it easy to set up tables, but also to make 
any needed editing changes to them. These changes can include resiz
ing the columns and rows, adding and deleting rows and columns, 
changing the type of rules drawn around the table or between the columns 
and rows, and varying the amount of shading applied to various parts of 
the table. 

Resizing Columns and Rows 
V' 
You can always change the size of the columns and rows in your table to 
suit its contents. The easiest way to change the width of a column or row 
is to position the Pointer in the grid labels area on the border between the 
columns or rows to be adjusted. When the Pointer changes to a double
headed arrow, you drag the border left or right, up or down, as needed. As 
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Figure 5.30: Table with calculated total 
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soon as you release the mouse button to set the new column width, the 
program reflows the text in the cell to fit its new size. 

When you change the width of a column in the table in this manner, the 
Table Editor automa tically adjusts the width of an adjacent colunm as 
needed to maintain the original table width you specified when setting up 
the table. In other words, if you drag the border between columns Band 
C to the left to decrease the width of column B from 2 inches to 1.5 inches, 
the program will automatically increase the width of column C to 2.5 
inches to maintain the original table width. If you prefer to have the ,.vidth 
of the table adjusted rather than that of a nearby colunm, you must 
remember to hold down the Option key as you drag the column border. 

You can also change the height of a row by dragging its border line up 
or down. When you adjust the height of a row by dragging its border, the 
Table Editor does not adjus t the height of adjacent rows to maintain a 
constant table height. Instead, it increases or decreases the overall table 
height to suit the change made to the row. Thus, if you drag the border 
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Tip 
V' 
You cannot use the 
Insert command to 
add new columns or 
rows at the end of a 
table. To do this, you 
must insert new 
columns or rows 
before the last column 
or row, and then use 
the Cut and Paste 
commands to move 
existing text up or in. 

Warning 
V' 
The Undo command 
on the Edit menu 
(~+Z) will not restore 
rows or columns 
deleted from the table. 

between rows 1 and 2 up, to decrease row 1' s height from 1 inch to one-half 
inch, the program reduces the overall height of the table by a half inch, 
leaving all other rows at their original height. 

If you need to change the size of several neighboring columns and rows 
equally, it is more efficient to use the Column width (~+M) and Row height 
(~+H) commands located on the Cell menu than to drag the cell border as 
described earlier. Select the range of colunms or rows before choosing the 
appropriate command, then enter the new width or height in the dialog 
box, and click the OK button. Note that when resizing several colmm1 
widths with the Column width command, the program does not attempt to 
adjust adjacent column widths to n1aintain the original table ·width, as is 
the case when dragging the column border. 

Inserting and Deleting Columns and Rows 
v 
If you find that your table doesn't have sufficient columns and rows, you 
can easily insert as many new ones as you need. Likewise, if you later find 
that the table contains more columns or rows that you can use, you can 
quickly delete them. 

To insert new columns or rows in a table, select the cell \•vith the Pointer 
or the Text toot indicating where you want the new columns or rows 
inserted. Then, select the Insert command on the Cell menu(~+ I). This brings 
up a dialog box where you enter the number of columns or rows to be 
added. By default, the Row radio button is selected. If you wish to insert 
new columns instead of rows, be sure to click the Column button before 
you click OK If you're adding columns to the table, the program will in
sert them to the left of the selected cell. If you're adding rows, these are 
inserted above the selected cell. 

To delete rows or columns from the table, you need to select the range 
of cells that spans the rows or columns you wish removed, then choose the 
Delete command on the Cell menu (~+K). Like the Insert dialog box, this 
dialog box has radio buttons that enable you to choose between Row and 
Column options. Be sure that the correct button is selected before you click 
the OK button to complete the deletion. 



Warning 
\1 
If you have already 
entered text in the 
cells that you're 
joining, the program 
will wipe out all entries 
except for the one 
made in the leftmost 
cell when combining 
columns, or the 
topmost cell when 
combining rows. To 
bring back all of your 
entries, use the Un
group option on the 
Cell menu (~+U). 

Tip 
\1 
To make it easier to 
see the changes you 
make to the lines of 
your table, hide the 
grid lines (~+9). 

Joining Cells 
\7 
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Many times, your tables will have titles and headings that span more than 
one column in the table. For example, notice how the title in the table 
shown in Figure 5.30 is centered in the table. To do this, the cells in columns 
A, B, and C of row 1 were first combined into one. Then, the title was 
entered and the alignment for the new cell was changed to centered. 

To join table cells in this v.ray, you use the Group command on the Cell 
menu (~+G). Before you choose this command, select all of the cells that 
should be combined into one. Once the cells have been joined into one, you 
can enter your text and then select the appropria te Alignment option from 
the Type menu. Note that you can also use the Group command to combine 
cells that span several rows into one. If you ever find that you have joined 
cells in error, select the Ungroup option on the Cell menu (~+U) to return 
them to their original configuration. 

Changing Borders and Shading Cells 
\7 
By default, all of the cells in your new table are bordered with 1-point rules, 
and none of the cells are shaded. If you wish, you can change the type and 
thickness of lines that border various parts of the table or apply shading 
to some or all of the cells. For example, you might wish to create a three
d imensional effect for your table by adding a very thick rule to the right 
and bottom sides of the table. And you might want to shade the rows 
containing the table's title and the column headings. In some tables, you 
may even want to remove all internal borders between columns and rows, 
leaving only an outside border for the table itself. In others, you might 
want to dispense with inside and outside border lines en tirely. 

To apply different shading patterns to parts of the table, you simply 
select the cells you want shaded and then choose the desired shading 
pattern from the Shades menu. To change border styles, you first need to 
ind icate which borders are to be affected by selecting the Borders command 
on the Cell menu (~+B). Choosing this command brings up the Borders 
dialog box, shown in Figure 5.31. 

When you first see it, all Perimeter and Interior check boxes on this dialog 
box are selected as shown in Figure 5.31. This means that any new selection 
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Apply neHt line style to: 
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In terior: 181 Horizontals 

181 1Jerticals 
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Figure 5.31: The Borders dialog box 
v 

185.00 

Total 

$1b5 .00 

$515.00 

made on the Lines menu will be applied to all borders of the cells selected 
in the table. To apply new line types or thicknesses to just certain borders 
of these cells, you need to deselect some of these options. For example, to 
add a 6-point rule to the border of the entire table, you need to deselect 
Horizontals and Verticals in the Borders dialog box, then select all of the cells 
in the table, before you select the 6 pt option on the Lines menu. If, how
ever, you wished to have a 6-point rule just around a particular cell of the 
table, you would follow exactly the same sequence of steps, only this time 
you would select just the single cell to be changed instead of a ll cells in 
the table. 

Figure 5.32 shows you a table after shading has been applied to some of 
the cells and various borders have been modified. To place a 6-point rule 
on the right and bottom side of the table, all cells of the table were selected 
before choosing the 6 pt option on the Lines menu. To draw the horizontal 
2-point rules between the table title and the column headings, only the 
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Horizontals option in the Borders dialog box was checked. The three col
umns of the table were then selected with the Pointer before choosing the 
2 pt option on the Lines menu. To draw the 2-point vertical rule between 
the second and third colwnns below the row containing the title of the 
table, this tin1e just the Verticals option in the Borders dialog box was left 
checked. Then, the cells in the second and third columns from the second 
through the last row were selected with the Pointer before choosing once 
again the 2 pt option from the Lines menu. 

The 10% shade was applied to the cells in the table simply by selecting 
them with the Pointer before choosing the 10% option on the Shades menu. 

Exporting Tables to PageMaker 
v 
Use the Save or Save As command on the File menu to save your table as 
your work progresses. When your table is complete, you need to select the 

-0 

&uerBodoni 175.00 
-

lTC Bookman 225.00 

Broadway 185 .00 -

Figure 5.32: Table with shading and various types of rules 
v 

$155.00 

$195.00 
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Note v 
Some programs, such 
as Aldus Freehand 
and Persuasion, allow 
you to ungroup and 
edit parts of a graphic 
saved in the PICT file 
format. 

Export option from the File menu. This brings up an Export to file dialog box, 
like the one shown in Figure 5.33. 

If you want to retain a copy of the table that can still be edited in the Table 
Editor, be sure to rename the table in this dialog box. For example, if you 
saved the table with the name April Sale(Fig 1-1), youmight exportit under 
the name Figure 1-1 (Apr Sale). The April Sale (Fig 1-1) document can always 
be edited in the Table Editor. The Figure 1-1 (Apr Sale) exported document 
can be placed in your PageMaker publication. 

By default, the PICT file format and Entire table options are selected. This 
means that the table \•vill be exported to the new file as a graphic image. 
Therefore, it will retain all of its graphics characters but ca1mot be edited 
in PageMaker. 

If you would rather retain the ability to edit the contents of the table, 
select the Text only (Tab delimited) option before clicking the OK button to 
create the new fil e. With this option in effect, all text entered into different 
columns of the table will be separated by tabs when the table is imported 
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into PageMaker. Although this does allow you to edit its contents, you 
may have to ad just the tab settings in your publication to accommodate the 
entries once the table is imported . 

To import a table into your PageMaker publication, you use the Place 
command on the File menu, just as you do to import any document or 
graphic created in another program. The options available when placing 
your table depend upon whether you exported it as a Text only or PICT file. 
If you chose Text only, the table can be placed as a new story, replace the 
selected story, or replace selected text. If you chose PICT, the table can be 
placed as an independent graphic, as an in line graphic, or as a replacemen t 
for a selected graphic (see Chapter 6 for more information on placing 
graphics). 

You can also transfer a table or selected parts of the table from the Table 
Editor to a PageMaker publication through the Clipboard. To do this, 
select all of the cells that you wish to use, then select the Copy command on 
the Edit menu (~+C). Quit the Table Editor, then start PageMaker and 
open the desired publication. Go to the place in the publication where you 
want the table information to appear, then select the Paste option from the 
PageMaker Edit menu (~+V) and use the Pointer to drag the table to its 
final position on the page. 

ESSENTIAL 
TECHNIQUES 
v 
To Import a 
Document 
into Your 
Publication as 
a New Story 1. Select the Place command on the File menu (~+D). 

2. Choose the name of the document you wish to bring into your 
publication in the list box of the Place document dialog box. 
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To Import a 
Document 
into Your 
Publication as 
a Replacement 

3. Make sure that the As new story radio button is selected. Check or 
uncheck the appropriate options (if the document contains 
style-name tags, be sure to select Read tags), then click the OK 
button. 

4. When the Text icon is loaded, position it at the appropriate 
place in the publication, and click the mouse to begin flowing 
the text. 

Story 1. Use the Pointer to click on a text block that contains the story 
you wish to replace. 

To Insert the 
Text of a 
Document 
into an 

2. Select the Place command on the File menu (:J€+D). 

3. Choose the name of the document you wish to bring into your 
publication in the list box of the Place document dialog box. 

4. Click the Replacing entire story radio button. Check or uncheck the 
appropriate options, then click the OK button. 

Existing Story 1. Choose the Text tool, then click the 1-Beam cursor at the exact 
place in the text block where you want the imported text to be 
inserted. 

2. Select the Place command on the File menu (:J€+D). 



To Place the 
Text of a 
Story Pre
pared in the 
Story Editor 

To Import a 
Story Saved 
in Another 
PageMaker 
Publication 
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3. Choose the name of the document you wish to bring into your 
publication in the list box of the Place document dialog box. 

4. Click the Inserting text radio button. Check or uncheck the appro
priate options, then click the OK button. 

1. Select the Place command on the File menu (3€+0), or click on the 
Close box in the story window and select the Place option in 
the warning message box. 

2. When the Text tool is loaded, position it in the appropriate 
place in the publication and click the mouse button. 

1. Select the Place command on the File menu (3€+0). 

2. Choose the name of the PageMaker publication that contains 
the story (or stories) you wish to import into your publication 
in the list box of the Place document dialog box. 

3. In the PageMaker 4.0 Story Importer dialog box, click on the name of 
the story you wish to import. If you want to import several 
stories, hold down the Shift key as you click on their names. To 
import all of the stories in the publication, click the Select all 
button. 

4. Once you've finished selecting your stories, click on the OK 
button. When the Text icon is loaded, position it at the appro
priate place in the publication and click the mouse to begin 
flowing the text. 



USING 
GRAPHICS 

EFFECTIVELY 
v 
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You will probably create few publications with PageMaker that rely 
entirely on type to carry your message and use no graphic elements 
whatsoever. In fact, because PageMaker allows you to mix type and 
illustrations freely in the publications you design, as you continue to work 
with the program, you will probably come to rely on graphic images as a 
means of helping you quickly and effectively communicate with your 
audience. 

In this chapter, you will learn how you can enhance your PageMaker 
publications through the use of graphics. We start by looking at the types 
of graphks supported by the program and the ways that you can bring 
them in and place them in your publication. Next, we examine techniques 
for manipulating graphics within PageMaker. As part of this, we will 
cover some specialized techniques for combining type and graphics for 
maximum effect. 

GRAPHICS 
FUNDAMENTALS 
v 

ll5 
Paint-type Graphics 
Icon 
v 

PageMaker can import the various types of graphics supported by the 
Macintosh either as i11depende11t graphics or as inline graphics. As the name 
implies, an independent graphic is one that remains separate from sur
rounding text. As a result, once placed on the page, it does not move when 
the program reflows surrounding text. Just the opposite is true with an 
inline graphic: such a graphic is embedded in a particular paragraph of 
text, and it remains a ttached to its paragraph and moves with it whenever 
the program reflows the text on the page. 

You can import four types of graphics into your PageMaker publica
tions. Each type is saved its own special file format and displays a different 
placement icon when you import one of its files into your publication: 

• Pnint-type or bitmnpped graphics: This type of graphic is created 
by programs such as MacPaint or PixelPaint. 
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Draw-type 
Graphics Icon 
v 

EPS Graphics Icon 
v 
[iii 
TIFF Graphics Icon 
v 

• Draw-type or PICT graphics: This type of graphic is also known 
as vector graphics and is created by programs such as MacDraw 
or CricketDraw. 

• Encapsulated PostScript or EPS graphics: This type of graphic is 
created by drawing programs such as Adobe illustrator '88 or 
Aldus Freehand. 

• Black-and-white, grayscale, and color TIFF graphics: This type of 
graphic is created by scanners, video-frame grabber software 
such as Aldus Snapshot, and many screen snapshot programs. 
TIFF stands for Tagged Image File Format. 

If the graphics program you are using doesn't save files in one of these 
file formats, you should investigate if it's possible to use the program's 
Save as or Export option on the File menu to save a copy in one of these 
formats. If you cannot convert your graphics file, you can import the image 
by copying it to the Clipboard or Scrapbook, then opening your PageMaker 
publica tion and pasting it on the appropriate page. 

Bitmapped Graphics Files v 
Bitmapped graphics all have a resolution of 72 dots per inch, matching the 
resolution of the Macintosh screen. When placing a bitmapped graphic in 
your publication, you can scale it to match the resolution of your printer. To 
do this, you hold down the~ key as you drag one of the corner handles. Be 
aware that when printed with higher-resolution printers such as laser printers 
or imagesetters, curves in bihnapped graphics often display jagged edges. 

Figure 6.1 shows a sample bitmapped graphic printed on a LaserWriter 
II/NTX at a resolution of300 dots per inch. Even a t this resolution, you can 
see some jagged edges il1 the pie plate and quite a few in the text. 

PICT Graphics Files v 
Because draw-type or vector graphics are described mathematically, they 
can be scaled in PageMaker with no loss of resolution. The Macintosh uses 
two PICT formats: PICT and PICT2. PICT 2 represents an enhanced PICT 
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Twin Peaks 
A Cherry Pie A 

Figure 6.1: Bitmapped graphic printed on a LaserWriter 
\j 

format that can support color. The Macintosh Plus and SE save d raw-type 
graphics in PICT files only. The Macintosh SE/30 and Mac II models can 
save draw-type graphics in either PICT or PICT2 files, depending upon the 
capabilities of your graphics software. 

Figure 6.2 shows you a PICT sample graphic that comes with MacPaint ll 
printed on a LaserWriter II/NTX. The size of this graphic image was 
reducedinPageMaker so that it would fit properly on the page. Draw-type 
graphics are easy to resize, as changing the size of the image does not 
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C\ 

Figure 6.2: PICT sample graphic printed on a LaserWriter 
\1 

impair its resolution when you print it. 

Encapsulated PostScript Graphic Files 
v 

DINING 
ROOM 

An Encapsulated PostScript (or EPS) graphic file usually consists of two 
parts: an optional PICT or bitmapped graphic that shows how the image 
looks on the screen, and the PostScript programming code that describes 
how to print the image. If you place an EPS file that doesn't contain the 



Note v 
Save your graphics in 
EPS files if you plan to 
use a process color 
program such as Aldus 
Preprint to produce 
color separations (see 
Chapter 9). 
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optional PICT or bitmapped graphic, PageMaker will simply display a box 
on the screen when you place the file. Although you won't be able to view 
the graphic image in the publication, it will still print correctly when sent 
to a PostScript-compatible laser printer or imagesetter . 

Figure 6.3 shows an EPS image from the ClickArt EPS collection by 

Figure 6.3: EPS graphic printed on a LaserWriter 
v 
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T /Maker as printed on a LaserWriter. Notice how this image usesshading 
to give it a three-dimensional feel. 

TIFF Graphics Files 
\1 
Most TIFF graphics files ewe crea ted with scanners that digilize line art and 
photographs so tha t they can be included in your publica tions. When 
scanning black-and-white line art, you should select line art as the image 
type. When scanning photographs and other images that contain multiple 
shades of gray, you can choose between halftone and grayscale as the 
image type. A halftone simula tes shades of gray by converting the image 
to a pattern of black-and-white dots. A grayscale image saves various 
parts of the image in d ifferent shades of gray. Most scanners support at 
least 16 levels of gray, and some support up to 256 levels of gray. The more 
levels of gray, the finer the gradations possible in the digitized image nnd 
the larger the resulting T[FF fil e. Color scanners can save color art and 
photographs in either a color TIFF or grayscale file. 

Figure 6.4 shows a sample of line art from the Quick Art collection 
available from Wayzata Technology, saved in the TIFF forma t. Figure 6.5 
shows a sample of a TIFF fil e crea ted by scamting a black-and-white 
photograph with the Hewlett-Packard ScanJet Plus scanner. 

When given a choice between scanning a photograph as a halftone or a 
grayscale image, you will usually want to choose grayscale, as this will 
give you a finer image with more detail. Figures 6.6 and 6.7 illustrate this 
point. Here, identical black-and-white photographs were scanned wi th 
the HP ScanJet Plus (a black-and-white scanner supporting up to 256 
shades of gray). The first image, shown in Figure 6.6, was scanned as a 
halftone (using the Scan}et's Diffusion image setting). The second image, 
shown in Figure 6.7, was scanned as a 256-grayscale image. 

As you notice in"'mediately, the grayscale version in Figure 6.7 shows 
much more detail than the halftone in Figure6.6. The halftone has a grainy 
and blurry appearance not evident in the grayscale version. A lot of detail is 
lost when the various gray levels in the original photograph are converted to 
black-and-white dots in the halftone. 
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Figure 6.4: TIFF fi le from line art printed on a LaserWriter 
v 

(}o 

Saving scanned images as grayscale TIFF files allows you to adjust their 
contrast and brightness with PageMaker' s Image control command (see next 
section). Grayscale TIFF files a lso create fairly large graphics files, how
ever. For example, Lh e TIFF file saved as a halftone in Figure 6.6 takes up 
47K on the disk, whereas the 256-grayscale version in Figure 6.7 takes 
up 366K (almost eight times as big as the halftone version). 

Grayscale scanned images are not the only type of TIFF graphics tha t 
take up a lot of disk space. Images created w ith paint programs tha t save 
their fil es in TIFF format can also be very large (especially those tha t u se 
color). To help you work with large TIFF files, PageMaker lets you make 
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Figure 6.5: TIFF file from scanned photograph printed on a LaserWriter 
v 

compressed copies of them for your publications (see "Compressing TTFF 
Images" for details on how to do thls). 

Editing TIFF Images · 
v 
The Image control command on the Element menu allows you to adjust the 
appearanceofTIFF Lmages tha t you import into your publication. You can 
use it to modify the lightness or darkness of the image, heighten or lower 
the contrast, or alter the screen pattern used in printing it. You firs t select 
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Figure 6.6: Black-and-white photograph scanned as halftone 
v 

Figure 6.7: Black-and-white photograph scanned as 256-grayscale image 
v 
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the imported TIFF image you wish to enl1ance, then choose this option, 
and the Image control dialog box shown in Figure 6.8 appears on the screen. 

Besides using the Image control command to modify the contrast or 
lightness of a TIFF image, you can also use it to create special effects when 
working with a grayscale black-and-white image (the options have no 
effect on color TIFF images). To understand how this is done, it is helpfu l 
to understand something of the halftoning process used by PageMaker to 
screen the grayscale image so that it can be printed on PostScript laser 
printers. In this process, the program overlays the image with a uniform 
square grid or screen that is made up of smaller areas called halftone cells. 
Each halftone cell is made up of several pixels, which can be either off or 
on. When a pixel is on, the printer prints it as a black dot. It is the pattern 
and density of dots that creates the various levels of gray in the printout. 

The number of halftone cells per inch is referred to as the frequency of the 
screen. In the Image control dialog box, you can modify the frequency by 
using the Lines/in option. The number of d egrees by ,.vhich the screen is 

0 Block ond white 
@Screened Q lirlll.f 

0 Screen.~ 
~ Rngle:EJ• 

Lines/In: Unillj • Lightness 

Figure 6.8: The Image control dialog box 
v 
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Note 
v 
Increase the Lines/in 
value to make the 
image appear more 
uniform and even, 
although this will 
reduce the number of 
levels of gray in the 
image. 

Using Graphics Effectively V 235 

rotated in relation to the bottom of the page is referred to as then ngle of the 
screen. As you would expect, you modify this aspect with the Angle option 
in the dialog box. In addition to allowing you to alter the frequency and 
angle of the screen, Page Maker enables you to choose between two types 
of halftone screen patterns: dotted, whereby the halftone cells are turned 
off and on in an evenly spaced radial pallern; or lined, w hereby the 
halftone cells are turned off and on in a linear pattern. 

The first options in the Image control dialog box are Black and white, 
Screened, and Gray. If your TIFF image is black-and-white line art-a 
paint-type TIFF image-the Black-and-white button is automatically se
lected. A black-and-white image contains no gray levels. When this button 
is selected, the Screen, Angle, and Lines/in options are not available and 
appear ghosted in the dialog box, meaning that you can adjust only the 
lightness or contrast of the image. If you wish to see how the image would 
appear when screened, you can manually select the Screened option by 
clicking on its button. 

If you are using one of the Mac II models and have a color monitor or a 
black-and-v,rhite monitor that can display various shades of gray, the Gray 
option is automatically selected. When this button is selected, the Screen, 
Angle, and Lines/in options are a ll unavailable. 

If your image is of the grayscale type, the Screened button is automati
cally selected. When this button is selected, you can modify any of the 
Image control options. The Screen option determines w hether PageMaker 
uses a dot (the d efault) or line screen. To change from a dotted screen 
pattern to a linear screen pattern, you click on the icon containing the diag
onal lines. The Angle option determines the screen angle used, and the 
Lines/in option determines the number of lines per inch. Both these options 
are marked DFLT (for default) . When this is the case, the actual screen 
angle and lines per inch are d etermined by the type of printer you are 
using. Typically, the number of lines is 53 for a LaserWriter and 90 for an 
imagesetter, with an angle of 45 degrees in both cases. If you wish to 
change the angle or frequency value, move the cursor to the appropriate 
box and then type in a new value. 

The bar chart in the middle of the Image control dialog box shows the 
current gray-level patterns applied toyourTIFFimage. To change the gray 
levels, you can modify individual bars on this chart by dragging them up 
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or down, or you can modify the values of all the bars at one time by clicking 
on the up or down arrow over Lightness or Contrast. Click on the up 
Lightness arrow to lighten the entire image and the down arrow to darken 
it. Click on the up Contrast arrow to increase the contrast. 

You can also choose between four predefined gray-level settings for 
your TIFF image simply by clicking on the appropriate icon above the bar 
chart. The first one represents the Normal setting (this one is selected by 
default). Figure 6.7 shows you a printed example using this setting. The 
next icon to the right represents the Negative setting, which creates an 
inverse of the originaJ TIFF image. Figure 6.9 shows the same TIFF image 
as shown in Figure 6.7, printed this time using the Negative setting. The 
third icon represents the Posterized setting. The effect of selecting this 
setting can be seen in Figure 6.10. The fourth icon represents the Solarized 
setting. This effect is seen in Figure 6.11. 

To see how a particular combination of changes affects your TIFF 
image, you can click the Apply button. Remember that you can move the 
dialog box around the screen so that you can better see the effect of your 

Figure 6.9: TIFF image printed using the Negative gray-level setting 
\1 
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Figure 6.10: TIFF image printed using the Posterized gray-level setting 
v 

Figure 6.11 : TIFF image printed using the Solarized gray-level setting 
V' 
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changes on the selected image. When you have finished making your changes, 
click the OK button . If you Ia ter discover that you want to return the image 
to its original condition (as when you imported it), you need to click the 
Reset button. 

Compressing TIFF Images 
V' 
PageMaker enables you to compress the TIFF files you place in your 
publications to save disk space. It offers a choice between two degrees of 
compression: moderate and maximum. You define which level of com
pression to use by the keystroke combination you press when using the 
Place option on the File menu to place the graphic. For example, to com
press a TIFF image a moderate amount, you hold d own the ~+Option 
keys as you click the OK button in the Place document dialog box (be sure 
to keep these keys depressed for at least a couple of seconds after click
ing the button). To compress an image the maximum amount, you hold 
down the ~+Option+Shift keys as you click the OK button. 

When you use either of these methods, PageMaker makes a compressed 
copy of the original TIFF file that you then place in your publication. After 
you have placed the compressed version of your TIFF file, you can d elete 
the original file from your disk to free up space. 

The amount of compression depends upon the amount of information 
stored in the fil e as well as the level you have chosen. For example, the 
original TIFF file of the scanned photograph shown in Figure 6.5 took up 
1138K of file space. The copy made by PageMaker using the maximum 
amount of compression has a fi le size of 277K, representing a reduction to 
about 24% of original size. The original size of the TIFF file of the 
photograph shown in Figure6.7was366K The compressed version (using 
the maximum level again) is 139K, which is almost 38% of the original size. 

To show that a file has been compressed, PageMaker adds letters that 
indicate the level of compression used. For black-and-white line art and 
palette-color TIFF files, the program adds (P) to the end of the file name for 
the modera te level of compression and (L) for the maximum level. For 
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grayscale and color TlFF files of scanned photographs, PageMaker adds (LD) 

for the moderate level of compression and (LD2) for the maximum level. 
Other Macintosh programs, including many graphics programs, can

not use a TIFF file tha t has been com pressed with PageMaker. To create an 
uncompressed copy of a TIFF file for use with other programs, you press 
the~ key as you click on the OK button in the Place dialog box. PageMaker 
will append (U) to the name of the uncompressed copy of the TIFF fil e that 
it creates. You can then use this file with other software that can't read 
PageMaker's compressed TIFF files. Remember that you don' t have to 
place the uncompressed copy of the TIFF image in your publication. Just 
click the TIFF graphics icon on the Pointer in the Toolbox after the copy has 
been made. That way, you can still retain the compressed version in your 
publication. 

IMPORTING GRAPHICS 
v 

You use the same basic procedure to import and place graphic images in 
your publication as you d o to import and place text files. As mentioned 
earlier, when importing graphics, the program differentiates between two 
types: inline and independent graphics. Remember that an inline graphic 
is attached to a particular paragraph of text and remains with that 
paragraph as text is reflowed . An independent graphic, just as the name 
sta tes, is placed separate from all surrounding text and graphics on the 
page and does not move when text is reflowed. With an independent 
graphic, you can control how text flows around the image and the amount 
of space between its borders as surrounding text. With an inline graphic, 
the image is treated like a special type element that can only be track
kerned or for which you can specify new leading. These are the only 
means, however, for controlling the amount of space between an inline 
graphic and its surrounding text. 



240 V Mastering PageMaker 4 on the Macintosh V CH 6 

Note 
V' 
All Options in the 
Place document 
dialog box become 
ghosted whenever you 
select a graphics file in 
the list box. 

Note 
V' 
Remember that you 
can compress a TIFF 
file while importing it. 
For moderate com
pression, press 
3€+0ption when you 
click OK. For max
imum compression , 
press 3€+0ption+Shift 
instead. 

You can import an image as an inline graphic in two ways: 

• In layou t view, select the Text tool from the Toolbox and click the 
!-Beam cursor at the place in the paragraph where you want the 
graphic image to appear. Then choose the Place option on the File 
menu (OO+D) and select the file that contains your graphic (the As 
inline graphic button will automatically be selected in the Place 
document d ialog box). 

• In layout view, select the s tory that is to contain your graphic, 
then get into story view (OO +E or choose Edit story on the Edit 
menu). In story view, move the cursor to the position in the text 
where the graphic is to appear (you can also indicate the place
ment by clicking the insertion pointer with the Text tool before 
entering story view), then choose Import on the Story menu and 
select the file that contains your graphic (the As inline graphic 
button will automatically be selected in the Import to Story Editor 
dialog box, and the As independent graphic button will' b e ghosted ). 

If you use the first method, PageMaker will automatically select the As in line 
graphic button in the Place document dialog box, although you can still place 
the image as an independent graphic simply by clicking the As independent 
graphic button before selecting the OK option. When you use the second 
method, you can' t change your mind and place the image as an indepen
dent graphic, because the As independent graphic button is ghosted. 

If a graphic in1age in the publication is selected when you choose the 
Place command in layout view, PageMaker lets you choose whether to 
replace it with the image you are about to import. To replace the selected 
grnphic, you click the Replacing entire graphic button in the Place document 
dialog box. To add the incoming image to your publication withou t 
replacing the one currently selected, you leave the As independent graphic 
button selected when you click the OK button. 



Note v 
To change an inline 
graphic to an inde· 
pendent graphic, 
select it with the 
Pointer, then choose 
the Cut and Paste 
options on the Edit 
menu. 

Note v 
To change an in de· 
pendent graphic to an 
inline graphic, select it 
with the Pointer, then 
choose the Cut option. 
Select the Text tool, 
click it in the para· 
graph, then choose the 
Paste option. 

Placing Graphics 
V' 
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After you select the graphics file from the list box and select OK in the Place 
document or Import to Story Editor dialog box, PageMaker loads the graphic 
image. You may see an Importing dialog box that keeps you informed of the 
program's progress if the file is large enough. 

If you imported the image as an inUne graphic, PageMaker then places 
it a t the position of the cursor and reflows text as required. If you are in 
s tory view, however, the program displays only a graphics marker tha t 
indicates its relative position in the text. You won't see the graphic image 
itself until you return to layout view. 

If you imported the image as an independent graphic, the Pointer will 
change to one of four graphics icons, representing the particular type of 
graphic you are about to place in tl1e publication (to see these icons, refer 
to "Graphics Fundamentals" a t the beginning of this chapter). You then 
need to place the graphics Pointer a t the position on the page where you 
want the image p laced and click the mouse button. 

Sizing Independent Graphics As You Place Them 
V' 
If you wish to size your graphic image as you p lace it on the page, you can 
do so by positioning the Pointer at the place where the upper left corner of 
the image is to be, and then dragging the Pointer diagonally until you 
reach the place where the lower right corner is to be. PageMaker will then 
size the graphic to fill the square or rectangular boundary that you crea te. 
Note, hm·vever, that when sizing an independent graphic image at the 
same place, you run the risk of d istorting its proportions . If this happens, 
you have to resize the graphic at the same time as you scale it, as described 
later in the section "Resizing and Scaling Graphics." 

Linking Graphics and Text Files 
V' 
PageMaker 4.0 automatically establishes links between the graphics and 
text files for the publication in which you place them. These links allow 
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Tip 
V' 
If you import a 
complete copy of a 
graphic and then 
decide you want to 
store only a low
resolution copy of it, 
choose Links on the 
File menu and click on 
the name of the image. 
Then select the Link 
options button in the 
Links dialog box, and 
click on the Store 
copy in publication 
option in the Link 
options dialog box to 
uncheck it. 

you to make changes to these fi les in the programs with which they were 
created and then have them updated in the PageMaker publication. This 
makes it unnecessary to replace graphics that have changed, as was the 
case with previous versions of the program . 

In the case of large graphic images, you can keep your publication 
smaller by having the program store a low-resolution copy of the imported 
graphic rather than the complete copy normally used. This low-resolution 
copy takes up a fraction of the space of the complete copy. This no t only 
helps reduce the size of the publication, but also increases PageMaker's 
performance. Wh en you prin t the publication, however, the program uses 
the link established between the lmv-resolution copy in the publica tion 
and the original graphics file to automatically print the latest version of the 
graphic image in high resolution. 

Setting Link Options 
V' 
By default, PageMaker stores complete copies of all graphics that you 
import into your publication, meaning tha t they contain all of the infor
mation necessary to display and print them in high resolution. If you wish 
to save space by storing low-resolution copies instead, uncheck the Store 
copy in publication box in the Link options dialog box before you begin plac
ing any of your graphics. To get to the Link options dialog box, you must 
select the Links op tion on the File menu (or press~+=) and then click the 
Link options bu tton. Note that PageMaker allows you to store low-resolu tion 
copies of all types of graphics except for EPS graphics. If the image is stored 
in an EPS file, the Store copy in publication option remains ghosted when you 
open the Link options dialog box, and the program won't allow you to 
remove the check mark from this box . 

Even when the Store copy in publication box is checked in the Link options 
dialog box, the program still alerts you if you are about to p lace a large 
graphic. You can then choose to have a low-resolution copy placed instead 
of a complete copy. If the image you are importing is bigger than 256K, 
PageMaker automatically sounds the alert and then displays a warning 
dialog box. As you can see in Figure 6.12, the warning box indica tes the size 
of the graphic tha t you are about to import. To have the complete image 
brought into your publication, you must click the Yes button. To have a 



Note v 
The Update auto
matically option is 
available only when 
the Store copy in 
publication box is 
checked. Likewise, the 
Alert before updating 
option is available only 
when the Update 
automatically box is 
checked. 
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Options 

6 Document: BARNABY'S MRTCHES256 •. . 

Th e graphic in the document w ould occupy 
279 KBytes in the publicatio n. I nclude 
complete copy in the publ ication anyw ay? 

Yes 

Figure 6.12: Large graphic warning dialog box 
v 

low-resolution copy stored in your publication ins tead, you click the No 
button . 

You can have PageMaker automatically update links between text and 
graphic images that you have placed in your publication, or you can do 
this yourself. You can also have the program alert you when a link needs 
upda ting, meanjng that the external file has been ch anged and the most 
recent form is not yet s tored in the PageMaker publication. 

To set the link options for a particular graphic image or story, you select 
it in layout view, choose Links on the File m enu, and click on the Link options 
button in the Links dia log box (i f you forget to select the graphic in layout 
view, you can always do so in the Links dialog box by clicking on the name 
of its document in the list box). You then see a Unkoptions rualog box similar 
to the one shown in Figure 6.13. To have the updates performed automatic
ally for that link whenever you open the PageMaker publica tion that 
contains it, you check the Update automatically box. If you also want the 
ability to override an automatic update, you should also check the Alert before 
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Tip 
V' 
To change the default 
link options after 
placing a graphic or 
text, select Link 
options on the 
Element menu. 

Options Pege Type Element Windows 

Link options: CG & Greg. tiff(LD2) 

IZ! Store copy in publicetion 
~ Updete automatically 
b Alert before updating 

( Cancel ) Cherry Pie 
Cocktaii.EPS 
Sample Floor Plan 
Sh elties 256 gray 
Sh elties Diffusionl!=:==::;:::;~;:;<========r==;=;=;~ 
Tour ist.TI F Image 

Status: This il•m is up to dal• . 

Figure 6.13: Link options dialog box for single linked element 
v 

4 

updating box in the Link options dialog box. When this option is selected, 
PageMaker sounds the alert and displays an alert box before performing 
the update. You can then prevent the graphic from being up dated by 
clicking the Ignore or Ignore all button instead of the Update or Update all 
button in this dialog box. 

If you want to set the link options for all text and graphics that you 
import into a publica tion, you need to select your settings in the Link op
tions dialog box before you open a new publication or before you import 
any external docwnents or graphics files. When you select Link options on 
the Element menu when this is the case, PageMaker displays the Link op
tions: Defaults dialog box shown in Figm e 6.14. Here, you can set the link 
options for all the text and graphics files that you import into the publi
cation. If you la ter wish to override these new defaults for a particular 
document or graphic image, you can do so by selecting the file name in the 
list box of the Links dialog box before clicking on the Link options button, 
and then choos-ing your new settings in the Link options dialog box. 
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Links 

Document 

Shtus: 

link options: Defaults 

Tent: 
1:8:1 S1 on! < O(HI In pul>lii:il1ion 

0 Update automatically 
0 llll~r t IH~ ton~ U(>tlu tinq 

Graphics: 
1:8:1 Store copy in publication 

0 Update automHticall y 
0 lllt~ r t ht~ ton~ upt!n tin1.1 

Figure 6.14: Link options defaults dialog box 
v 

Updating Links 
v 

~ 
[ C11ncel J 

If you don't choose the Update automatically option in the Link options dialog 
box, you must manually update the linked files in the publication. When 
you open the Links dialog box(~+=), PageMaker tells you the status of the 
document that is currently selected in the list box, as shown in Figure 6.15. 
It also indicates the status of all documents displayed in the list box by 
means of link s tatus indicators, which are placed before the name of the 
document. The absence of a status indicator means that the link is up to 
date (or that the document is not linked). The following status indicators 
are used: 

? Unable to locate linked file 

+ Linked file has been modified and link will be updated 
automatically 
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0 Linked file has been modified and link must be updated 
manually 

~ Both the linked file and ~he publicaHon file have been modified 

(x) Publication does not contain complete copy of linked file 

To manually update a particular link, you click on the document name 
in the list file box of the Links dialog box, then click the Update button. To 
have all links in the publication updated at one time, you click on the 
Update all button. 

Reestablishing Links 
\7 
When you firs t open a publication tha t con tains links to external text and 
graphics files, PageMaker must first locate these files on the disk. In 

r aliml Edit Options Page Type Element Windows 

~ 
[";n t:.. I-"' I I 

links n OK 

Document Kind Page 

CG & Greg.t iff(LD2) Image 5 F -·~· 'I • 

Cock: taii .EPS Encapsulated PostScript 3 
Sample Floor Plan PICT 2 
Shelties 256 gray(LD2) Image 7 
Shelties Diffusion Image 6 
Tourist.TI F Image 4 

0 
Shtus: Tho linkod documont has boon modifi ed since tho las t tim• it w•s placod. 

Howover, automat ic updates have not been r oquostod. 

I link: info ... l [link options •.. ) I Update ~ I IJ p t!tl tl~ tlll 

Figure 6.15: Links dialog box showing the link status of the selected document 
v 

• .., -
r--

n 

l 
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a ttempting to locate a particular file, the program first searches the folder 
from which the text or image was last placed. If PageMaker can't find the 
file there, it then searches the folder containing your publication. If the pro
gram locates the file, it updates the link only if you have selected the Update 
automatically option in the Link options dialog box. 

If the program still can' t locate the file after searching the folder 
containing the publication, it displays the Cannot find dialog box. To re
establish the link, you must then locate the file in the list file box, select it, 
and then click the Link button. 

If you reloca te a file or change its file name while you still have the 
publication open in PageMaker, you will also have to reestablish the links 
between the publication and the particular file. To do this, you need to 
choose the Links option on the File menu(~+=), then select the name of 
document in the list file box (it will be preceded by the question mark 
sta tus indica tor, as shown for the Cherry Pie file in Figure 6.1 6), and click 

Options Page Type Element Windows 

Links ~ OK 

Document Kind Page 

CG II' Greg. ti ff(lD2) I mage 5 . . IJ[• I • 

Cocl<taii.EPS Encapsuleted PostScript 3 
Semple Floor Plan PICT 2 
Shelties 256 gray(l02) I mage 7 
Shelties Diffusion Image 6 
Tourist.TI F Image 4 

S tatus: PagoM akor cannot locato tho linkod doeumont . Us• tho 'Link info .. .' dial og to 
find tho documont . 

Figure 6.16: Document that can no longer be found 
V' 

F 

IQ 
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SPECIAL 

on the Link info button. This will take you to the Link info dialog box, like the 
one shown in Figure 6.17. Here, you need to locate the file in the list file box, 
then select it, and click on the Link button. This reestablishes the link, up
dates it, and returns you to the Links dialog box. 

~ * IIICI Edit Options Page Type Element Windo w s • ., - .:;n. ~ 1 - ~ 1 
;:_ = 

link info: Cherry Pie [ l:j (!( t ) n linlc l 
I= HD 20 1 ( ) ( Cancel ) Driue 

D Aldus PageMalcer 4.0 r =HD 20 D Ch6 figs 

••• ' ·r.n•~ 
D Font / DA Mouer Folder Loc~tion : DTP Graphics :MacPaint :Ch• rry Pi• 
D Picture 0 
D System Fo lder Kind: lmag• 

D WordPerfect 1.04 Siu:NA 

Placed: 7/30/90, 4:54PM 

Document modified : N A 

0 Internal data modified :NA 

II 
( link info ... l (link opt ions ... ) ( llpd <J1e 

Figure 6.1 7: Reestablishing the link in the Link info dialog box 
v 

) ( IJ p illl tf> Ill! ) 

GRAPHICS TECHNIQUES v 
Once you place your graphics in your publication, you can make many 
enhancements. For one thing, you can resize or crop the graphic images to 
fit a particular space on the page. If you have imported your images as 
independent graphics, you can also set the way text wraps around each 
image and the spacing between its borders and the surrounding type. As 
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you will see, you can even customize the botmdary surrounding a graphic 
image, making it easy to flow text around any kind of curved or other 
special shape. You can use this technique to run text around a drop cap 
placed as a graphic linage or to embed a graphic within text. 

Resizing and Scaling Graphics 
v 
Many of the graphic images that you import into your publication will 
need to be resized to fit a particular space on the page. PageMaker allows 
you to resize both inline and independent graphics. When resizing a 
graphic, you can either scale it proportionally or resize it in such a way that 
you can distort its proportions. 

To resize a graphic so that you can distort it, you click on the graphic 
with the Pointer to select, then point to one of the four corner handles that 
appear and hold down the mouse button. When the Pointer changes to a 
double-headed arrow, you drag diagonally until the image is the size you 
desire, then release the mouse button. 

If you find in resizing the image that you have distorted too much, you 
can restore its original proportions. To do this, you select the distorted 
graphic with the Pointer, hold down the Shift key, point to any of the 
handles, hold down the mouse button until the Pointer changes into a 
double-headed arrow, and then release it. Note that although this method 
will restore the graphic to its original proportions, it will not necessarily 
restore the image to its originaJ size. In fact, most of the time after returning 
your graphic to its original proportions, you will still have to resize it if you 
want the image to be the same size as it was when you first imported it. 

To prevent PageMaker from being able to distort a graphic when you 
resize a graphic, you need to remember to hold do·wn the Shift key when 
you drag one of the four corner handles. With the Shift key depressed, 
PageMaker will not allow you to select a size that does not match the 
original proportions. 

When resizing graphics, you can scale the linage for the resolution of the 
printer you are using as well as maintain the original proportions. To do 
so, you hold down both the Shift and~ keys as you drag one of the corner 
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handles of the graphic. Doing this ensures that your graphic will look its 
best when printed on the printer you have selected for the publication. It 
also can reduce the number of sizing choices you have, as PageMaker may 
no longer allow you to select all the same sizes as you could when just 
scaling the image proportionally (with just the Shift key). 

Cropping Graphics v 
In addition to resizing, you can also crop your graphic images so that not 
all of the imported image is displayed in the publication . To crop a 
graphic, you need to choose the Cropping tool from the Toolbox and click 
on the graphic image you wish to crop to select it. Next, you position the 
Cropping tool so tha t it is centered over one of the four corner g raphic 
handles, as shown in Figure 6.18, and hold down the mouse button. When 

File Edit Options 

Figure 6.18: Selecting the graphic with the Cropping tool 
v 
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the Cropping tool change·s to a double-headed arrow, drag diagonally 
towar d the opposite corner until only the part of the graphic you want to 
use is displayed in the frame (Figure 6.19), then release the mouse button. 
To enlarge the frame and see more of the image, you need to drag ii1 the 
opposite direction, away from the opposite corner. 

After you have reduced the size of the frame, you can still manipulate 
the image with the Cropping tool. To move a new part of the image into 
view in the smaller frame, you position the Cropping tool somewhere 
within the frame of the graphic, then hold the mouse button until the 
Cropping tool chan ges to the Grabber hand (as seen m Figure 6.20). Once 
this happens, you can use the Grabber hand to move the full-size graph
ic image in any direction within its frame. As soon as you have the part of 
the image you want d isplayed, simply release the mouse button . 

r a File Edit Option s Page Type Element Windows 

Figure 6.19: Cropping the graphic image 
v 



252 V Mastering PageMaker 4 on the Macintosh V CH 6 

Note v 
The third icon under 
Text wrap represents 
a customized graphics 
boundary. This option 
becomes automatically 
selected when you 
customize a graphics 
boundary, as described 
later. When this icon is 
selected, you can 
restore a custom 
boundary to a rec
tangular one by click
ing on the middle icon. 

Figure 6.20: Moving a full-size graphic in a smaller frame 
v 

Controlling Text Flow around Graphics v 
PageMaker gives you a great deal of freedom in deter11Uning how the text 
and graphics in your publication interact with each other on the page. If 
you take an independent graphic that you've just imported into your 
publication and place it in the midst of text, the image will overlay the text, 
as does the sneaker graphic shown in Figure 6.21. This is because, by 
default, PageMaker does not assign any boundary to the graphics that you 
place in your publication, and it is precisely the graphics boundary that 
determines if and how text flows around the image. 

To assign a boundary to a graphic image and designate how text is to 
flow around it, you need to select the graphic with the Pointer, then choose 
the Text wrap option on the Element menu. This brings up the Text wrap 



Column-break Icon 
v 
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Windows 

Figure 6.21: Graphic image without any boundary 
v 

dialog box, shown in Figure 6.22. Notice the three icons beneath Wrap option. 
The first icon, which is selected by defau lt, shows the text flowing right 
through the square representing the graphic. To have PageMaker crea te a 
rectangular boundary around the graphic, you need to click the middle 
icon, the one that shows the text flowing around all four sides of the square 
representing the graphic (but not flowing through it) . When you select this 
icon, the Text flow and Standoff options become available and the Standoff 
options are given d efault values, as shown in Figure 6.23. 

You use the following Text flow options to determine how text flows 
around the graphics boundary: 

• Column-break icon: When you choose this option, PageMaker 
stops flowing text when it encow1ters a graphic and continues 
flowing a t the beginning of the next column. 
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Jump-over Icon 
\1 

Wrap-all-sides Icon 
\1 

File Edit 

Wrop option: 

• ~ r~~~.1 
TeHt f low: 

;-" "" '!\, ~··· ··· ···!\,. 

! I ~ .-.! .... 111 ...... · .• ''! L .. -.... .1 -

Stondoff in picos: 

Ri gh t 

Bottom ._I _ ___, 

Figure 6.22: The Text wrap dialog box with default options selected 
\1 

• 

• 

Jump-over icon: When you select this option, PageMaker f1 ows 
text above and below the graphic image, leaving white space on 
either side of it. 

Wrap-a ll-sides icon: This option is selected by default when you 
first assign a graphics boundary to your image. When it is cho
sen, PageMaker flows text on all four sides of the graphic, leaving 
the amount of space between the border of the image and the text 
as specified by the Standoff options listed below. 

If you wan t to set a new default type of text f1ow for all of the graphics in 
your publication, select your Text flow option from the Text wrap dialog box 
before you import an y graphics into the file. 

When you assign a rectangular boundary to your graphic, you can also 
specify the amount of space (referred to as the standoff> between the bor
ders of the graphic image and the text that flows around it. To increase or 



Note v 
PageMaker retains all 
the standoff values 
that you assign to a 
graphic even when 
you resize it. 
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* File Edi t Options Page Type •• Windows • "' -o nP t'ln •orr 0~ 

TeHt wrap n OK D §0§ ToolboH = 
Wrop option: ( Concel J 

i) a li.~~ 
TeHt f low: 

[!1 [i1 a ~ 
Standoff in picos: 

lenl~l Right 11 I 
Top 11 I Bottom j1 I 

Figure 6.23: The Text wrap dialog box with rectangular boundary selected 
v 

! 
I 

I 

decrease this space, you simply select the appropriate Standoff option and 
enter the new value. PageMaker shows the current standoff values in the 
units selected as the measurement system for the publication in the Pref· 
erences dialog box. For example, if the Picas option is selected, the default 
standoff values will all be 1 pica each. If the Inches option is selected in
stead, the default values will all be 0.167 inch each. Note that you can 
specify a negative value for a particular standoff to have the surrounding 
text overlap that part of the graphic. This enables you to create special 
effects where the text and graphicinterpenetrate on some or all sides of 
the-image. 

Figure 6.24 shows the effect of selecting the Wrap-all-sides icon as the 
Text flow option. Figure 6.25 shows you the same text and graphic image, 
this time when the Jump-over icon is selected as the Text flow option. Both 
illustrations use the default standoff values of 1 pica. 
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File Edit Options Page Type Element Windows 
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Figure 6.24: Using the Wrap-all-sides Text flow option 
'\1 

Creating Runarounds 
v 
Once you have established a standard rectangular graphics boundary for 
your image as described above, PageMaker allows you to customize it so 
tha t your text follows any irregular or curved edges of the image. This 
makes it easy to create runarounds, whereby the shape of your type 
follows the shape of one of the borders of the graphic image. Figures 6.26 
and 6.27 both use runarounds to shape the text to the general shape of a 
nearby graphic. In the case of the poem in Figure 6.26, the right boundary 
of the frog-and-lotus graphic has been customized so the text of the 
associated verse follows the general shape of the stems (this is most 
prominent in the third stanza). In Figure 6.27, the graphic is embedded 
with the text. Here, a custom boundary is used to wrap the text on both 
sides so that it accommodates the curves on either side. 

When you select a graphic image that has a rectangular boundary, 
handles appear not only at the four corners of the image's borders and 



Tip 
v 
To speed up the 
process of cust
omizing a graphic 
boundary, hold down 
the spacebar as you 
make adjustments to 
it. This prevents 
PageMaker from 
reflowing the text 
until you release the 
spacebar. 

' 
' 

' 
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Figure 6.25: Using the Jump-over Text flow option 
'V 

mid way on each side, bu t also at the four corners of the graphics boundary. 
PageMaker uses a diamond shape for boundary handles, to differentiate 
them from the square handles for the graphic's borders. Also, the program 
connects the four boundary handles with dashed lines. 

To cus tomize the boundary of a graphic image, you manipulate either 
the dashed lines or the boundary handles. If you simply wish to increase 
or decrease the standoff between the image and surrounding text, you 
need to work with the dashed lines. Click the Pointer somewhere on the 
line on the side to be adjusted. When the Pointer changes to a two-headed 
arrow, drag the li11e in the appropria te direction to adjus t the standoff as 
you desire. When dragging the boundary handles, you must be careful to 
drag in a straight line. It is possible (even easy) to distort the dashed 
boundary lines ever so slightly, so that they are no longer completely 
straight. Remember that if you find you've distorted the rectangular shape 
and are having trouble setting it righ t, you can restore it simply by 
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Ti p v 
Don't try to drag one 
of the corner boun
dary handles in an 
attempt to adjust the 
standoff for two 
adjacent sides of the 
image. This will only 
result in distorting the 
boundary lines. 
Instead, drag one 
boundary line and 
then the other in two 
separate operations. 

Flowers 

Who shall conquer this world 

And the world of death and all its gods? 

Who shall discover 
The shining way of the dhamma? 

You shall, even as someone 
Who seeks flowers 

Finds the most beautiful, 

The rarest. 

Understand that the body 
ls merely the foam of a wave, 

The shadow of a shadow. 

Snap the flower arrows of desire 

And then, unseen, 

Escape Yamarajah. 

And travel on. 

-The Dhammapada 

Figure 6.26: Frog-and-lotus graphic with text runaround on right side 
v 

selecting Text wrap on the Element menu and then clicking on the middle 
icon beneath the Wrap option. 

To customize the shape of the graphics boundary so that it is no longer 
rectangular or square, you manipulate the boundary handles instead of 
the dashed boundary lines. To help customize the shape of the boundary, 
PageMaker allows you to add new boundary handles. To add a new 
boundary handle, you simply position the Pointer somewhere on the 
dashed boundary line and click the mouse. When you do, a new boundary 
handle will appear (shown as a diamond). 
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ONE 
The Tao tbat can be talked al1out is not tl1e clcrnal Tao. 

Tla: name Lbat can be named is nol tl1c clemalname. 

ginning of heaven a nd eartl1. 

m otl1cr o f ten tl1ousand tbings . 

0) can perceive the mystery. 

·p perceive the boundaries. 

Tbc nameless is tbe be-~~~~'tj 
Tl1 c named is tl, c 

Everwi tl,o uldcsire, o ne 

Ever desiring, one can 

Their source is the 
\ 

· same, yet tbeir names differ. 

Tbi s source appears as darkness. 

D.1rkncss witbin darkncss.TIJC gateway to all mystery. 

Figure 6.27: Lao-Tzu graphic embedded in text with runarounds on either side 
v 

You can add as many boundary handles on a side as you need to 
fabricate the new shape. To create complex runarounds that follow very 
irregular sides of a graphic image, you will need to add quite a few 
boundary handles. In Figure 6.28, you can see that even this simple 
runaround required the addition of several boundary handles. 

To create an irregular boundary, you simply drag the boundary handles 
until you have manipulated a part of the boundary line so that it begins to 



260 V Mastering PageMaker 4 on the Macintosh V CH6 

Windows 

• · ~ ls merely the foam of a wave, ~ 
.the sha.dow of a shadow. ! 
:~nap the flower arrows ofd esi~ 

+And then, unseen, 

~scape Yamarajah . 

• 

.. 
~ ~ 
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Figure 6.28: Boundary handles required to run some of the text around part of a graphic 
'V 

follow the shape you want. As you drag a boundary handle, the program 
moves an associated segment of the boundary line. Manipulating bound
ary handles to move these line segments is something like the inverse of 
those connect-the-dots drawings that many of us had when we were 
children. Here, your goal is to add the dots (boundary handles) instead of 
drawing lines, and then move them so that they trace the shape of an 
existing graphic. However, you will find that just as with connect-the-dots 
pictures, cmves require many more dots (boundary handles) with shorter 
line segments than do straight angles. 

If you find that you have added a boundary handle that you d on't need, 
you can d elete it by dragging it on top of another boundary handle. 
Remember that you can speed up your work by holding down the 
spacebar as you drag the boundary handles, as thjs prevents PageMaker 
from reflowing the text around the graphic boundary. When you have the 
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boundary as you want it, release the spacebar to see how the text reflows. 

Creating Figure Captions 
v 
Many illustrations and graphics require captions. When adding a caption 
to a graphic, you first need to assign a graphics boundary to the image, 
then increase the size of the standoff on the side where the caption is to 
appear so that it contains all of the type. It is important that the standoff 
encompass all of the text of the caption. Only then will PageMaker join the 
caption to the graphic so that the caption does not move when surround
ing text is reflowed. 

Figure 6.29 shows a correctly placed caption that is positioned beneath 
the figure. Here, you see that the entire text block containing the figure 
caption fits within the graphics boundary. Because of this, its placement 
will not be affected should the text that wraps around this graphic have to 
be reflowed. 

• ~swn. 

~p'wn dolor 3it amet, 
i:oiUec ~etuer 
~ipiscing elit, sed 
;nonununy nibh 
;tin.cidunt ut laoreet 

o" ~'nao.lique.m ent 

ngure 2-1: low-CUI Sneaker .. :Utwienimad 
n i m~ "\" ~niam, quis nostrud 
e r c ~ . . ... .......... . .............. .. .. . ....... .... ...... . ........... .. .. .. .. .. ...... .. . ia lion ul lamcorper 

nisi ut aliquip ex ea commodo coruequat. Duis autem veleum iriure dolor in 

Figure 6.29: Placing a caption beneath a figure within the graphics boundary 
v 
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Creating Drop Caps with Graphics 
V' 
In Chapter4, we looked a t creating drop caps using the superscript option. 
This technique is the best one to use when your drop cap consists of type, 
because it ensures that the drop cap will always remain a part of its 
associated paragraph.Ifyourdropcapisagraphic,however, you can't use 
this technique. Instead, you must import the captial letter into your 
publica tion as an independent graphic, assign it a rectangular graphics 
boundary, select Wrap-all-sides as the type of text wrap, and specify the 
amount of standoff on at least the right and bottom sides (some drop caps 
may require a standoff on all four sides of the graphic boundary). After 
you specify these settings, you simply need to place the graphic at the 
beginning of the paragraph and then size it as required. 

Figures 6.30 and 6.31 show two examples of drop caps placed as graphic 
images. The drop cap in Figure 6.30 uses an Art Nouveau A tha t was 
scanned and saved in a TIFF file. This graphic has a rectangular boundary 
and uses Wrap-all-sides as the Text flow option, with a standoff of 1 pica on 
the left and top, 10 points on the right, and 6 points on the bottom. 

(1-IAPTER 3 8 

2 

nd Yahweh answered Job from the heart of the 
tempest, and said: 
Who is this who darkens Providence 
By words devoid of insight? 

3 Gird up yo ur loins then like a ma n; 
I wi ll qu esti on you and you will in form me! 

4 Where were you when I laid the foundations of the earth? 
Tell me that, if yo u know the truth. 

Figure 6.30: Drop cap created with scanned TIFF graphic image 
\1 
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CHAPTER 24 

W 
hy have the times been hidden from Shaddai? 

And why have those who know Him not seen His days? 
2 Wicked men remove landmarks, 

They seize the flock and its shepherd, 
3 They drive away the ass of the orphan, 

They take the widow's ox as a pledge, 
4 The needy turn aside from the road, 

All the poor of the land must needs hide themselves. 

Figure 6.31: Drop cap created with FreeHand EPS graphic image 
v 

The drop cap shown in Figure 6.31 uses an EPS graphic image created 
with Aldus Freehand. There, we created an outline form of a W using thl 
Cooper Black font in 48 points. Then this EPS graphic was imported into 
a PageMaker publication and placed using the same boundary, text flow, 
and standoff dimensions. However, after placing the W at the start of the 
paragraph, we changed the angle of the right boundary line so that the text 
of verses 1 and 2 follows the slant of the final s troke of the W. 

ESSENTIAL 
TECHNIQUES 
v 
To Import an 
Inline Graphic 1. Click at the place in the story where you want the graphic to 

appear with the I-Beam cursor (if you're in layout view, you 
need to first choose the Text tool). 
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To Import & 
Place an 
Independent 

2. If you're in layout view, choose the Place option on the File 
menu (~+D). If you're in story view, choose the Import option 
on the Story menu. 

3. Select the name of the graphics file you wish to import in the 
list files box. 

4. Click the OK button. If you're importing a TIFF file that you 
wish to compress, hold down the ~+Option keys as you click 
the OK button to compress the image a moderate amount, or the 
~+Option+Shift keys to compress the image the maximum 
amount. 

Graphic 1. In layout view, choose the Place option on the File menu (~+D). 

2. Select the name of the graphics file you wish to import in the 
list files box. 

3. Click the OK button. If you're importing a TIFF file that you 
wish to compress, hold down the ~+Option keys as you click 
the OK button to compress the image a moderate amount, or the 
~+Option+Shift keys to compress the image the maximum 
amount. 

4. When the file is loaded, position the graphics Pointer in the 
place on the page where you wish the image to appear, then 
click the mouse. 

5. To size the image as you place it, drag the graphics Pointer 
diagonally. To resize the image after you place it, click to select 
it, then drag one of the corner handles diagonally (hold down 
the Shift key as you drag to preserve its proportions). 



To Flow Text 
around a 
Graphic 
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1. In layout view, select the graphic image. 

2. Choose the Text wrap option on the Element menu. 

3. Click on the middle icon beneath Wrap options that shows the 
text flowing around all four sides of the square representing 
the graphic image. 

4. To have the text jump to the next column when it encounters 
the graphic, select the Column-break icon (the first one) under 
Text flow. To have the text flow above and below the graphic 
image but not on either side, select the Jump-over icon (the 
middle one). 

5. Enter new standoff values if required. Otherwise, to accept the 
default standoff and apply the new Text wrap settings, click the 
OK button. 



7 
PAGE 

COMPOSITION 
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PAGE SETUP v 

Page Composition and Layout V 267 

Thus far, we've independently explored the mechanics of type and 
graphics and how you place these elements in your publication. Now it's 
time to examine the relationship between the elements that you set up 
when you compose and lay out the page-in other words, the design of the 
publication. 

Perhaps no aspect of desktop publishing is more misunderstood than 
design. Although some professional graphic designers claim to work from 
a set of universal and unchanging design rules, most would freely admit 
that their designs result from a process of applying a few tried-and-true 
design principles to a specific problem, during which the original guiding 
principles may often be modified, ignored, or even outright defied. 
Contrary to popular belief, excellent publica tion design is much more the 
result of extended trial and error ra ther than artis tic insight. Therefore, it 
is not unusual for the final design of a publication to bear little resemblance 
to the original idea. 

In many ways, PageMaker is the perfect tool for a design process based 
on trial and error because the program makes it so easy to modify the basic 
page layout. Because the program lends itself to experimentation, you will 
find yourself encouraged to play with the layout of the elements on the 
page until you are satisfied \•vith their composition. 

As you will learn in this chapter, templates and style sheets are two 
important keys to efficient and proficient design in PageMaker. The use of 
templa tes substantially reduces the time it takes to develop a basic design, 
whereas the use of styles makes it easy to refine the basic design until you 
feel it appropriately solves the problem at hand. But before we explore 
these design aids at some length, we need to look at the basic tools that 
PageMaker gives you to design an original publication. Once you under
stand the basic procedure for creating a new publication, you will be able 
to appreciate how templates and style sheets can enh ance this process. 

The first design issues that confront you when beginning a new publica
tion in PageMaker concern the page makeup. When you open a new 
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Note v 
You don't have to 
select Custom as the 
Page setting before 
you enter custom page 
dimensions. Entering 
nonstandard page 
dimensions causes 
Page Maker to auto· 
matically select 
Custom as the 
Page setting. 

publication in PageMaker, the firs t thing you encounter is the Page setup 
dialog box (shown in Figure 7.1 ). This is where you specify all of the basic 
page parameters, such as the page size, orientation, numbering scheme, 
and margin settings. 

Page Size and Orientation v 
The Page pop-up menu on the Page setup dialog box (shown in Figure 7.1) 
contains four options: 

• Letter, w ith page dimensions of 8.5 by 11 inches or 51 by 66 picas 

• Legal, with page dimensions of 8.5 by 14 inches or 51 by 84 picas 

• Tabloid, with page dimensions of 11 by 17 inches or 66 by 102 picas 

• Custom, with dimensions other than those set by Letter, Legal, or 
Tabloid and as large as 17 by 22 or 431 by 538 picas 

To enter custom page dimensions, you need to type in new values in the 
Page dimensions boxes. The first value that you enter represents the width 
of the page, and the second represents its length. You don't have to be 
concerned if you specify a page size tha t is larger than the paper your 
printer uses (most laser printers can print only on 8Vz by 11 or 8112 by 14 inch 
pages), as PageMaker allows you to print each page a t a reduced size or to 
print just a portion of it on each physical page. You can then assemble the 
complete oversized page from the parts printed on several standard 
pages. If you specify a page size that is smaller than the physical size of the 
paper in your printer, PageMaker automatically centers it on the page 
when you print. In such a case, you can also have PageMaker print crop 
marks at the corners of each page that indicate how the paper should be 
trimmed. (See Chapter 9 for examples of oversized pages printed on 
several physical pages and undersized pages printed with crop marks.) 

You can use the Orientation option on the Page setup dialog box to print 
across the widest page dimension. By default, the Tall button is selected, 
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by 1-j1_1 _ ___,jl inches 

#of pages:~ 

Options: 181 Double-sided 1:81 Facing pages 

Inside j 1 
:=::=~ 

Top jo. 75 

PM4 Help 

Figure 7.1: The Page setup dialog box 
\7 

Outside I 0. 75 

Bottom I 0. 75 

n OK 

Cancel 

(N umbers ... ) 

meaning that the largest page dimension runs from the top to the bot
tom- that is, the length- of the page (this orienta tion is also referred to as 
portrait mode). If you choose the Wide button, PageMaker automatically 
switches the orientation (also known as landscape mode), applying the 
largest dimension to the width of the page. For example, if you have Letter 
selected as the Page option and Tall as the Orientation, the Page dimensions 
will be displayed as 

8.5 by 11 inches 

If you then select Wide as the Orientation, the Page dimensions will auto
matically change to 

11 by 8.5 inches 

The page size and orienta tion that you specify in the Page setup dialog 
box determine the way the page is represented on your Macintosh screen. 
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The page dimensions, of course, also determine how much of the page can 
be displayed on the screen at one time when each page size is selected. 

Page Numbers 
v 
Besides setting the page din1ensions and orientation, you also use the Page 
setup dialog box options to designate other basic page format settings, 
including the starting page number, number of pages in the publication, 
whether the publication is single-sided or doubled-sided and uses facing 
pages, and the page margins. If your publication uses page numbers, you 
can also specify the type of numbering to be used . 

Although PageMaker can automatically number the pages of your 
publica tion, you must manually specify the s tarting number and the type 
of numbering to be used in the Page setup dialog box and then insert the 
page-number marker in the master pages to have it do so (see "Setting Up 
Master Pages" la ter in this chapter for information on how to do this). By 
default, PageMaker makes 1 the first page number of a new publication. 
If the publication you are creating represents a new section or chapter of 
a longer publication (such as a manual or book), you will have to enter the 
correct starting page number (up to 9999) in the Start page# box. 

Adding and Removing Pages 
v 
If you want your publication to have more than a single page, you enter the 
total number of pages (up to 999) in the# of pages box. If you don't specify 
enough pages or you specify more pages that you actually need in the Page 
setup dialog box, you can always add or delete pages later when working 
on the publication. 

To insert new pages while crea ting the publication, you select the Insert 
pages option on the Page menu. This brings up the Insert pages dialog box, 
which lets you choose between inserting the pages before or after the 
current page (After current page is the default) and indicating how many 
pages to insert (2 is the default when facing pages are specified, and 1 is the 
default when they are not). Note that if you've stipulated facing pages in 
the Page setup dialog box and a pair of facing pages are currently selected, 
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a third option called Between current pages becomes available. If you choose 
this option, PageMaker inserts the specified number of blank pages 
between the existing facing pages, pushing the right-hand page of the pair 
farther back in the publication. If you want to add blank pages at the end 
of the publication, make the last page or pair of facing pages current and 
then use the After current page option. If you want to add blank pages at the 
beginning of the publication, make the firs t page current and then choose 
the Before current page option. 

To delete extra pages from a publication, you select the Remove pages 
option on the Page menu. The Remove pages dialog box that then appears 
contains two edit boxes, where you indicate the numbers of the first and 
last pages to be deleted. If the page or pages that you specify here aren't 
blank, the program wm sound the alert and display a warning box that says 

Delete page and all items on it? 

when you click the OK button. To have PageMaker proceed with the 
deletion of the sped fied page(s), you must then select the OK button in this 
warning dialog box. If you wish to save the material, click on the Cancel 
button or press the Return or Enter key. 

Specifying the Type of Page Numbers 
v 
PageMaker allows you to choose the type of page numbering you wish to 
use in your publication. By default, the program uses Arabic numerals (1, 

2, 3, and so on).lf your publication calls for a different numbering scheme, 
you need to click on the Numbers button in the Page setup dialog box. For 
example, if your publication contains frontmatter for a book or manual, 
which normally uses Roman instead of Arabic numerals, you would use 
this option to change the page numbering to lowercase Roman numerals. 

Selecting the Numbers button brings up the Page numbering dialog box, 
shown in Figure 7.2. As you can see from this figure, you can choose 
between uppercase and lowercase Roman numerals (either I, II, III, or i, ii, 
iii) and uppercase and lowercase letters (A, B, C, or a, b, c). PageMaker 
automatically reverts to s tandard Arabic numerals if you are using a 
Roman numeral option and the page number exceeds 4000. In other 
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words, MMMM or mmmm is the highest Roman page number that 
PageMaker can produce. Likewise, PageMaker automatically reverts to 
Arabic numerals when you are using the uppercase or lowercase letters 
option and the page number exceeds 52, meaning that ZZ or zz is the 
highest alphabetic page designation that the program can produce. 

At the bottom of the Page numbering dialog box, you' ll find an edit box 
where you can enter any page-number prefix. This option can be useful 
when you are working with publications that contain different sections, 
each of which requires its own table of contents or index, and you use a 
particular initial or word in front of each page number to indica te both the 
current section and page. 

Assume, for example, that you're setting up a users manual for an 
integrated software program that contains both word processing and 
database management features. To differentiate the section on word 
processing features from that on database management, you decide to use 

Stort poge # : 

Options: 181 D 

Poge numbering 

® Arobic numerol 
0 Upper Romon 

1, 2, l, ... 
I, II, Ill, ... 

0 Lower Romon i, ii, iii, ... 
0 Upper olphobetic A, B, C, ... AA, BB, CC, .. . 
0 Lower olphobetic o, b, c, ... oo, bb, cc, .. . 

TOC ond indeH prefiw: '----------J 

Figure 7.2: The Page numbering dialog box 
v 
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composite page numbers with the prefixes W- (for word processing) and 
D- (for database management). Thus, in the word processing section, the 
numbers will appear as W-1, W-2, and so on, and in the database man
agement section, the numbers will appear as D-1, D-2, and the like. 

With this type of page numbering, you need to enter W-as the TOC and 
index prefix in the Page numbering dialog box for the publication that con
tains the word processing fea tures. Similarly, add D- for the publication 
that contains the database management features. The page numbers 
placed in the table of contents and index that you genera te for each 
publication will then match those used in the publica tion itself. (See 
Chapter 8 for complete information on generating tables of contents and 
indexes in PageMaker.) 

Note that the prefix you enter in the TOC and index prefix box can' t exceed 
16 characters. Although this is more than sufficient in most cases, you 
should keep this limit in mind when crea ting composite page numbers 
that use d escriptive prefixes, which tend to be long. 

Page Layout and Margins 
v 
The Page setup dialog box has two layout options: Double-sided and Facing 
pages. Both of these options are checked by default when you create a new 
publication. If the publica tion you' re creating is to be printed on only one 
side (single-sided), however, you should uncheck the Double-sided box. 
When you unch eck the Double-sided option, PageMaker automatically 
unchecks the Facing pages option. Also, the Inside and Outside margin 
settings in this dialog box become Left and Right, resp ectively. 

To understand the difference between left and righ_t margins in a single
sided publication and the inside and outside margins of a double-sided 
publication, refer to Figure 7.3. This figure shows a diagram of facing 
pages for a double-sided publication, indicating the loca tion of the mar
gins. Note that whereas the top and bottom page margins remain the same 
for the left-hand and right-hand pages, the inside and outside margins do 
not. On the left-hand (even-numbered) page, the outside margin appears 
on the left and the inside margin appears on the right. On a right-hand 
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(odd-numbered) page, just the opposite is true: the outside margin ap
pears on the right and the inside margin appears on the left. 

Because of this left-hand, right-hand alternation, the inside margins of 
a double-sided publication meet at the binding edge, forming the gutter. 
Usually, the inside margin is larger than the outside margin to offset the 
gutter space used in binding the publication. Thus, PageMaker makes 
the default inside margin 1 inch, as opposed to an outside margin of 0.75 
inch, when the Double-sided option is checked. 

Just as the program assumes that a double-sided publication will be 
bound, it assumes that a single-sided one will not. Therefore, the page does 
not require any gutter space for binding, and the program changes the 

Top margin 

Bottom margin 

Binding edge 

Inside margins ~ l 
Verso (left-hand page) Recto (right-hand page) 

J<--t--

L Outside margin Outside margin _j 

L Gutter 

Figure 7.3: Diagram of facing pages for a double-sided publication 
v 
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Inside and Outside margin options to Left and Right as soon as you uncheck 
the Double-sided box. Note, however, that PageMaker does not change the 
de fault margin settings at the same time (the left remains 1 inch and the right 
remains 0.75 inch). If you want to have equal left and right margins, you 
must enter new values in the appropria te margin box before you exi t from 
the Page setup dialog box. 

For single-sided publications and double-sided publications where the 
Facing pages option is not checked, PageMaker displays only one page at 
a time on your Macintosh screen. If your publica tion is d ouble-sided and 
you want to see a two-page spread on the screen, you must leave the check 
mark in the Facing pages box. Note that the first page of all publications is 
always considered to be a right-hand page and is shown alone, even when 
you indicate tha t the publica tion is double-sided with facing pages. This 
means that the first two-page spread invariably occurs on the second and 
third pages of the publication. 

After entering the proper values for the four margins of your publica
tion, you are ready to click the OK button. When you do, PageMaker will 
draw the first page of your publication on the screen, using the page 
dimensions and margin settings you assigned . The top and bottom and 
inside and outside (or left and right) margins are indicated on the screen 
by the dashed lines inside the rectangle representing the borders of the page. 

At the bottom of the publication window, you will see page icons for the 
number of pages you added to the publication (on the 9-inch built-in 
screen, you see icons for only up to 13 pages-for pages beyond that, you 
must click on the right scroll a rrow). To go to a different page, you simply 
click on the appropriate page icon. If you have specified facing pages, 
clicking on either one of the pair of page icons will bring the two-page 
spread into view. To move to the next page from any page in the pub
Ucation, you can use the keyboard shortcut of ~+Tab. To move to th e 
previous page, you press ~+Shift+ Tab. To m ove to a specific page in 
the publication, you press ~+G to bring up the Go to page dialog box, where 
you enter the page number before clicking the OK button. 

If you ever find that you have to change some of the page setup options 
while working on a publication, you can re turn to the Page setup dialog box 
by selecting Page setup on the File menu. Once there, you can change all of 
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the page setup options except for the number of pages. The only way to 
insert or delete new pages in a publication after creating it is to use the Insert 
pages or Remove pages option on the Page menu. 

Specifying Your Layout and Edit View Preferences 
v 
As you might remember from Chapter 2, you can use the options on the 
Preferences dialog box to change several layout and edit view settings 
relating to how the text and graphics in your publication appear on the 
screen. Before you begin work on the d esign of a new publication, you may 
want to adjust some of these settings. To get to this dialog box, you simply 
select Preferences on the Edit menu. Figure 7.4 shows you this dialog box 
using the program's default settings. 

The first option under Layout view in this dialog box is Measurement 
system, which contains a pop-up menu that gives you four choices besides 

Po 

Preferences H OK 

( Cancel ) layout uiew: 

Measurement system: Jlnches I 
Uertical ruler: Jlnches I L..._ _ __.l points 

Greek t ent below: piHels 

Guides: 
@ Front 
0 Back 

Detailed graphics: 
0 Gray out 
@ Normal 

Show layout problems: 
0 loose/tight lines 
0 "Keeps" uiolat ions 

0 High resolution 
Story uiew: 

Size: '11-2---.11>"'1 points Font: JTimes I 

Figure 7.4: The Preferences dialog box with default settings 
'V 
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correspond exactly 
to the old ones. 
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the default of Inches: Inches decimal, Millimeters, Picas, and Ciceros. The 
choice you make from this pop-up menu determines the units used by the 
horizontal ruler in the publication window. Your choice also determines 
the units in which all dialog box options that require measurements are 
expressed (except for type sizes and leading, which always use points). 

Remember that you need not enter measurements in the units specified 
by the Measurement system option. To enter measurements in other units, 
you merely indicate the units. For example, to enter a value in inches, you 
type i after the value, as in l.Si. To enter it in picas, you add a p to the value, 
as in 2p (any value after pindicates points, as in 2p6 for 2 picas and 6 points 
or 2Y2picas). And to enter a value in millimeters, you append an m to the 
value, as in 45m. 

The Vertical ruler option, which uses the default unit of inches, has a pop
up menu that contains the same four choices as the Measurement system 
pop-up menu, plus a unique fifth option called Custom. You use the Custom 
option on this menu to set the vertical ruler equal to the leading you are 
using. That way, you can use tick marks on the vertical ruler to help you 
properly align text blocks that use the same leading. 

When you first select Custom, the program d efaults to 12 points, mean
ing tha t the major tick marks on the vertical ruler are spaced 12 points 
apart. If you have set the leading to some other value, you need to enter this 
value in the edit box that follows the Vertical ruler pop-up menu. 

Figure 7.5 shows you how setting up a custom vertical ruler tha t 
matches the leading you're using can help in aligning text blocks. In this 
case, the 12-point body text is set with 14 points of leading in two separate 
text blocks. To make it easier to align these blocks, the vertical ruler is 
customized so that its major tick marks match the leading. In Figure 7.5, 
you can see a ruler guide placed in line with the first major tick mark. 
Notice that this guide corresponds to the baseline of the second line of the 
first text block. Further, notice that the baseline of each subsequent line in 
this text block coincides with another major tick mark. Because this 
vertical ruler is customized for 14-point leading, it makes it easy to align 
any block that uses either the same leading or a multiple of it (such as 28 
points). 

When selecting your layout preferences, you need to d ecide several 
other layout view display settings, including the size at which text should 



278 V Mastering PageMaker 4 on the Macintosh V CH7 

Tip 
\7 
To temporarily set the 
Detailed graphics 
option to High 
resolution when 
importing a particular 
graphic, hold down the 
~ key as you click 
the mouse to place it. 

. . r .... "l."ore"m "ipsiilii "d~l"oi""Sii iimei; "ci:i~"cili tue"i"" .. . ~~ ~ ~ ~~ ~~ ~~~ .. . 
. . . . . . . . . . . . . . . ~ipi:J~ing .C lit, :!e.d .diM\ IW.nllJ)U))Y. Jll b)l .C\IJJIMd . , lA t.JIIIIII~--f.''---~~t!!i!f 

)incldunt ut Jaoreet dolore m~na aliqu.am erat !1-endrerit 
lrolutpat. Ut visi enim ad minim Vl!niam, quis 
~strud exerci tation u!Jamcorper suscipit 
lobortis nisi ut aliq uip ex ea commode 
~onsequ.at. Duis autem VI!! eum iriure dolor in 
h.eru!rerit in vulputate velit es~ molestie 
~onsequ.at , VI!! illum dolore eu !e112:iat nulla 

ilisis at vero erose t accumsan e t ius to odio 
qui bland it praesent !up tatum zzril 

augue duis dolore te !euge.it nulla !a.cilisi. 
ipsum dolor sit amet, consectetuer 

IWll'"'"lru: e lit ,~ d diam nonummy ni bh euismod 
ut Jaoreet dolore magna aliqu.am erat 
Ut visi enim ad minim veniam, quis 

exe rti tation u!Jamcorpe r suscipit 
nisi ut e.liq uip ex ee. commode 

Figure 7.5: Using a custom vertical ruler that matches the leading of the text 
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be greeked, whether guidelines are positioned in front or in back of the text 
blocks and graphics placed on the page, the amount of detail in the graphic 
images you import, and whether to show layout problems. Figure 7.4 
shows you the default settings for these options. 

By default, PageMaker greeks any text below 9 pixels, a size at which the 
type is too small to read except at the 400% page size. If you wish to 
decrease the time it takes the program to draw the text on the screen, you 
can increase this value so that larger type sizes will also be greeked (it takes 
less time to draw a representation of the shape of the text with shading than 
the text itself). 

You can also decrease the time it takes to draw graphics on the screen 
by selecting the Gray out option under Detailed graphics on the Preferences 
menu. By default, PageMaker uses the Normal option, whereby the 
graphics that you import are displayed as low-resolution graphics. When 
you select the Gray out option, you further decrease the time it takes to 
redraw the screen because the images no longer show any detail and are 
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displayed entirely as shaded shapes. Should graphic detail be more 
importan t to you than screen response time, you can select the High reso
lution option. With this option selected, PageMaker will display as much 
detail in your graphic images as your screen can produce. Also, color 
PICT2 images will be displayed in color only when you have selected High 
resolution. 

The Guides option in the Preferences dialog box lets you choose between 
having nonprinting margin, ruler, and column guides placed in front of or 
behind the text and graphics on the page. By default, PageMaker places 
such lines in front of (you can also think of them as being on top of) these 
elements. This is one default that you will probably want to change. If you 
select the Back option, you will find it easier to move text blocks and 
graphics without inadvertently selecting and adjusting nearby guides 
instead. 

The Show layout problems options allow PageMaker to flag, in layout 
view, two kinds of text problems that can occur: 

• Lines in a story that have either too much or too little word 
and letter spacing according to the spacing limits you set in the 
Spacing attributes dialog box (for more on setting spacing limits, 
see "PageMaker's Typographic Controls" in Chapter 4). 

• Lines that violate the widow, orphan, or keep-with-next controls 
that you set in the Paragraph specifications dialog box (for more on 
keeping text together on a page, see "Paragraph Specifications" 
la ter in this chapter). 

To have the program highlight lines tha t are either too loose or too tight 
according to your spacing specifications, you check the Loose/tight lines 
box. To have PageMaker highlight lines in a paragraph that are widows or 
orphans or that should have stayed together on a single page according to 
your paragraph specifications, you check the "Keeps" violations box. 

As mentioned ea rlier in our discussion ofstoryview,PageMaker allows 
you to control the size and font of the text displayed in story view. The size 
and font that you select for Story view in the Preferences dialog box does not 
bear any rela tionship to the font and type size that you assign to the story 
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Note 
\1 
To get to the left 
master page, either 
click on the L icon at 
the bottom of the 
publication window, or 
press 3€tG and select 
the Left master page 
option before you click 
the OK button. To get 
to the right master 
page, click on the R 
icon or press 3€tG 
and select the Right 
master page option 
before you click OK. If 
your publication uses 
facing pages, the 
program will display 
both left and right 
master pages when 
you go to either one. 

in layout view. Bydefault, PageMakerdis plays all tex t in s tory view as 
12-pointTimes. If you wish to use another type size or font, select the new 
point size from the Size pop-up menu (or type in the new value), and select 
the new type style from the Font pop-up menu. 

When selecting new Ia you t view and story view preferences, remember 
that if you have a publication open when you make your changes, your 
new settings apply to that publication only. If you want your new settings 
to apply to all the publications that you open, make your changes when no 
publication is open. 

Setting Up Master Pages 
v 
After selecting your page setup, layout, and edit view preferences, you are 
ready to crea te the master page(s) for your publica tion. If you specified 
that your publication is to be double-sided when completing the page 
setup, PageMaker automatically provides you with a left and right master 
page marked with an L andR page icon, respectively. If you indicated tha t 
your publication is single-sided, the program provides you with just one 
master page-a right master page marked with the R icon. 

If your publication has elements tha t are repea ted on man y or all of its 
pages, you will want to place them on the appropriate master pages. Two 
types of master items are placed on these pages: 

• Nonprinting items, such as column and ruler guides 

• Printable items, such as the text of running heads, automatic 
page number markers, and graphics such as rules or logos that 
are repeated throughout the publication 

Any p rintable master item placed on the left master page will show up 
on all left-hand pages as long as the Display master items option on the Page 
menu is checked. Likewise, all printable master items placed on the right 
mas ter page will show up on all right-hand pages as long as this Page 
option is checked (or on all pages, if your publication is single-sided ). 

If you don't want the master items to appear on a particular page of the 
publication, you must go to that page (or page spread, if you have facing pages) 
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and then uncheck the Display master items option from the Page menu by 
selecting it. Doing this will make the master items d isappear on only that 
page (or page spread, with facing pages). When printable master items are 
invisible on a particular page, Page Maker not only does not print them but 
also no longer wraps text around them. 

Note, however, that to delete a printable master item from the entire 
publication, you must go to the appropriate master page and make the 
deletion there. The same is true when you only need to edit a master page 
item. This is because PageMaker won't allow you to select any printable 
master item on an actual page of the publication. You can select master 
items only on the master page where you originally p laced them. Because 
PageMaker won't allow you to select them, you have no way of moving, 
copying, or deleting when you are on one of the actual pages of the 
publication. 

The nonprinting master items made up of margins and column and 
ruler guides placed on master pages can also be made invisible. To make 
these master items disappear, you need to uncheck Guides on the Options 
menu. This can be done by selecting the menu option or by pressing ~+J. 
You can use this command any time you wish to see a closer approximation 
(without any guidelines) of how your page or page spread will look when 
printed . Note that the Guides command is a toggle switch, so to redisplay 
all nonprinting master items in the publication, you simply select Guides 
on the Options menu or press ~+J a second time. 

Unlike printable master items, some nonprinting master items can be 
edited and removed from actual pages of the publication. You can move 
or delete ruler guides from particular pages, and you can move column 
guides (to change the number of columns on a particular page, you must 
choose Column guides on the Options menu and do it from the Column guides 
dialog box; see the following section for more information about setting up 
columns). Note, however, that the only way to change the margins in a 
publication is by selecting Page setup on the File menu and then changing 
the margin values in this dialog box (as d escribed earlier). 

If you wish to make a change to the column or ruler guides that affects 
all such guides throughout the publication, be sure to make these modifi
cations on the master pages where you originally created them. Of course, 
any modifications previously made to nonprinting mas ter items on 



282 V Mastering PageMaker 4 on the Macintosh V CH 7 

specific pages of the publication will override any global changes you 
make to them on the master pages. 

Creating Layout Grids v 
One of the key elements i.n designing a publication is the creation of the 
layout grid. The grid consists of column and ruler guides that form the under
lying structure of the design. You use this structure in placing the text and 
graphic elements that goon each page of the publica tion. Most publication 
designs benefit from the use of a basic layout grid that you create on the 
master pages. Then, as required, you can modify the basic grid to suit 
whatever variations occur on particular pages. 

As the grid provides the basic framework for the entire design, it 
requires great care and planning on your part. Many excellent books, 
however, cover designing publications with layout grids and can help you 
in developing and executing an appropriate grid design for your piece. 
One of the most valuable of these for the PageMaker user is Desktop 
Pub/ ishing by Desig11 (Microsoft Press, 1989). This book is full of ideas for 
layout grids for a wide variety of projects, and it is specifically tailored to 
the use of PageMaker on the Macintosh or IBM PC (as of this writing, it 
covers only version 3.0 of PageMaker). 

In PageMaker, the layout grid not only provides the foundation of the de
sign but also aids in the placement and alignment of the elements on the 
page. As you will see shortly, this enables you to position text blocks and 
graphic images quickly and with a great degree of accuracy. 

Setting Up Columns 
v 
Column guides serve as the boundaries for the text and graphics that you 
place on the page. All PageMaker publications have at least one column, 
which consists of the area between the inside and outside (or left or right) 
margins. Within this space, the program allows you to create up to 20 
columns. To set u p new columns for the entire publication, you first go to 
the appropriate master page. To set up columns for just one page, you first 
go to that page. Then, you choose Column guides from the Options menu. This 
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brings up the Column guides dialog box, where you enter the number of 
colunu1s and the space you want between them (called the gutter). 

Figure 7.6 shows the Column guides dialog box that appears when you add 
columns to a double-sided publication with facing pages. Here, you can 
set up columns for both your left-hand and right-hand pages. If your 
design calls for a different nwnber of columns or a different gutter space 
on the left-hand pages versus the right-hand pages, you n eed to check the 
Set left and right pages separately box by selecting it. When you do, Page
Maker displays separate Number of columns and Space between columns 
options for left-hand and right-hand pages. Note that if your publication 
is single-sided, the program displays only one set of these options in the 
Column guides dialog box. 

After you enter this information and select the OK button in this dialog 
box, PageMaker divides the area between the inside and outside margins 

,. • File Edit 

Column guides 

Both 

Number of columns: 

Spoce between columns: 

D Set left ond right poges separately 

i 
i 
i 

' . ·· ·········· ····· ····· ······ ···· ···· ·· ·' 

Figure 7.6: The Column guides dialog box 
v 

n OK ~ 
[ Cancel ] 
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Warning v 
Although the program 
supports up to 20 
columns on a page, 
each column must be 
a minimum of 1 pica 
or Ys inch wide. if your 
margins and gutter 
widths do not leave 
sufficient room for this 
minimum column 
width, PageMaker 
displays an alert box 
and refuses to create 
the columns when 
you select OK. 

into equally spaced columns with the gutter you specified. If you don't 
want the columns to all be equally spaced, you can then drag the pair of 
column guides that forms the column's gutter to either increase or d e
crease the size of that column. You can change the size of the column on 
the far left or right by dragging the guide that coincides with the inside or 
outside margin (these guides are the only single column guides on the 
page; all others move in pairs). Doing this does not alter the size of the mar
gin settings. Instead, it allows the elements that you place in the far left or 
far right column to overlap the associated margin. 

As soon as you create unequal columns by resizing any column in this 
manner, PageMaker changes the number of columns listed in the Column 
guides dialog box from the value you originally entered to the word 
Custom. If you need to alter the number of columns in a design even after 
resizing them, you do so by entering a new value for the number of 
columns in the Column guides dialog box. Note, however, that the program 
can only create equally spaced columns, so entering a new value for the 
numbers of columns will cause you to lose all your custom columns. To 
restore them, you must individually and manually resize them again by 
dragging the appropriate pairs of column guides. 

It is important to realize when setting up your columns how they affect 
the flow of text that you place on the page. When you place text simply by 
clicking the Text icon at the start of a column, PageMaker keeps all of the 
text within the column guides by restricting the line length to fit within 
the column width. When your text block spans more than one column 
(and you have selected Autoflow on the Options menu), the program 
flows the text from the bottom of one column to the top of the next, snaking 
the text up and down each column, as seen in newspaper and newsletter 
articles. 

Because columns restrict the line length of text to the column width, a 
narrow column can result in bad line breaks throughout the text and, when 
the text is justified, in uneven word spacing. Moreover, if you use Page
Maker's automatic hyphenation, you may get strings of hyphens at the 
end of consecutive lines. All of these effects make your text harder to read. 
If possible, avoid such problems altogether by making your columns wide 
enough and your text size small enough to accommodate an average of at 
least six to seven words of your body text without excessive hyphenation. 



Note v 
If the rulers aren't 
displayed in your 
publication, check 
Rulers on the Options 
menu by selecting it 
or pressing ~+A. 

Note v 
To turn off the 
attraction of the 
margin, column, and 
ruler guides toward 
the Pointer, uncheck 
Snap to guides on 
the Options menu by 
selecting it or press
ing ~+U. 

Note v 
You can think of the 
addition of a horizontal 
or vertical ruler line as 
making part of the 
invisible ruler grid 
"visible." 
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If you want a text block to go beyond the columns defined on the page, 
when placing the block, you must drag the borders of the block so tha t they 
extend beyond the colwru1 guides. This drag-place technique must be 
followed whenever you have a special block of text such as a headline that 
you want to appear over several columns of text. It gives you the freedom 
to adapt the shape of your text so that it needn't always rigidly conform to 
the layout grid as defined by the column guides. 

Setting Up Ruler Guides 
\1 
As you are already av,rare from the exercises i11 Chapters 2 and 3, you can 
create horizontal and vertical ruler guides simply by dragging them from 
the appropriate ruler. By adding these ruler guides to the column guides 
on your master pages, you refine the layout grid, making it easier to 
manually place text and graphics on the page. 

Unlike column guides, ruler guides do not constrain the placement of 
text. They are useful in helping you manually place individual elements 
on the page. Just like column guides, ruler guides can be placed either on 
the master pages or on specific pages of the publication. Although ruler 
guides do not restrain the flow of text, they can help you in placing 
elements. When you check Snap to guides on the Options menu (the defau1 t), 
it is much easier to align text or g raphics that you're placing. This is 
because they are naturally attracted to any nearby column or ruler guides 
(the doctunentation describes the guides as exerting a "magnetic-like 
pull" on the Pointer, text blocks, or graphic images). 

Even if you d on' t crea te ruler guides for your publication, you can use 
an invisible grid in placing your text blocks or graphic images. This grid 
is composed of invisible lines formed by the intersection of each tick mark 
on the horizontal and vertical ruler. The increments on these rulers and, 
therefore, the fineness of this grid, depend upon three factors: the size and 
resolution of your monitor, the page size option you are using, and the 
units of measuremen t you 've selected for the rulers. Of these three, 
the page display size is the most significant. To work with finer incre
ments on the rulers, you simply increase the page display size. Table 7.1 
shows you how the ruler increment (represented by the smallest tick 
mark) changes as you change the size of the page di~play. 
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Note v 
To turn off the 
attraction of the 
invisible ruler grid, 
uncheck Snap to 
rulers on the Op
tions menu by 
selecting it or 
pressing ~+[ a 
second time. 

Table 7.1: Ruler Increments by Page Display Size 

UNITS OF MEASUREMENT 

PAGE DISPLAY SIZE INCHES PICAS 

25% size 1/8 inch 1 pica 

50% size 1/16 inch 6 points 

75% size 1/ 16inch 3 points 

100% (Actual) size 1/32 inch 3 points 

200% size 1/32 inch 1 point 

400% size 1/32inch 1 point 

Notice from this table that at the 200% or 400% page display size, you 
are working vvith a ruler grid madeup ofinvisible linesspaced V32 inch apart, 
if you' re working in inches, or 1 p oint apart, if you're \•Vorking in picas. 
Wh.en you switch to 50% page size, for example, the grid is half as fine, as 
the lines are now spaced Vl6 inch or 6 points apart, depending upon the 
system of measurement you' re using. 

To aid you in precise placementofelementson the page, you can use this 
invisible ruler grid. When you check Snap to rulers on the Options menu by 
selecting it (or pressing~+[), any text or graphics that you position on the 
page is pulled onto the invisible grid lines formed by the intersection of 
the rulers . 

Snapping elements to the tick marks of the ruler grid gives you precise 
control over their placement in page display size. Of course, the larger you 
make the page size, the smaller the increments that can be displayed on the 
ruler, thus enabling you to work with more accurate measurements. 

The easiest way to place an element with the greatest precision is to use 
the a ttraction of both the ruler guides and the invisible ruler grid. To do 
this, make sure that both Snap to guides and Snap to rulers are checked on the 
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Options menu. Then increase the page display size to 200% or 400% so tha t 
you are working with the smallest increments possible, and create ruler 
guides tha t mark exactly where you want the element to be placed . After 
that, you reduce the page display size to w hatever size gives you a 
complete view of the text block or graphic you want to place (even Fit in 
window is fine). Finally, you position the element so that it is aligned with 
ruler guides. Because you have placed it using both the Snap to rulers and 
Snap to guides options, you can be assured tha t it is precisely placed, 
regardless of the size of the screen display or the page display size used in 
positioning it. 

Creating Running Heads 
v 
A running head is the text that is printed at the top of every page of a 
publication (text that appears at the bottom of the page is called a running 
foot) . Publica tions such as manuals and books normally use running head s 
(or feet) to indicate the name of the work or the chapter as well as the 
current page number (called a folio) . When creating running heads for such 
publications, you enter the text containing the name of the work or section 
and the page-number marker in the master pages. 

In books and some types of manuals, it is customary to use two running 
heads (or feet): a left-hand head placed on the left master page of the 
publication, and a right-hand head placed on the right master page. As is 
true with this book, the running head for the left-hand page is left-justified 
and begins with the page number followed by the name of the work 
(Mastering PageMaker4 on the Macintosh, in this case). The running head for 
the right-hand page is just the opposite: it is right-justified, with the name 
of the chapter or section ("Page Composition and Layout" in this case) 
followed by the page number. 

Entering Page-Number Markers 
v 
Page Maker automatically numbers any page in a publication that con tains 
a page-number marker somewhere on it. To insert a page-number marker, 
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Note v 
Remember that 
PageMaker will 
use Arabic numerals 
and start the page 
numbering from 1 
unless you entered 
some other starting 
number or selected 
some other kind of 
numbering from the 
Page setup dialog 
box. 

you select the Text tool, click it at the place on the page where you want the 
page number to appear, and press ~+Option+P. To have the program 
number all of the pages in the publication, you need to insert this marker 
on the master pages. When you enter a page-number marker on the left 
master page, PageMaker displays it as LM. Likewise, when you place a 
page-number marker on the right master page, the program display it as 
RM. However, as soon as you go to a particular page in the publication, the 
LM or RM marker is replaced by an actual numeral. 

Figure 7.7 shows the running head for the right-hand pages of Chapter 2 
of this book as it was entered in the top margin of the right master page. 
Note that PageMaker enters the page-number marker on this master page 
as RM. Contrast this to Figure 7.8, which shows you the same running head 
on the first right-hand page. Here, you can see that the program has 
replaced the page-number marker with the actual page number. 
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FROM TEMPLATES v 
In Chapter 3, you had the opportunity to design a brochure from one of the 
templates provided with PageMaker 4. Templates simplify the design 
process considerably by allowing you to concentrate more on content than 
on form. Because the template already contains the basic design and 
format, you can easily adapt it to the particular requirements of the project. 
Although templates can save you time even when you are creating one-of
a-kind pieces, they are most useful for periodic projects, such as a monthly 
newsletter or magazine or a quarterly review or report. 

Your PageMaker 4 package includes several different types of tem
plates, which you are free to use or adapt as required. These template files 
are automatically copied to a folder named Templates when you install the 
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program. Included in this folder are two different types of templates: grid 
templates and placeholder templates. 

Using Grid Templates 
v 
Grid templa tes, as the name implies, consist of layout grids placed on the 
master pages. PageMaker 4 includes ten different grid templates. All of 
these files are contained in the folder named Grids. Figure 7.9 shows you 
the contents of this folder. As you can see from the figure, the name of each 
fi le indicates the page size as well as the number of columns across the 
page followed by the number of rows down the page. 

To use a grid template, you open it as you would any other PageMaker 
publication. Note, however, that PageMaker always opens the original 
template if you open it by double-clicking its file name in the appropria te 
folder. To open a copy of the template instead, select the template fi le name 
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Figure 7.9: The Grid folder showing the names of its templates 
v 
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in the Open publication dialog box (the Copy button is selected by default). 
Figure 7.10 shows you how a copy of one of the grid templates appears on 
the screen. Here, you see a copy of the template named 8.5xll 5x8 col 
opened by choosing Open from the File menu, then selecting its file name 
in the list box of the Open publication dialog box when the Copy button is 
selected. 

Because the program opened a copy of the template instead of the 
original, the publication is currently untitled. One of the first things you 
should do when you open a template is to use the Save as command on the 
File menu to save it under a new file name. After naming the publication, 
you proceed to place the appropriate text and graphics just as you would 
if you had developed the layout grid yourself. 

When placing text iJ1 a grid template, keep iJ1 mind that the vertical grid 
lines are colwnn guides, but the horizontal ones are horizontal ruler 
guides. This means that the column guides will cause PageMaker to flow 
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text from column to column unless you drag-place its text block. Con
versely, the ruler guides d o not restrain the text flow and are useful only 
for precision placement of particular text blocks and graphic images. 

Using Placeholder Templates 
v 
If you did the fi rst exercise in Chapter 3, you are already familiar with 
placeholder templates. The brochure template that you worked with in 
thjs exercise, like all the other placeholder templates supplied with 
PageMaker 4, contained dummy text and graphic images that mark the 
position of these types of elements in the publication. Unlike grid tem
plates, this type includes not only the layout grid, but also paragraph styles 
and sample elements. 

Placeholder templa tes are the easiest and fastest type to work with 
(provided that you don' t have to make major changes to the layout). To 
create your own publication, you need only replace these text and graphic 
images with ones of your own (prepared as outlined in Chapters 5 and 6). 
If you do have to make modifica tions to the s tyles or layout ofthe tem
plate, the placeholders will help you immediately see their effect on the 
pubHcation. 

The PageMaker 4 package includes a wide selection of placeholder 
templa tes that you can use as is or adapt to your specific project. In 
addition to the placeholder templates tha t are supplied with PageMaker, 
you can also purchase additional sets of placeholder templates directly 
from Aldus Corporation. These sets of placeholder templa tes are mar
keted under the PageMaker PortfoHo trademark. To date, three packages 
are available for PageMaker on the Macintosh: Designs for Newsletters, 
Designs for Manuals, and Designs for Business Communications. Although these 
templates were originally created for version 3.0 of PageMaker, they work 
transparently with version 4.0, as they are automatically converted from 
version 3.0 to version 4.0 files when opened. To decrease the time it takes 
to load a template (the time it takes the program to convert the template 
from 3.0 to 4.0), you should save a 4.0 version of it by selecting the Save as 
option on the File menu, typing a new file name, and clicking the Template 
button before you click the OK button. 
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Figure 7.11 shows you a copy of one of the newsletter templates in
cluded in the Designs for Newsletters package. This particular model uses 
a newspaper style with columns. It contains two pages and is the model 
used in the tutorial that's included in the workbook that accompanies the 
template files. 

After opening a copy of a placeholder template, you are ready to replace 
the placeholder text blocks and graphic images with those of your own 
(refer to Chapters 5 and 6 for details on preparing text and graphics for 
importing into publications). The easiest way to do this is to get into layou t 
view and select the placeholder to be replaced. Then choose the Place 
command on the File menu (~+D). After selecting the name of the text 
or graphic file to use in the list box, be sure to click the Replacing entire story or 
Replacing entire graphic button before you click the OK button. PageMaker 
will substitute the text or graphic you chose to import for the one that you 
selected in the publication. You can then make any minor adjustments to 
the position or size of the text block or graphic image, if required. 

-·-====~ 

···--====== 
NOTES FOR 
TUTORIAL: -

Figure 7.11 : Copy of placeholder template from the Designs for Newsletters package 
\1 
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Creating Your Own Templates 
v 
You can, of course, create your own templa tes. The most natural way to 
crea te a template from scratch is to firs t crea te an actual publication that 
contains the layout grid and styles that will be reused. When you have 
comp leted the final version of the publica tion, you then need to d ecide 
whether to delete the text blocks and graphic images from the publica tion 
or retain them as placeholders. If you delete all the text and graphics from 
the fil e, you crea te a grid templa te. If you retain them, you create a 
placeholder template. 

Either way, you need to save the completed file under a new name, 
using the Save as command on the File menu. After typing in the new 
name, be sure to click the Template button before you click on the OK 
button to save it. To then use your template, you only need to open a copy 
of it, rename it, and replace or add the required text and graphic elemen ts. 

DESIGNING 
WITH STYLES v 

Paragraph styles are one of the most important fea tures in PageMaker. 
First introduced in version3.0,styles provide theeasiestand most consistent 
way to format the text of your publica tions. As you will see, the use of 
styles greatly simplifies and augments the design process as it applies to 
setting type. As enhanced in version 4.0, styles can now encompass simple 
graphics in the form of rules that can precede or follow the text of a 
particular paragraph. 

Through the style that you apply to a paragraph, you can control all 
aspects of its formatting, including: 

• The font, type size, type style, and leading of the paragraph text 

• The position (normal, superscript, or subscript) of the tex t in the 
paragraph 
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• The case (normal, all caps, or small caps) of the text in the paragraph 

• The color (black, paper, registration, or any custom color you 
add) of the text of the paragraph 

• The tracking (no track, very loose, loose, normal, tight, and very 
tight) of the text of the paragraph 

• The horizontal scaling of the characters (the set width percent
age) of the text in the paragraph 

• The alignment of the text (left, centered, right, justify, or force 
justify) in the paragraph 

• The indent of the paragraph on the left or right as well as the 
indent of its first line 

• The space that is to come before or after the paragraph 

• How many lines of the paragraph should always be kept to
gether on a page (widow and orphan control) 

• Whether to include the text of the paragraph in the table of 
contents 

• The size, color, and position of any rule tha t is to be drav.rn 
before or after the paragraph 

• The word and letter spacing (minimum, maximum, and desired) 
and leading method (proportional or top of caps) of the text of 
the paragraph 

• The type of tabs and position of the tabs applied to the paragraph 

• The type of hyphenation (if any), the limit of consecutive hy
phens, and the hyphenation zone of the paragraph 
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As is evident from this extensive list, you can control all paragraph 
formatting with styles. The only down side to styles is that their formatting 
must be applied uniformly to the text of the paragraph. In other words, the 
style can apply only one font, one type size, one leading value, and so on, 
to all of the text in the paragraph to which it is assigned. In order to have 
some of the paragraph text set in one font and another part set in a d ifferen t 
font, you must go beyond the use of styles alone and include the more 
traditional method of selecting the text to be formatted and then choosing 
the appropriate options directly from the PageMaker Type menu (for more 
information on how this is done, see "Overriding the Style Formatting" 
later in the chapter). 

Despite this limitation, you will find that most of the publications you 
create in PageMaker can be formatted, if not entirely, then mostly through 
the use of styles. Because styles give you so much freedom in the area of 
type design, don' t overlook them for even the simplest of projects. "The 
Old Pond" haiku by Basho shown in Figures 7.12 through 7.14 illustra tes 
this point. This simple publication uses four styles: Title, Text, Japanese text, 
and Credits. 

The Old Pond 

Old pond! 
frog jumps in -

the sound of water. 

Furu ike ya 

kawazu tob1komu 

mizunooto 

-Basho 

Figure 7.12: "The Old Pond" with title in lTC Berkeley Old Style and text in Humanist 521 Light 
v 
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The Old Pond 

Old pon d! Fwu ike ya 

hog jumps in - l.awaz.u tobikomu 

the sound of water. mizu no o lo 

-Basho 

Figure 7.13: "The Old Pond" with title in Souvenir and text in Bernhard Modern 
V' 

The Old Pond 

OUporuf! 
frog jumps in

tlie sound of water. mizu M oto 

-Basho 

Figure 7.14: "The Old Pond" with title in Isbell Medium and text in Zapf Chancery 
V' 
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The Title style is applied to "The Old Pond," the title of the haiku. It 
centers the text of the title in the text block. In the first version shown in 
Figure 7.12, thestyle uses the fontlTC Berkeley Old Style Blackin24 points 
with autoleading. The Credits style is based on the Title style. The only 
d ifference between the Credits style and the Title style is that Credits right
aligns the text and changes the type size to 14 points. The Text style is 
ap plied to the English translation of the haiku. This style is left-justified. 
In the first version shown in Figure 7.12, this style uses the font Humanist 
521 Light in 18 points with 20 points of leading. The Japanese text style is 
applied, of course, to the phonetically transcribed Japanese that appears to 
the immediate right of the English translation. This style is based on the 
Text style. As such, it uses the same formatting as the Text style except that 
Japanese text reduces the type size from 18 to 10 points (the 20-point leading 
is retained to make it easy to align the Japanese with the English). 

Once the styles were crea ted and the text was placed in the original 
version of the publication shown in Figure 7.12, it was easy to create the 
two other versions shown in Figures 7.13 and 7.14. In each case, it required 
only two sim ple modifications to just the Title and Text styles. 

In the second version in Figure 7.13, the font for the Title style was 
changed from ITC Berkeley Old Style Black to Souvenir. Because the 
Credits style is based on the Title style, changing the font in the Title style 
also changed the font in the Credits style. The last modification involved 
changing the fon t in the Text style from Humanist 521 Light to BernJ1ard 
Modern. Because the Japanese text style is based on the Text style, making 
this font change to the Text style was the same as making it to the Japanese 
text style. The third version, shown in Figure 7.14, required the same 
simple changes to complete. Here, all that was required was to modify the 
font in the Title style to Isbell Medium and the one in the Text style to Zapf 
Chancery. 

Contrast this method for experimenting with different type combina
tions to the more traditional method, where you have to select the text in 
each paragraph, then individually choose the new font, and in some cases, 
type size for each one, using the appropriate options on the Type menu. The 
time savings afforded by making such rudimentary formatting changes 
through styles is significant even on this simple project. When this method 
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You can also use No 
style to create a new 
style from scratch by 
clicking on its name as 
you hold down the ~ 
key. 
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is applied to designing a really large or complex job, the time saved 
becomes even more impressive. 

Using the Default Styles 
v 
The program automatically provides you with several default styles 
whenever you start a ne\".' publication. You can then u se these styles as is 
or modify them as required . To see the defaultstylesheet- that is, the group 
of styles predefined for your publication- you need to display the Style 
palette on the screen. If thepalette is not already d isplayed when you open 
a publication, you can do so by selecting Style palette from the Windows 
menu or pressing~+ Y. Because this command is a toggle, you can remove 
it from the publica tion window by selecting the same option a second time. 

Figure 7.15 shows you the Style palette with the names of the styles that 
are automatically provided for you when you open a new publication. 

··· ·· ······················· ··········· . 

Figure 7.15: The Style palette with default styles 
v 

Subheod 2 
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Notice that the first one is called No shjle. This selection doesn't represent 
a bona fidestyleatall; instead, it is used to remove a previously applied style 
from a selected paragraph. Beneath No style, you see the names of the five 
actual styles provided for you. Table 7.2 briefly describes the contents of 
these five styles in the default style sheet. The style description contains all 
of the following that apply: 

• The name of the style on which the current style is based 

• The name of the style that will be automatically assigned to the 
next paragraph if you don't assign one yourself 

• The face (font), size, and leading assigned to the type in the 
paragraph 

• The indent for the entire paragraph and the indent for the first 
line of the paragraph 

• Whether hyphenation is active and whether the style is to be 
included in the table of contents 

Table 7.2: The Contents of the Default Style Sheet 

STYLE NAME STYLE DESCRIPTION 

Body Text next: Same style+ face: Times+ size: 12 +leading: auto+ flush 
left+ first indent: 0.3333 + hyphenation 

Caption next: Same s tyle+ face: Times+ italic+ size: 10 + leading: auto 
+flush left 

Headline next: Same style+ face: Times+ bold+ size: 30 + leading: auto 
+ flu sh left + incl TOC 

Subhead 1 Headline+ next: Same style+ size: 18 

Subhead 2 Subhead 1 +next: Same sty le+ s ize: 12 
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To view the contents of a style or to modify it, you can either hold down 
the~ key as you click on the name of the s tyle in the Style palette, or hold 
down the~ key as you select Style on the Type menu and then the name of 
the style in the pop-up menu that then appears. The former method is by 
far the easiest, provided that the Style palette is already displayed some
where on the screen. When you use either method, PageMaker displays 
the Edit style dialog box, where you can view a brief description of the 
contents of the style and make all necessary changes. Figure 7.16 shows 
you the Edit style dialog box for Body text, the first default style. 

Defining Your Own Styles 
v 
You can define styles for your own publications in several ways: you can 
modify the settings of one of the default styles; you can create a style from 
an existing paragraph that contains all of the formatting you want it to 
include; or you can create a style from scratch. 

,.. a File Edit Options Pa 

Edit style 

Name: 

Based on: I No style I 
NeHt style: I Same style I 
n~xt : Sam~ styl~ +fact : Tim.s + sitt : 12 + 
ltading : auto+ nush ltfl + fir st indtnt : 0 .333 + 
hyphtnalion 

Figure 7.16: The Edit style dialog box for Body text 
V' 

Windows 
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To modify an existing default style, you need only select the Edit style 
dialog box (as described above) and then make changes to the type and 
paragraph specifications and the tab and hyphenation settings as required 
(for details on how to do this, see "Creating a Style from Scratch" later in 
this chapter). 

If the default styles are not close enough to the settings you need, you 
will have to create new styles that do the job. 

Creating a Style from a Formatted Paragraph v 
One of the easiest methods for creating a new style is to define it from the 
format settings applied to an existing paragraph. This method allows you 
to experiment with various settings in a paragraph until you achieve the 
look you want. Then you can save the formatting settings in a new style so 
that they can be easily applied to other paragraphs in the publication. 

There are two ways todefineastyleusingexisting text. Bothrequireyou 
to select the text of paragraph whose formatting is to be used before you do 
anything else. If the Style palette is displayed on the screen, you can then 
hold down the ~ key as you click on the No style listing at the top of the 
palette. Thjs causes PageMaker to display an Edit style dialog box, like 
the one shown in Figure 7.17. Here, all you need do is type in the name for 
your new style a11d click the OK button to save it. The name that you enter 
will then be displayed in alphabetical order in the Style palette listing. 

The second method does not require that the Style palette be displayed 
on the screen, but does involve a few more steps than the first. After you 
select the text of the paragraph, you choose the Define styles command on 
the Type menu (or press ~+3). PageMaker then opens a Define styles dialog 
box simHaT to the one shown in Figure 7.18, where you see Selection as the 
selected style at the top of the list box and a description of the format 
settings applied to the selected paragraph at the bottom of the dialog box. 

To create a style using the format settings listed for Selection, you then 
click on the New button in the Define styles dialog box, which brings up an 
Edit style dialog box just like the one shown in Figure 7.17. The last step is 
to type in the name for your new style and click the OK button in thjs dialog 
box to save it. Note that beforesavingyournewstyle, youcanalwaysmake 
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File Edit Options Page Type Element Window s 

Name: 

Based on: I No style I 
Neut style: I Same style I 
next : Same style + face: ATRotis Sans Serif SS + 
bold+ size : 14 +leading : auto +track : normal + 
centered • hyphenation 

( Para ... 1 
[ Tab s ... 1 
( Hyph ... 1 

Figure 7.17: The Edit style dialog box that appears when text is selected and you click on No 
'V style 

modifications to the contents of the style using the options in the Edit style 
dialog box. 

Inconsistencies in the Formatting 
v 
Defining a style from existing text is an easy method provided that all 
formatting is uniformly applied to the text of the paragraph. If any 
attributes are not consistent in the paragraph-such as some words 
italicized in a paragraph that otherwise contains normal text-the program 
will mark these inconsistencies by placing the word mixed after the af
fected a ttribute in the description (PageMaker refers to such irregularities 
in the formatting as overrides). For example, if your paragraph mixed 
different type sizes in. the text, you would see 

size: mixed 

in the description at the bottom of the Edit style dialog box. 
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Fil e Edit Options Pa Windows 

Define styles n OK 

Style: ( Cancel ) 

Jelet lion :!1 
Body teHt 
Caption 
Headline 
Subhead I 
Subhead 2 

No sly l• + foco: ATRotis S~ns Strif55 + bold + s iz•: 14 
+ l•ading: auto+ track: norm~l + c•nl•r •d + hyphonation 

Figure 7.18: The Define styles dialog box that appears when text is selected and you choose the 
V' Define styles command 

Before you save a style, you need to delete any overrides tha t Page
Maker marks. To do this, you need to assign a new setting to the formatting 
in question . For instance, to remove the override on position caused by 
mixing superscript with regular text in the previous example, you would 
select Type on the Edit style dialog box, then select Normal from the Position 
pop-up menu. When you click the OK button on the Type specifications 
dialog box and return to the Edit style dialog box, the word mixed will no 
longer show u p in the style description. 

Creating a Style from Scratch 
v 
To define a new style from scra tch, you need to be able to specify the 
forma tting without first seeing its effect on the text. To begin the definition 
process, you select the Define styles option on the Type menu (or press ~+3). 
When the Define styles dialog box appears, you select the New option. This 



Page Composition and Layout V 305 

takes you to the Edit style dialog box, where you sp ecify all of its format 
settings. 

In the Edit style dialog box, you enter a new name for the style. The name 
you enter should be fa irly short (although the edit box will accept up to 32 
characters), so that you can see the s tyle name when the Style pa lette is 
displayed on the screen. 

Basing the New Style on an Existing One 
v 
The Based on option will contain No style unless you selected some other 
s tyle in the list box of the Define styles d ia log box before you clicked on the 
New button . If you want to base mostof thesettingson an existing style, you 
can do so by selecting the appropria te style name from the Based on pop
up menu. You can then use the other options su ch as Type, Para, and so on 
to make whatever modifications are required in the new style you are 
defining. 

Always use the Based on option when defining a style tha t is rela ted to 
one you've already defined. Not only does this speed up the process of 
defining the new style, it also makes it much easier to make modifica tions 
down the line. We've already touched on this aspect in the discussion of 
the three versions of "The Old Pond" haiku shown in Figures 7.12 through 
7.14. Because two of the four styles were based on existing styles, it 
required only two modifica tions to the original to change all four styles 
and create an entirely ne'"' version. 

In many publication designs, the different levels of headings share 
many of the same type specifica tions; only the type size or type style 
change to signal a new level. In this kind of rela tionship, the styles should 
be based on one another . Tha t way, a change to the style for the highest
level heading w ill be immedia tely reflected in all of the subheadings in the 
publication. 

Designating the Next Style 
v 
When defining a style, you can a lso designate the name of the style that 
should be automatically applied to the next paragraph in the publication 
(provided tha t the next paragraph does not already use a style that either 
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you assigned in PageMaker or you imported from a word processed 
document). To designate the style that should be used in the next para
graph, you need to select its name from the Next style pop-up menu. If you 
don' t select a style from this menu, PageMaker will automatically apply 
the same style to the next paragraph. 

The Next style option is useful in publica tion designs where one style 
always follows another. You can see this in Barnaby's Afternoon Menu, 
shown in Figure 7.19. In this menu, two styles were required for each 
selection listed under the Appetizers& Light Entrees and theSoup&Salad 
headings. The first style, named 1 tem, lists the name of the selection in bold 
and is a lways followed by a second style named Description that describes 
the dish in more detail. Because one or more lines using the Description 
style always follow the Item style, Description was chosen as the Next style 
option when defining the Item style. Thus, in the Story Editor, we only had 
to type in the name of the dish and assign it the Item style. Then, when we 
pressed the Return key to start a new paragraph containing the explanatory 
information abou t the selection, PageMaker would have alread y assigned 
Description as its sty le. Because the design of the menu sometimes required 
more than one line of explanation, the Next style option for the Description 
style was left to the default of Same style. 

After you specify the style name, the basic style, and the style to follow, 
you are ready to specify specific format settings in four areas-type, 
paragraph, tab and indent, and hyphenation settings-each of which has 
its own dialog box. 

Type Specifications 
v 
To make changes to the type specifica tions such as the font, type size, type 
style, and so on, you select the Type option on the Edit style dialog box. This 
brings up the Type specifications dialog box, shown in Figure 7.20 (identical 
to the one tha t appears when you select Type specs on the Type menu or 
press~+ T). When specifying type settings using the options in this dialog 
box, remember that these type specifications will be applied uniformly to 
all tex t in the paragraph to which you assign this style. 
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SHORE G HILL & SMOKE HOUSE: 

#\ 1Iit ~ rr f1U ® ® f1U M ~ f1U (ill 
Appetizers &. Light Entrees 

J ohnson's Oysters on the Half SheU 
1/2 dozen, Raw or Grilled with Garlic Dutter or BDQ Sauce ----------5.95 

Mussel's Marlnicre 
Shallots, White Wine, & Cream--·--------- ---------------6.50 

Steamed Manila Clams 
Garlic & White Wine--------- ·----------------6.50 

Smoked Norwegian Sa.lmon 
with Many Mustards Sauce----------------- -7.25 

Baby Back Ribs 
Applewood Smoked 5.95 

Petaluma Duck Sausage 
with Braised Red Cabbage & Drown Mustard-·· -----5.50 

Cheese Dellce 
Fried Mozzarella in Bread Crumbs with Marinara Sauce - ----------------3.95 

Warm Brie 
with Tomato Coulls & l'esto ---

Garlic Bread 
Garlic Butter, Parmesan, & Basil --

Sampler Platter (For Two) 
Barbecued & Garlic Orsters, Baby Back l'ork Ribs, 

------------1.95 

- --------3.00 

& Mussels Marinicrc served with sourdough brcad-----------·-------- 11.50 
Each Additional l'crson - ----------------------------------Add ---5.75 

Barnaby's Chuck Burger 
served with your choice of l'rcnch Fries or Cole Slaw ---------------------1.95 
with your choice of Cheddar or jack Cheese -----------------·-----------5.15 

Barnaby's Hot Dog 
1/4 lb. 100% all beef o n a Sesame Seed Steak Ro ll, 
served with )'Our choice of French Fries or Cole Slaw-------·-----3.50 
with your choice o f Cheddar o r jack Cheese --------3.95 

Soup &. Salad 
New England Clam Chowder 

Cup -------------------------------------------------2.50 
Bowl with sweet bagucuc ---------- ------------ 3.25 

Soup of the Day 
Cup----
Bowl with sweet baguette--··- ----

Dinner Salad 

-------- -----2.50 
- --3.25 

with Barnaby's Tarragon Vinaigrcnc----------------------- ------·2.50 
with Crumbled Maytag bleu chcese--------------------------·----------·3.00 

Caesar Salad ----------------------------------------------------------------6.25 

Figure 7.19: Barnaby's Afternoon Menu 
\1 
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,. c File Edit Options Page Type Element Windows 

Type specifications 

Font: 

Size: 

Leading: 

points 

points 
:====::~ 

Set width: I Normal It> I percent 

Color: ~ 

Position: I Normal I 
I Normal I It 

Case: 

Track: I No track I 

Type style: 181 Normal 0 Italic 0 Outline 0 Reuerse 

n OK ll 
[ Cancel ) 

[option s ... ) 

0 Bold 0 Underline 0 Shadow 0 Strikethru 

Figure 7.20: The Type specifications dialog box 
'V 

Paragraph Specifications 
v 
To make changes to the paragraph specifica tions such as the paragraph 
indents, the amount of space before or after the paragraph, the a lignment 
of its text, and so on, you select the Para option in the Edit style dialog box. 
When you do, PageMaker will display a Paragraph specifications dialog box 
like the one shown in Figure 7.21. As you can see from this figure, many 
options are available in th.is dialog box. 

The Indents edit boxes allow you to indicate how much the paragraph is 
to be indented from the publication margins or from the left or right edge 
of the column in which the paragraph is placed. To have just the first line of 
the paragraph indented (asitisin this paragraph), you leavethe leftindent 
setatOand specify a Firstvaluesuchas0.167inch. Tocreatea hanging indent, 
where the first line of the paragraph begins to the left of all remaining lines 
in the paragraph, enter a Left indent value such as 0.125 inch and a negative 
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... 

* File Edit Options Page Type Element Windows 
= llntHi n A 
.::...;::. 

Paragraph specifications ~ OK ll 
Indents: Paragraph space: ! Cancel ) 

Left ~inches Before I 0 I inches --···-····-········--··· 

First inches After jo I inches ( Rules ... ) 

Right 0 I inches ~ (spacing ... ) 

Al ignment: I Left I Di ct ionary: I US English I 
Options: 

0 Keep lines together 0 Keep with neHt ~ lines 

0 Column break before 0 Widow control ~lines 
0 Page break before 0 Orphan control ~lines 
0 Include in t able of con tents 

Figure 7.21 : The Paragraph specifications dialog box 
\I 

• ., 
~ 

value for the Firstindent suchas-0.125 inch. To create a nested indent, where 
both the left and right edges of the paragraph are indented from the 
margins, enter both a Left and Right indent value, leaving the First indent 
value set at 0. 

The Paragraph space options allow you to add extra space before or after 
the text of the paragraph. Use the After option to insert space between 
paragraphs without having to resort to using additional carriage returns 
in the text. N ote that any value specified for the Before option is not ad ded 
to the paragraph when that paragraph begins a column. 

The Alignment option contains a pop-up menu that gives you standard 
choices in the alignment of the paragraph text. These options include Left 
(the default), Center, Right, Justify, or Force justify. If you are creating a 
style for headings tha t you always want centered between the margins, 
select the Center option on this pop-up menu. If you are creating a style for 
the paragraphs that contain body text in the publication and you want this 
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text to be right-justified, select the Justify option. (For more information on 
type alignment, see Chapter 4.) 

The Dictionary option allows you to specify the dictionary PageMaker 
should use when spell-checking or hyphenating the paragraph. As dis
cussed in Chapter 5, Aldus Corporation offers several specialized dictio
naries in addition to the English d ictionary that comes with the program. 
If you p urchase an auxiliary dictionary, you can specify that it be u sed 
instead of the English dictionary when the program spell-checks and 
hyphenates paragraphs using thjs style. For example, if you were crea ting 
a style that was to be assigned to all French paragraphs in the publication, 
you would select the Fran~ais option on the Dictionary pop-up menu so that 
the French d ictionary would be used instead of the English dictionary in 
making all hyphenation decisions (see "Hyphenation Settings," later in this 
chapter) and in checking all spelling. 

As you can see in Figure 7.21, the Paragraph specifications dialog box con
tains quite a few Options that are activated simply by checking their boxes: 

• To have the text of a paragraph s tay together on the page, check 
the Keep lines together box. 

• To have the paragraph always begin a new column, check the 
Column break before box. 

• To have the paragraph always begin a page in the publication, 
check the Page break before box. 

• To have the entire text of the paragraph included in the table of 
contents, check the Include in table of contents box. Use this option 
when crea ting a style for a heading that should always be listed 
in the table of contents that you generate for the publication (see 
Chapter 8 for details on how to do this). 

• To have the last line of a paragraph always appear on the same 
page or in the same column with a certain number of lines from 
the next paragraph, you check the Keep with next box and enter the 
number of lines in its edit box. 
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• To avoid \•vidow lines in the paragraph text (lines at the begin
ning of a paragraph that are p laced on a different page or in a 
different column than the remaining lines), check the Widow 
control option and enter the number of lines that constitute a 
widow in the text (usually 1 or 2). 

• To avoid orphan lines in the paragraph text (lines at the end of a 
paragraph that are placed on a different page or in a different 
column than the rest of its text), check the Orphan control option 
and enter the number of lines that constitute an orphan in the 
text (usually 1 or 2). 

This Keep with next option is useful when you are creating a style for a 
heading and you want to ensure that when the heading appears at the 
end of a page or column, a minimum number of lines from the first 
paragraph of text always follow it. If PageMaker cannot place the heading 
with the number of lines you've specified at the bottom of a column or 
page, it will place the heading at the beginning of the next column or page. 
The widow and orphan controls work in a similar manner. If the number 
of lines you've specified as a widow are about to be positioned alone at the 
bottom of a column or page, the program wHl move them to the beginning 
of the next column or page so that they are with the rest of their paragraph. 
If the number of lines you've specified as an orphan are about to be placed 
alone at the beginning of new column or page, PageMaker will move the 
entire paragraph to the beginning of the column or page. 

Click the Spacing button in the Paragraph specifications dialog box to 
display the Spacing attributes dialog box, where you can specify the word 
and letter spacing for the text of all paragraphs that use your style (for 
detailed information on the spacing options, see "Controlling the Letter 
and Word Spacing" in Chapter 4). 

Click the Rules button in the Paragraph specifications dialog box to display 
the Paragraph rules dialog box, shown in Figure 7.22, where you can define 
a ru le that either precedes or fo llows every paragraph to which you assign 
this style. 

To place a rule in front of each paragraph, check the Rule above paragraph 
box. To place a rule after each paragraph, check the Rule below paragraph box. 
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When d efining a rule as part of the paragraph style, PageMaker allows you 
to specify the thickness of the rule (1 point by d efault), its color (black by 
defau lt), and whether the rule should extend the entire width of the 
column (the default) or just the width of the text of the paragraph. 

To change the thickness of the paragraph rule, click on the Line style pop
up menu an d select the desired line thickness or pattern (this pop-up menu 
contains the same options as the Line pop-up menu that you select from the 
Element menu, excep t that it lacks a Reverse option). To change the color 
of the paragrap.h rule, click on the Line color pop-up menu and choose your 
color. Your choices here are limited to Paper, Black, Registra tion, Blue, 
Green, or Red (see Chapter 9 for more iniormation on selecting colors for 
prin ti ng). 

If you want to have the paragraph rule ind ented from the edges of the 
column or the page margins by a cer ta in d is tan ce, you need to en ter 
the appropriate va lue in the Indent Left and Right edit boxes. In add ition to 
specifying left and right indents, you can specify the vertical distance 
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To reset the vertical 
placement and grid 
size to the default 
values, select the 
Reset button. 
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between the rule and the paragraph text that precedes or follows it. To do 
this, you select the Options button on the Paragraph rules dialog box. This 
takes you to the Paragraph rule options d ialog box, shown in Figure 7.23. 

As you can see,Autois the default for both types of paragraph rules. The 
Top edit box is used to position paragraph rules that are placed above the 
paragraph. Auto means that PageMaker aligns the upper edge of the rule 
with the top of the slug of the first line of paragraph text. To increase the 
amount of space between the rule and the first line of text, you enter a new 
value in the Top edit box. Note that the value you enter in this edit box 
increases the size of the slug of the first line to add space between the rule 
and this line of text. 

The Bottom edit box is used to position paragraph rules that are placed 
below the paragraph. Auto means that PageMaker aligns the lower edge 
of the rule with the bottom of the slug of the last line of paragraph text. To 
increase the amount of space between the rule and the last line of text, you 

,. 
* File Edit Options Page Type Element Windows • - lntltlnlf 
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:J Par Paragraph rules [ OK B ~ -
l nd 0 Rule abou e 

~ OK i l line style: 
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R line width: ···········~··· ··············· 

Indent: Left 
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Figure 7.23: The Paragraph rule options dialog box 
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Tip 
\1 
You can use the Align 
to grid and Grid size 
options to ensure that 
the baselines of text in 
adjacent columns are 
aligned even when you 
aren't using paragraph 
rules or creating styles. 
Just click the insertion 
point somewhere in the 
paragraph that's caus
ing the misalignment 
of subsequent para
graphs in the same 
column, then get to 
the Paragraph rule 
options dialog box 
and set these options 
as you would when 
defining rules. 

Tip 
\1 
To have the zero point 
on the tab ruler in the 
Indents/tabs dialog 
box aligned with the 
left edge of the col
umn, use the Text tool 
to click the insertion 
point at the beginning 
of a line of text in that 
column before you 
start to define your 
style. 

enter a new va lue in the Bottom edit box. Note that the value you enter in 
this edit box increases the size of the slug of the last line to add space 
between the rule and this line of text. 

If your publication contains multiple columns and you want the text of 
the paragraphs that follow a paragraph rule always to align with the 
baselines of text placed in adjacent columns, you need to check the Align to 
grid box and enter the leading value used in those paragraphs in the Grid 
size edit box. For example, if the colwnn text is set in 10 points with 12-
point leading, you would enter 12 in the Grid size edit box. That way, you 
can be sure that the program will always insert sufficient space after a 
paragraph rule so tha t the baselines of subsequent text align with those in 
adjacent columns. 

Tab Settings 
v 
To make changes to the types of tabs or tab settings for the style, you select 
the Tabs option in the Edit style dialog box. This brings up the Indents/tabs 
dialog box, shown in Figure 7.24. You can use the tab ruler and options in 
this dialog box to specify paragraph indents or tab stops for your style. 
Here, you not only designate the position of your tabs but also their type. 
You can choose between left-aligned (the default), centered, right-aligned, 
and decimal-aligned tabs. You can also select a tab leader style for the tabs 
you create. 

The tab ruler that is displayed in the Indents/tabs dialog box already 
contains defau lt tab settings (every half an inch, if you're using inches as 
your system of measurement). The tabs are indicated by the flat down
ward-pointing triangles in Figure 7.24. You can move these default tabs to 
a new position on the ruler simply by dragging them. 

At the beginning of the ruler, you see two right triangles that point to the 
right, one on top of the other. The top triangle represents the indent for 
the first line of the paragraph. The bottom one represents the left indent 
for all of the lines of the paragraph. At the end of the ruler, you will see a 
left-pointing triangle that represents the right indent (it is not visible in the 
figure). You can set left, right, or first indents by dragging the appropria te 
triangle to a new position on the ruler. Note, however, that if you've 
already specified a left, right, or first indent for your style in the Paragraph 



Note v 
To change the tab 
settings for the entire 
publication instead of 
just for the paragraph 
style, select the 
Indents/tabs option 
on the Type menu 
(~+I) when no text is 
selected and make 
your changes. 

Note v 
The dashed vertical 
lines at the beginning 
and end of the tab 
ruler represent the 
margins or the edges 
of the column. They 
cannot be dragged to 
new positions. To 
change the margins, 
you must return to the 
Page setup dialog 
box. To change the 
column widths, you 
must adjust the 
column guides. 
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Figure 7.24: The Indents/tabs dialog box 
\1 
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Custom 

specifications dialog box, PageMaker will have already adjusted these 
triangles to their correct position on the tab ruler. There is no need for you 
to drag them to nevv positions unless you wish to edit the paragraph in
dents for your style. 

All default tabs on the tab ruler are left-aligned. If you wish to change 
the type of one of the default tabs, you need to click on the default tab stop, 
and then select one of the other icons that appear on the left side of the 
dialog box. PageMaker will then replace the left-aligned default tab with 
a tab of the type you've selected. 

The tab icon that's selected by default with the arrow bent to the left 
represents the left-aligned tab. The icon below it with the downward
pointing arrow represents a centered tab. The icon with the arrow bent to 
the right represents a right-aligned tab, and the one below it with the dot 
represents a decimal-aligned tab. To add new tabs to the ruler, you can 
click on the appropriate tab icon to select it, then click on the position on 
the tab ruler where you want it to appear. 
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Note v 
To scroll new parts of 
the ruler in view, click 
on the left or right 
scroll arrows in the 
Indents/tabs dialog 
box. 

PageMaker will show you how far your new tab is from the zero point 
by displaying this measurement in the Position box. A pop-up menu at
tached to the Position option allows you to add, delete, m ove, or repeat tabs 
on the ruler according to the value you place in this edit box. For example, 
to add a tab at 3 V2 inches on the tab ruler, you would type 3.5 in the Position 
box, then select the Add tab option from its pop-up menu. To remove a tab 
set a t 2 Y4 inches on the rul er, you would type 2.25 in the Position box and 
then select the Delete tab option. 

To move a tab, you would select it on the ruler, then type its new position 
in the Position box before selecting the Move tab option on the pop-up menu. 
To insert tabs at equal intervals on the tab ruler, you first place a tab at the 
increment from the zero point tha t you want all the tabs to be. Then, while 
it's still selected , you choose the Repeat tab option on the Position pop-up 
menu. For example, to have equally spaced left-aligned tabs a quarter inch 
apart, you would add a new left-aligned tab Y4 -inch in from the zero point, 
then choose the Repeat tab option. 

By default, PageMaker doesn' t assign any kind of leader character to a 
tab stop. If you would like to have some sort of leader character repea ted 
before the tab, select your option from the Leader pop-up menu (shown in 
Figure 7.24). You can choose between periods, dashes, or a solid line, or 
you can select the Custom option and enter your own leader characters in 
the Leader box. 

Assigning a leader style to your tabs can help strengthen the relation
ship between associated items that are set in columns, as Barnaby's Wine 
Lis t shown in Figure 7.25 shows. Here, the dashed-line tab leader has been 
assigned to the decimal-aligned tabs used in the Description s tyle, which 
is assign ed to lines of text that contain the name and description of the 
wineaswellasits price. Note tha t because the leader is assign ed w ith 
the Leader option on the Indents/tab dialog box, PageMaker varies the number 
of dashes to accommodate wine descriptions of different lengths in the 
same column space. 

Hyphenation Settings 
v 
To change the hyphenation settings for your s tyle, you select the Hyph 
option in the Edit style dialog box. This brings up the Hyphenation dialog box, 
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Aperitifs 
Barnaby's Wine List 

Dubonnet ·--------·------·1.75 
Cinzano ·------·----- ·- - ·---·--- --·--·· 1.75 
Ullet ·-------------·---------2.00 
\Vine Cooler· ----------2.00 

Sherry 
Emilio l.ustau Dry Amoncillado JL .. l.o.s Arcos"----·2.00 
l.u.srau Alamccnist:t Oloroso de Jerez 

l / l /3llllorrego ·----·----·--·-----·--·2.50 
l.ustau l::l.!tt Jndia Solen. Crc01.m Sherry ---- ·---·-2.50 

Sparkling Wines 
l';ml Chcncau Blanc de Ulana Brut NV ·-- - ·-- 10.00 
Korbel llnJt " Natural" "86 -----------20.00 
l 'lpcr-Sonoma Blanc de Nolr. "86·------20.00 
I ron l-lorM: lllanc de Noirs "Wedding CU\"CC .. '87 --25.00 

Chcnin Blan c 
Kenwood Dry California ·us------·------·9.50 
Dry Creek Sonomo County "88·----- ·- ·--10.00 

S:ou,•ignon Blanc- Fume Blanc- Scm ilion 
l'rc.ston .. CuvCc FumC .. '88 ---·- --------· t 2.00 
C:armcnct Sonoma Councy '88 - -·------12. 75 
Murphy·Goode Alexander Voller '88 ·-- -----13.00 
l.olonis Mendocino County '85 ·---·-----13.00 
Gr.tnd Cru Sonoma County '88--·----·-·- 13.50 
Iron Horse Alexander Valley '88·---------14.50 
Matanzos Creek Sonoma County "88 ·--·--·--- 16.50 
Cakcbrc:td Cellars Napa Valley "88 ---·------·18.00 
Clos du Val Scm ilion Napo Valley '86 ----· 13.75 

Joharmisbcrg Riesling 
The Firc$10nc Vincya.rd Sant~ YnC"L ValiL-y '89 -- 10.00 
Fetzer Coli(ornla '89 -----------11.00 

Zinfandel 
Sausol P.R. Alexander Valley "87 ·---------18.00 
llop Kiln Hussian River Valley '88 ·-··-·--·---·--·· 16.00 
Storybook Mountain Nap• Valley '86 ·--·--·---- 16.00 
~'• lie Dry Creek Voile)' '88----------- 18.00 
I lop Kiln " l'rimitivo" '85 ·--·---(Magnum) 30.00 

Mcrlot 
Franciscon l'apa Valley Oakville Estate '87 --·16.50 
Clos Du llols Sonoma County '87 ·-----·-- ·· 18.50 

House Wines 

Kir-------·---------1.75 
Kir Royale ------·--------·---2.75 
Mimosa----------------3.00 
Bellini ----------------3.00 

Port 
Field in Cali(oml• Port ------·---------2.50 
Gr.tham's Porto 6 Grapes Vintage Char.tacr ---2.75 

t"or Two (187m!) ·---------·-------6.75 
Churchill Graham Finest Rcscrva l'on------- ----2.75 

Rose 
Hop Klln Whi te Zlnfandcl Russian R.V. "89 ·----· 12.00 
llonny Doon Vln Grls de Clgare "89 - --·--11.00 

Cewiirztramincr 
Na>-arro Dry Estate llottled '88 ·----------- 12.00 

Chardonnay 
llclvedcrc Russian River Valley '88 ----·---·16.00 
Cha1eau Souvcraln Cameros RcSC r'\'C '8 7 ----- 17.50 
u Crema Coli(ornl• '88·-----------18.00 
Sonoma-Cmrcr "Jtussian River Ranches .. '88 ---20.00 
Fcrrari-C;arano Alexander \';alley '88 -------25.00 
Acocio Comeros '88 -------------22.00 
Kent Ramussen Napa Valley '88 --·-·------23.00 
Sonoma-Cutrcr "Lcs Plcrrcs Vineyard" '87 ·-----·30.00 
ZD Winery Napa Valley--·------·(Split) t-1.50 

Syrah-S irah 
Prcs1on Dry Creek Valley "8i -----·----17.00 

Cabcmet Sauvignon 
Geyser Pcok Alexander Vo.lley '86 ·-----·--·-12.00 
Oenzlgcr of Glen F.lien Sonoma County "86 ---- 14.00 
tau rei Glen Sonoma Mountain '87 - - ------32.00 
Cain "Five" Nopa Valley lied Table Wine '86 ·- - - -·35.00 
Coymus "Napa Valley Cuvec" '87·-------22.00 
Co)mus "Napa Valley Cu•-l:e" "86-----(Split) 12.00 

Pinot Noir 
Saintsbury "Garnet" Cameros '88 - --·---13.00 
Husch Andcr.on Valley '87-----------16.50 

Geyser Peak Chablis ·-··----··-·-·- ··-·-·-·-----· .. -----gl. I. 75 ·--112 carafe 3.75 -----car•fe 7.50 
Gerser l'eak Bui"J:landy ·-··-·--·----·--·--···-··--·-- ·-- ·-gl. 1.75 ·--112 c:tra(c 3.75 ·------carafe 7.50 

Non-Alcoholic Crape Juice 
NaY.arro 11inot Noir '88 ·--·--·--- ·-------·-·-----gl. 1.75 ·--·--·btl. 6.UU 
N;l\'arro Gcwtirar::mtincr '88-----------·--gl. 1.75 ----btl. 6.00 

Dcsscn Wines 
Quody Esscnsia Or.tngc Musc:tt Coliforni• '86 ·---·----gl. 2.00 ----·-·I>Li. 9.00 
Qu•dr t:llysium Block M•,.c•t Coli fornia "86 ·-------gl. 2.00 ----·btl. 9.00 
Kal:tn• " !;special de Cafc"···--·----·-----·---·-·---····gl. 2.00 ·--w/J:o(fec 2.75 
Mas de Bellevue Museu de l.uncl --- - ·---·-------------gl. 2.SO 

Figure 7.25: Barnaby's Wine List 
v 
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shown in Figure 7.26. To have PageMaker automatically hyphenate the 
text in paragraphs to which you assign the style you are creating, you will 
want to click on the On button to activate it and make sure that the Manual 
plus dictionary button is also selected . Many times, you will also want to 
select the Limit consecutive hyphens to box and enter a maximum value (No 
limit is thedefault)./\. lotofhyphenson the right margin oftextcan hamper 
the paragraph's legibility (for more detailed information on selecting 
hyphenation, see '~Controlling the Hyphenation of Text" in Chapter 4). 

Completing the Style Definition 
\1 
When you've selected all formatting selections that belong in your new 
style, you need to select the OK button in the Edit style dialog box and select 
the OK button in the Define styles d ialog box. To make sure that your new 
style definition is saved in you r publication file, you should then select the 
Save option on the File menu (or press ~+S). 

,.. c File Edit Option s 

Edit style 

Nome: 

Based on: 

Neut style: 

n~xt : Same style + 
leading: auto + 

Hyphenation 

Hyphenation: @ On 0 Off 
0 Manual only 
@ M anual plus dictionory 
0 M onuol plus algorithm 

limit consecutiue hyphens to: I No limit I 
Hyphenation z on e: 

Figure 7.26: The Hyphenation dialog box 
\1 

inches 
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Assigning Styles to Your Text 
v 
Once you have created all of the styles you need in the style sheet for your 
publication, you are ready to apply them to the paragraphs of your text. 
The easiest way to do this is to display the Style palette (~+ Y), click the 
Text tool somewhere within the paragraph that is to use the s tyle, and 
then select the style name in the Style palette. You can also assign a style 
for a selected paragraph by choosing the Style option on the Type menu 
and then selecting the style name in the pop-up menu that appears. 

If you want to apply a style to several paragraphs at once, you need 
to select all of them before you click on the d esired s tyle name. If you 
ever selec t a style in error, you only need to click on the paragraph with 
the Text tool and then click on the correct style name in the Style palette to 
change styles. Note that you can apply styles to paragraphs in layout or 
story view. Remember, however, tha t when you assign styles in story 
view, you may not be able to see all of the formatting effects defined by the 
style until you return to layout view. 

Overriding the Style Formatting 
v 
As we've indicated earlier, you can't mix attributes in a style, but this does 
not mean that you can' t override the style's formatting by making changes 
in the paragraph. To mix formatting without affecting the style so tha t 
your changes are registered as overrides, you first click the insertion point 
somewhere in the text of the paragraph and then select No sh;le in the Style 
palette. When you do this after you've applied the style, PageMaker d oes 
not remove any of the formatting assigned by the style; it merely cuts the 
link between the style and the paragraph so that any changes you make to 
the paragraph's formatting from that point on have no effect on the 
contents of the style. 

PageMaker will show that the style contains overrides by displaying a 
plus (+)after the style name in the Style palette. Overrides remain in effect 
even after you edit the part of the style that affects them. To change 
overrides so that they conform to the rest of the settings used in the 
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paragraph text, you must specifically select the conforming settings for 
them and the appropriate Type options. 

If you are still experimenting with the type specifications of the publi
cation design, you won't want to cut the link between the paragraph and 
its style, because then changes made to the style won' t be reflected in it. In 
such a case, you just go ahead and make all necessary formatting changes 
to the paragraph text. 

Importing Style Sheets from Other Publications v 
If you have a style sheet in a publication that you've already created whose 
styles you would like to use as is or adapt in the publication you're 
currrently working on, you can easily copy them. To copy the styles from 
another publication, you select the Define styles option on the Type menu, 
then choose the Copy option. This brings up the Copy styles dialog box 
(shown in Figure 7.27), where you select the name of the publication or 
template that contains the styles you wish to use. 

If the style sheet you're importing contains style names that duplicate 
existing style names, PageMaker will sound the alert and display a warn
ing box containing the following message: 

Copy over existing styles. 

To have the program replace all existing styles with those in the publication 
you've selected, you must choose the OK button. If you want to avoid such 
replacement, click the Cancel button, and PageMaker will abandon the 
copy operation. 

If, after you've imported a style sheet, you find that you aren't going to 
use some of the styles, you can delete them by selecting them in the list box 
and then clicking on the Remove button. If you need to modify the contents 
of a style that you've imported, you need to select its name in the list box, 
then click the Edit button. While making your changes to the forma t 
settings, you can also change the style name by selecting the Name box and 
typing a new name. 



Page Composition and Layout V 321 

,.. It File Edit Options Po Windows 

Copy styles n OK n 
Ia Templates I ( Cancel ) 

D Application 
D Auery labels 
Ill : I 

D Brochure 2 
D Business cords 
D Calendar 

= HD 20 

nt x t : Sam• stylt + fact : H•lvttic• + sizt: B + l .. ding : 9 
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' 
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Figure 7.27: The Copy styles dialog box 
\1 

TECHNIQUES 
FOR PRECISION LAYOUT v 

Before we leave the subject of page composition and layout, we would 
like to introduce you to a few special techniques tha t can make designing 
the page a lot easier. The first techniqu e comes in handy when you have 
a page tha t requires d ifferent numbers of columns, such as a newsletter 
that sets one s tory in three columns and another in two columns on the 
same page. The second technique covers crea ting drop caps by manipulat
ing the initial letter as a separate text block. Finally, we look at tips to keep 
in mind when working with different elements on a page. 
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Combining Different Numbers of Columns on a Page 
V' 
To mix different numbers of columns on a single page, you must create the 
columns required to set the firs t story and drag-place its text into its final 
p osition iJ1 the upper part of the page. Then, once you've finished placing 
the firs t story, you're ready to redefine the number of columns and use 
them to place the text of the second story in a lower part of the page. You 
can keep going in this manner until you've placed all of the text that is to 
appear on the page. 

Figures 7.28 and 7.29 illustrate this process. In Figure 7.28, we d efined 
three columns to contain the first story in the top half of the page. After we 
defined the columns, we imported the text of the story and drag-placed it 
so that the text in each column extended no farther than the horizontal 
ruler guide placed right above a 6-point rule. 

Figure 7.29 shows the page after we changed the number of col
umns from three to two and placed the second story around a gra p hic. 

File Edit Options Page Type Element Windows 

Figure 7.28: Placing the first story in three columns 
v 
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Figure 7.29: Placing the second story in two columns 
v 

Norm ol"' 
Subheod 1 

Immedia tely after changing the numberof columnsfrom three to two, we 
placed the graphic between the two columns and defined its text wrap 
attributes so that text wraps around all four borders using the default 
standoff valu es. Then, we imported the text of the second story and placed 
it with manual text flow, as shown in the figure. 

Creating Drop Caps with Text Blocks v 
It's now time to look at one last method for creating drop caps in Page
Maker. This method requires quite a few steps, but it works well provid ed 
that the text on the page doesn't require a lot of editing to surrounding text 
tha t would cause the drop cap to move in relation to its associated 
paragraph. 
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1. Select the first letter of the paragraph with the Text tool, then 
choose Cut from the Edit menu (~+X). 

2. Drag-place a new text block outside of the one containing the 
paragraph, and select the Paste option on the Edit menu (~+ V). 

3. Select the initial capital letter, and enlarge it by selecting with 
the Size option on the Type menu or in the Type specifications 
dialog box (~+ T). 

4. Use the Pointer to position the drop cap at the start of the 
paragraph, as shown in Figure 7.30. If needed, narrow its text 
block. 

5. Select the text block containing the rest of the paragraph, and 
drag the lower window-shade handle all the way up to the 

s File Edit Options Poge Type Element Windows •• 
=0 Untitled 

:0§ Toolbow ~ :m 

a" ~- A lii: 
.-------- -----10 0 0 ~ !!!! 

""""': 

Figure 7.30: Dragging the drop cap into place 
v 

;;O.a Styles ~ 
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upper window-shade handle of the text block, as shown in 
Figure 7.31. 

6. Click on the lower window-shade handle to load the text icon. 
Then drag-place a new text block so it is positioned immedi
ately to the right of your drop cap and extends down as far as 
the baseline of the drop cap, as shown in Figure 7.32. 

7. Drag a horizontal ruler guide so that it's in line with the lower 
window-shade handle of the text block you just placed. 

8. Click on the lower window-shade handle to load the Text icon. 
Then position the Text icon at the intersection of the column 
(or margin) guide and the new ruler guide, and drag-place the 
rest of the text as shown in Figure 7.33. 

* File Edit Options Page Type Element Windows 

Figure 7.31 : Getting ready to reflow the block containing the main paragraph 
"il 
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Tip v 
The easiest way to 
move an item from a 
page is to drag it onto 
the pasteboard, then 
go to the new page 
and drag the item from 
the pasteboard into 
its new position on 
the new page. 

· · · C:irem·ipsum.·· 
consectetuer adipiscing elit, sed 
diam nibh euismod 

Figure 7.32: Drag-placing the text block to the right of the drop cap 
v 

Working with Several Elements on the Page v 
Many times when designing publica tions you will find yourself working 
with several graphic linages and text blocks on a single page. At such 
times, you may want to select more than one item to move or copy on the 
same page or to a new page of the publication. There are three ways to 
select more than one element on a page: 

• Select the Pointer and use it to drag a selection box so that it 
surrounds all of the text blocks and graphic images that you wish 
to group together. 

• Hold down the Shift key as you click the Pointer on each text 
block and graphic linage that you wish to group together. 
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Figure 7.33: Drag-placing the text block below the drop cap 
v 

• Choose the Select all option on the Edit menu (or press ~+A). This 
selects every element on the page (plus any that have been placed 
on the pasteboard). To exclude particular items on the page, you 
can then hold down the Shift key as you click on them. This dese
lects the particular text block or graphic image without deselect
ing all of the others on the page. 

When elements on the page overlap each other, you may have trouble 
selecting the text block or graphic image tha t you wish to use. If you find 
tha t continued clicking on a desired object always selects one that partia lly 
overlaps it, you need to choose the Send to back option on the Element menu 
(or press ~+B). This moves the overlapping object to the back of the stack. 
Then you can click on the desired element and select it with no problem, 
as it will now be on top. Note that you can also use the Bring to front option 
on the Element menu (or press ~+F) to bring an element from the back to 
the front of the s tack (provided tha t you can first select it with the Pointer). 
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If two elements completely overlap each other (as is the case when you 
crea te a reverse type effect, which places white lettering on a rectangle 
using a black or gray fill pattern), you need to hold down the~ key while 
you click the Pointer when a ttempting to select the hidden item. If you 
keep clicking the mouse as you hold down the~ key, PageMaker alter
nates between selecting the object on top and the one on the bottom (you 
will see only the handles of the block or the borders of the item on the 
bottom). 

ESSENTIAL 
TECHNIQUES 
v 
To SetUp 
Master Pages 1. Click on the Lor R page icon at the bottom of the publication 

window. 

2. Place any text or graphic element that is to appear o~ every 
page or almost every page of the publication in its proper 
position on the appropriate master page. 

3. To have the page number appear in a running head or foot or 
in some other place on the master pages, click the Text tool 
at the place where you want the numbers to appear and press 
3€+0ption+P. The page-number marker will be displayed as 
LM on the left master page and RM on the right master page. 

4. Add any column (see below) or ruler guides to the master 
pages that you need to h elp place the text and graphics 
fo r the publication. 



To Create 
Columns 

To Create 
Styles from 
Existing Text 
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1. Go to the page where you want the columns. Go to the master 
pages if you want your columns to appear on every page of the 
publication. 

2. Select Column guides on the Options menu. 

3. Enter the number of columns that you want in the Number of 
columns box (up to 20 maximum). 

4. If you want more or less than 0.167 inch or 1 pica of space 
between your columns, enter your new value in the Space 
between columns box. 

5. Select the OK option to have PageMaker create your columns. 
If you need unequal columns on the page, drag the column 
guides until the columns are the width you want. 

1. Format a paragraph of text that you've already placed on the 
page, using all of the Type options required to get the format
ting of the paragraph exactly as you want it. 

2. Select the formatted paragraph with the Text tool. 

3. If the Style palette is displayed, hold down the 3€ key as you 
click on No style at the top of the Style palette listing to get 
directly to the Edit style dialog box. If the Style palette is not 
displayed, choose the Define styles option on the Type menu or 
press 3€+3. With the style called Selection at the top of the list 
box still highlighted, click the New button in the Define styles 
dialog box to get to the Edit style dialog box. 

4. If you don't need to make any modifications to the style defini
tion, give your style a name, then select the OK option in the 
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To Create 
Styles 
from Scratch 

Edit style dialog box. Otherwise, use the options in this dialog 
box to make all desired changes before selecting OK. 

1. Choose the Define styles option on the Type menu or press 00+3. 

2. If you wish to base the contents of your new style partially on 
an existing style, click on its style name in the list box before 
you click the New button. Otherwise, just click the New button 
when the No style style name is selected. 

3. Enter the name for your new style in the Name box of the Edit 
style dialog box. 

4. If the Based on box says No stljle and you decide that you 
wish to build the new style on an existing one, or if the 
wrong style name is listed in this box, click on its edit box 
and drag down to the name of the style to use. 

5. If the Next style box says Same style and you wish to desig
nate a style that is to be automatically applied to new 
paragaraphs that follow, click on its edit box and drag 
down to the name of the style to use. 

6. To set the type specifications for your new style, click the 
Type button in the Edit style dialog box and make all of your 
selections. 

7. To set the paragraph specifications for your new style, 
click the Para button in the Edit style dialog box and make 
all of your selections. 

8. To set new tab and indent settings for your new style, click the 
Tabs button in the Edit style dialog box and make all of your 
selections. 



To Apply 
Styles to 
Your Text 
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9. To turn on automatic hyphenation in your new style, click the 
Hyph button in the Edit style dialog box and make all of your 
selections. 

10. To complete the definition of your style, select the OK 
button in the Edit style dialog box, then select the OK button 
in the Define styles dialog box. 

1. Either use the Text tool to click the insertion point somewhere 
in the paragraph to which you wish to apply the style, or select 
its text with the 1-Beam cursor. 

2. If the Style palette is displayed, click on the name of the 
style you wish to use. If not, select Style on the Type menu 
and then drag to the name of the desired style in its pop
up menu. 

3. If you need to apply formatting to just some of the text of 
the paragraph and don't want to affect the style, select the 
No style selection in the Style palette or in the Style pop-up 
menu on the Type menu before you make your changes. 



PRODUCING 
LONGER 

~PUBLICATIONS 
v 
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In this chapter, we examine a group of new PageMaker4 features designed 
specifically to make it easier to create longer publications such as books, 
manuals, magazines, and the like. These features all depend upon the Book 
command, which allows you to set up a connection between separate pub
lications. This connection causes the program to treat them as one publi
cation for purposes of printing and genera ting tables of contents and 
indexes. 

If you work with books, periodicals, or any of these longer types of 
publications, you will quickly come to appreciate these new features. 
Together with the new editing and typographic controls introduced in 
version 4.0, they make PageMaker a much more effective tool for publishing 
long documents. 

BUILDING A BOOK LIST 
v 

Note v 
PageMaker 4 uses the 
term book to denote 
any document that 
consists of more 
than one publication, 
whether the pub
lication is a book or is 
actually a catalog, 
manual, or some other 
kind of publication. 

Longer documents need to be organized into sections according to their 
natural divisions. For example, if you are publishing a book or manual, 
these sections will usually consist of the frontmatter (title, half title, 
copyright page, acknowledgments, table of contents, and preface or 
introduction), chapters, appendices, and index. Each section of the 
document is placed in its own PageMaker publication. 

You use the Book command on the File menu to establish the connection 
between each publica tion that belongs to the "book." When you select this 
command, the program displays the Book publication list dialog box, similar 
to the one shown in Figure8.1 . Here, you create the book list, which includes 
all of the publications in the work. 

In creating a book list, you establish both the contents and the order of 
the book. You use the book list to generate the table of contents and index, 
and to print a ll of the parts of the book as a single unit. By d efault, the book 
list of each publica tion contains its own file. You then have to insert the 
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Figure 8.1: The Book publication list dialog box 
11 

name of all other publications that are to be associated withitusingthe Insert 
option in the Book publication list dialog box. 

To add a publication to the list, you need to select it in the list box on the 
left, then click the Insert button. PageMaker will place the name of the file 
you just selected after the name of the current document in the Book list box 
on the right. If this file precedes the ctrrrent one in the book, you need to 
dick the Move up button to advance its position in the Book list box. You 
continue in this manner, selecting the name of the next publication in the 
book from the list on the left and placing it in the Book list box with the Insert 
button until you 've added all of the publications. If you ever find that a 
publication you've added should follow another one on the list, select it 
and then click the Move down button as many times as required to position 
it in its correct order. After you've finished listing all the publications, 



Note v 
Build a book list in 
each chapter that you 
index, so that you can 
create cross-refer
ences between 
chapters and make 
sure that each topic is 
indexed in the same 
way. See "Creating an 
Index" later in this 
chapter for details. 
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select the OK option to return to the publication, then use the Save 
command to save this list as part of the file. 

You need to create book lists in the publications that contain the table of 
contents and the index, as well as in nil publications that are indexed. In 
books, you will usually \•vant to locate the table of contents in a publication 
that includes the rest of the frontmatter (called 433FrntMatter for this 
book), but you will place the index in its own publication. Figure 8.2 shows 
the last part of the completed book list for this book that was created in the 
433FrntMatter publication. The book list includes the publications con
taining all nine chapters and the two appendices, plus the one for the 
index. The same book list was also placed in the index publication called 
433Indexpm. Because all nine chapters in the book are indexed, the same 
book list is built in each of them. 

Element Windows 

Dook publlcollon lis I ~ n OK g ~ ~.::.::.:::.:..::...=1 
=neiO>ti SeogoteD ~ ~ 
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Figure 8.2: Last part of completed book list for Mastering PageMaker 4 on the Macintosh 
"il 
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CREATING A 
TABLE OF CONTENTS v 

Once you've finalized all of the publications in your book, you can 
generate a table of contents for it. Before you do this, you must mark all 
paragraphs that contain the headings you want to appear in the contents. 
Although you can manually mark paragraphs for inclusion in the table of 
contents, the most efficient method is to define inclusion in the table of con
tents as a part of the style(s) that you apply to all headings that should 
appear in the table of contents. 

After you mark all of the paragraphs that are to be included in the table 
of contents, you open the publication that is to contain theta ble of contents 
and then generate it with the Create TOC command on the Options menu. 

Indicating Table Entries 
v 
To manually mark a paragraph, you must first select it with the Text tool 
by clicking the insertion point somewhere within it or by highlighting 
some or all of its text. Then, select the Paragraph option on the Type menu 
(or press ~+M) and check the Include in table of contents box at the bottom 
of the Paragraph specifications dialog box. 

To make inclusion in the table of contents a part of a particular style, you 
select the Para option in the Edit style dialog box, then check the Include in 
table of contents box a t the bottom of this Paragraph specifications dialog box. 
After that, all paragraphs that are formatted with the style will automati
cally show up in the table of con tents that you generate. 

Remember that you can streamline your efforts to mark headings with 
styles. To do so, first create a style for the firs t-level headings that includes 
the paragraph in the table of contents, and then base the styles for all other 
subsidiary headings that should also appear in the table of contents on it. 
For example, the table of contents for this book contains all first- and 
second-level headings in the nine chapters. To mark them for inclusion in 
the table of contents, an A Head style was created for first-level headings 
that called for their inclusion in the table of contents. Next, a B Head style 
for the second-level headings was crea ted based on the A Head style 
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(this style is identical except that it reduces the type and leading size and 
elimina tes the rule above the heading). To prevent third-level headings 
from being included in the table of contents, the C Head style used for these 
headin gs was not based on the B Head s tyle (it uses a different font as well 
as new type and leading size, anyway). 

Generating the Table of Contents 
v 
After you've marked all of your table entries, either manually or via a 
paragraph style that you assign, you are ready to generate the table of 
contents. To do this, you op en the publication where you want the table 
placed. This publication should already contain a book list that includes all 
publications that constitute the book. If this is not the case, you will need 
to crea te the book list before you proceed (see "Building a Book List" 
earlier in the chapter for details). 

When you are ready to create the table of contents, you select the Create 
TOC command on the Options menu. This brings up the Create table of 
contents dialog box shown in Figure 8.3. 

By default, PageMaker gives the title Contents to the first paragraph of 
the new table of contents that you create. If you wish it to haveanother title 
(up to 30 characters), you need to enter it in the Title edit box. If you don't 
want any title to appear at the beginning of your table of contents, you 
simp ly delete all text from this edit box. 

The first time you generate a table of contents for your book, the Replace 
existing table of contents option is ghosted. However, once you 've genera ted 
a table of contents, this check box is selected when you choose the Create 
TOC command, so that the new table you generate automatically replaces 
the old one. If you decide that you would like to generate a new table of 
contents and then examine its entries before replacing the existing table, 
you should uncheck this option. Also, if the publication you' re working on 
is included in a book list, the Include book publications check box is auto
matically selected in this dialog box, meaning thatPageMakerwill generate 
a table of contents for all publications included in the book list. If you want 
to generate a table of contents for only the current publica tion , you 
n eed to uncheck this option by selecting it. 



338 V Mastering PageMaker 4 on the Macintosh V CH a 

0 lll.•pltll:e <mi~tinq tnl>lf~ or l:<lntenh 
~Include book publications 

Format: 0 No page number 
0 Poge number before entry 
® Poge number ofter entry 

Between entry ond page number: r-1 ~-t----, 

Figure 8.3: The Create table of contents dialog box 
v 

PageMaker automatically includes the current page number for every 
paragraph that you've marked for iJ1clusion in the table of contents unless 
you choose the No page number button. By default, this page number fol
lows the text of the entry, as in 

Building a TOC ....... 535 

If you wan t the page number to precede the entry, as in 

535 ........ Building a TOC 

select the Page number before entry button. 
In the Between entry and page number edit box in Figure 8.3, you see the 

character " t, which indicates that PageMaker will place a leader tab 
between each table of contents entry and its page number . If you would 
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prefer to have some other character between the entries and page num
bers, you need to replace " t with the appropriate character (see the inside 
back covers for a lis t of other characters tha tyou can use and how you enter 
them into dialog boxes). If you select the No page number button, the Between 
entry and page number option automatically becomes ghosted. 

After making all required changes to the options in the Create table of 
contents dialog box, you are ready to generate the table of contents by 
selecting the OK button. When you do, PageMaker displays a dialog box 
containing a progress indicator to keep you informed of the generation 
process. If you are building a table of contents for a long document that 
contains many stories, the process will take several minutes as PageMaker 
crea tes a new table of contents story and then searches each page of all the 
publications in the book list to locate the marked entries. 

When the generation of the table is complete, PageMaker loads a text 
icon containing the table of contents as a new story, provided that either 
this is the first table of contents you've generated for the book or that you 
unchecked the Replace existing table of contents box in the Create table of 
contents dialog box before genera ting the table. You can then place the 
table of contents story in the current publication as you would any s tory 
that you'd imported. 

If you genera te a table of contents for the first time when you are in story 
view, PageMaker p laces the table in a new story window. To place the new 
story containing the table of contents into the publication, you need to 
select the Place command on the File menu (~+D) or click on the Close box 
in the window and choose the Place button in the alert box that then ap
pears. This loads a text icon, which you place on the page as with any other 
story. If you' re not generating the table of contents for the first time and 
you left the Replace existing table of contents box checked, PageMaker will 
replace the existing table with the newly generated table without requiring 
you to place it as a new story. 

Figure 8.4 shows you the first part of the table of contents for this book 
right after it was generated and placed in the Front Matter publication. 
Once a table of contents has been placed, you can edit it as you would any 
other publication text. If, however, you've crea ted a preliminary table of 
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Figure 8.4: First part of the table of contents for Mastering PageMaker 4 on the Macintosh right 
\7 after placing it in the Front Matter publication, using default TOG style 

contents and you anticipa te that you w ill Later have to regenerate the table 
of contents, you are well advised to hold off on making your editing 
changes until you know that you're working with the final version. 

Editing Table of Contents Styles v 
PageMaker generates default styles for table of contents entries whose 
paragraphs were formatted with styles. The table of contents style names 
consist of TOC plus the name of the style assigned to the paragraph. Fig
ure 8.5 shows the default TOC styles that were created when the table of 
contents for this book was generated. 

Three styles marked for inclusion in the table of contents-A Head, BHead, 
and Summary-were assigned to headings in the book. In generating the 
table of contents, PageMaker created three comparable TOC styles-



Tip v 
Remember you can 
get directly to the Edit 
style dialog box from 
layout view by holding 
down the 3€ key as 
you click on the name 
of the style in the 
Style palette. 
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Figure 8.5: Default TOC styles created for Mastering PageMaker 4 on the Macintosh 
V' 

roc A Head, rOC 8 Head, and roc Summary-plus a completely new 
style, roc title, to format the title Table of Contents in the first paragraph. 

The contents of the TOC styles are almost identical to their counterparts 
used to format the first-level and second-level headings in the book. There 
is one major difference between them and the TOC styles: the TOC styles 
contain a right-aligned tab at the outside margin that uses periods as the 
leader character (introduced as a result of u sing "t as the character 
between the entries and the page number) for placing the page number 
that is not present in their companion styles. 

Many times, you will have to edit the TOC styles to fine-tune the 
formatting of the table of con tents entries. Editing a TOC style is no 
different from editing any other paragraph style: you simply choose the 
appropriate TOC style name from the Define styles d ialog box (:J€+3) and 
select the Edit option to get to the Edit style d ialog box, where you make your 
changes to it. 
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Figure 8.6 shows you the preliminary design for the first part of the table 
of contents for this book after editing the TOC styles. First, we changed the 
bold type to normal, reduced the type size to 11 points, and changed the 
leader character for the right-aligned tab from a string of periods to None 
in the TOC A Head, TOC B Head, and TOC Sum mary styles. Next, we reduced 
the type size for the TOC title style from 30 to 24 points and added a left 
paragraph indent of 1 pica to the TOC B Head styles so that second-level 
headings are indented somewhat in the table of contents. Finally, we 
added a new TOC Ch Title style, which formats the name of the chapter and 
the page that it starts on. This information is not automatically generated 
in the table of contents and must be added manually. We based the new 
TOC Ch title style on the TOC A Head style to retain the font, type size, and 
tab settings. We did, however, change the type style from normal to bold 
and increase the amount of space before and after the paragraph. 
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Figure 8.6: First part of table of contents for Mastering PageMaker 4 on the Macintosh after 
V editing the TOC styles (preliminary design) 
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The procedure for creating an index for a longer publication is similar to 
the one we just outlined for creating a table of con tents. Of course, creating 
an index for a publication is a much more complex operation than ere
a tin g a table of contents for it, and this increased complexity is reflected 
in additional steps required in marking index entries. Nevertheless, if 
you've ever manually prepared an index for a long publication, you can't 
help but appreciate just hO\·V much PageMaker's indexing feature can 
reduce the tedium normally associated with indexing and, therefore, help 
you create a better index. And as everyone knows, a good, thorough index 
is a vitally important part of any technical or reference work. 

Developing any index, even one with PageMaker, requires advance 
planning. First, you need to identify the important topics in the publica
tion and d ecide how detailed the index should be (PageMaker allows you 
to create up to three levels for each index entry you mark). You also need to 
contemplate aJ ternate wording for each topic, decide which one repre
sents the best way to list the topic, and then decide whether you need to 
cross-reference the topic. For example, in creating the index for this book, 
we had to decideifmostreaders would look up information on using type 
under fon ts or n;pe, and further, whether to cross-reference these entries. 

Marking Index Entries 
v 
After you've completed your planning work on the index, you're ready 
to begin m arking the topics that you've identified to be included in 
the index. To mark the entries for a particular publication, you need to 
open the publica tion and locate the occurrence of the text that describes each 
index topic. 

The easiest way to locate specific topics in a publication is with the Find 
command on the Edit menu in story view. You can, of course, also locate 
the topic in layout view by using the Go to page command on the Page menu 
or by clicking on the page icon. Once you've located the first occurrence of 
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Tip v 
To mark an entry for 
the index without 
opening the Create 
index entry dialog 
box, select its text in 
the publication and 
then press ~+Shift+; 

(semicolon). This 
enters the selected 
text as a first-level 
entry using Current 
page as the page 
range. 

the topic in the publication, you can choose between two method s for 
marking it: 

• Choose the Text tool, use it to select the text you want to become 
the firs t-level index entry, then choose Index entry on the Options 
menu or press~+; (semicolon). The selected text will then show 
up ii1 the first Topic edit box in the Create index entry dialog box, 
meaning that it will become a first-level index entry. If you need 
to, you can then edit the text in this edit box. 

• Click the insertion point somewhere in the paragraph where the 
discussion of the topic you wish to index begins, select Index entry 
on the Options menu or press ~+; (semicolon), and then type in the 
first-level entry exactly as you want it to appear in the final index. 

The first method is best used when the wording of the firs t-level index 
matches wording in the text. If the wording matches, you can create the 
entry simply by highlighting text in the publication and then using it as is 
or editing it slightly in the Create index entry dialog box. The second method 
is best used when the wording does not match, so that you have to create 
the firs t-level index entry by typing it in the Create index entry dialog box. 

Figure 8.7 shows you the Create index entry d ialog box after using the first 
method to insert templates as the first-level index entry by selecting the 
word from the heading "Designing from Templates" in the Chapter 7 
publication. Notice from this figure that the Create index entry dialog box 
contains three edit boxes benea th Topic. The first box (which currently con
tains templates) is where you place your first-level entry. Below, you can 
see two nwre edit boxes for the second- and third-level index entries, 
respectively. 

Figure 8.8 shows you an example of a rela ted topic that requ ires both a 
first- and second-level entry. As part of the complete discussion on 
using templa tes in Chap ter 7, three subtopics need to beindexed:using 
grid templa tes, using placeholder templa tes, and creating your own tem
plates. In Figure 8.8, you see how we created the index entry for grid 
templates: first, we entered the major topic, templates, in the firs t-level edit 
box. Then, we entered the subentry, grid, in the second-level edit box. 
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Figure 8. 7: The Create index entry dialog box with templates as the first-level index entry 
v 

In a similar way, we created three other related entries for crea ting and 
defining templates. In all cases, we used templates as the first-level entry, 
varying only the second-level entry . Figure 8.9 shows you how the 
completed index entries on using templa tes are organized. When the final 
index is generated, the first entries under templates will be arranged in the 
following manner: 

templates, 289-294 

creating from publications, 294 

creating new publications from, 1 08- 109 

defined, 65 

When you complete an index entry, PageMaker places an index marker 
in the text. This marker is visible only when you are iJ1 story view, where 
it ap pears as a diamond within a rectangle, as shown in Figure 8.10. If you 
ever want to d elete an ind ex entry, you can do so by dele ting this index 
marker. 
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Sort Specifications 
v 
In Figure 8.7, notice the three Sort edit boxes immediately to the right of 
those in which you enter the first-, second-, and third-level entries. Here, 
you specify how each topic entry should be sorted in the index. For 
example, if you entered 3-D as your firs t-level iildex topic but want it 
sorted in the index as though you had entered three-dimensional, you would 
enter three-dimensional in the edit box under Sort tha t is immediately to 
the right of the one containing 3-D. 

You only need to enter a sort specification for an entry when you have 
marked the same topic in two different ways ii1 the ii1dex (such as L.A. and 
Los Angeles) and you want them to be sorted as though they had been 
entered the same way, or w hen your entry begins with a letter or special 
character tha t would place it ii1 a part of the ii1dex where your reader 
would not normally look (such as putting 3-D before the A entries instead 
of under the T entries). 
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Figure 8.9: The index entries on using PageMaker templates 
\1 

f 

The normal sort order used by PageMaker in arranging index entries is 
as follows: 

• Blank entry 

• Symbols such as !,#, %, and? in random order 

• Numbers in ASCII sort order, as in 1, 100, 2, 28, 3, and so on 

• Letters in alphabetical order 

Also, be aware tha t PageMaker does not sort words with accented 
vowels correctly (accented vowels are sorted as if they contained no 
accent). If you have two entries exactly alike except that one contains an 
accented vowel and the other does not, PageMaker will place the one with 
the accent after the one without the accent. 
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Figure 8.10: Index marker displayed in story view 
'V 

Setting the Page Range for the Index Entry 
v 
When marking an index entry, you must indica te the extent of the topic so 
that the program will insert the correct page range when you generate the 
index. The default Range option on the Create index entry dialog box is 
Current page. To indicate that the topic extends to the next style change in 
the publication, you need to click the To next style change button. To indicate 
that the topic extends to the next occurrence of a particular paragraph 
style, you need to select the To next occurrence of style button and then select 
the correct style name from its pop-up menu. To indicate that the topic 
discussion encompasses just the next few paragraphs, you need to select 
the For next_ paragraphs button and enter the number of paragraphs in its 
edit box. 

The Reference override options at the bottom of the Create index entry 
dialog box allow you to select between the bold, italic, or underline type 
style for printing just the page reference portion of your index topic. For 



Tip v 
Don't forget to build a 
book list that includes 
all the publications in 
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indexed. Then, you 
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references. 

Producing Longer Publications V 349 

example, if your basic index style uses normal text, you can make the page 
references s tand out by making them bold; to do so, check the Bold box 
following Reference override. If, however, your index entry happens to be 
formatted with the type style that you have chosen as the reference 
override, PageMaker will print the page reference in the normal type style. 
For instance, if you check the Italic box and then format the index entry in 
italics, the program vvill display the page reference in the normal type style. 

Specifying Cross-References 
v 
To cross-reference your entry with another topic in the index, you select 
the Cross-reference (x-ref) button in the Create index entry dialog box under 
Range. When you do, PageMaker activates the X-ref button located on the 
right side of the dialog box under the Topic button. To crea te ~he cross
reference, you then click the X-ref button, which brings up a Select cross· 
reference topic dialog box similar to the one shown in Figure 8.11 . 

This dialog box contains an alphabetical lis t of all the topics in the 
publication that have been indexed so far. To increase the lis t to include all 
the index topics from all the other publications in the book, click on the 
Import button. PageMaker will then read in all topics in the publications 
included in the book list. 

The program shows only a list of topics that begin with the same letter 
as the topic for which you're creating the cross-reference. For example, in 
Figure 8.11, you see the Ustings under T because we were creating a cross
reference between the topics tables,creatingnew and Table EditOJ'in the index. 
As the current topic is Table Editor, the Select cross-reference dialog box shows 
only the T topics in the index. To see the topics in another section of the 
alpha b et, you need to use the Topic section pop-up menu and drag to 
the appropriate letter, or you can also use the Go to next button to advance 
to the next section of the alphabet tha t contains index topics (the program 
will skip any letter that does not currently contain any index topics). 

Once you've located the topic you wish to cross-reference, you click on 
it to select it and choose the OK option in the Select cross-reference dialog 
box. Then, you choose OK in the Create index entry dialog box to complete 
the procedure. If the entry for which you're creating the cross-reference 
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Figure 8.11 : The Select cross-reference topic dialog box 
\1 

has already been added to the index using a Range option that has a page 
reference, the program will display the cross-reference as See also in the 
final index; for example, 

fonts, 114, 125-130. See also type 

If the entry does not have a page reference-that is, you add to the index 
using only the Range option Cross-reference (x-ref)- the cross-reference will 
appear as See in the final index, as in the following example: 

Aldus PageMaker. See PageMaker 

Editing Topic References 
V' 
After you've finished marking the index entries and cross-references in all 
publications of the book, you are ready to check your index topics for 
consis tency and then preview the index. When preparing an index for a 
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long publication that is composed of several sections, you often find that 
topics must be indexed more than once. In marking index topics indepen
dently, it is easy to enter the same topic in the Create index entry dialog box 
in a slightly different manner. For example, in marking entries on using the 
Adobe Type Man ager with PageMaker, we could easily end up with 
entries listed under both ATM and Adobe Type Manager (ATM). To avoid 
such inconsis tencies, you can check the list of indexed topics to see how 
you previously indexed the topic as you create your new index entry. 

To check how previous entries are indexed, click the Topic button on the 
right side of the Create index entry dialog box. This brings up the Select topic 
dialog box. This dialog box is arranged just like the Select cross-reference 
topic dialog box. Instead of indicating cross-references, you use the options 
in the Select topic dialog box to examine how existing entries are indexed 
and, perhaps, use them as replacements fo r the entries you are about to 
create. 

If you want to see the index topics for all of the publications in the book, 
click the Import button before searching the entries. Then, use the Topic 
section pop-up menu or the Go to next button to see how existing index 
entries are treated . If you locate a related topic in the list and d ecide that 
you would like to use its wording instead of the wording you selected or 
entered for the new index entry, select the topic in the dialog box, then 
select the OK button. This will cause PageMaker to replace the Topic 
you've entered in the Create index entry dialog box with the topic (in
cluding the first-, second-, and third-level entries) you chose in the Select 
topic dialog box. 

Previewing the Index 
v 
Even when you've used the Topic button to check the consistency of your 
entries, it is still a good idea to preview the contents of your index before 
you generate it. This gives you a chance to d o a more comprehensive check 
of your entries, making sure that they are consistent and all have proper 
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Note 
v 
You can preview the 
index from any pub
lication in the book. 
Just make sure, 
however, that you've 
built a book list in the 
publication that in
cludes all publications 
where you've marked 
index entries. 

page references. (Entries that are marked in text that is no longer properly 
placed in its publication will not have proper page references.) 

To preview your index, choose Show index on the Options menu. Page
Maker then assembles the index entry information for all of the publica
tions included in the book list and lists each entry in alphabetical order 
with its page reference in a Show index dialog box similar to the one shown 
in Figure 8.12. 
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Figure 8.12: The Show index dialog box 
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Note that you can preview different sections of the index by choosing 
a particular letter of the alpha bet on the Index section pop-up menu or by 
clicking on the Go to next button. 

The Show index dialog box not only lists all entries in alp habetical order, 
but also indica tes their page reference. If, however, the marked entry is 
currently not properly placed in the publication, the program will indica te 
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this by displaying one of the following codes under Reference: 

Code Meaning 

PB Pasteboard 

LM Left master page 

RM Right master page 

ov Unplaced text 

UN Unplaced story 

If an entry has been cross-referenced and does not use a page reference, 
PageMaker will indicate this with X-ref followed by the firs t letter of the 
topic to which it's cross-referenced. 

As you examine the index, if you locate an entry that should be deleted 
from the final index, you need to select it and then click the Remove button 
at the bottom of the Show index dialog box. If you locate an entry that should 
be edited, select it and then click the Edit button. This takes you to an Edit 
index entry dialog box similar to the one shown in Figure 8.13. This dialog 
box contains the same options as the Create index entry dialog box, allowing 
you to edit the first-, second-, and third -level index entries as well as the 
way the page references are determined and listed. After you make your 
editing changes in this dialog box, select the OK button to record the 
changes and re turn to the Show index dialog box. 

If you loca te an entry that requires a cross-reference, you select that 
topic and then click the X-ref button a t the bottom of the Show index dialog 
box. This takes you to the Create index entry dialog box, where the selected 
topic is displayed in the first-, second -, and third-level edit boxes and 
Cross-reference (x-ref) is automatically chosen as the Range option. To create 
the cross-reference, you click the X-ref button beneath the Topic button and 
select the index entry to cross-reference from the list of topics displayed in 
the Select cross-reference topic dialog box that appears. After you have 
selected the appropriate en try, choose the OK button in both the Select 
cross-reference topic and Create index entry dialog boxes to record the cross
reference and return to the Show index dialog box. 
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Figure 8.13: The Edit index entry dialog box 
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Once you've finished checking your index entries and making all 
necessary ed iting changes, select the OK button to update your index 
entries and return to the publication window. 

Generating the Index 
v 
To generate your index, create or open the publication tha t is to contain 
the index, then select Create index from the Options menu. This brings up the 
Create index dialog box shown in Figure 8.14. By default, PageMaker gives 
the title Index to the first paragraph of the new index that you crea te. If you 
wish it to have another title (up to30 characters), you need to enter it in the 
Title edit box. If you don't want any title, delete all text from this edit box. 

The first time you generate an index for your book, the Replace existing 
index option is ghosted. However, once you've generated an index, this 
check box is selected when you select the Create index command, so that the 
new index you are about to generate automatically replaces the existing 
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Figure 8.14: The Create index dialog box 
v 

one. If you d ecide that you would like to generate a new index and then 
examine its entries before replacing the exis ting one, you should uncheck 
this option. 

Also, if the current publication is included in a book list, the Include book 
publications ch eck box is automatically selected in this dialog box, meaning 
that PageMaker will generate an index for all of the publications in the 
book list. If you want just to create an index for the current publication, you 
need to uncheck this option. 

The Remove unreferenced topics check box is also selected by default. This 
means that PageMaker will remove any index entries that do not occur a t 
least once in the index text. For example, if you created an index entry 
called Wind surfing and then deleted the only paragraph in the book tha t 
referenced that topic, PageMaker would remove the Wind surfing entry 
when it generated the index because it is no longer tied to a page reference 
or cross-reference. If you want unreferenced index entries to appear in the 
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index (albeit without page references or cross-references), you must un
check this option. 

Specifying the Format of the Index 
v 
Before you generate your index, you may want to alter some of the 
formatting defaults. To do this, you click the Format button in the Create 
index dialog box. This brings up the Index format dialog box shown in 
Figure 8.15. 

As you can see from this figure, quite a few formatting options are 
available. By defauJ t, the Include index section headings check box is selected. 
This means that PageMaker will precede each group of index entries with 
the appropriate letter as the section head (A, B, C, and so on). If you don't 
want these letters used as section heads, uncheck this option. 

Notice, however, that the Include empty index sections check box right 
below is not selected. This means that PageMaker will not include letters 

r S File Edit 

Create lndeH 

Titre 
lndeu format 

OH 
O 1 1811nclude indeH section headings ~ 
18! R 0 Include empty indeu sections 

Format: ®Nested 0 Run- In 

Following topic: Page range: 

¢ OK D 
( Cancel ) 

I ~ .. 
Between page #s: Before H-ref: I· ~> 
Between entries: Entry end: 

Example: l ndexcommand' 1-4 

Index entry 1, 3. See abo Index mark- up 

Sho"' index 2-4 

Figure 8.15: The Index format dialog box 
v 
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as section heads when there are no index entries for that letter. In other 
words, if your index contains no entries that begin with x, X will not appear 
as a section head. If you want all letters to be used as section heads even 
when they have no entries, you must check this box. 

The Format option is used to choose the Nested or Run-in layout for your 
index entries. By default, the much more common Nested formal is selected. 
An example of how this layout looks appears next to Example at the bottom 
of the Index format dialog box (see Figure 8.15). With the Nested format, each 
first-, second-, and third-level topic and page reference is placed on its 
own line. With the Run-in layout, the topics and references continue on the 
same line. PageMaker starts new lines only when the line length forces text 
to wrap to a new line. As a result, when you choose the Run-in option, you 
can' t control the placement of each index entry and page reference. 

Six options allow you to select which characters are to be used to set each 
part of the index entry. Note that the"> character in the edit boxes s tands 
for an en space, and the"= character stands for an en dash (see the chart 
on the inside back covers for a full list of special characters). These options 
can be summarized as follows: 

• The Following topic option determines the character to be placed 
between each topic referen ce and its page number or cross
reference. The default is two en spaces. 

• The Between page #s option determines the character to be placed 
between multiple page references for a single topic. The default is 
a comma followed by an en space. 

• The Between entries option determines the character to be placed 
between subentries when you use the Run-in layout. The default 
is a semicolon followed by an en space. 

• The Page range option determines the ch aracter to be placed 
between a range of page numbers. The default is an en dash, as in 
112-120. 
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• The Before x-ref option determines the character to be placed 
between a topic reference (or page reference) and a cross-refer
ence. The default is a period followed by an en space. 

• The Entry end option d etermines the character to be placed after a 
final topic reference when using the Nested layout, or after each 
reference when using the Run-in layout. PageMaker does not 
supply a default character for this option. 

After you've finished making all your changes to the format in the Index 
format dialog box, select the OK option to return to the Create index dialog 
box. Once there, you can begin generating the index by selecting its OK 
button. When you do, PageMaker displays a dialog box containing a 
progress indica tor tha t keeps you informed of the index generation 
process. If you are building an index for a long document, the process will 
take several minutes as PageMaker creates a new index story and then 
searches each page of all the publica tions in the book list to locate the 
marked index entries. 

When the generation of the index is complete, PageMaker loads a text 
icon containing the index as a new story, provided either that this is the 
index you've generated for the book or that you unchecked the Replace 
existing index box in the Create index dialog box before generating the index. 
You can then place the index story in the current publication as you would 
any story tha t you'd imported. 

If you generate an index for the firs t time when you are in story view, 
PageMaker places the index in a new story window. To place the new story 
containing the index into the publica tion, you need to select the Place 
command on the File menu (~+D) or click on the Close box in the window 
and choose the Place button in lhe alert box tha t then appears. This loads 
a text icon, which you place on the page as with any other story. If you're 
not generating the index for the first time and the Replace existing index box 
was checked, PageMaker will replace the existing index with the new 
index without requiring you to place it as a new story. 
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When PageMaker generates the index, it creates specific index styles based 
on the contents of your index. These styles are automatically added to the 
Style palette and can include: 

• An Index Ievell style, which is applied to all first-level index 
entries. 

• An Index level 2 style, which is applied to all second-level index 
entries. If your index has no second-level entries, PageMaker 
does not crea te this style. 

• An Index level 3 style, which is applied to all third-level index 
entries. If your index has no third-level entries, PageMaker does 
not create this style. 

• An Index section style, which is used to format all index section 
headings (such as A, B, C, a11d so on) . 

• An Index title style, which is used to forma t the title tha t you 
assigned to your index. 

After you've placed the index in your publication, you ca11 modify its 
contents just as you would any other paragraph s tyle. 

ESSENTIAL 
TECHNIQUES v 
To Create 
a Book List 1. Open the document where you want the book list to be built. 

Usually, you will add a book list to the publication that contains 
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To Create a 
Table of 
Contents 

the frontmatter and the index, as well as all the publications 
that are indexed. 

2. Choose the Book option on the File menu. 

3. Select the name of the publication to be added to the book list 
in the list box on the left. 

4. Click the Insert button to add it to the Book list box on the right. If 
it is not in proper order, click the Move up or Move down button as 
required to properly arrange it. 

5. Repeat steps 3 and 4 until you've added all the publications 
in your book, then select the OK button and choose the Save 
option on the File menu to save your book list as part of the 
current publication. 

1. First, mark each heading in all publications in the book that is 
to be included in the table of contents. To do so, either click the 
insertion point somewhere in its paragraph, select Paragraph on 
the Type menu (~+M), and check the Include in table of contents but
ton; or assign a style to it where inclusion in the table of con
tents is part of the paragraph specifications. 

2. Open the publication where you plan to place the table of 
contents. 

3. Choose Create TOC on the Options menu. 

4. Indicate the title of the table of contents, whether the table of 
contents should include all book publications or just the cur
rent publication, how the page references should be formatted, 
and what character should be placed between the entries and 
page numbers by using the options in the Create table of contents 
dialog box. Then, select OK to generate the table. 
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5. Place the table of contents in the current publication just as you 
would any other document that you've created with the Story 
Editor or imported into PageMaker. 

6. Make any desired formatting changes to the table of contents 
by editing the TOC styles created when the table was generated. 

1. Mark each index entry in all publications in the book that is to 
be included in the index either by clicking the insertion point 
somewhere in the appropriate paragraph, or by selecting the 
term you wish to use as a topic reference and then choosing 
Index entry on the Options menu (:}€+;). 

2. Enter any second- or third-level topic reference in the Create 
index entry dialog box. 

3. Select the appropriate Range option on the Create index entry 
dialog box to indicate the length of the discussion. If you want 
to cross-reference the topic with another, select Cross-reference 
(x-re0, click the X-ref button, and select your cross-reference topic. 

4. After specifying all your options for the index entry, select OK 
to add it to the publication. 

5. Repeat steps 1 through 4 until you've marked all your index 
entries in all the publications in the book. 

6. Select Show index on the Options menu to preview the index and 
check its contents. Use the X-ref, Edit, and Remove options to 
make all necessary editing changes. 

7. Open the publication where you plan to place the index. 

8. Choose Create Index on the Options menu. 
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9. Specify the title for the index and what should be included in it 
using the options on the Create index dialog box. If you need to 
make changes to the formatting, click the Format button and make 
your changes using the options on the Index format dialog box. 
Then select OK to return to the Create index dialog box, and 
select OK a second time to generate the index. 

10. Place the index in the current publication just as you would 
any other document that you've created with the Story Editor or 
imported into PageMaker. 

11. Make any desired changes to the formatting of the index by 
editing the index styles created when the table was generated. 
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Printing represents the last and most important step in the publishing 
cycle. After all, in desktop publishing, the printed version of the Page
Maker publication is the product for which you have labored. As such, it 
must be perfect in every detail. Mistakes in the printed pages, if not caught, 
can be especially vexing, as publications tend to be mass-produced and 
widely distributed. Even if caught, mistakes can still be expensive when 
the printed pages represent camera-ready art that was used to produce 
printing plates, which have to be redone. 

In this chapter, we explore printing PageMaker publications. As long as 
you are printing the final pages with your own printer, printing publica
tions in PageMaker is much like printing with any other Macintosh 
program. If, however, you can only print page proofs with your own 
printer and plan to use an outside service bureau to print final pages, the 
printing procedure becomes a little more involved . 

The two most common reasons for having your publication printed 
outside are that the pages require higher-resolution printing than your 
printer can produce, or your publication uses color. Most laser printers 
used with the Macintosh can produce between 300 and 600 dpi (dots per 
inch). Although this resolution is sufficient for most interoffice publica
tions such as fliers and forms, many people do not consider it sufficient for 
any mass-produced publica tions tha t are to receive wide circulation, such 
as ads, annual reports, magazines, books, and so on. Such publications 
usually require a minimum resolution of at least 1270 dpi (dots per inch), 
which is the about the lowest resolution for the PostScript imagesetters 
used by your local service bureau. 

Printing quality color publications requires the services of a profes
sional p rinter (color laser printers) and involves the use of spot color or 
process color separa tions. As you will learn la ter in this chapter, Page
Maker 4 can produce spot color separa tions, and you can use its files with 
special color prepara tion programs like Aldus PrePrint to produce me
dium-resolution process color separa tions. You can then supply these 
color separations to your printer, who will produce the required pla tes 
and do the print run. 
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PRINTING 
FUNDAMENTALS v 

Note 
V' 
You can select the 
Chooser option on 
the Apple menu to 
choose a new printer 
at any time when 
working in Page
Maker except when 
Page Maker is dis
playing one of its own 
dialog or alert boxes. 

The basic procedure for printing publications with PageMaker will be 
familiar to anyone who has printed documents with any other Macintosh 
program: you choose your printer, select the Print option on the File menu, 
determineyourprintsettings,and click the OK button to start the printing. 
To select the printer you want to use, you need to use the Chooser desk 
accessory on the Apple menu. When you select this option, a Chooser 
dialog box similar to the one shown in Figure 9.1 appears. 

On the left side of this dialog box, you see a scrolling window contain
ing icons representing the various printing d evices installed on your 
Macintosh. To change the printer, you must click on the correct icon. In 
Figure 9.1, we've selected the LaserWriter icon. Doing this places the 
name of the LaserWriter printers cmmected to your system into the scroll 

r a File Edit 

Figure 9.1: The Chooser dialog box 
v 
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Note v 
To have PageMaker 
use the Apple print 
driver instead of Aldus 
Prep, hold down the 
Option key as you 
select the Print option 
on the File menu (or 
press ~+P). 
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box on the right. If you have more than one printer of a particular type, 
such as two LaserWriters connected to your AppleTalk network, you 
would have to click on the appropriate name to select it. 

Beneath this scroll box, you'll find the Background Printing options if you're 
running PageMaker under MultiFinder. Background printing allows you 
to continue work in PageMaker or some other program while the program 
prints your publication in the "background." 

When printing your publication with a PostScript printer or imagesetter, 
you can choose between two laser printer drivers: the Aldus printer driver 
called Aldus Prep, which is supplied as part of PageMaker (and selected 
by d efault), or the Apple printer driver, which is supplied by Apple and 
is located in the Laser Writer file in the System folder. Most of the time, you 
will want to use the Aldus Prep instead of the Apple printer driver be
cause the Aldus driver uses the Aldus Printer Description (APD) files that 
are written for the specific laser printer or imagesetter that you select with 
the Chooser. By using the APD fil es for your particular brand of PostScript 
printer, PageMaker can print images at the highest quality your printer 
can produce. 

Unfortunately, you can only use background printing when printing 
your publication with the Apple printer driver; it does not work properly 
with the Aldus Prep printer driver. If you are using Aldus Prep and 
rmming PageMaker under MultiFinder, you need to deactiva te back
ground printing in the Chooser dialog box by clicking the Off button. Once 
you've chosen your printer and deactivated background printing (if 
necessary), click on the Close box in the upper left corner of the dialog box. 

Using Print Spoolers 
v 
The background printing feature available under MultiFinder isn' t the 
only way that you can output your PageMaker publications to the printer 
and then get back to work. Several print spooling programs are available 
that can p erform this task. When choosing a print spooler to use with 
PageMaker 4, be aware that the Aldus Prep printer driver doesn't work as 
well with computer-resident print spoolers as it does with network 
spoolers. Computer-resident spoolers are those that are active whenever 
you print (the background printing feature available under MultiFinder is 
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an example of a computer-resident print spooler). Network spoolers act 
. like printers. To use such a print spooler, you must select it on the Chooser 
dialog box just as you would any other printer. 

If your print spooler doesn't work well with PageMaker, you have two 
choices for using it to print your publications: either select the Apple print 
driver, or print your publication to disk. When you print to disk, you create 
a new PostScript file that contains all of the instructions necessary to print 
each page of your publication (for details on how to do this, see "Printing 
to Disk" later in the chapter). You then print this PostScript file with your 
print spooler. 

Printing with PostScript Laser Printers 
v 
After you've chosen your laser printer in the Chooser, you are ready to 
prin t your PageMaker publications with it. To print, you simply select the 
Print option on the File menu (or press ~+P). Figure 9.2 shows you the Printto 
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dialog box that appears when the LaserWriter II/NTX is selected in the 
Chooser. Because the Aldus Prep printer driver is used, PageMaker uses 
the APD file specifically written for this printer. The name of the printer 
will show up not only after Print to at the top of the dialog box, but also after 
Printer near the bottom of the box. To see a pop-up menu of the other 
printers for which an APD file is installed, you need to click on Printer. 

Figure 9.3 shows you the first dialog box that appears when you hold 
down the Option key as you select Print on the File menu to choose the 
Apple driver instead of the Aldus Prep driver. As you can see, the printer
specific Print to : LaserWriter 11/NTX dialog box has now been replaced with 
the more generic Print options for "LaserWriter" dialog box. Absent from this 
dialog box are options for printing multiple copies, reversing the printing 
order, and printing only a range of pages. Also, as you \•vill see when we 
discuss the printing options in more detail, this dialog box contains many 
of the same options as a separate Aldus print options dialog box that appears 
when you use the Aldus Prep printer driver. 

Windows 
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Book: ®Print this pub only 0 Print entire book 
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Figure 9.3 : The Print to: LaserWriter dialog box using the Apple printer driver 
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Note 
v 
Although you can 
select a new printer to 
use from this pop-up 
menu, remember that 
you must also select 
this prinler in the 
Chooser on the Apple 
menu before you can 
print with it. 

After you select your settings from the Print options for "LaserWriter" dia
log box and select OK, PageMaker 'Arill display a LaserWriter Page Setup 
dialog box where you can change the paper size, scaling, and various 
printing effects such as font substitution and text and graphics smoothing 
before printing. To choose other printing options for the Laser Writer such 
as mirroring or inverting the image, click the Options button and make your 
changes in a third dialog box called LaserWriter Options. 

Determining the Print Area and Paper Size 
v 
The Paper selection in the Print to dialog box for the Apple driver deter
mines the page dimensions listed after Size in the lower part of this dialog 
box, just as the Printer selection determines the dimensions lis ted after the 
Print area. Most laser printers have a border from Ys to Vz inch around all 
four edges of the paper that can' t be used in printing. If you select a new 
device on the Printer pop-up menu, the dimensions of the Print area may 
change, too. 

Some laser printers let you choose between two print areas for a single 
paper size. For example, depending upon which laser printer you've 
selected, you might see both a Letter and a Lettersmall option listed on the 
Paper pop-up menu in the Print to dialog box. If you choose the Lettersmall 
option ra ther than Letter, PageMaker will reduce the dimensions of the 
print area for that page size. Selecting a smaller paper size reduces the time 
it takes to download fonts and frees more printer memory. Remember, 
however, that if you choose a smaller page size, it is up to you to crea te a 
design that fits within the new reduced print area. 

Selecting the Print To Options 
v 
The options in the Print to dialog box that comes up when printing a Post
Script laser print allow you to designate the number of copies, the order in 
which your copies are printed, the range of pages to include, the source of 
the paper to be used, the size of the printing, and whether to print all the 
publications in the book. By default, PageMaker prints one copy of the se
lected publica tion only a t 100% size using the paper tray. 
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If you want to print multiple copies of your publication, you need to 
enter a new value in the Copies edit box (up to 100). When printing more 
than one copy, the program normally prints each page as many times as 
you designate before printing the next page. If you wish PageMaker to 
print one complete copy of the document (or the range of pages you've 
specified) before printing another copy, you need to check the Collate box. 
Also, PageMaker prints the pages in ascending order, from lowest to high
est. If you want the pages to be printed in descending order, from highest 
to lowest, you need to check the Reverse order box. 

When you only need a copy of a particular range of pages instead of the 
entire publication, you can ha ve just those pages printed by en tering 
the beginning page number in the From edit box and the ending page 
number in the to edit box. To print a single page of the publication, you 
enter the same page number in the to box as you do in the From box. Note 
that you enter the page range values in Arabic numerals even when your 
publication uses a different numbering system. For example, to have 
pages iii through xv printed in the frontmatter publica tion, you would 
enter 3 in the From box and 15 in the to box. 

PageMaker assumes that the paper used in printing your publication 
will be located in the printer's paper tray. If you plan to manually feed each 
sheet of paper instead, you must select the Manual feed button instead of 
Paper tray. Some laser printers allow you to specify a particular tray to be 
used. To use a new tray when Paper tray is selected as the Paper source 
option, click the button next to the name of the tray listed after Tray in the 
lower right corner of the dialog box. If your printer offers no tray options, 
you will see only the Select button listed after Tray, and this option will be 
ghosted. 

The Scaling option in this dialog box allows you to reduce or enlarge the 
pages from between 25% to 1000% of their original size. To do this, enter 
the desired percentage value in the Scaling edit box. PageMaker always 
centers the scaled image on the sheet of paper. If you enlarge the image, 
keep in mind that it may no longer fit on the size of paper you have 
selected. To prevent losing some of the image, you need to check the Tile 
box in the Aldus print options dialog box (see the next section for more details 
on u sing this option). 
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The Thumbnails option, located to the right of the Scaling option, allows 
you to print smaller images of several pages of your publica tion on a single 
sheet of paper, as illustrated in Figure 9.4. You can use this option to 
preview finaJ pages if you want to make sure that they don' t contain any 
obvious errors in the layout of the text and graphics. To print thumbnail 
versions of your publication, click the Thumbnails box. 

By default, PageMaker prints the image of your final pages small 
enough to fit a maximum of 16 on each sheet of paper. If you wish to 
increase or decrease the number of thumbnails per page, enter your new 
value (up to 64) in the per page edit box. Remember, however, that the more 
thumbnails you specify per page, the smaller the image of each page will be. 

The Book option on the Print to dialog box allows you to have all of the pub
lications listed in the book printed at one time. To do this, you click the Print 
entire book button. Before you can use this option, however, you must have 
already created a book list in the current publication (see Chapter 8 for 
complete information on building a book lis t). 

When printing all the publica tions in the book, PageMaker uses the 
print specifications that you select in the Print to and Aldus print options 
dialog boxes for the current publication. If you are using the Aldus Prep 
printer driver, you can have the program use the print specifica tions 
stored in each publication of the book instead. To do this, you must 
remember to hold down the Option key when you click the Print button in 
the Print to dialog box to start the printing. 

Selecting Aldus Print Options 
v 
When you use the Aldus Prep printer driver, the program makes several 
printing optionsavailable in aseparate Aidusprintoptionsdialogbox (shown 
in Figure 9.5). To bring up this dialog box, you must click the Options but
ton in the Print to dialog box. The choices available from this d ialog box are 
as follows: 

• Proof print: Select this option to have PageMaker print only the 
text in your publica tion. All graphics in the publication are 
represented by placeholders (rectangles with Xs through them). 
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loserWriter II NTH 

Aldus print options 

0 Proof print 
0 Substitute fonts 
0 Spot color ouerloys: 
0 Kno< kuut s 

0 Tile: 0 1-1<1rllWI 

0 Print blank poges 

0 Crop morks 
0 Smooth 
! ................................. , 

l fill < ulurs I 

® nutu I)(JI~ rlt~p i"liil•l inches 

Size: 
Euen/odd poges: ®Both 0 Euen 0 Odd 

Print Orlentotlon: ®Toll 0 Wide I moge: 0 I n111~r t 0 1-11tn1r 

Figure 9.5: The Aldus print options dialog box 
\1 

Use this option when you want to proofread just the text of your 
publication, as it substantially reduces the time it takes to print 
your pages, 

• Crop marks: Select this option to have PageMaker print crop 
marks (hairlines at the four corners of the page) indicating the 
edges of your page. You can use this option only when the page 
size you've selected for your publication is smaller than the 
paper size you've selected by at least Y2 inch or more all the way 
around (otherwise, the program will fail to print your crop marks). 
Crop marks are used to show the printer where to cut the pages, 

• Substitute fonts: Select this option to have PageMaker substitute 
any text set in the Apple screen fonts New York, Geneva, or 
Monaco with printer fonts Times, Helvetica, or Courier, respec
tively. This reduces the time it takes to print the pages and 
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increases the resolution of the printing (screen fonts take longer 
to print and can't be printed at high resolution on PostScript laser 
printers). 

• Smooth: Select this option to improve the printed quality of all 
paint-type graphics in your publication (this option has no effect 
on any other type of graphics). With this option selected , the 
program attempts to smooth out any jagged edges in the image. 
Note, however, that smoothing can also darken the printed image. 

• Spot color overlays: Select this option if you have used spot color 
in your publication (see "Printing Color Publica tions" la ter in this 
chapter), and you want to print a separate page for each color. By 
default, PageMaker prints a separate page containing all elements 
in a particular color for all the colors used in the publication. U you 
want to print spot color overlays for just a particular color, you 
need to select tha t color from the Spot color overlays pop-up menu. 
When you use this option, PageMaker automatically adds regis
tration marks to each color separation that it prints. 

• Knockouts: Select this option when you have selected the Spot 
color overlays option and you wish to blank out each color that 
overlaps another in the lower color separation (see "Preparing 
Color Publica tions for Printing" later in the chapter for examples). 
By using knockouts, you avoid any color distortion that might 
result from overlapping different color inks in the same area of 
the page. 

• Tile: Select this option when you have selected a page size for 
your publication that is bigger than the paper size used by your 
printer, or if you have enlarged the page size with the Scaling 
option so tha t the entire page may no longer fit on the paper. Se
lect the Manual button if you wish to control the size of each tile 
and how much it overlaps the next one. To use this option, you 
first designate the upper left corner of the first tile to be printed 
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by dragging the zero point to it before you choose the Print com
mand. Then, reposition the zero point to the upper left corner of 
the next tile before printing the next section, continuing in this 
manner until you have printed all tiles. To have PageMaker 
automatically determine the size of the tiles and how much they 
overlap, select the Auto overlap button and enter the amount that 
each tile is to overlap the next in its edit box. Figure 9.6 shows an 
example using this option. 

• Print blank pages: Select this option when you want PageMaker to 
print all pages in the selected print range, even if they are blank 
(meaning that they contain only items from the master pages). By 
default, the program does not print any blank pages. 

• Even/odd pages: Both is the default for this option, so that all odd 
and even pages in the print range are printed. To have only the 
even-numbered pages printed, click the Even button . To have 
only the odd-numbered pages printed, click the Odd button. 

• Orientation: Tall is also known as portrait and Wide as landscape. 
Make sure that the orienta tion selected in this dialog box matches 
the one you selected in the Page setup dialog box. 

• Image: These options are used when you are printing your publi
cation on film with an irnagesetter. Check the Invert box to make a 
nega tive image of your pages. Check the Mirror box to reverse the 
elements on each page (this op tion is normally selec ted w hen 
the emulsion side of the film is to be up rather than down). 

Selecting PostScript Print Options 
v 
In addition to the print options available on the Aldus print options dialog 
box, PageMaker offers several advanced printing options on the PostScript 
print options dialog box, shown in Figure 9.7. To display this dialog box, you 
need to select the PostScript option on the Print to dialog box. 
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Figure 9.7: The PostScript print options dialog box 
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Notice in this dialog box that four of the seven PostScript print options 
are checked by default. The first six print options can be summarized as 
follows: 

• Download bit-mapped fonts: With this option selected, PageMaker 
downloads bitmapped (screen) fonts whenever the PostScript 
(printer) fonts can't be loca ted and downloaded to the printer. 
Bitmapped fonts exhibit the same jagged edges seen in any Paint
type graphics. Most often, you will want to deselect this option, 
as your publications will seldom use bitmapped fonts. 

• Download PostScript fonts: With this option selected, PageMaker 
downloads any PostScript (printer) fonts that are not already 
resident in your laser printer. Note that these fonts must be avail
able in the System folder in order for the program to successfu lly 
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download them at print time. If you're printing to disk (see next 
section), selecting this option will cause PageMaker to include the 
PostScript fonts as part of the resulting PostScript file. Deselect 
this option if the printer or service bmeau already has the printer 
fonts used in your publication. 

• Make Aldus Prep permanent: With this option selected, PageMaker 
makes the Aldus Prep printer driver resident in your PostScript 
printer until the printer is shut off or reset. If you deselect this 
option, the program must download Aldus Prep each tim e you 
print a publication. Although downloading Aldus Prep takes 
more time, it does aJlow you to print documents with other 
programs that need the Apple printer driver without having to 
reset your laser printer. 

• View last error message: Select this option w hen you want the 
program to display all printer error messages until the printing of 
all selected pages is completed. Normally, PageMaker displays a 
printer error message on the screen only unti l the printer has 
finished processing the job in preparation for printing. Use this 
option when you are experiencing printing problems and you 
want to try to diagnose the problem. 

• Include images: With this option selected, PageMaker prints color 
EPS and TIFF images as a single image. Deselect thjs option 
when you are printing color separations. Leave this option 
selected when you want to print camps on a color PostScript 
printer or print grayscale versions of your TIFF images. 

• TIFF for position only: Select this option when you want Page
Maker to print a lower-resolution version of all TIFF images in 
your publication. You can use this option to decrease the time it 
takes to print proofs of your pages. Leave this option deselected 
when printing the final version of a publication that contains 
TIFF images. 
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Warning 
v 
When you are creating 
an EPS file, the page 
range must consist of 
one page, and you 
can't use the Thumb
nails, Spot color, or 
Tile option. 

After you've finished selecting all your printing options in the Aldus print 
options or the PostScript print options dialog box, click OK to return to the 
Print to dialog box. To begin the printing, select the Print button in this 
dialog box. A dialog box informing you of the status of your print job will 
then appear on the screen. To stop the printing before the job is completed, 
click the Cancel button in this dialog box. 

Printing to Disk 
\1 
As mentioned earlier, you need not always send your publication directly 
to a PostScrip t printer that is attached to your computer. If you don' t have 
direct access to the PostScript laser printer or imagesetter that you wish to 
use to produce the final pages, you can print your publica tion to disk. 
Printing to d isk results in a PostScript version of the d ocument, whicl1 you 
can then send to the final printer or use in other programs that work with 
PostScript files (such as Aldus Freehand or Adobe Illustrator). If you' re 
having your publication printed at a service bureau, find out if you should 
submit a PostScript version of your document instead of a copy of the 
original PageMaker file. 

To print to di~k, you need to check Print PostScript to disk box in the 
PostScript print options dialog box, then select the type of PostScript file by 
clicking on the appropriate option Hsted below. If you are creating a 
PostScript file with multiple pages for your service bureau, leave the 
Normal button selected. If you want to create a file tha t consists of a single 
page to be used in another program that works with PostScript files, select 
the EPS button . With this option selected, PageMaker crea tes an Encapsu
lated PostScript file that contains a screen image of the selected page as 
well as the PostScript commands needed to print it. This allows you to 
manipulate the page as though it were a graphic image in another 
PostScript-compatible graphics program . If you' re working with a color 
publication and you will be sending the PostScript file to a color separation 
program such as Aldus PrePrint, select the For separations button. 

By default, PageMaker checks the Include Aldus Prep box so that a copy 
of this driver is included in the PostScript file. Leave this box checked 



Tip v 
For the best results, 
always select the 
name of the image
setter that your service 
bureau will be using as 
the Printer option on 
the Print to dialog box 
before you create a 
PostScript version of 
your publication. If you 
don't have the APDfile 
for the final printer (so 
that it doesn't show up 
on the Printer pop-up 
menu), ask your serv
ice bureau to supply 
you with a copy. 
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unless you know that the printer or service bureau tha t will be using the 
Pos tScript file already has the latest version of the Aldus Prep printer 
driver. 

After selecting the type of PostScript file to create and checking over all 
of the other PostScript print options to make sure that they're correct, click 
the File name button. This brings up a Print PostScript to disk dialog box 
sirn.ilar to the one shown in Figure 9.8. Here, you need to select the disk and 
folder w here you want the PostScript file to be stored and enter a new file 
name. If you've selected the Normal button, PageMaker will suggest PostScript 
followed by the next ava ilable consecutive nwnber, as in PostScriptOl iJ1 
the list box. If you've selected the EPS button, it w ill suggest Untitled.eps as 
the file name. If you 've selected the For separations button, it will suggest 
Untitled.sep as the fil e name. 

Enter your own file name in this list box and then select the OK button. 
To create the PostScript file, click the Print button in the PostScript print options 
dialog box and the OK button in the Aldus print options dialog box. 

Print PostScript to disk 
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Figure 9.8: The Print PostScript to disk dialog box 
v 

El ement Windows 

1: j (H t ) n o K a 
~~~ 

Driue ] ( Cancel ] 

= HD 2 0 



382 V Mastering PageMaker 4 on the Macintosh V CH 9 

Tip v 
When printing with the 
Apple printer driver 
under Multi Finder, you 
can safely use back
ground printing. To 
print in the back
ground, select the On 
button after Back
ground Printing in the 
Chooser dialog box 
when you select your 
printer. 

Printing with Non-PostScript Printers v 
You can print PageMaker publications to two kinds of non-PostScript 
printers: Applelmagewriters such as theimageWriter II or the imageWriter 
LQ, and QuickDraw laser printers such as the Apple LaserWriterSCor the 
CCC Personal Laser Printer. Printing publications on any of these types of 
printers is similar to printing with a PostScript printer, except that you 
always use the Apple printer driver instead of the Aldus Prep printer 
driver, which is normally used when printing with a PostScript printer or 
imagesetter. 

Before you attempt to print with a non-PostScript printer, make sure 
that your printer is selected in the Chooser dialog box. To start printing in 
PageMaker, select the Print cmTimand on the File menu (or press ~+P). This 
brings up a Print options for dialog box that should display the name of your 
printer. Figure 9.9 shows you the Print options for: "LQ Apple Talk Image Writer" 

Print options for: "LQ RppleTolk: lmogeWriter" 

Scaling: ~ '7. 0 Thumbnails, ~ per page 

Bo ok:: ®Print this pub only 0 Print entire book: 

Options: 0 Coll6te 0 Reuerse order 
0 Proof print 18] Crop maries 
0 Spot color ouerloys ["fiif(l).ii).ril.j 
0 Knut:~ouh 
0 Tile: 0 1'-1<trlll<ll 0 nu to I)IJPrltlP 13p 10. B I picas 

0 Print bl6nlc p6ges 

Euen/ odd p6ges: ®Both 0 Euen 0 Odd 

Figure 9.9: The Print options for: "LQ Apple Talk lmageWriter" dialog box 
v 



Note 
\1 
The dialog boxes and 
options offered differ 
somewhat when you 
are using a Quick
Draw laser printer 
instead one of the dot
matrix lmageWriters 
as described here. 

PRINTING 
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dialog box that appears when we selected the Print command and the Image
Writer LQ connected to our AppleTalk network was selected in the Chooser. 

As you can see in Figure 9.9, the Print options for dialog box offers many 
of the same options as the Print to and Aldus print options dialog boxes 
discussed earlier. When you've selected your printing options from the 
Print options for dialog box, click the OK button to display another dialog 
box where you can specify the paper size, orientation, and scaling for the 
printout (these options depend upon your printer). After you select your 
options from this second dialog box and click the OK button, the program 
displays a third dialog box where you specify the number of copies, range 
of pages, print quality, and type of paper feed. After you specify these 
options and click the OK button, PageMaker will print your publication 
according to your choices. 

COLOR PUBLICATIONS v 
PageMaker offers two methods for adding colors to your publications: 

• Process color, where percentages of four basic colors (cyan, ma
genta, yellow, and black) are blended to produce each colored 
element in the publication 

• Spot color, where a single color is applied to each colored element 
in the publication 

If you use process colors in you r PageMaker publication, you will have to 
use a special color separation program such as Aldus PrePrint to create the 
four-color separations necessary to print it (or you can have your commercial 
printer or service bureau create the color separations for you). If you use 
spot colors, you can produce the spot color separations necessary to print 
the publication yourself without using a separate color separation pro
gram or having your printer or service bureau do it for you. 
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Select spot color printing when your publication uses just a few colors 
(three or less, usually) that highlight different elements on the page. To 
print spot colors, you need to create a spot color separation for each color 
used on the page. Each separation contains only the elements on each page 
that are to be printed in a particular color. 

You must use process color printing instead of spot color printing when 
your publication contains many colors or uses color photographs or other 
color graphics that require a wide range of colors to reproduce. Process color 
printing is accomplished by mixing varying percentages of the four ink colors 
cyan, magenta, yellow, and black (referred to as the CMYK model). To 
print process colors, you need to ere ate four-color separations that determine 
the percentages of each color and how they mix when applied to the page. 

Four-color separations are more difficult to produce than spot color 
separations and require the use of a specia l color separation program. As 
you can imagine, process color printing is also more expensive than spot 
color printing. 

Defining Colors 
'\1 
Working with colors in a PageMaker publica tion is much like working 
with paragraph styles: first you define the colors for your publication, then 
you assign them to particular elements in the publication by choosing the 
desired color from a Color palette. Six default colors are available when
ever you start a new PageMaker publication. These colors include Paper, 
Black, Registration, Blue, Green, and Red, as shown in the Define colors dialog 
,box in Figure 9.10. 

Pnperrefers to thepapercolorand is initially set to white. If you have 
a color monitor and plan to print your publication on paper with a 
different color, you can change this color to match the paper color you plan 
to use. That way, you can get an idea of how the printed page will appear. 
You can also use the Paper color to mask out any objects on the page that 
you don't want to appear in the printed publication. Black is automatically 
applied to all text in your publication. You cannot edit thiscolor(or absence 
of all color, if you will). However, you can apply black to a particular block 
of text or graphic image to which you previously assigned some other 



Tip 
'\7 
To get directly to the 
Edit colors dialog box 
when the Color palette 
is displayed (~+K) , 

hold down the ~ key 
as you click on one of 
the colors listed there. 
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Figure 9.10: The Define colors dialog box 
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color. Registration is automatically applied to objects such as crop marks 
that appear on each color separation. You apply the Registration color (which 
is black, and can' t be ed ited to another color) to any object that you want 
printed on each separation. 

The last three colors- Blue, Green, and Red- are basic colors whose 
values you can edit or apply as is to selected objects in your publication. 
To ed it these colors or to crea te nev,r ones to use, you select the Define colors 
option on the Element menu. This brings up the Define colors dialog box shown 
in Figure 9.1 0. To edit an exis ting color, select it in the list box and click on 
the Edit button. To create a new color, select the color that is closest in value 
to the one you wish to create, then click the New button . 

Clickin g on either button takes you to an Edit color dialog box similar to 
the one shown in Figure 9.11 . If you are editing a color, you will see its 
name in the Name edit box. If you are creating a new color, this edit box will 
be blank and you must enter a name for your new color there. 
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Note 
'V 
You can also define a 
color by using the 
Apple color wheel, 
unless you're using 
Page Maker on a Mac 
Plus or SE. To access 
the color wheel, select 
a color to edit, then 
hold down the Shift 
key as you click the 
Edit button in the 
Define colors dialog 
box. 

Define colors 

Nome: ~~ ---------------~ 
Model: 0 RGB 0 HLS @ CMYK 

c yon: II] % 1¢ I IHiii1i!i!iHHI 91 

Mogento: II] '7. 1¢0nm::mmm!l91 
Yellow: II]% l¢0iii! i!!i!!i!Wm!l91 
Block: II] '7. 1¢ I li!WH!!W!!!i!!!l ¢1 

IlK 

Cancel 

(PANTONE® ... J 

Figure 9. 11 : The Edit color dialog box 
\1 

• 

• 

You can base the color you're creating or editing on four color models: 

RGB: The red, green, and blue model defines colors based on the 
percentages of red, green, and blue in them. To define a color 
using this model, click the RGB button, then adjust the percent
ages of the three colors by either typing in the values or selecting 
them with the appropriate scroll box. 

HLS: The hue, lightness, and sa tura tion model defines colors 
based on the degree of the hue and the percentage of lightness 
and color saturation. To define a color using this model, click the 
HLS button, then adjust the degree of the hue and the percentages 
of the lightness and sa turation by either typing in the values or 
selecting them with the appropriate scroll box. 

• CMYK: The cyan, magenta, yellow, and black model defines 
colors based on percentages of these colors. To define a color 
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using this model, click the CMYK button, then adjust the percent
ages of the four colors by either typing in the values or selecting 
them w ith the appropriate scroll box. 

• PANTONE: The Pantone colors are standardized colors orga
nized into a numbered system used by designers and commercial 
printers. To specify a Pantone color, click the Pantone button, then 
select the color from the PANTONE color dialog box. If you know 
the number of the color you wish to use, you can select it by 
typing it into the PANTONE CV lis t box. 

When you have the new or edited color adjusted the way you want it, 
click the OK button in the Edit color dialog box to return to the Define colors 
dialog box. Once there, click the OK button to complete the color definition. 

~plying Colors 

To apply a color to one of the graphic elements on the page, you first need 
to select it with the Pointer. To apply a color to text, select it with the Text 
tool. Then, display the Color palette in the publication window (select 
Color palette on the Windows menu or p ress ~+K), and apply a particular 
color to the selected object by clicking on its name. If you have a color mon
itor, you will see the color on the screen. If you don' t have a color monitor, 
you can tell which color is applied to a particular object by selecting it when 
the Color palette is displayed and then seeing w hich color is selected 
in its lis t . 

If you want to apply a color to several objects on the page, select all of 
them before you choose your color. If you want to apply a particular color 
to just selected text in a paragraph, use the Text tool to highlight it before 
you choose your color. 

Preparing Color Publications for Printing 
v 
If you've used spot colors in your publication, you can print the spot color 
separations by selecting the Spot color overlays option in the Aldus print 
options d ia log box. If different-colored areas overlay each other and 
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you don't want the colors to be mixed in those areas, be sure to select the 
Knockout option in this dialog box as well. Figures 9.12 and 9.13 show you 
the spot color overlays for the Barnaby's salad dressing label using these 
two options. The firs t spot color overlay represents the Pan tone color value 
291 (a blue) used for the logo and all of the label text. The second spot color 
overlay represents the area to be printed in the Pan tone color value 137 (a 
burnt orange). In this case, orange is u sed to print the setting sun and its 
rays tha t appear behind the sailor and his boat. This second overlay almost 
appears as a reverse of the sun, the sailor, and his boat shown in the 
original logo in the first overlay because it's a knockout of where the two 
colors overlap. Using a knockout ensures that the orange ink will not mix 
with the blue when the final label is printed. 

If you've used process colors in your p ublication and you plan to use a 
color-separation program su ch as Aldus PrePrint to prepare the four-color 
separa tions, you need to crea te a PostScript version of your publica tion. Be 
sure to select the For separations button in the PostScript print options dialog 
box when making this file. If you plan to have the four-color separations 
prepared by a commercial printer or service bureau, find out which format 
they prefer. 

If you have access to a color PostScript laser printer, you can print 
composites of your publication just as you would print any other Page
Maker publication. Just make sure that your color printer is selected in the 
Chooser and in the Print to dialog box before you print. 

ESSENTIAL 
TECHNIQUES v 
To Print a 
Publication 
Using the 
Print Defaults 1. Open the publication that you wish to print. 
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Figure 9.12: Spot color overlay for a Pantone blue in Barnaby's salad dressing label 
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Pago 1 • PANTONE 1~ overlay 

Figure 9.13: Spot color overlay for a Pantone orange in Barnaby's salad dressing label 
V' 



To Print 
Thumbnail 
Versions of 
Your Pages 

To Print 
Oversized 
Pages 

Printing Publications from the Desktop V 391 

2. Select the Print option on the File menu (or press 3€+P). 

3. Specify the number of copies and the print range in the Print to 
dialog box, then click the Print button to start the printing. 

1. Open the publication that you wish to print. 

2. Select the Print option on the File menu (or press 3€+P). 

3. Specify the Scaling percentage, check the Thumbnails options, 
enter the number of thumbnails to be printed on each page in 
the Print to dialog box, then click the Print button to start the 
printing. 

1. Open the publication that you wish to print. 

2. Select the Print option on the File menu (or press 3€+P). 

3. Specify the Scaling percentage, if necessary, then click the Options 
button to display the Aldus print options dialog box. 

4. Check the Tile box, then click either the Manual or Auto overlap 
button in the Aldus print options dialog box. If you choose Auto 
overlap, specify the amount of overlap in the edit box. If you 
choose Manual, you need to have specified the placement of the 
upper left corner of the page by the position of the zero point. 

5. Click the OK button in the Aldus print options dialog box, then 
click the Print button to start the printing. 
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Alignment. The way lines of text are arranged in their colunm or text 
block on the page. In PageMaker, you can choose between several differ
ent kinds of alignment: left (flush left and ragged right), center (all lines 
centered), right (ragged left and flush right), justify (flush on left and right 
except for last line of the paragraph), and force justify (flush on left and 
right of every line in the paragraph). 

Autoflow. A text placement mode in PageMaker whereby text flows 
continuously onto successive pages (added automatically if needed) until 
all the text of the imported document is placed or the maximum number 
of pages (999) is reached. To change to this mode, hold down the ~ key 
before you click the Manual flow text icon until the Pointer changes to 
Au toflow icon shown to the left, or select Autoflow on the Options menu 
before you import your document. 

Bitmapped (or Paint-type) graphic. A graphic that is produced by a 
pattern ofblack-and-white dots by such programs as MacPaint. When you 
import a bitmapped graphic image into your publica tion, the Pointer 
changes to the Paint-type Graphics Pointer shown to the left. 

Bleed." The result of placing a graphic so that it extends to the edge of the 
paper when the page is trimmed. In PageMaker, you can create bleed s by 
extending the appropria te border of your graphics beyond the margin 
guides on the page. 

Body type . Type that measures between 6 and 14 points, usually u sed to 
set the main body of text in a publication. See also Display type 

Book. In PageMaker, a book is any group of publications that you 
associate by add ing to a book list with the Book command on the File menu. 
You can create a table of contents or index for all publications in the book 
and print them as one unit. 

Cicero. A system of measurement used by some European typesetters 
and printers, similar to a pica (there are approximately 13 points in one 
cicero). 



394 V Mastering PageMaker 4 on the Macintosh V APP A 

w 
Draw-type Graphics 
Pointer 
\1 

CMYK colors. A color model that defines colors by the percentages of the 
four process colors, cyan, magenta, yellow, and black. See also Process colors 

Color palette. A small PageMaker w indow that you can display on the 
screen thatcontains the namesofall thecolors that you'vedefined for your 
publication. To display the window, select Color palette on the Windows 
menu or p ress ~+K Once it is displayed, you can resize and move the 
Color palette in the publication window as required . To assign a color to 
an element on the page, select the element before you click on the color in 
the Color palette. 

Crop marks. Pairs of fine lines drawn at each corner of the page to mark 
the borders of the page. You can have PageMaker print crop marks for all 
page sizes that are smaller than your paper size by selecting the Crop marks 
option when printing. 

Discretionary hyphen. A hyphen that you enter by pressing~+- (hy
phen) in a PageMaker publication to indicate where a word can be split. This 
type of hyphen is displayed in the document only when the program uses it 
to break the word at the end of a line. Otherwise, the hyphen is not used. 

Display type. Type that is 14 points and larger, usually used to set 
headings and headlines in publications. 

Double-sided publication. A publication that will be printed or copied 
on both sides of the paper. The front side of the paper is the odd-numbered, 
right-hand page (or recto). The back side is the even-numbered, left-hand 
page (or verso). The inside margin is the left margin on a right-hand page 
and the right margin on a left-hand page. 

Draw-type graphic. A vector or object-oriented graphic image created 
with a graphics program such as MacDraw. When you import a draw-type 
graphic image into your publication, the Pointer changes to the Draw-type 
Graphics Pointer shown to the left. 

Em. A unit of measure equal in height and width to the point size of the 
font you are using. This unit is applied to spaces and dashes. To insert an 
em space, press ~+Shift+m. To insert an em dash, press Option+Shift+
(hyphen). 
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En. A unit of measure equaJ to one half the width of an em. This unit is 
also applied to spaces and dashes. To insert an en space, press ~+Shift+n. 
To insert an en dash, press Option+- (hyphen). 

Encapsulated PostScript (EPS). A fil e that contains the PostScript code 
needed to print the graphic on a PostScript printer and the draw-type 
graphic needed to display it in the publica tion. See also PostScript 

Facing pages. A two-page spread for double-sided publications that 
places the even-numbered page on the left and the odd-numbered page on 
the right. To select a particular pair of facing pages, you click on the 
appropriate Facing-page icon shown on the left. 

Folio. Refers to the page number usually placed in the running head or 
foot at the top or bottom of each page. To print the folio in a PageMaker 
publication, you need to insert a page-number marker by pressing 
~+Option+p. 

Font. In commercial printing, a complete collection of all characters for 
a single size and specific style of a typeface. In Macintosh programs, a font 
usually refers to all characters in a particular typeface without regard to its 
style or point size. That is why you select a font independently of the type 
size and type style on the Type menu in PageMaker. 

Grabber hand. The tool used to manually drag a new part of the page 
into view in the publication window. To change the Pointer into the 
Grabber hand (shown to the left), you hold down the Option key as you 
click the mouse button. 

Greeked text. A facsimile of text used to show its general shape in a 
publication. In PageMaker, greeked text is usually applied to the smaller 
sizes of type to improve the program's performance by decreasing the 
time it takes to redraw the screen. You can change the pixel size at which 
PageMaker greeks the text in the Preferences dialog box. 

Grid. A pattern of intersecting horizontal and vertical lines that extend 
from the tick marks of the PageMaker rulers. The g rid is used to aid in 
the precise placement and alignment of text and graphics on the pages 
of the publication. 
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Guides. In PageMaker, one of the three types of nonprinting lines that 
help you place and align text and graphics in your publication. The three 
types of guides are margin gu ides (created by the page size and margins 
you select), column guides (created by the columns you define), and ruler 
guides (created by dragging lines from the horizontal and vertical rulers). 

Halftone. A process used to print photographic illustrations in a publi
cation by creating a screen that converts each contrasting area in to a 
different pattern of black-and-white dots. 

I-Beam cursor. The icon that is used to position the insertion point in text 
when editing it. To change the Pointer to the 1-Beam cursor (shown to the 
left), select the Text tool. See also Insertion point; Text tool 

Independent graphic. In PageMaker, a graphic that is not tied to the 
surrounding text block, and therefore does not move when the program 
reflows the text. 

Inline graphic. In PageMaker, a graphic that is embedded in a particular 
text block, and therefore does move when the program reflows the text. To 
import a graphic as an inline graphic, you must select the Text tool and 
click the insertion point at the place in the text where you wish to embed 
the graphic before you import it. 

Insertion point. The flashing vertical bar that appears at the p lace in the 
text where you click the 1-Beam cursor. The insertion point marks the place 
where new text will appear if you start typing or if you select the Paste 
command on the Edit menu. See also I-Beam cursor; Text tool 

Italics. A variation of a normal (or Roman) typeface where the characters 
all slant to the right. This type style was originally developed by Aldus 
Manutius (for whom Aldus Corporation is named) to fit more text into the 
same amount of space. 

Justification. Refers to the alignment of text so that both the left and right 
margins are set flush (even). See also Alignment 
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Kerning. In commercial printing, adjusting the amount of space be
tween specific letter pairs known as kern pairs. In PageMaker, you can 
decrease the space by pressing ~+Delete and increase it by pressing 
~+Shift+Delete. 

Layout view. In PageMaker, the normal display of the pages in the pub
lication window that shows the layout of the publication with all of the 
elements represented pretty much as they will appear when printed. You 
place text and graphics on the page in layout view. See also Story view 

Leading (pronounced ledding). In commercial printing, the difference in 
points between the type size and the line space, so that 10 I 12 means 1 0-point 
type on 12-point line space for 2 points of lead. In desktop publishing, it 
is the amotmt of space between successive lines of text and is measured 
from the baseline of the current line to the baseline of the next line of text, 
so that 10/12 means 10-point type with 12 points of leading. 

Letter spacing. The amount of spacing between characters. In Page
Maker, you can adjust the letter spacing in a paragraph of text by changing 
the Letter space percentage in the Spacing attributes dialog box. See also Word 
spacing 

Manual text flow. The default placement mode in PageMaker, whereby 
text flows until it reaches the bottom of the current page or column. To flow 
remaining text, indicated by the presence of a downward-pointing tri
angle in the lower window-shade handle, click on the handle to reload the 
text icon so that it looks like the Manual text flow icon shown to the left. 
Then click the text icon at the top of the next page or column. 

Master page. In PageMaker, a page that contains the guides, text, or 
graphic images that are to be used in all or most of the actual pages of the 
publication. If your publication is double-sided, it has a left and right 
master page indicated by the Land R master page icon (shown to the left). 
Before you can add or change any items on the master pages, you must 
make them current. 
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Mechanical. In commercial publishing, the boards containing all of the 
elements of the page ready for reproduction. In desktop publishing, this 
concept is extended to the final pages that contain all the elements and are 
ready for printing or copying (boards may not be used). Also known as 
camera-ready art. 

Orphan. In commercial printing, a single word or short line at the end of 
a paragraph. In PageMaker, one or more lines at the end of a paragraph 
that are separated from the ma]n part of the paragraph at the top of a new 
column or page. You can define the number of lines that constitute an 
orphan in a style and prevent them from being placed alone at the top of 
a new column or page. See also Widow 

PANTONE colors. A standardized system of colors developed by 
Pantone, Inc., that is widely used by commercial printers and ink manu
facturers. In PageMaker, you can define new colors to use in your publi
cation by selecting them from a menu of Pantone color values. 

Pasteboard. In PageMaker, the white area surrounding the one- or two
page spread in the publication window. Any element that you place on the 
pasteboard remains there even when you make a new page current or 
close the publication. To display the entire pasteboard area in the publica
tion window, select the "Fit in world" view by holding down the Shift key 
as you select Fit in window on the Page menu. 

Pasteup. The process of placing text and graphics on the page. In 
desktop publishing, almost all pasteup is done electronically. In tradi
tional printing, all pasteup is accomplished by hand. See also Mechanical 

Pica. A unit of measurement used in typesetting and layout. There are 12 
points in one pica and approximately 6 picas in one inch. See also Point 

PICT (or Picture format). A format for draw-type graphic files such as 
those produced by MacDraw. New Macintosh models can utilize a PICT2 
format that can contain color information. PageMaker can read and use all 
types of PICT files. 
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Pixel. The smallest picture element on the screen. On a monochrome 
screen, a pixel can be either black (on) or white (off). The density of pixels 
on your monitor is one of the most important factors in determining the 
resolution of text and graphics tha t are displayed on it. 

Point. A unit of measurement used in typesetting and layout. There are 
12 points in a pica and almost 72 points in an inch. 

Pointer. In PageMaker, the default tool in layout view (shown to the left) 
that enables you to select the text blocks and graphic images on the page that 
you wish to place, move, or resize. 

PostScript. The standard page-description language d eveloped by 
Adobe Systems tha t is used by many laser printers and imagesetters to 
print text and graphics. 

Process colors. The system of using various percentages of the four 
process colors-cyan, magenta, yellow, and black-to produce the color 
separations needed to print complex colored illustrations and photo
graphs. See also CMYK colors 

Publication. The document that you create in PageMaker that contains 
the actual text and graphics that you want printed in the final pages. The 
publication icon is shown to the left. See also Template 

Recto. The right-hand, odd-numbered pageofadouble-sided publication. 
See also Verso 

Registration mark. The marks added to color overlays and separations, 
indicating to the printer how they are to be aligned. In PageMaker, you can 
have registration marks au tom a ticall y added to your pages when printing 
spot-color overlays. 

Resolution. The nwnber of dots in a particular area of the screen or page. 
Screen resolution refers to the number of pixels per inch, whereas printer 
resolution refers to the number of dots tha t are printed per inch. 
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Reverse type. White text printed on a contrasting backgronnd. In Page
Maker, you can reverse type by drawing a box around the text that you fill 
with a pa ttern, shade, or color, then sending the box to the background, 
and selecting Reverse as the Type style on the Type menu. 

Ru lers. In PageMnkcr, the horizontal and vertical rulers that can be 
displayed in the publica tion window to help you in placing and aligning 
text and graphics on the page. If the rulers aren't displayed, select Rulers 
on the Options menu or press ~+R. Both rulers use the system of mea
surement that you select in the Preferences dialog box. The increments on 
the ruler d epend upon the resolution of your monitor, the display size of the 
page, and the units of measurement you 're using. 

Running h ead (or foot) . Information tha t is repeated in the top or bot
tom margin of each page of a publication. If the information appears at the 
top of the page, it is called a running head. If it appears at the bottom of 
the page, it is called a running foot. The running head (or foot) usu ally 
contains the name of the publica tion, the section, and the folio. In Page
Maker, running heads (or feet) are placed on the master pages. See also 
Folio; Facing pages; Master page 

Sans serif. A typeface tha t does not use serifs (the small cross strokes 
projecting from most of the letters). 

Semiautomatic text flow. A mode of text placement where text flows to 
the bottom of the current column or page and then waits for you to click the 
mouse to flow remaining text onto the next column or page. To change 
the Manual tex t icon to the Semiautomatic text icon (shown to the left), 
hold down the Shift key as you cl ick the mouse to place the text. 

Separations. The four screens containing the various percentages of 
cyan, magenta, yellow, and black used to produce the colors in th e printed 
publication. See also Process colors 

Serif. Short cross strokes added to most of the letters in a typeface or a 
font that uses such cross strokes. 



Essential Desktop Publishing Terminology V 401 

Set solid. Refers to specifying type where the type size and leading are 
equal. See also Leading; Type size 

Slug. In commercial printing, a line of type cast in a single piece. In 
PageMaker, the horizontal bar indicating the amount of leading you've 
specified that appears when you select a portion of text. Inside the slug, the 
characters are aligned on a common baseline. 

Spot-color overlay. A page containing only the elements that are to be 
printed in a particular color. In PageMaker, the spot-color overlay con
tains registration marks and the name of the color used, and you can print 
overlays for all colors in the publication or for just a particular color. See 
also Registration mark 

Story. All the text from a single word-processed document that is placed 
in your publication, or all of the text that you enter in or paste together in 
PageMaker. A single s tory can consist of several text blocks, provided that 
they are all threaded together. See also Text block; Threaded text 

Story view. A special text view that displays all text of the selected story 
in a single type size and font. In story view, inline graphks are displayed 
by graphic markers, and independent graphics are not displayed at all. 
Story view makes it easy to add, edit, or spell check the text of the story 
you're working on. To get into story view, you select Edit story on the Edit 
menu or press ~+E. 

Style. In PageMaker, a collection of format settings applied to all para
graphs in the publication to which the style is assigned. See also Style 
palette 

Style-name tag. A style name placed in a pair of angle brackets, such as 
<Headline>, tha t is entered at the beginning of paragraphs in a \<VOrd 
processed document before it is placed in your PageMaker document. As 
long as the style name matches that of an existing style in the publication 
and you check the Read tags box in the Place document dialog box when 
importing the document, PageMaker applies the s tyle's definition to each 
paragraph that has been tagged. 



402 V Mastering PageMaker 4 on the Macintosh V APP A 

PageMaker Template 
Icon 
v 

A 
Text Tool 
v 

Style palette. A small PageMaker window that you can display on the 
screen that contains the names of all the styles you've defined for your 
publication. To display the window, select Style palette on the Windows 
menu or press~+ Y. Once the palette is displayed, you can then resize and 
move the palette in the publication window as required. To assign a style 
to a paragraph of text, click the insertion point in the paragraph and then 
dick on the style in the Style palette. 

Template. A special publication that contains the structure required to 
generate actual publications that share the same design. In PageMaker, 
you can use two types of templates: grid templates, which contain only the 
layout grid used by actual publications; and placeholder templates, which 
contain dummy text and graphic placeholders showing the placement of 
the elements on each page. To generate a publication from a placeholder 
template, you open a copy of it and then replace the dummy text and 
graphic placeholders with the actual text and graphic images that are to be 
used in your publication. The template icon is shown to the left. 

Text block. In PageMaker, a portion of the text that has been placed on 
the page. When you select a text block in PageMaker with the Pointer, its 
borders are displayed by a box. At the top and bottom of this box, you see 
window-shade handles that can be u sed to change the size of the block or 
reflow it. See also Window-shade handles 

Text tool. In PageMaker, the tool used to manipulate text in layout view 
(shown to the left). When you select the Text tool, the Pointer changes to the 
I-Beam cursor, which can be used to position the insertion point or to select 
text. See also I-Beam cursor; Insertion point 

Thin space. In commercial printing, a fixed space that is less than the 
width of an en space. In PageMaker, a thin space is one half of an en space 
and is entered by pressing ~+Shift+t. 

Threaded text. In PageMaker, text that belongs to one story even when 
it has been split up by graphics into different text blocks. Threaded text 
always appears as a single story in story view. 
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Thumbnail. In commercial printing, a quick d esign sketch in which text 
is greeked and graphics are represented by shapes used to evaluate 
alternate layouts. In PageMaker, a miniature version of the printed page 
in which text is greeked and graphics are represented by shaded boxes 
used to check the layout of your pages. The program allows you to print 
up to 64 thumbnails per page. 

TIFF (Tagged Image File Format). A special format for storing bitmapped 
graphics that is used primarily by scanners to store scanned images of line 
art and photographs. 

Tile. In PageMaker, a portion of an oversized page that is printed on a 
single sheet of paper. You must assemble the tiles to create the complete 
oversized page. 

Track kerning. Uniformly adjusting the amount of Jetter and word 
spacing in a selected range of text. In PageMaker, you can choose between 
five different types of track kerning: Very loose, Loose, Normal, Tight, and 
Very tight. To select one of these settings, choose Track on the Type menu. 

Type size. The distance from the top of an ascender to the bottom of a 
descender, measured in points. 

Verso. The left-hand, even-numbered page of a double-sided publica
tion. See also Recto 

Widow. In commercial printing, a single line or less than a third of a line 
that appears at the top of a page. In PageMaker, one or more lines at the 
beginning of a paragraph that are separated from the rest of the paragraph 
at the top of a new column or page. You can define the number of lines that 
constitute a widow in a s tyle and prevent them from being placed alone at 
the top of a new column or page. See also Orphan 

Window-shade handles. In PageMaker, the horizontal lines with 
handles that appear a t the top and bottom of a text block when you select 
it with the Pointer. If there is more text to be placed, PageMaker indicates 
this by displaying a solid triangle in the lower window-shade handle. If 
there is no more text to flow, the handle will appear empty. 
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Word spacing. The variable amount of space placed between each word 
to justify a line of type. In PageMaker, you can adjust the word spacing 
with the Word space percentages in the Spacing attributes dialog box or the 
Track command on the Type menu. 

X-height. The height of the lowercase x in the font. The size of the x
height has the most influence on how large the type appears to be to the 
reader. · 

Zero point. In PageMaker, the intersection of 0 (zero) marks on the 
horizontal and vertical rulers (see Rulers). You can change the zero point 
in a publication by dragging the zero-point marker (the intersecting 
hairlines in the upper left corner of the publication window) to a new 
position on the page. 
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Desktop publishing with PageMaker naturally involves the use of a wide 
variety of additional programs. Throughout the book, we've mentioned 
some programs that you can use with PageMaker to generate either text or 
graphics for the publications you 'll create. In this appendix, we look at a 
few of the companion products such as fon ts and clip art graphic images 
that make it more enjoyable to work with PageMaker, as well as some of 
the more essential utility programs that make it easier to work with 
PageMaker. 

We end the book with suggestions on where to go to learn more about 
desktop publishing on the Macintosh and garner new design ideas. 
Although we've not been able to spend much time discussing the more 
crea tive aspects of desktop publishing, we're acutely aware that the crea
tive side of designing a publication is much more important (and difficult) 
than the technical side of putting it together. Fortunately, many resources 
are available to you as a new desktop publisher that can keep you current 
in this fast-paced fi eld as well as keep your crea tive juices running. 

FONTS AND 
FONT UTILITIES v 

Every d esktop publisher needs a wide variety of fonts at his or her 
disposal. It seems that no matter how many fonts we have to choose from 
for a project, we could always use more. Fortunately, locating new fonts 
that you'd love to own is seldom any problem, as new fonts are being 
released into the marketplace every day. 

The best way to go shopping for fonts is through the font catalog that 
each manufacturer puts out. If you're using Adobe Type Manager (A TM) 
with PageMaker, be aware that not all PostScript fonts are compatible with 
this utility (fo_r information on A TM, see Chapter 4). So-called Type 3 
PostScript fonts aren't supported by ATM; only Type 1 Adobe fonts are. 
Although most font manufacturers are in the process of converting their 
PostScript laser fonts from Type 3 to Type 1, you should verify this 
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information before you invest heavily in fonts that look great in print, but 
continue to appear jagged on the screen . 

The following font vendors offer a good selection of top-quality fonts : 

Adobe Type Library, Adobe Systems, Inc., P.O. Box 7900, 
Mountain View, CA 94039. This library includes one of the 
widest selections of fonts for $95-$370 each. 

Agfa PostScript Fonts with Adobe Hints, AGFA/ 
Compugraphic, 90 Industrial Way, Wilmington, MA 01887. 
AgfaType fonts are excellent quality and include some that are 
not available from Adobe for $90-$340 each. 

Bitstream Typeface Library for the Macintosh, Bitstream, Inc., 
215 First St., Cambridge, MA 01142. This library includes an 
interesting variety of text and display typefaces for $45 each. 

Fluent Laser Fonts, Cassady & Greene, Inc., P.O. Box 223779, 
Carmel, CA 90278. These fonts include some of the more decora
tive type styles along with traditional favorites for $90-$130 each. 

Foreign Language Fonts, Linguis ts Software, 925 Hindley Lane, 
Edmonds, W A 98020. They offer one of the best selections of 
foreign language fonts for $50-$150 each. 

As your font library grows, you may experience some problems with 
organizing your fonts. Luckily, a grea t number of useful font utilities are 
available that can help you keep tabs on them. Here are two of our 
favorites: 

SuitCase II, version 1.2.6, Fifth Generation Systems, 10049 North 
Reiger Road, Baton Rouge, LA 70809. This utility makes your 
screen fonts available to any program \o\rithout having to load 
them in your System file with the Font/ DA mover. Suitcase also 
comes with a utility called Font Harmony, which allows you to 
combine all styles of a font into a single family. That way, your 
font lis t on the Font menu isn' t cluttered ·with a separate listing 
for the italic, bold, and regular version of a font. To use the italics 
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or bold version of the font, you select the font on the Font menu 
and then the attribute from the Type style menu. 

Adobe Type Reunion, Adobe Systems, Inc., P.O. Box 7900, 
Mountain View, CA 94039. This utility goes one step further than 
Font Harmony and groups different styles of a single font so they 
can be selected from a pop-up menu that appears when you 
select the basic font on the Font menu. This makes it a lot easier 
to locate and select a specific style for a font that offers a wide 
variety of styles, such as ITC Eras, which comes in Light, Book, 
Medium, Bold, and Ultra. 

Some jobs will require some special effects with type that may not be 
possible with PageMaker alone. Several type utilities allow you to ex
periment with type and even develop your own fonts. 

Adobe Type Align, Adobe Systems, Inc., P.O. Box 7900, Moun
tain View, CA 94039. If you're using Ad obe Type Manager with 
PageMaker, you will probably be interested in getting this pro
gram, which allows you almost unlimited freedom in manipulat
ing PostScript fonts. 

Fontographer, Altsys, 720 Avenue F, Suite 109, Plano, TX 75074. 
Although somewhat expensive, Fontographer gives you the 
freedom to design and create your own personal typefaces that 
you can then use in your PageMaker publications. 

GRAPHIC IMAGES v 
Knowing that you won't always have the time (and inclination) to draw 
your own illustrations for the projects you undertake with PageMaker, 
you may well want to invest in some of the clip-art collections that are 
available. That way, you will have access to a library of stock graphic 
images that you can use in your publication either as is or with slight 
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variations. Clip art, like PageMaker graphics, comes in different formats. 
You can select between bitmapped, draw-type, and EPS images. Once 
you've purchased the clip-art collection, you can bring any of its graphic 
images directly into PageMaker with the Place command and then posi
tion it, scale it, and crop it as needed. 

Clip-art collections run the gamut from cartoons to intemational symbols. 
In fact, so many collections are available that it's almost impossible not to 
find the image you want in one format or another. The best way to find out 
what images a particular collection of clip art contains is by consulting a 
catalog. To date, one extremely useful, if somewhat dated, catalog is 
available: 

The Electronic Clip Art Digest: Volume 1: A Compendium of Art 
for the Macintosh (1988, The Electronic Clip Art Company, 6376 
Quail Run, Kalamazoo, MI 49009). This digest contains over 
15,000 clip-art illustrations available from 30 different companies. 
It comes in a loose-leaf format and comprises over 600 pages. 

If you have access to a CD-ROM player, you may want to look into 
collections of clip art available in this medium. A CD-ROM disk can hold 
many more images than standard floppy disks. We are familiar with a 
really diverse collection by Wheeler Arts that is available from Wayzata 
Technology: 

QuickArt by Wheeler Arts, Wayzata Technology Inc., P.O. Box 
97, Prior Lake, Minnesota, MN 55372. This collection of over 2000 
images is divided into 24 diverse categories, including such 
groups as Animals, Clothing, Farm, Food, Maps, People, Travel, 
and more. In addition to the images, the collection includes a 
utility called Retouch that enables you to enhance and resize the 
images before you import them into your PageMaker publications. 



DESKTOP 
PUBLISHING 
RESOURCES 
v 

Desktop Publishing Companion Product Guide V 411 

Desktop publishing is an exciting and rapidly changing field. To learn 
moreaboutit, keep current with the latest developments, and get valuable 
design ideas, you may want to investigate the following books and 
magazines: 

Forget All the Rules about Graphic Design (Including the Ones in 
This Book) by Bob Gill (1981, Watson-Guptill, 1515 Broadway, 
New York, NY 10036). A unique guide to graphic design that 
presents the design process as taking boring problems and giv
ing them interesting solutions. 

Looking Good in Print: A Guide to Basic Design for Desktop 
Publishing by Roger C. Parker (1988, Ventana Press, P.O. Box 
2468, Chapel Hill, NC 27515). A good compendium of design 
ideas for the new desktop publisher. This book is noted for its 
makeovers that show you before-and-after versions of many 
types of publications. 

Graphic Design for the Electronic Age by Jan V. White (1988, 
Watson-Guptill, 1515 Broadway, New York, NY 10036). A thor
ough introduction to type design and basic page layout. 

How to Understand and Use Design and Layout by Alan Swann 
(1987, North Light Books, 1507 Dana Ave., Cincinnati, OH 45207). 
Excellent introduction to basic design principles applied to pub
lications. This book is divided into three parts: exploring design 
options, making design decisions, and fine-tuning the design. 

Desktop Publishing by Design by Ronnie Shushan and Don 
Wright (1989, Microsoft Press, 16011 NE 36th Way, Box 97017, 
Redmond, WA 98073). Combines hands-on projects v.rith a 
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wealth of practical and inspiring design ideas using PageMaker 
(version 3.0). 

Aldus Maga zine (Aldus Corporation, 411 First Ave. South, 
Seattle, WA 98104). This magazine is devoted primarily to the use 
of PageMaker, although you will find articles on other Aldus 
products. Aldus offers a free trial subscription to all registered 
PageMaker users. 

Publis11! (CW Communica tions, 501 Second St., San Francisco, 
CA 94107). This monthly magazine is devoted to desktop pub
lishing, using all types of programs. It will keep you informed of 
major changes in the field as well as how businesses are actually 
using the technology. Publish! is full of hints for both new and 
more experienced desktop publishers. 
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Av 
Add word to user dictionary dialog box, 193-194 
adding columns and rows to a table, 216 
adding pages to the publication, 201 
adding text to a story, 173-176,197 
adding text to tables, 211 
Adobe Type Manager (ATM), 127-130 

Character shape option, 129-130 
font cache, 128-130 
Line spacing option, 129-1 30 
and PostScript fonts, 407-408 

Aldus print options, 372-376 
Aldus Printer Description (APD) files, 367 
Align to grid option, 314 
alignment, 122-123, 309-310, 393 
All caps Case option, 146 
AppleTalk, 8 
ASCII import filter, 169- 171 
Attributes dialog box, 186 
autoflow, 199-200, 393 
autoleading, 140-141 

Bv 
background printing, 367, 382 
Before x-ref option, 358 
Between entries option, 357 
Between page #s option, 357 
bitrnapped (paint-type) graphics, 225, 226, 393 
bleed, 393 
body type, 393 
book, 393 
Book command, 333, 393 
book list, 333-335 

adding publications to, 334-335 
printing all publications in, 372 
steps in creating, 359-360 

Book publication list dialog box, 333-335 
Bring to front option, 327-328 

Cv 

captions, adding to figures, 261 
Change command, 188-191 
Chooser, 366-367, 382 
ciceros, 393 
clip-art collections, 409-410 

clipboard, 5 
CMYK (Cyan, Magenta, Yellow, Black) 

colors, 384, 386-387, 394 
Color palette 

defined, 394 
displaying and hiding, 387 

color publications, 383-388 
color separa tion programs, 383-384 
color separations, 400 
colors 

applying to text and graphics, 387 
CMYK model, 384, 386-387, 394 
default, 384-385 
defining for publications, 384 
HLS model, 386 
Pantone, 387, 398 
Paper, 384 
process, 383, 399 
Registration, 385 
RGB model, 386 
spot, 383 

Column break before option, 310 
column g uides, 79 
Column guides dialog box, 283-284 
Column-break option, 253 
columns, 282-285 

combining different numbers on one page, 
322-323 

creating on master page(s), 283 
defu1ing, 329 
unequal, 284 

comps (comprehenSives), 2 
Convert quotes option, 198 
Copy styles dialog box, 320 
Create index entry dialog box, 344 
Create TOC command, 336-337 
crop marks, 394 
Crop marks printing option, 374 
Cropping tool, 36, 250-251 
customizing graphic boundaries, 256-261 
customizing vertical ruler, 277 

Dv 

Define colors command, 148 
Define colors dialog box, 384-385 
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Define styles dialog box, 302, 305 
desktop publishing 

defined, 1-4 
on the Macintosh, 4-5 

desktop publishing resources, 411-412 
dictionaries 

for hyphenation, adding words to, 134-135 
purchasing additional, 194-195 
selecting, 310 
specifying hy phenation for added words, 194 
for spelling, adding words to, "1 93-194 

discretionary hyphens, 394 
Display master items option, 280-281 
display type, 394 
double-sided publications, 394 
Download bit-mapped fonts option, 378 
Download PostScript fonts optio n, 378-379 
downloadable fonts, 7 
downloading bitmapped fonts, 378 
downloading PostScript fonts, 378-379 
drawing tools, 36-37 
drop caps 

creating with graphics, 262-265 
creating with Subscript position option, 148-152 
creating with text blocks, 323-325 
defined, 148-149 

dummy text, p lacing in publication, 100- 105 

Ev 
Edit color dia log box, 385-387 
Edit s tyle d ialog box, 301-303 
em, 394 
em dashes, 94 
em space, 122 
en, 395 
en dashes, 94 
en space, 122 
Entry end index option, 358 
EPS (Encapsula ted PostScript) 

defined, 395 
format, 6 
graphics, 226, 228-230 

Even/odd pages o ption, 376 
Export dialog box, 171- 173 
export filters, 171 

Export tags option, 173 
exporting text from PageMaker publications, 

171- 173 
exporting tables to PageMaker publications, 

219-221 

Fv 
facing pages, 395 
figure captions, 261 
fi ll patterns, 38 
Find command, 185-188 
flowing text, 199-200 
folios, 287, 395 
Following topic option, 357 
font utilities, 407-409 
fonts, 114, 125-130. See also type 

defined, 395 
downloading, 378-379 
PostScript and A TM, 407-408 
screen, bitmapped, 125 
selecting, 30-36 
substitution in printing, 374-375 

Force justify command, 144-145 
four-color separations, 383-384 

Gv 

galleys, 1 
Go to page dialog box, 275 
Grabber hand, 36, 43, 251, 395 
graphics, 225-239 

bitmapped, 225-226, 393 
bitmapped, printing with Smooth option, 375 
boundaries for, 252-253 
boundary handles, 257-261 
boundary hand les, adding new, 258 
boundary handles, deleting, 260 
changing independent into inline, 241 
changing inline to independent, 241 
clip-art collections of, 409-410 
cont rolling text flow around, 252-255 
cropping, 250-251 
customizing boundaries for, 256-261 
displaying in low resolution, 278-279 
drilw-type, 394 
EPS (Encapsulated PostScript), 226, 228- 230, 395 



flowing text around, 265 
importing as independent graphics, 264 
impor ting as in line graphlcs, 263 
importing into publications, 239-240 
independent, 240 
independent vs. inline, 225 
inlinc, 240 
PICT, 226--228, 398 
placing in publications, 241 
replacing, 240 
resizing, 249-250 
retaining proportions when resizing, 249 
scaling, 249-250 
scaling to printer's resolution, 249-250 
sizing during placement, 241 
switching to hlgh-resolu tion display of, 278 
TIFF, 226, 230-239. See also TIFF graphics 

grayscale images, 11, 230-231 
grayscale monitors, 9, 10 
greeked text, 38-39 

defined, 395 
specifying size of, 278 

grid, 282, 395 
Grid size option, 314 
guides 

defined, 396 
displaying or hiding in publication, 281 
specifying placement of, 279 

gutter, 274 

Hv 
halftones, 2, 11 , 230, 396 
halftoning, 234 
Help command, 14-15 
HLS (Hue, Lighh1ess, Saturation) colors, 386 
hyphenation, 133-135 

Hyphenation zone op tion, 134 
Limit consecutive hyphens option , 134, 318 
Manual only option, 134 
Manual plus dictionary option, 134 
specifying type of, 316--318 

lv 

!-Beam cursor, 396 
Image control command, 232- 238 

Image option, 376 
Imagewriter printers, 382 

Index V 41 5 

Import command, in story view, 196 
import fil ters, 160-162 
importing 

formatting from word processed documents, 
162-163 

independent graphics, 264 
inline graphlcs, 263 
stories from other PageMaker publica tions, 223 
tables into PageMaker publications, 219-221 
text from IBM PC word p rocessors, 161 
text from Macintosh word processors, 160 
text-only (ASCII) files, 169-171 
Word 4.0 documents, 164-165 
Word 4.0 tables into PageMaker, 167-169 
Word styles into PageMaker, 166--167 

lnclude Aldus Prep print to d isk option, 380-381 
Include images print option, 379 
Include in table of contents option, 310 
Indent/ tabs dialog box, 314-316 
independent graphics, 240 

defined, 396 
importing as, 264 
vs. in line graphlcs, 225 

Index format dialog box, 357- 358 
index(es), 343-359 

for a ll publications in book list, 355 
checking entries for consistency, 350- 351 
cross-referencing in, 349-350, 353 
formatting, 356--358 
genera ting, 354-356 
Include index section headings option, 356 
marking entries in, 343-345 
Nested vs. Run-In format, 357 
page ranges for entries, 348-349 
previewing, 351-354 
Reference override o ption, 348-349 
Remove unreferenced topics op tion, 355 
removing entries from, 353 
replacing, 354-355, 358 
sort order in, 347 
sort specifications for, 346--347 
steps in creating, 361-362 
in story view, 358 
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styles for, 359 
in line g raphics, 240 

defined, 396 
importing as, 263 
vs. independent graphics, 225 

Insert pages dia log box, 201 
Insertion point, 396 
ita lic type, 117, 396 

JV' 

jump-over option, 254 
justification, 396 

Kv 

Keep lines together option, 310 
Keep with next option, 310 
kern pairs, 136-137 
kerning, 121- 122 

defined, 397 
letter pairs, 136-139 
manual, 138-'139, 155 

kerning superscripted text, 152-154 
Knockouts option, 375, 388 

Lv 
landscape mode, 269, 376 
Lase rWriter, 6-8 

Print options for, 369-370 
LascrWriter U/NTX, 369 
LaserWriter Page Setup dialog box, 370 
layout grids, 282 
layout view, 43-44 

defined, 397 
edi ting text and graphics in, 49 
selecting preferences for, 276-280 

leaders behveen tabs, 316 
lead ing (ledding), 119-120 

defined, 397 
proportiona I method, 139-140 
specify ing amount of, 139-1 41 
top-of-caps method, 139-140 

letterspacing, 121-122, 132, 397 
line length, specifying, 120-'121 
Line menu, 37-38 
lines 

adding, 92-94 
changing thickness of, 37-38 

Link info dialog box, 248 
links (linked fi les), 241-248 

automatic updating of, 243 
manually updating, 245-246 
reestablishing, 246-248 
setting default Link options, 243-244 
setting Link options for, 242-244 

LM page marker, 288. See also master page(s) 
long documents, 333-335 

Mv 

Make Aldus Prep permanent option, 379 
manual kern ing, 138-139 
manual text flow, 199- 200, 397 
margins 

inside and outside, 273-275 
left and right, 273, 275 

master page(s), 56, 280-282, 328 
adding ru ler guides to, 82-84 
creating columns on, 79-82 
defined, 397 
d isplayi11g master items on, 280--281 
going to Left master page, 280 
going to Right master page, 280 

measurement system 
overriding d efaults, 25 
selecting, 276-277 

mechanicals, 398 
Microsoft Word. See Word 4.0 
monitors, exte rna l, 8-10 
moving e lements to a new page, 326 

Nv 
ew story command, 45 

Ov 

Orientation option, 376 
Orphan control option, 311 
orphans, 398 

Pv 

Page break before option, 310 
page numbering 



entering page-number markers for, 287-288 
specifying starting page number, 270 
specifying type of page numbers, 271-273 

Page numbering dialog box, 271-273 
Page range option, 357 
Page setup dia log box, 76-79, 268-270 
page size, 268-270 

changing, 38-42, 61 
in Fit in window view, 41 
in Fit in world view, 41 

page(s) 
adding to publications, 270-271 
deleting from publications, 270-271 
double-sided, 273-276, 394 
facing, 273-276, 395 
going to next, previous, or page number, 275 
orienta tion, 268-270 
setting up, 267-288 
specifying margins for, 273-276 

PageMaker 
hardware requirements for, 5 
starting, 19, 59 
version 4.0, new features in, 12-13 

PageMaker 4.0 Story importer dia log box, 179-182 
Pair kerning option, 137-138 
Pan tone colors, 387, 398 
paragraph. Sec nlso styles 

contro lling Jetter and word spacing in, 31 1 
marking, for table of contents, 336 
preventing widows and orphans in, 311 
rules above or below, 311-312 
rules, specifying position of, 312-314 
rules, specifying thickness of, 312 
specifying alignment for, 309-310 
specifying breaks, 310 
specifying indents for, 308-309 
specifying space before or after, 309 
table of contents, 336 

Paragraph ru les dialog box, 311 
Paragraph specifications dia log box, 308-314 

Dictionary pop-up menu, 195 
paragraph styles. See styles 
pasteboard, 27-28, 398 
pasteup, 398 
picas, 117-118, 398 
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PICT (draw-type) graphics, 226-228, 398 
pixels, 399 
Place command, 196-199 

options, 197-199 
used to import graphics, 240 

Place document dialog box, 197 
options when placing graphics, 240 

placeholders, 65 
placing elements precisely, with guides, 286-287 
placing text in publications, 196-199 

as addition to current stories, 222 
as new story, 87, 221 
prepared wi th Story Editor, 223 
as replacement for curren t story, 222 

Pointer, 30, 399 
points, 117-118, 399 
portrait mode, 269, 376 
PostScript, 6, 399 
PostScript print options, 376-380 
PostScript printers, 7-8, 368-370 
Preferences dialog box 

changing units of measurement, 24 
defaults, 276 
options, 276-280 
Show layout problems option, 132 
Size and Font options, 44 

Print blank pages option, 376 
print spoolers, computer-resident vs. network, 

367-368 
Print to dialog pox, 368-372 
printer drivers, 367-368 

Aldus Prep, 367, 379 
Apple printer driver, 367, 382 
and print spoolers, 367- 368 

printers 
choosing, 366-367 
non-PostScript, 382-383 
PostScript, 7-8, 368-372 
printer area, 370 
selecting for PageMaker, 6-8 

printing, 366-383 
Aldus print options, 369-372 
background, 367, 382 
bitmapped graphics, with Smooth option, 375 
blank pages, 376 
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color EPS and TIFF images, 379 
color publica tions, 383-388 
color separa tions, 380 
crop marks on pages, 374 
determining print area, 370 
to d is k, 380-381 
even or odd pages, 376 
knockouts, 375, 388 
mirror images, 376 
negative images, 376 
non-PostScript printers, 382-383 
orientation, 376 
oversized pages, 375-376, 391 
page proofs, 372, 374 
pages on film, 376 
publications in book list, 372 
scaling page size, 371 
selecting page size, 370 
service bureaus, 8 
specifying options for, 371 
spot-color overlays, 375, 387 
thumbnails, 372 
TIFF images a t lower resolution, 379 
tiling, 375-376 

printing exercises 
oversized pages, 391 
thumbnails, 391 
using defaults, 388, 391 

process colors 
defined, 399 
printing, 388 
in publications, 383-384 

Proof option, 372, 374 
Publication window, 22-43 
publications 

color, 383-388 
creating fro m scratch, 75-110 
creating from templates, 65-73 
defined, 399 
double-sided, 394 
opening, 20-22, 59 
opening new, 109-1 10 
saving changes in, 62 

pull quotes, 94-95 

Qv 

QuickDraw laser printers, 382 

Rv 
Read tags option, 163-173, 198, 401 
recto, 399 
registra tion marks, 399 
Remove pages dialog box, 201 
replacing graphics, 240 
replacing placeholders with text and g raphics, 293 
replacing text, 188-191 
replacing text attributes, 189-190 
resolution, 399 
Retain format option, 198 
Reverse option, 148 
reverse type, 140,400 
RGB (Red, Green, Blue) colors, 386 
RM page marker, 288. See also master page(s) 
rotated text, 142-143 

editing in story view, 71 
procedure, 155 

ruler guides, 79, 285-287 
rulers, 23-25 

defined, 400 
hiding or d isplaying, 23-24 
increments by page d isplay size, 286 
specify ing units of measurement for, 24-25 
vertical, customiz ing uni ts of measurement 

for, 277 
rules, 92-94 
runarounds, 256--261 
running heads, 287, 400 

Sv 

sa ns serif type, 400-401 
saving changes to a publication, 57-58 
scanned images, 10, 230-231 
scanners, 10- 12 
scroll bars, 42-43 
searching 

for special characters, 188- 189 
for text attributes, 186 
for text in story, 184-188 
with w ildcard character, 188 



selecting 
all elements on a page, 327 
overlapping elements, 328 
several elements at one time, 326 

semiautomatic text flow, 199, 400 
Send to back option, 327-328 
serifs, 400 
set solid, 401 
Set width command, 143- 144 
shading, 38 
Show index dialog box, 352-354 
Show layout problems options, 279 
slug, 139, 401 
small caps, 145-147 
Smooth option, 375 
Snap to guides option, 285 
Snap to ru lers option, 286-287 
sort specifications for indexes, 346-347 
spacing, adjusting letter or word, 132-133 
Spacing attributes dialog box, 131-132, 311 
spelling checker, 191-193 
Spelling command, 192- 193 
spot-color overlays, 401 
Spot color overlays print option, 375 
spot colors in publications, 383-384 
standoff, 254-255 
stories 

copying text be tween, 181 
creating new, 176-177 
defined, 176, 401-404 
editing in Story Editor, 177-178 
editing text of, 182 
importing from other publications, 179- 182 
methods for selecting text in, 183 
placing in publication, 178 
replacing in publication, 178 
shortcuts for moving around, 183 

Story Editor, 43-49 
disp laying paragraphs, tabs, and spaces in, 176 
displaying style names in, 175 
editing stories in, 177-178 
markers for index entries, 175-176 
markers for inline graphics, 175- 176 
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markers for page numbers, 175-176 
preparing text with, 173-176 

story view, 44 
defined , 401 
menu optio ns in, 46 
specifying font and type size for, 174, 279- 280 

style-name tags, 163-164 
Style palette 

defined, 402 
hiding and displaying, 35-36, 299 

style s heet, default styles in, 300 
styles, 33- 36, 294-320 

applying to text, 319, 331 
assigning type specifications for, 306 
Based on option, 305 
defau lt, 299-301 
defined, 401 
defining from existing text, 302-304, 329 
defining from scratch, 304-318, 330 
importing from other publications, 320 
for index, 359 
Next style option, 305-306 
No s tyle option, 300 
overrides in, 303-304 
overriding for selected text, 319-320 
for table of contents, 336, 340-342 
viewing contents of, 301 

Subscript position option, 150-152 
Substitute fonts option, 374-375 
Super~cript position option, 152-154 

Tv 
Table Editor, 207-221 
table of contents, 336-342 

default s tyles for, 340-342 
generating, 337-340 
indicating numbering system for, 338 
marking entries for, 336-337 
placing in publication, 339-340 
replacing, 337-342 
specifying character between entry and page 

number, 338-339 
steps in creating, 360 
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tables 
adding new columns and rows to, 216 
a ligning text in columns and rows of, 212 
calculating totals in, 212-213 
copying to publications via the C lipboard, 221-223 
creating new, 208-212 
deleting columns and rows from, 216 
deleting text from, 211 
entering text in, 211 
exporting to PageMaker publicatio ns, 219-221 
formatting numbers in, 213 
formatting text of, 211-212 
grid labels, 210 
grid lines, 210 
joining cells of, 217 
resiz ing columns and rows of, 21 4-21 6 
saving as PICT fi les, 220-221 
saving as Text only files, 220-221 
selecting borders for, 217-219 
shading cells in, 217-219 
using Table Editor, 207-221 

tabs 
adding, 316 
deleting, 316 
w ith leaders, 316 
repeating, 316 
setting, 314-316 

Tabs option, 314-316 
tags for style names, 163-164 
templa tes, 289-294 

creating from publications, 294 
creating new publica tions from, 108-109 
defined , 65, 402 
designing publications from, 289-294 
grid, 290-292 
p laceho lder, 292-293 
replacing p laceholders in, 66-73 

text. See also sto ries 
flowing a round graphics, 252-255, 265 
inserting in selected story, 197 
placing as new story, 197 
p reparing for PageMaker, 159-160 
p reparing with word processors, 160-173 
replacing iJ1 selected story, 197 
selecting, 31 
threaded , 201, 402 

text blocks, 201-207 
breaking into smaller blocks, 204-205 
combining, 206-207 
cutting and copying to Clipboard, 202 
defined , 402 
deleting, 202 
drag placing to span columns, 285 
reflowing, 98-100, 205-206 
selecting multiple, 202-203 
sizing and positioning manually, 203-204 

Text flow options, 254-255 
Text rotation command, 142- 143 
Text tool, 30-36, 402 
Text wrap dia log box, 252- 254 
thin space, 122, 402 
threaded text, 402 
thumbnails, 2, 372, 391, 403 
TIFF (Tagged Image File Format) 

graphics, 226, 230-239 
adjusting the ang le of the screen fo r, 235 
adjusting frequency of screen for, 234-235 
adjusting lightness and contrast o f, 236-238 
compressing, 238-239 
defined, 403 
editing in PageMaker, 232- 238 
printing in publica tions, 379 
uncompressing, 239 

TIFF for position only option, 379 
tile, 403 
Tile option, 375-376 
TOC and i11dex prefix option, 273 
Toolbox, 28-29 
Track command, 135-136 
track kerning, 135-136, 403 
type. See also fonts 

a lignmen tof, 122-123, 309-310 
body, 393 
compressing or expanding, 143-144, 156 
display, 394 
filling out a line of, 144-145 
ita lic, 396 
measurement of. 11 7-118 
point size of, 118-119 
reverse, 148, 400 
rotated, 142-143, 155 
sans serif, 114, 400 



serif, 114, 400 
shortcuts for sizing and enhancing, 185 
x-height of, 118-119 

type families, 116-117 
Type menu, 30-31, 182 
type size, 403 
Type specifications dialog box, 182-184, 306 
Type style command, 147-148 
typeface. See fonts 
typography, 113 

Uv 
units of measurement. See nlso Preferences dialog 

box 
overriding defaults, 25 
selecting, 276-277 

Vv 
verso, 403 
vertical ruler, specifying measurement system 

for, 277 
View last error message print option, 379 

Wv 
Widow control option, 311 
widows, 403 
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wildcard character, in text searches, 188 
window-shade handles, 403 
Windows menu, 178 
Word 4.0, 165-169 

import filter dialog box, 165-166 
importing documents into PageMaker, 164-165 
importing style sheets into PageMaker, 166-167 
importing tables into PageMaker, 167-169 

word spacing, 121- 122, 131-132, 404 
Wrap-all-sides option, 254, 262 
WYSIWYG, 4 

Xv 
x-height, 118-119,404 

Zv 
Zero lock command, 25-27 
zero points, 25-27, 404 
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The ABC's of Excel 
on the Macintosh 
Douglas Hergert 
314pp. Ref. 562-X 
This title is written for users who want a 
quick way to get started with this highly
acclaimed spreadsheet program. The 
ABC's offers a rich collection of hands-on 
examples and step-by-step instructions 
for working with worksheets, charts, data
bases, and macros. Covers Excel 
through Version 1.5. 

ABC's of Excel on the 
Macintosh 
(Second Edition) 
Douglas Hergert 
334pp. Ret. 634-0 
Newly updated to include version 2.2, this 
tutorial offers a quick way for beginners to 
get started doing useful work with Excel. 
Readers build practical examples for 
accounting, management, and home/ 
office applications, as they learn to create 
worksheets, charts, databases, macros, 
and more. 

AppleWorks Tips and 
Techniques 
(Second Edition) 
Robert Ericson 
462pp. Ref. 480-1 
An indispensible collection of timesaving 
techniques, practical solutions, and tips 
on undocumented problems fo r every 
AppleWorks user. This expanded new 
edition covers all versions through 2.0, 
and includes in-depth treatment of 
macros. 

Desktop Publishing with 
Microsoft Word on the 
Macintosh 
(Second Edition) 
Tim Erickson 
William Finzer 
525pp. Ref. 601 -4 
The authors have woven a murder mys
tery through the text, using the sample 
publications as clues. Explanations of 
page layout, headings, fonts and styles, 
columnar text, and graphics are interwo
ven within the mystery theme of this excit
ing teaching method. For Version 4.0. 

Encyclopedia Macintosh 
Craig Danuloff 
Deke McClelland 
650pp. Ref. 628-6 
Just what every Mac user needs-a com
plete reference to Macintosh concepts 
and tips on system software, hardware, 
applications, and troubleshooting. 
Instead of chapters, each section is pre
sented in A-Z format with user-friendly 
icons leading the way. 

Excel Instant Reference 
SYBEX Prompter Series 
William J_ Orvis 
368pp. Ref. 577-8, 4 3J4' x 8" 
This pocket-sized reference book con
tains all of Excel's menu commands, math 
operations, and macro functions. Quick 
and easy access to command syntax, 
usage, arguments, and examples make 
this Instant Reference a must. Through 
Version 1.5. 

HyperTalk Instant Reference 
SYBEX Prompter Series 
Greg Harvey 



316pp. Ref. 530·1. 4 3/<'' x 8" 
For serious HyperCard users, this finger· 
tip reference offers complete, cross· 
referenced summaries of HyperTalk 
commands, functions, properties, and 
constants. Examples of usage and an 
introduction to Scripting are provided. 

Mastering Adobe Illustrator 
David A. Holzgang 
330pp. Ref. 463·1 
This text provides a complete introduction 
to Adobe Illustrator, bringing new sophisti· 
cation to artists using computer-aided 
graphics and page design technology. 
Includes a look at PostScript, the page 
composition language used by Illustrator. 

Mastering AppleWorks 
(Second Edition) 
Elna Tymes 
479pp. Ref. 398·8 
New chapters on business applications, 
data sharing DIF and Applesoft BASIC 
make this practical, in-depth tutorial even 
better. Full detai ls on AppleWorks 
desktop, word processing, spreadsheet 
and database functions. 

Mastering Excel 
on the Macintosh 
(Third Edition) 
Carl Townsend 
656pp. Ref. 622·7 
This highly acclaimed tutorial has been 
updated for the latest version of Excel. 
Full or extensive examples, tips, applica· 
tion templates, and illustrations. This book 
makes a great reference for using work· 
sheets, databases, graphics, charts, 
macros, and tables. For Version 2.2. 

Mastering Microsoft Word on 
the Macintosh 
Michael J. Young 
447pp. Ref. 541·7 
This comprehensive, step-by-step guide 
shows the reader through WORD's exten· 
sive capabilities, from basic editing to cus· 
tom formats and desktop publ ishing. 

Keyboard and mouse instructions and 
practice exercises are included. For 
Release 4.0. 

Mastering Powerpoint 
Karen L. McGraw, Ph.D. 
425pp. Ref. 646-4 
The complete guide to creating high· 
quality graphic presentations using 
PowerPoint 2 .01 on the Macintosh
offering detailed, step-by-step coverage 
of everything from starting up the soft· 
ware to fine-tuning your slide shows for 
maximum effect. 

Mastering Ready, Set, Go! 
David A. Kater 
482pp. Ref. 536·0 
This hands-on introduction to the popular 
desktop publishing package for the Mac· 
intosh allows readers to produce 
professional-looking reports, brochures, 
and flyers. Written for Version 4, this title 
has been endorsed by Letraset, the 
Ready, Set, Go! software publisher. 

Understanding Hard Disk 
Management on the Macintosh 
J. Russell Roberts 
334pp. Ref. 579·4 
This is the most comprehensive and acces· 
sible guide to hard disk usage for all Macin
tosh users. Complete coverage includes 
SCSI and serial drives and ports. formatting, 
file fragmentation, backups, networks, and a 
helpful diagnostic appendix. 

Understanding HyperCard 
(Second Edition) 
Greg Harvey 
654pp. Ref. 607-3 
For Mac users who want clear-cut steps to 
quick mastery of HyperCard, this thor· 
ough tutorial introduces HyperCard from 
the Browsing/Typing and Authoring/ 
Painting levels all the way to Scripting with 
HyperTalk, the HyperCard programming 
language. No prior programming experi· 
ence needed. For Version 1.2. 
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At SYBEX, each book is designed with you in mind. Every manuscript is 
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computer experts. We publish the best authors, whose technical expertise 
is matched by an ability to write clearly and to communicate effectively. 
Programs are thoroughly tested for accuracy by our technical staff. Our 
computerized production department goes to great lengths to make 
sure that each book is well-designed. 

In the pursuit of timeliness, SYBEX has achieved many publishing firsts. 
SYBEX was among the first to integrate personal computers used by 
authors and staff into the publishing process. SYBEX was the first to 
publish books on the CP/M operating system, microprocessor interfacing 
techniques, word processing, and many more topics. 

Expertise in computers and dedication to the highest quality product 
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lated into fourteen languages, SYBEX books have helped mill ions of 
people around the world to get the most from thei r computers. We hope 
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This book was produced on a Mac II with 5120K memory and a 
40Mb hard disk using PageMaker version 4.0. The text was 

produced with WordPerfect Mac, version 1.05. The body text is 
set in Palatine. Headings, running heads, and captions are set in 
Helvetica Narrow and Palatine. The index and table of contents 
were generated using PageMaker. Fractions were created with 
ParaFont. Scanned images were crea ted \•vith the ScanJet Plus. 

Line art was prepared with Aldus Freehand. Screen images 
were created with Capture. Page proofs were printed with a 
QMS-PS 810 Turbo laser printer at 300 dpi. Final pages were 

printed \•vith a Varityper 4200B-P at 1800 dpi. 



Extended Characters 
v 
TEXT DIALOG BOX 
GRAPHIC DESCRIPTION TEXT ENTRY METHOD ENTRY METHOD 

White space wildcard N/A "w 

Tab Tab " t 

End of paragraph Return " p 

Forced line break Shift+ Return " n 

I Nonbreaking slash ~+Option+/ "I 
Nonbreaking dash ~+Option+- "-
Discretionary hyphen ~+- "-
En d ash Option+- "= 
Em dash Option+Shift+- 1\ _ (underscore) 

Thin space ~+Shift+t "< 

En space ~+Shift+n "> 

Em space ~+Shift+m " m 

Single wild card character "? "? 

? Ques tion mark ? ? 

1\ Caret Shift+" 1\1\ 

Open quotation marks Option+[ (Same as text) 

Close quotation marks Option+Shift+[ (Same as text) 

Single open quota tion mark Option+] (Same as text) 

Single close quotation mark Option+Shift+] (Same as text) 

« Open guillemets Option+\ (Same as text) 

)) Close guillemets Option+Shift+ \ (Same as text) 

Single open guillemet Option+Shift+3 (Same as text) 

Single close guillemet Option+Shift+4 (Same as text) 

Ellipsis Option+; (Same as text) 

Nonbreaking space Option+spacebar (Same as text) 

1 Page-number marker ~ +Option+p "# 



Special Symbols 
v TEXT AND DIALOG BOX 
SYMBOL DESCRIPTION ENTRY METHOD 

t Dagger Option+t 

t Double dagger Option+Shift+7 
0 Degree Optio n+Shift+8 

a Gene ral currency Optio n+Shi ft+2 

¥ Japanese Yen Option +Y 

£ Britis h Pound Optio n+3 

rt U.S. cent Option+4 

00 Infinity Optio n+S 

§ Section O ption+6 

'll Paragraph Option+? 

• Bulle t O ption+8 
<1 Feminine o rdina l indica tor Option+9 
Q Masculine ordina l ind icator O ption+O (zero) 

(5 German d oubles Option+s 

® Regis tra tion symbol Option+r 

© Cop yright symbol Optio n+g 
nt Trademark sym bol O ption +2 

0 Diamond or lozenge symbol Option+Shift+v 

Acute accent ma rk Option+e+spacebar 

Diaeresis or umlaut accent mark Option+Li+spacebar 

Circumflex Option+Shift+n 

Tilde Option+Shift+m 

Macron (diacritical) O ption+Shift+, (comma) 

Breve Option+Shift+ . (pe riod) 



MASTERING 

PAGEMAKER4 
ON THE MACINTOSH 
Mastering PageMaker 4 on the Macintosh is a complete hands-on guide 
to desktop publishing on the Mac, using the full features and capabilities 
of the latest PageMaker release. Whether you're exploring desktop 
publishing for the first time, or simply looking for an effective way to 
learn PageMaker 4, turn here for: 

A concise overview of desktop publishing and PageMaker-from the 
terminology of publishing to a hands-on tour of the PageMaker 4 
working environment on the Mac. 

Instructions for using built-in templates and style sheets to get fast and 
easy results. You'll learn to use PageMaker templates and style sheets to 
produce quick "pre-designed" documents. 

A comprehensive guide to using PageMaker 4 to design publications 
from scratch. You'll find complete hands-on lessons and practical 
illustrations for every major desktop publishing topic, including: 

• how to use type effectively-from choosing fonts to creating 
special effects 

• preparing and importing text from your word processor 

• creating and editing text in PageMaker's Story Editor 

• importing and working with graphics, including scanned images 

• using PageMaker's drawing tools and Table Editor 

• combining text and graphics on a well-designed page 

• fine-tuning and troubleshooting a page layout 

• using Styles, and creating your own custom templates 

• producing books, manuals, and other long publications 

• mastering the printing process-including how to prepare color 
separations for commercial color printing 

You'll also find quick-reference summaries of essential techniques; 
plenty of expert tips and warnings; and a resource guide listing add-on 
fonts, clip-art packages, utilities, design guides, and more. 
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nJva1 ceo Reference 

About the Authors 

Greg Harvey is a computer consultant, 
instructor, and author of numerous 
training manuals, user guides, and 
books for business software users. His 
many popular SYBEX books include 
Understanding HyperCard and 
HyperTalk Instant Reference, as well 
as comprehensive reference guides to 
Lotus 1-2-3 and WordPerfect. 

Shane Gearing spent many years in 
government service before giving full 
rein to his interests in photography 
and the visual arts. He is now an 
expert on HyperCard and desktop 
publishing on the Macintosh. He 
worked on the sample Stacks for 
Understanding HyperCard, and is 
principally responsible for the sample 
publications in this book. 

SYBEX. Help Yourself. 

90000 

9 780895 884336 

MACINTOSH: Desktop Publishing/Drawing I S B N 0 - 8 9 58 8-4 3 3- X U.S. $26.95 


